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COPYRIGHT & CREDITS

The contents of this guide are Copyright © 2007 Koroush Ghazi, TweakGuides.com and protected under US,
Australian and International Copyright laws. No unauthorized reproduction, alteration or distribution of the
guide, in part or in whole, in any language, is permitted. All Trademarks used in this publication are the
property of their respective owners.

This guide was formerly distributed under the name The Windows XP Tweaking Companion (XPTC).

HOSTING OR DISTRIBUTING THIS GUIDE

I do not grant permission for anyone to reproduce and/or alter any part of this guide and/or host it or
distribute it on their site: the latest version of this guide is always available for free from TweakGuides.com.

I do not grant permission for anyone to produce translations of this guide: unfortunately I can't be sure of
the quality and accuracy of any translations and hence I don't allow my works to be translated. I apologize to
my non-English readers.

Any site or individual is welcome to link to the TweakGuides Tweaking Companion download page, or to
the main TweakGuides page without seeking written permission. Direct links to the file itself are blocked.

I have put a great deal of personal time and effort into creating and maintaining this guide and have
released it free of charge so that the widest possible audience can benefit from its contents. Out of respect for
my efforts and the fact that I didn't write the guide to make a quick buck, please do not rip off my work or
host it on other sites. If I find, or am informed of other sites hosting copies of my guides, I will make every
effort to have those copies removed — including but not limited to pursuing the matter with the site's domain
owner, their ISP, the site host, their IP Registrar, Google's DMCA provisions, and finally through a Court of
Law. TweakGuides.com only produces tweak guides - if I allow others to rip off my guides then my site
loses all its traffic and I lose version control over my material, therefore I will take every step necessary at
my own expense to prevent widespread unauthorized distribution of my works.

CREDITS

This guide is a reference compilation borne out of a great deal of research, reading and personal experience. I
give due credit to all the sites and authors linked throughout this guide - without their work this guide
would not be possible; my thanks go out to them for their contribution to the PC community. The same goes
for all the software developers whose excellent tools I recommend in this guide, especially those who
provide their software for free. It is amazing that they invest so much time and effort into developing and
testing this software then provide it free to PC users.

Thank you to my readers who, since my site began in April 2004, have provided incredible support. From
those who support TweakGuides.com by linking to my guides on various websites and Internet forums, to
those who take the time to write to me or post on the TweakGuides Forums - I really do appreciate all your
feedback, support and ideas. The only thing which motivates me to keep writing my guides is the fact that I
know there are people out there who are willing to give them a go. I wish I could name everyone who has
written to me and provided valuable feedback, but once again there are too many.

A special thanks goes to Larry Kuhn for preparing several pages of very detailed and highly valuable
feedback which has been immensely helpful in earlier revisions of this guide.
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Hij,

Windows XP is a popular, well-established operating system and is still one
of the best operating systems to use on a home PC. I first started using
Windows XP in late 2001, and in late 2002 I released my first Windows XP
Tweak Guide: WinXP Tweaking: From Reformat to Relax. It became quite
popular, so I wrote two follow up guides: WinXP Tweaking: From Relax to
Righteous and The System Optimization Guide for Gamers.

Looking back at these guides now I can see that they are far too simplistic
and totally outdated, but they started me down the road to writing the
‘ultimate’ Windows and System tweaking guide. I want to write a guide
which covers all the major Windows tweaks and tips, yet takes them much
further by providing information on understanding and optimizing your
entire system all in one place: thus was born The TweakGuides Tweaking
Companion, the Windows XP version of which you now see before you. It is
by no means perfect, but I feel it brings me one step closer to my goal.

The first version of this guide came out in December 2004, and since then it has proven to be very popular.
Over the years the guide has been continually refined, and has now undergone a major revision - the
culmination of a great deal of user feedback, experimentation and new discoveries, and of course recent
changes to PC hardware and software. In response to requests from readers I'm continuing to release this
guide as a free downloadable PDF document. This makes the guide readily available to everyone, and makes
it easier to store, read, print and search through.

The nature of tweaking itself has also undergone many changes since my first Windows tweak guide came
out. Tweaking used to be almost solely about finding secret tips and 'hacks' to make things go faster. To my
mind, this is no longer the case. It is now just as important to understand exactly what every setting on your
system does. It doesn't have to be a hidden or secret setting to deserve close attention or have a major impact
on your performance. So you may find less magical Registry tweaks in this guide, and more descriptive text
about standard Windows options. But fear not; the guide also has plenty of links to amazing free
applications which you may not have known about, which will make your life easier and take Windows
beyond the stock standard settings. Tweaking is first and foremost about customizing and optimizing your
machine, and this guide continues that tradition.

And so with that I proudly present the latest version of The TweakGuides Tweaking Companion for Windows XP
to you. It's taken me a long time to compile, so I truly hope it assists you in optimizing your PC. If you find
the guide useful, please consider providing feedback, making a donation, or purchasing the hard copy
version of this guide at www.TweakGuides.com - this will allow me to work on further refining this guide,
and creating a range of new guides in the future.

Cheers,

Koroush

Koroush Ghazi

Owner/Author In honor of 2,500 years of Persian Culture
TweakGuides.com Dedicated to the noble ideals of Cyrus the Great
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USING THIS GUIDE

BASIC REQUIREMENTS

There are several important requirements you must meet before using this guide:

*  You should have prepared backups of all your important information prior to undertaking any of the
changes detailed in this guide. Follow the instructions in the Backup & Recovery section.

*  You should have your original Windows XP installation CD readily available - do not undertake the
tweaks in this guide if you don't have an original Windows XP installation CD.

*  You will need Administrator level access to Windows XP to make the majority of the changes in this
guide. See User Accounts under the Control Panel section for more details.

*  You should be viewing Windows XP using Windows Classic Folders so that the references make sense
to you. See Folder Options under the Control Panel section for more details.

*  You will need Internet access to use this guide, as there are references to online articles, guides and
resources which are essential to understanding and performing some of the major tweaks in this guide.

Unless you meet all of the requirements above, I do not recommend proceeding with the guide as you may
be unable to successfully undertake the tweaks in this guide, or may run into problems.

DIFFERENT VERSIONS OF WINDOWS

This guide is designed equally to suit Windows XP Professional and Windows XP Home. There are no major
content or performance differences between XP Pro and XP Home. The main differences between XP Pro
and Home are covered in this Microsoft Article.

Furthermore, there are no content differences between the various versions of Windows XP such as the OEM
Edition, Academic Edition, and Upgrade Edition. These are all identical in terms of performance and content
to the Full Version of Windows XP. The only difference between these editions is that certain purchasing
conditions are attached to them: the OEM (Original Equipment Manufacturer) Edition can only be provided
with the purchase of a new computer; the Upgrade Edition requires that you own an earlier version of
Windows to install it; and the Academic Edition requires that you be a student or qualified educator to
purchase it. However the tweaks and tips in this guide apply to all these versions equally.

This guide does not apply to other versions of Windows: Windows95/98/SE/ME are all based on a different
architecture to Windows XP, so many of the descriptions of Windows functionality in this guide (such as
Virtual Memory) are not correct for other versions of Windows. Windows 2000/NT/2003/x64 are based on
the same architecture as XP, so most of the general tips, descriptions and tools should work for those
versions. However I cannot specify which do and do not work. I have only tested the tweaks and settings in
this guide on Windows XP, and cannot provide recommendations for other Windows versions. There is a
separate TweakGuides Tweaking Companion for Windows Vista downloadable from the main TweakGuides
Tweaking Companion download page.

WHY IS THE GUIDE SO LONG?

For those wondering why this guide is so long, the reason is simple: the guide is intended as a reference
source. I provide relatively detailed explanations and procedures for a wide range of general system
optimization. To find anything in the guide at any time, use the Table of Contents or the PDF search
functionality (CTRL + F). I will not be providing a 'cut-down' version of this guide at any point: my aim is for
readers to get a good understanding of how their system works, not just rely on my specific
recommendations. I firmly believe in the old saying: "Give a man a fish and he will eat for a day; Teach a man to
fish and he will eat for a lifetime". As such if you find the guide does not have enough detail about a particular
aspect of Windows I encourage you to follow the links provided to do your own research and find out more.
If the one thing this guide does is get you to learn more about your PC, then it has done its job.

opmo sy, Sursn
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RECOMMENDED SOFTWARE

Listed throughout this guide is a range of software which I recommend you download to enable you to carry
out the tweaks and procedures in the guide. Download as much of this software as possible in advance of
tweaking. At no point do you have to purchase any software. I am not paid or sponsored by any software or
hardware company, hence my recommendations are based only on two criteria: functionality and price.
Specifically it must be the best free software available to do the job. In a few cases the software may require
purchase, but usually the trial version of the software retains enough functionality to complete the job for
which I have recommended it. Of course if you do find any of the software useful I encourage you to
purchase it or donate to the software's author. Not everything on the Internet is free, nor should it be.

LINKS TO OTHER GUIDES, ARTICLES & WEBSITES

For those of you hoping that this guide is completely self-contained, I'm sorry to say that is not the case. I
have tried as hard as possible to provide all the relevant information within the pages of this guide.
However aside from tripling the size of the guide if I did so, certain information such as comprehensive
BIOS settings listings, step-by-step Windows installation screenshots, full Service configuration descriptions,
etc. have all been covered much more expertly by other authors. At best I would only be rehashing their
specialized work; at worst I would be plagiarizing it. Therefore you will see many links throughout this
guide to recommended guides, articles and websites which are necessary to supplement the information
provided herein, and which also provide you with an avenue for further investigation if you want to learn
more about a particular topic. The links provided are genuinely useful, and I have no affiliation with the
referred links nor do I gain in any way from referring you to any website.

PICTURES AND DIAGRAMS

You may notice while going through this guide that there is a distinct lack of pictures, diagrams and
graphics. This has been done to keep the guide as small as possible. The Deluxe Edition of this guide does
contain screenshots and images, as well as higher quality image and text resolution. If you want a guide with
these features, and also want to show your support for the site, please consider purchasing the Deluxe
Edition of the guide, either in PDF or printed hardcopy form. See the link above for details.

PROBLEMS WITH THE GUIDE

While I have made every effort to ensure this guide is as accurate and detailed as it can be, I hope you
appreciate that I can't possibly test the information and recommendations in this guide on every potential
type of PC hardware and software. I stress that [ can't provide technical support to readers. Unfortunately I
just don't have the time, so I can't provide personalized tweaking advice, purchasing advice or tech support -
no exceptions. The whole reason for writing this guide is to give each and every reader a thorough rundown
on all the steps necessary to optimize your system.

I also am relying on readers to tell me if there is anything which needs fixing in the guide. Please Email Me
with corrections or additions, and most importantly any dead links you find in the guide.

YOUR RESPONSIBILITIES

The basic theme throughout this guide is that as long as you follow the procedures carefully and use
common sense when applying these tweaks and recommendations, you will remain problem-free. In all
respects the guide is safe to use if followed correctly. However for legal reasons, 1 cannot take any
responsibility for any damage or loss incurred through the use of this guide. It is a condition of use for this
guide that you agree to take full responsibility for your own actions. If you do not wish to take full
responsibility for using this guide, and any resulting impacts, then do not proceed any further - close the
guide now and delete it from your system.
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BASIC PC TERMINOLOGY

If you're not totally familiar with the various components of a modern PC, then this section will familiarize
you with the common terminology used throughout the guide and what each hardware component does in
layman's terms. Note that in this section I use the human body analogy to describe PC hardware
components, hopefully clarifying their functionality in more familiar terms. If you are an experienced PC
user you can skip this section.

BITS & BYTES

You will often see the terms Bits, Bytes, Kilobytes, Megabytes and Gigabytes (or their abbreviations) being
thrown around in guides such as this one. A Bit is the lowest form of computer information and can take the
value 0 or 1 (i.e. Off or On). All computer functionality is derived from the behavior of Bits. For our
purposes, the main conversion factors you need to know are:

8 bits (b) = 1 Byte (B)

1,024 Bytes = 1 Kilobyte (KB)

1,024 Kilobytes (KB) = 1 Megabyte (MB)
1,024 Megabytes (MB) = 1 Gigabyte (GB)

Note in particular that the general convention is that bits are shown as a small 'b, and Bytes are shown as a
capital B. E.g.: 512kbps is 512 kilobits per second, which translates to 64KB/s (KiloBytes per second).

PC

A PC (Personal Computer), often referred to as a System, Machine, Rig or Box, is a collection of hardware
(electronic components) which function as a unified system through the use of software (programmed
instructions). This is similar to the way a human body has a range of organs, connective tissue and structures
designed to work together to achieve an outcome.

CPU

The CPU (Central Processing Unit) is the single most important component of a PC. It is typically a thin
square chip which is seated firmly on your Motherboard, usually covered by a large metal heatsink and fan
to cool it. The CPU controls and co-ordinates the actions of the entire PC under instruction from software. It
has the role of determining which hardware component does what, assigning tasks and undertaking
complex calculations which are then fed through the various relevant components and back. In human body
terms, the CPU is the brain.

MOTHERBOARD

The Motherboard, also called the Mainboard, or Mobo for short, is the large rectangular plastic Printed
Circuit Board (PCB) into which a large range of electronic components are connected in a PC. The
motherboard provides a network of pathways (or Buses) for the CPU to communicate to the various
hardware components, and a range of ports for standard peripherals and devices to plug into the PC. The
major pathway for information flow in the motherboard is the main Bus (Front Side Bus or HyperTransport).
In human body terms, the motherboard is the nervous system and arterial system combined.

MEMORY

RAM (Random Access Memory), also called System RAM or just Memory, is the most common form of
computer memory hardware used by a PC. RAM usually comes in long thin 'sticks' of set sizes that plug into
the motherboard and through it provide a place for the CPU and other components to temporarily store
information. RAM only holds information while the PC is on; if a PC is rebooted or switched off, any
information in RAM is instantly cleared. Aside from System RAM, the graphics card usually has its own
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RAM called Video RAM, and the CPU and other hardware often have small memory chips called Caches to
hold information temporarily. In all cases, memory is used to speed up data transfers because information
can be written to and read from memory much faster than any other form of storage (such as the Hard Drive
or CD ROM). This is primarily because such memory chips have no moving parts.

ROM (Read Only Memory) is a permanent form of memory, and works similar to RAM, however unlike
RAM it can only be read from and not written to under normal circumstances, and it will not clear when the
system is rebooted or switched off. ROM is primarily used to hold small amounts of important information,
such as the BIOS (Basic Input Output System) — the program which tells the computer how to function when
it is first switched on - stored on the ROM chip in the motherboard. Certain ROMs can be written to by use
of a process called Flashing, such as when the BIOS is flashed with a new version. In human body terms,
Memory is like our own memory with RAM being short term memory and ROM being long term memory.

HARD DRIVE

The Hard Drive is a semi-permanent storage area that acts like Memory, except it is slower and far larger.
The hard drive is a rectangular metallic box inside which is a stack of round platters and a read/write head.
The hard drive plugs into the motherboard's IDE (Integrated Drive Electronics) Controller, SATA (Serial
Advanced Technology Attachment) Controller or SCSI (Small Computer System Interface) Controller
depending on the drive type and the motherboard type. Whenever the PC requires information, it must first
be read from the hard drive, usually into RAM, from where it is then accessed by the CPU and other devices.
Data such as installed software will remain on the hard drive regardless of whether the system is rebooted or
switched off. Because the hard drive involves moving physical components, such as the read/write head and
a spinning disk, it can never be as fast as RAM/ROM - which have no moving parts - in providing
information. Often a system may slow down or stutter while waiting for more information to be loaded up
or written to the hard drive. The amount of information on the hard drive itself usually has no significant
impact on its performance. In human body terms, the hard drive and the information it holds is like a library
of books, or a notepad that can be read from and written to.

CD/DVD DRIVE

Much like the Hard Drive, a CD, DVD, CDRW or DVD-R drive is a storage device that reads from and
sometimes writes information onto CDs or DVDs that permanently hold this information until overwritten
or deleted. Such drives usually come in plastic rectangular boxes with a loading slot or extendable tray in the
front. They usually plug into the motherboard's IDE Controller or SATA Controller depending on the drive
and motherboard type. Specifically, CD and DVD ROM drives can read information from CDs or CDs &
DVDs respectively, but cannot write anything onto them. CDRW and DVD-R drives can both read from and
write information to writeable CDs and DVDs respectively. All these drives are slower than a hard drive in
reading and writing information due to physical limitations once again and also the way in which they are
connected to the main system Bus. In human body terms, these drives are again much like an external
library and the CDs and DVDs themselves are like books or notepads.

FLOPPY DRIVE

Much like a Hard Drive or CD/DVD Drive, a Floppy Drive stores information on a recording medium,
usually a thin plastic 3.5" Floppy Disk. The floppy drive comes in a rectangular plastic box with a loading
slot at the front and a large ejection button, and plugs into the floppy controller on the motherboard. Floppy
drives can read from and write information to floppy disks, but are incredibly slow compared to any other
form of drive, and also hold very little information (1.44MB) and hence are not commonly used anymore.
Most PCs retain a floppy drive for emergency use when Windows won't load up for example, or to flash the
BIOS. Again, in human body terms a floppy drive is like a library, with the floppy disks a document or
notepad for reading from and writing to.
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GRAPHICS CARD

The Graphics Card, also called the Video Card, Graphics Adapter or VGA Adapter, is a miniature computer
of its own dedicated solely to graphics-related functions on the PC. It is a thin rectangular plastic PCB with a
GPU (Graphics Processing Unit, or 'Core') - similar to a CPU - and Video RAM (or VRAM) - similar to
System RAM - as well as Pipelines for transferring information internally, similar to the FSB. It plugs into the
motherboard through the AGP (Accelerated Graphics Port) Port, a PCI (Peripheral Component Interconnect)
slot, or a PCI-E (Peripheral Component Interconnect Express) slot. Most graphics cards have one or more
heatsinks on the GPU and the VRAM, and often have a fan on the GPU or covering the entire card. The
graphics card undertakes the majority of 2D and 3D graphics calculations and also sends information
directly to the Display Device, which is usually a monitor. Some motherboards have built-in graphics
functionality that works in much the same way as a graphics card, but is referred to as Onboard Graphics or
Integrated Graphics. PCs with such graphics functionality typically process graphics-related information far
less quickly than those with plug-in graphics cards. In human body terms, the graphics card is like the
portion of the Brain that relates to visual or artistic expression.

DISPLAY DEVICE

A Display Device, or more commonly referred to as the Monitor, is the device through which the PC's
information is displayed graphically. This graphical information comes from the graphics card, and a
display device must usually be plugged directly into the graphics card through the back of a PC to facilitate
this. While most computers still have a CRT (Cathode Ray Tube) monitor as their primary display device,
modern PCs can utilize Televisions, LCD displays and sometimes multiple types of displays at once to
output the graphics information. Display devices have the ability to display graphics at various resolutions,
typically expressed in number of Pixels wide by number of Pixels high (e.g. a resolution of 1024 x 768). A
Pixel is the smallest component of graphics, and the higher the resolution, the more pixels are displayed on
the display device and hence the clearer the image. At each resolution a display device can also redraw the
image a number of times per second, referred to as the Refresh Rate. The higher the refresh rate the smoother
your graphics will appear and the less flickering you will experience. In human body terms the display
device is like a pen and a piece of paper, or a canvas used by a person to convey thoughts as images and text.

SOUND CARD

The Sound Card, also called the Audio Card or Audio Device, is a thin plastic PCB or sometimes an external
attachment that acts as a dedicated CPU for calculation of audio information. A sound card typically plugs
into the motherboard through a PCI slot, or in some cases as an external peripheral, and usually has no
heatsink or fan, as it does not require the same level of cooling as other major components. Some
motherboards have built-in audio functionality that works in much the same way as a sound card, but is
referred to as Onboard Audio or Integrated Sound. PCs with such audio functionality typically process
audio-related information less quickly or less faithfully than those using plug-in sound cards. In human
body terms, the sound card is much like the portion of the Brain that relates to audio interpretation.

SPEAKERS OR HEADPHONES

A PC speaker system (or headphones) is designed to output the audio signals of the PC, which usually come
from the sound card, and hence they typically plugged directly into the sound card. Even if a PC has no
attached speakers/headphones all PCs have a small built-in speaker that provides important system status
information usually as beeps. In human body terms the speakers or headphones are like the voice of the PC.

POWER SUPPLY UNIT

The Power Supply Unit (PSU) is a square metal box, usually with a fan at the back, which is cabled to all the
major components of a PC, particularly the motherboard, and provides the power for the PC to function. The
power cord from the wall usually plugs straight into the back of the PSU directly, as it draws the appropriate
power and regulates the precise voltages that certain devices need to function correctly. The PSU usually has
a wattage rating which indicates the maximum power output of the PSU under load, with the more devices
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connected to a PC the higher the wattage required to maintain ample smooth power to each and hence keep
the system stable under stress. In human body terms, the PSU is like the heart which pumps blood through
the arteries and organs.

HEATSINKS AND FANS

A Heatsink is a square or rectangular solid metal object typically with a perfectly flat surface on one side,
and many long square 'spines' on the opposite surface. The role of a heatsink is to sit on top of a chip like the
CPU or GPU, or even RAM - any component which gets quite hot - and draw out the heat these components
are producing through conduction. This heat then travels along the length of the heatsink to the top of the
individual metal spines where cooler air and a large surface area help in accelerating the dissipation of the
heat. Typically a fan is bolted on top of the heatsink to aid in blowing more cool air over the heatsink's
spines and hence dissipate the heat more quickly. In some cases where just a heatsink is sufficient for the job,
no fan is used — such as the heatsinks on the motherboard or heatsinks placed onto VRAM.

Often Fans are placed inside and around a PC case by themselves to draw in cool air and blow out hot air
from the enclosed space around the hardware components on the motherboard. Given the way heatsinks
work, the air around components will heat up quickly as heatsink(s) radiate the heat drawn from hardware
components. Fans of varying sizes and speeds aid in cooling the air in the entire case.

Other forms of PC Cooling such as refrigerator-like Peltiers, Heatpipes and Watercooling blocks can assist or
replace heatsinks and fans in the role of cooling system components, but are less common due to their cost
and complexity. In human body terms these devices are like the respiratory and perspiration functions.

CASE

The PC case is a hardened structure, usually made of thin but strong metal and/or plastic, which encloses all
the PC components and onto which the motherboard is firmly attached. The case usually provides the basic
framework required for affixing additional components such as hard drives, floppy drives and the PSU.
Often the case will also have a range of openings small and large to allow fans to draw and expel air for
better circulation. In human body terms the case is like the skeleton combined with the skin.

PERIPHERAL

A Peripheral generally refers to any external device attached to a PC, such as a mouse, keyboard, printer or
digital camera for example. The term 'peripheral’ is used specifically to indicate that the device lies outside
the periphery of the PC case. The only thing peripherals have in common with each other is that they
provide additional input to the PC, and often capture some of the PC's output too. In human body terms
peripherals are like the eyes, ears, nose, hands and feet of the PC.

OPERATING SYSTEM AND SOFTWARE

The Operating System (or OS) such as Windows XP, is a vital piece of software — a compilation of
instructions that tell all the hardware components in a PC how to function to achieve particular outcomes.
This information is interpreted and coordinated by the CPU, but is not confined to CPU functionality. An OS
is a necessity on all modern PCs since without an overarching program to provide core functionality, all the
computer components would not be able to function as a single machine. Additional installed software is
like modular functionality which slots under the OS to perform specific functions or tasks, such as word
processing or gaming. In human body terms the Operating System/software is like a combination of our
basic education, instincts and emotions — the driver behind our behavior that tells us how to act.

Hopefully this information has helped you understand the roles of the various hardware components a little
better. Ultimately a PC is an incredibly complex machine and as such the simplifications in this section don't
do justice to the intricate and multi-faceted ways in which hardware and software components interact.
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SYSTEM SPECIFICATIONS

The first step in optimizing your PC is to find out precisely what hardware components you have, and what
their various capabilities are. To do this, you require a general System Information tool. Information about
your system specifications is vital - for example you must know the model and chipset type of your
motherboard before you can upgrade your BIOS, or to install the correct motherboard drivers. Or you may
be asked to provide details of your PC's specifications so that a Technical Support person can help you via
email. Or you may simply be curious as to what exactly you paid for when you bought that PC recently.

B SYSTEM INFORMATION TOOLS

Fortunately there are several good free system information utilities to choose from, and a combination of
these will tell you everything you need to know about your system specifications. These are listed below and
I recommend you download and install as many of these programs as possible:

WINDOWS SYSTEM INFORMATION TOOL

You can access the Windows System Information Tool by going to Start>Programs>Accessories>System
Tools>System Information, or go to Start>Run and type "msinfo32.exe" (without quotes) and hit Enter. Note
that for this utility to work, you will need to have the 'Help and Support' service enabled - see the Services
section for more details.

The System Information Tool presents a range of basic information about your system. Unfortunately much
of it can be a little difficult to comprehend or may not be quite what you're looking for. Some of the more
useful pieces of information include the IRQ allocations under Hardware Resources>IRQs; the listing of your
hardware components by type under the Components section; and a listing of all the system drivers loaded
up and their status under Software Environment>System Drivers. In general the System Information Tool is
best used by medium to advanced users who can comprehend the interface and the information much easier
than a beginning user. Its major advantage is that it is a free and built-in utility that anyone can easily access.

DEVICE MANAGER

You can access the Windows Device Manager under the Control Panel>System>Hardware tab, or by going
to Start>Run and typing "devmgmt.msc" (without quotes) and then press Enter. As a built-in Windows
utility you can gain a great deal of useful information from this tool. Your major devices are displayed under
various categories, and you can even choose to update individual device drivers or uninstall a device
altogether should you wish. The device manager has several important roles and is covered in more detail
under the Control Panel section of this guide.

DIRECTX DIAGNOSTICS

You can access the DirectX Diagnostic Utility (DXDiag) by going to Start>Run and typing "dxdiag" (without
quotes) and pressing Enter. DXDiag is another built-in Windows Diagnostic/System Information tool that is
part of the DirectX API. When DXDiag starts up you don't need to worry about WHQL (Windows Hardware
Quality Labs) certificate checking - WHQL certification is not an indication of a driver's stability or
functionality (See the Driver Installation section for more details).

The main tab of DXDiag, called System, shows basic information about your system such as CPU type and
speed, amount of physical RAM and the total pagefile (Virtual Memory) usage among other things. Under
the Display, Sound and Input tabs you can find more information about the particular hardware you are
running for each of these functions, and also conduct some basic tests to ensure they are working to their full
extent under DirectX. In particular you should ensure that all the DirectX Features listed are Enabled and
that any Acceleration options are at maximum (slider to the far right). If you are experiencing problems with
your hardware you can try the DirectX troubleshooting procedures under the More Help tab.
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The most useful function for DXDiag is its ability to create a text file with all your major system information,
including your main hardware specifications, driver files, and environmental settings. To generate this text
file click the 'Save All Information' button found at the bottom of the DXDiag screen. You will be prompted
to save this report somewhere, and the default of the Windows Desktop is just fine. This DXDiag.txt file can
now be attached to an email you can send to a Technical Support person, or its contents can be posted on an
online forum to allow others to help you with any problems you may be experiencing. Don't worry - it
doesn't contain any private information such as serial numbers or passwords.

EVEREST

The free Everest Home Edition has now been officially discontinued. However you can still download the
last free version from sites like MajorGeeks and Softpedia. Keep in mind that over time it will become dated
and unable to correctly identify all new hardware. I still recommend it for most people because in terms of
depth of useful information and ease of use, Everest is one of the best free utilities you can get. For example
if you want to know your RAM's SPD settings (SPD is Serial Presence Detect - See RAM Overclocking under
the Overclocking section), simply go to Motherboard>SPD and you can see your RAM's current SPD
timings, RAM brand and even a link to your RAM manufacturer's website. If you're curious about your
motherboard's chipset type, to install the correct motherboard chipset drivers for example, go to
Motherboard>Chipset and you can see the chipset type and once again a link to the chipset manufacturer's
website. You can even run memory benchmarks under the Benchmark section of Everest to test your RAM.

SIW

SIW is the System Information for Windows tool which can be downloaded from the SIW Website. It is very
similar to Everest Home Edition. Once you've downloaded the program, you can simply run it from the file -
there's no need to install anything. The interface is quite intuitive; click the items in the left pane to see more
details about them. For example, to find out more about your motherboard, click the Motherboard item
under the Hardware section. After a short pause, the details will be shown in the right pane. Alternatively,
you can access these items by going to the Software or Hardware menus at the top of the screen. Note that
SIW also has some testing and tweaking tools built into it under the Network and Tools menus. These aren't
covered here, but I don't recommending changing anything using them unless you feel confident that you
know what they do. To find out more about these functions, go to the Help menu and select Online Help.
You can also check for updates to SIW under the Help menu.

3DMARK

You can download the latest version of 3DMark from the Futuremark Website and you can read more about
its main functionality under the Benchmarking & Stress Testing section in this guide. 3DMark is primarily
designed as a graphics benchmarking utility, however it has a nice system information section that gives you

plenty of important info. Start 3DMark and on the main screen, click the Details button under the System
section. A browser screen will open with a vast array of information about your system. Everything from
your CPU's clock speed and L1 & L2 Cache sizes, to your hard drive's capacity and interface type.

SANDRA

You can download Sandra from the SiSoftware Website. Once installed, run Sandra and you will see a wide
selection of information and benchmarking modules to choose from. Under the free version of Sandra, many
of these modules are inactive, however the main ones we need have sufficient functionality for our purposes.
For example, if you want to know more about your system, go to the Hardware tab and open the Computer
Overview module. It will display a range of basic but important information about your system, such as the
CPU speed and type, and your graphics card model. If you want to know more about your motherboard,
open the Mainboard module, and it will display the motherboard chipset type, and information related to
your motherboard and the types of devices on its various ports. Sandra has several very useful
benchmarking and stress testing features that are covered in full detail in the Benchmarking & Stress Testing
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section below. Note that Sandra installs two new Services for itself, called the 'SiSoftware Sandra Agent
Service' - which you can set to Manual; and the 'SiSoftware Database Agent Service' - which you can Disable.

CPU-Z

You can download CPU-Z from the CPU-Z Website. Run CPU-Z.exe and the CPU-Z Utility will provide you
with everything you need to know about your CPU, such as its precise speed, voltage, packaging type, cache
sizes etc. It will also tell you about your system's current Bus speed under the CPU tab, your full
motherboard details under the Motherboard tab, and your RAM's complete details under the Memory and
SPD tabs. Note that for information to appear under the SPD tab you will have to first select the slot(s) on the
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motherboard that your RAM stick(s) occupy, otherwise the box will be empty.

NERO INFOTOOL

You can download the Nero Disk InfoTool Utility from the CD Speed Website. Run the InfoTool.exe file and
you can see a wealth of information about your selected CD/DVD drives, as well as your drive channels
under the Configuration tab, and even a quick snapshot of your main system components under the
Hardware tab. The main use for InfoTool is to give you precise information about the capabilities of your
CD/DVD drives under the Drive tab, such as the types of media the drive(s) can read from and/or write to,
and their current firmware version for example.

B PROVIDING SYSTEM SPECIFICATIONS

If at any point you are seeking help from others you will have to provide your system specifications (e.g. on
an online forum or to a qualified Technical Support person). If no format is provided for you to follow, you
should try to use the format shown below. Use the system information tools covered above to fill in the
appropriate details. The more detail you can provide, the better - the bare minimum is the brand and model
number of your major components. Add details like overclocking, additional cooling or any modifications:

CPU: e.g.: AMD Athlon 64 X2 4400+ Dual-core CPU, stock speed, XP-90 cooling
Motherboard: e.g.: DFI NForce4 SLI-DR
Graphics card: e.g.: Nvidia GeForce 7800GTX at Stock speed
Sound Card: e.g.: Creative SoundBlaster Audigy 225
RAM: e.g.:2x1GB OCZ PC3200 at 400MHz, 2-3-2-5 (CAS 2)

Hard Drive(s): e.g.: 2 x 74GB Western Digital Raptor SATA RAID 0
CD/DVD Drive(s): e.g.: Pioneer DVR-109 DVD-R

Power Supply: e.g.: Silverstone 650W
Operating System: ¢.g.: Windows XP Pro SP2 including all updates

Driver Versions, Other Details: e.g.: 2.08.0002 Audigy 2 drivers, 84.21 Forceware, 6.70 NForce drivers

You can also provide details of your monitor, keyboard, mouse, speakers/headphones - however these are
usually not critical to solving a PC problem, unless of course your problem is with mouse input, display
output, or audio output for example. If you are still at a total loss as to how to provide full details of your
system, use DXDiag (see above) to generate a .txt report and attach it (or cut and paste its rather lengthy
contents) to an email or post on a forum. Neglecting to provide this information can greatly increase the time
taken to find a solution, and sometimes you may even be given the wrong solution.

In general I strongly recommend having several system information tools installed on your system, as you
will need to refer to your system information often throughout the course of this guide. You must become
familiar with the full specifications of the hardware on your system if you want to successfully optimize and
troubleshoot your PC now and in the future. Furthermore, whenever you request help from others to resolve
a PC issue, the first thing they will ask you is your exact system specifications.
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BACKUP & RECOVERY

If you are sure that your system is completely free of malicious software (See the PC Security section), you
should make sure you have a backup copy of all your important and irreplaceable documents. Backing up is
a vital and unavoidable part of sensible computing so familiarize yourself with the techniques in this section
and use the most appropriate one(s), especially before proceeding with this guide. I recommend at the very
least a manual backup of all your important data if preparing for a reformat and reinstall of XP or if you're
about to tweak a current install. Further, I suggest creating a new System Restore point and a full backup of
your Windows Registry if tweaking an existing installation of XP.

This section also covers a range of useful data recovery methods you can use to regain valuable information
which has been lost either through forgetting passwords, corruption or damage to your Windows
installation, or accidental deletion of files.

B MANUAL BACKUP

The following is a list of tips for creating a manual backup of your data and settings in Windows XP. There
are methods that can be used to create automated backups of your system which are covered further below,
however I personally use the manual method regularly to ensure I have a 'clean' backup copy of all my
important files, especially if I am going to do a reinstallation of Windows XP. Any automated backup utility
you use may inevitably backup the problematic or sub-optimal settings you were trying to escape in the first
place, so a clean manual backup is strongly recommended if you are experiencing problems.

How precisely you do a manual backup is up to you; below are my tips for preparing data and manually
backing up your important files regularly:

Logical Directory Structure: Create a logical directory structure under your My Documents folder, with
appropriately-named sub-folders, e.g. Music, Movies, Pictures, Patches, Downloaded Programs, Drivers,
Personal Documents, Tax - as many as necessary. Note that you can rename the default directories 'My
Pictures', 'My Music|, etc. to Pictures, Music - right click on each folder and rename it. Then sort all your
relevant documents into these directories. Keep copies of downloaded programs, keep a copy of all the latest
drivers, Service Packs, and so forth. Archive them in .zip files to save on drive space and give the archives
logical names (e.g. Quake4.zip for Quake 4 patches, .cfg files and save games). Alternatively, if you have a
separate data partition, store your files there in appropriately named folders. Having a logical file structure
makes storing and finding files easier, but importantly it also makes regular manual backups much easier.

Internet Bookmarks: In Internet Explorer you can create a backup file of your Favorites by going to File
menu>Import and Export>Export Favorites. Follow the prompts to export your Favorites to a suitable
location under the default name Bookmark.htm). Back this file up, and to import your Favorites back into
Internet Explorer at any time go back to the Import and Export function and choose 'Import Favorites'. If you
use a browser like Mozilla Firefox, you can backup your bookmarks by going to the Bookmarks menu,
selecting 'Manage Bookmarks', then selecting File>Export and choosing where to save the Bookmarks.html file.

Saved Games: If you want to backup any saved games or game configuration files, these are typically held
under the game's main directory and/or under your \Documents and Settings\[username] directory, often
under a Saves, Savegames, [profilename] or similar subdirectory. If you are having problems with a game, I
don't recommend backing up the game's configuration files as it may just pass the problem onto your new
install of Windows. Also, don't attempt to backup an entire game directory, as you cannot restore games (or
most other programs) in this manner - these will not run properly if they are copied back onto another
installation of XP due to the lack of appropriate registry entries and files spread throughout various other
directories. You must use the original installation files/discs to reinstall a game or program correctly.
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Usernames/Passwords: You can store all your usernames and passwords securely electronically - see the
Backing Up and Restoring System Passwords section below. If you have no faith in electronic storage
systems then compile a written list/printout of the major usernames and passwords on your system.
However you must then store this list safely in a physically secure place like a safe or lockable drawer.

Backup to Disk or Hard Drive: Once you have determined the files to backup, you should regularly backup
your important files/programs to another medium, such as another hard drive, or ideally to rewriteable CDs
or DVDs. I don't recommend backing up to another partition as a sole backup method. I recommend CDs or
DVDs simply because all hard drives eventually suffer from physical failure which renders them totally or
partially unreadable. It is also easier to transfer information between PCs via CD/DVD rather than having to
plug in a hard drive, but the choice is yours. When selecting which files to regularly back up, give top
priority to files that are genuinely irreplaceable, such as digital photos and financial documents. Anything
that has a high sentimental or monetary value should be backed up often, ideally to more than one location.
Information which changes regularly should be backed up at least weekly.

B AUTOMATIC BACKUP

If you want a more comprehensive method of backing up your data that will take up more space but is more
foolproof and automated then you can use an automated backup tool. Note that if you are having any sort of
system problems or quirky behavior, I do not recommend using this method to backup your data and
settings. Any automated tool will typically capture and transfer the same problems you experienced before
onto your new install of Windows XP — defeating the whole purpose of doing a fresh install of XP. Only use
these methods if you aren't experiencing any problems and have trouble-free performance.

WINDOWS BACKUP UTILITY

You can access the Backup Utility by going to Start>All Programs>Accessories>System Tools>Backup, or by
going to Start>Run and typing "ntbackup" (without quotes) and pressing Enter. Windows XP Home users
will not have access to the Backup utility by default, but it can be manually installed from the Windows XP
Home CD by following the instructions in this Microsoft Article. Basically it involves inserting the Windows
XP CD into your drive, opening Windows Explorer, going to the \VALUEADD\MSFT\NTBACKUP\
directory on the Windows CD and double-clicking on the Ntbackup.msi file to start installation of it.

The Backup Utility has several methods of usage, which are detailed in this Microsoft Article, but essentially
it involves the following steps:

1. Run the Backup Utility and click the 'Advanced Mode' link to switch to a more customizable method of
backing up.

2. Go to the Backup tab, and put a tick in the boxes next to the directories that you want to back up.

3.  Select the 'System State' box if you want to ensure all the additional system settings relating to your
setup are backed up as well (i.e. your Registry settings etc.). Alternatively, if you don't want to save
these as well (i.e. you want to restore your backups onto a clean install of Windows), then don't tick the
'System State' box.

4. Click the Browse button at the bottom, and select the destination for the backup. This is usually another
hard drive given the amount of data involved; the Backup utility cannot backup to CDs/DVDs.

5. Click the 'Start Backup' button to commence backing up. The process may take quite some time
depending on how many directories you chose to back up, and the type of medium to which they are
being transferred.

6. To restore this backup in the future, run the Backup utility again, but this time under 'Advanced Mode'
click the 'Restore Wizard' button and follow the prompts.

The Backup utility has many more options and methods for backing up, so go through the options for
configuring the utility under the Tools>Options menu in Backup.
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NORTON GHOST

The most commonly used and popular package for backing up quickly and easily is Norton Ghost.
Unfortunately Ghost isn't free. However if you genuinely can't be bothered with manual backups and/or you
have some very important information and want to make sure it's backed up completely and properly
and/or you often install risky software, play around with system settings and overclock heavily, then Norton
Ghost can save you a lot of grief. Since Ghost isn't free, and is not essential, it won't be covered in detail here,
but I recommend you refer to this Norton Ghost Guide for full details.

You can also try Acronis Truelmage, which some users prefer over Norton Ghost. Once again this is not a
free utility, so refer to the Truelmage User Guide for more details.

ONLINE BACKUP

Most ISPs provide their customers with a basic webspace, or if not, then free email services such as Yahoo
and GMail provide large amounts of storage in the order of several Gigabytes. While I do not recommend
uploading/emailing any sensitive data to these locations, they do serve as good holding spots for backups of
digital photos and other important but non-secretive documents. That way if you lose all your local backup
copies through fire for example, there are still copies online which you can download and restore.

If you really want to be secure and not worry about losing your backups - especially if you have extremely
valuable information - then consider an online backup service, like Backup.com. This ensures that your data
is encrypted and stored safely, but this not free use, so is only recommended for people who genuinely need
that level of protection against data loss or theft.

B USING SYSTEM RESTORE

Once the initial backing up of your data and programs is done, and if you are not going to reformat and
reinstall Windows XP, you need to create a new System Restore point as an additional safeguard before
doing any tweaking. Using System Restore means that even if you make a large number of changes you can
‘undo' these changes using System Restore. More details of this functionality can be found in this Microsoft
Article. It is strongly recommended that you create a new Restore Point prior to implementing any major
tweak or system change at any time by following these steps:

1. Go to Start>Programs>Accessories>System Tools and launch System Restore, or open MSConfig
(Start>Run>MSConfig), and click the 'Launch System Restore' button.

2. In the System Restore Wizard, click 'Create a Restore Point' and follow the prompts to save your system
state in a new restore point.

3. At any time, if you wish to return your computer to the state it was in when you created a particular
Restore Point, follow step 1 above to get to the System Restore Wizard. Then click 'Restore my computer
to an earlier time', and select the date on which you created the restore point you wish to return to.

Note if System Restore is enabled, Windows automatically makes restore points under -certain
circumstances, such as during the installation of drivers, or prior to installation of certain applications. This
gives you additional protection against catastrophic changes on your system. However a restore point is not
a guarantee that you can just go back to the way things were. In some cases trying to undo a change by
going back to a recent restore point won't work, so only use System Restore as an additional layer of
protection - you should always make backups of your important information often, regardless of whether
you use System Restore or not.

If your system is currently stable and problem-free, and you have made a recent restore point, you can clean
out all older restore points except for the latest one by using the Disk Cleanup utility (see the Cleaning
Windows section). This frees up a great deal of hard drive space. Finally, note that System Restore will not
function if you've disabled the 'System Restore' service - see the Services section of this guide.
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B BACKING UP THE WINDOWS REGISTRY

The Windows Registry is a critical component of Windows XP, and any problems you experience with it can
make Windows unbootable, or result in a variety of errors or strange behavior (See the Windows Registry
section). That is why it is important to have a backup of the Registry before undertaking any tweaking.

The most efficient and foolproof way of backing up the entire registry is not to use the Export function in
Registry Editor - that method is only handy for saving individual branches of the Registry. Unfortunately
full Registry backups made by Registry Editor will not restore correctly if your registry becomes corrupted.
Instead, I strongly recommend you use a free utility called Erunt (Emergency Recovery Utility for NT).
Download this program and install it, but note that during the installation of Erunt you should answer 'No'
when asked if you want Erunt to be placed in the startup folder, as this is unnecessary.

To make a backup of the Windows Registry using Erunt, launch the program. You will be prompted to
backup your registry to a folder, which you should accept by clicking Ok until the backup has been made. If
you want to restore this backup at any point, simply go to the directory where the backup was made,
typically \ Windows\ ERDNT\[Date of backup]\, and launch the ERDNT.exe file there to restore that backup.

B BACKING UP & RESTORING PASSWORDS

One of the biggest headaches when running Windows XP would be losing your main login password,
particularly if you're the System Administrator on your machine. With the NTFS file system it is quite
difficult to access the data on your hard drive without the correct login password (there is a method to reset
this password - see further below). Clearly the best thing to do is back up your password now before
anything happens, so that if necessary you can restore it without any difficulties. The recommended way to
back it up is as follows:

BACKING UP LOGIN PASSWORD

1. Go to Control Panel>User Accounts and click on your User account.

Click on 'Prevent a Forgotten Password' in the left pane. The Forgotten Password Wizard will open up.
Click Next.

3. Insert a blank formatted 3.5" floppy disk into your A:\ drive and click Next. If you need to format a
blank floppy first, insert the disk into your floppy drive, open Windows Explorer, right-click on A:\ and
select Format. Click Next.

4. Type in your current User Password in the box and click Next. Once the disk has been created, click
Next and select Finish. Store this disk somewhere very safe, as anyone can use it to access your account.

Note that most people will use any old 3.5" floppy they find to backup their password and typically these
disks are quite old. A floppy disk has an error-free life of about 10 years on average, so I urge you to obtain
relatively fresh 3.5" floppies. Nothing is worse than when the time comes to restore your password (or flash
your BIOS) and the floppy has an error and screws up your system.

RESTORING LOGIN PASSWORD

If you ever need to restore your password from the disk created above, follow these steps:

1. Boot your PC as normal, and on the Windows Login screen select your User Name.
Without entering anything, press the Enter key once and you should see the 'Did You Forget Your
Password?' message. Select the 'Use Your Password Reset Disk' and insert your password reset disk.

3. Follow the Password Reset Wizard to set a new password and log back into your system.

Note that the password reset floppy disk needs to be write-enabled (hole closed) so that Windows can
update your disk with the new password automatically during this procedure. When done, you should once
again put the disk away in a physically secure place.
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RESETTING YOUR LOGIN PASSWORD

There is a method by which you can get to your data in case you've lost your main Admin login password.
The utilities and methods are covered on this Offline N'T Password & Registry Editor site. The site provides a
bootdisk image (CD or Floppy) which when used to boot up your PC, will provide an option to unlock user
accounts which would otherwise be inaccessible. It is a method of last resort, since it can actually corrupt
data if used incorrectly, or if your files have been EFS encrypted for example. Read the instructions on the
site carefully, and use with caution.

STORING PASSWORDS

If you want to hold all your usernames and passwords in a central database which is protected by high level
encryption, use the free KeePass Password Safe utility. To use it, run the program and select 'New Database'
under the File menu, then enter a Master Password and/or select a 'Key Disk' - this is used to unlock the
password list so make sure the password has a high bit-rate (e.g. 128 bit). Once created, you can populate the
database with Group entries for home banking, Internet - any groups you require. Then in the right pane for
each group you can right-click and select 'Add Entry' to create a new Username/Password entry to store.
Make sure to read the help file under the '?' menu>Open Help File as there are many options in this utility.

You can backup this password database to another location, and if needed access it using the master
password or key disk as required. Because it is encrypted it is next to impossible to access the database
without the right password/key disk.

RECOVERING PASSWORDS

If you haven't stored your passwords and you've managed to forget or lose a username/password, there are
several utilities you can use to recover various passwords stored on your system. To recover passwords in
Internet Explorer, MSN Explorer or for your Outlook Express accounts you can use the Protected Storage
PassView Utility. If you have forgotten a password which is now only visible as a series of ***'s in a

password dialog box or on a website, you can try using Revelation or Asterisk Key to show you the actual
password being used. Finally, you can use RockXP to retrieve a series of passwords and keys on your
Windows installation that are usually hidden.

Detailed usage instructions for these utilities are not provided because they are relatively simple to use. The
presence of these tools also lets you see that nothing is completely safe on your machine, so it is important to
always restrict physical access to your machine only to trusted individuals.

While the tweaks in this guide are safe for the most part, there are times when human error or another issue
may result in problems and even data loss. Get in the habit of backing up regularly if you don't already as
that is the only guarantee you have of retaining your valuable information.

B FILE DELETION AND RECOVERY
RECOVERING DELETED FILES

If you delete a file from your system, the file is removed and you regain the space on your hard drive,
however it is still not permanently deleted from your hard drive. In fact, nothing on your drive is
permanently removed when you delete it. Whenever you delete a file Windows simply marks it for deletion
by changing one character in the file table. The entire file is still sitting on your hard drive, but it is hidden
from view. Windows then allows other files to write over the space where it resides if required, but the file is
not gone from your hard drive until it is completely overwritten at some point. This means that you can
actually recover files that have been 'permanently’ deleted, but you will require special software to do so.

The best utility I have found to restore deleted files is a small free tool called Restoration. To use Restoration
first download the file, and run it to extract the contents to an empty directory on your hard drive, or to a
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blank 3.5" floppy disk. Then run the Restoration.exe file and either enter a filename in the search box, or leave
it blank (to find all recoverable deleted files) and click the 'Search Deleted Files' button. Restoration will scan
your hard drive for files which can be restored and list them. Once done, you can highlight a file and click
‘Restore by Copying' to recover it - however note that the file may not be complete since portions of it may
have already been overwritten, so there is no guarantee you can recover an entire file this way.

The more hard disk activity there is after you have deleted a file, the less chance you can fully recover it,
since portions of it may have been overwritten by new data. If you have accidentally deleted an important
file, try and minimize any further disk activity. Do not play a game, start an application, defragment your
hard drive or even reboot Windows for example as these all aid in potentially overwriting the area where the
file is sitting. Don't even leave your system idle for long periods of time either, since by default Windows XP
starts defragmenting your hard drive in the background when idle. Run an undelete program like
Restoration immediately.

If you want to recover deleted or damaged files on a CD or DVD, you will have to use a utility like IsoBuster.
This utility is available for free, however it requires paid registration for full functionality. You can however
use it to see if there is any recoverable data on your particular CD or DVD. Check the program's help file for
detailed instructions. However just like hard drive data recovery, there is no guarantee that any usable data
can be recovered from a damaged or deleted disk - particularly if it has been erased.

PERMANENTLY DELETING FILES

If you happen to ever want to completely delete a file so that others can't undelete it, you can again use the
Restoration program to do this. First delete the files you want to permanently delete the normal way - i.e.
highlight them and press Delete, then empty the Recycle Bin. Then launch Restoration and enter the name of
the file in the search box and click 'Search Deleted Files'. When Restoration finds the file and lists it, highlight
the file (left-click on it once) and go to the 'Others' file menu in Restoration and select 'Delete Completely'.
This will permanently delete the file so it is unrecoverable by virtually any program or method. Note that
the file may still be recoverable by law enforcement agencies using specialized methods, although it is highly
unlikely that anyone could recover the bulk of this data regardless of the methods used.

LOW LEVEL FORMAT AND ZERO FILL

People might suggest that you 'Low Level Format' your drive. This is not recommended unless you are
experiencing severe hard drive problems, and even then only as a last resort. Modern hard drives are low-
level formatted at the factory to create tracks and sectors and do not need to have it done again. The correct
course of action is to Zero Fill your drive, which people often confuse for a low-level format. This method
overwrites the entire hard drive with blank data, ensuring that everything is deleted permanently for most
intents and purposes, but it is not as intensive or potentially disk-damaging as a low-level format. A note for
the extremely paranoid - nothing short of physically destroying the drive (by burning it for example) can
guarantee that data cannot be recovered from a hard drive by law enforcement agencies. So essentially a
zero fill is your best bet in getting back to a 'good as new' hard drive.

To zero fill a drive, check your hard drive make and model, then consult your manufacturer's website for an
appropriate format/installation utility: Seagate DiscWizard, Western Digital Data LifeGuard, Maxtor
PowerMax or Hitachi Drive Fitness.

If you still believe you have to low level format your drive — for example if it seems heavily damaged with
bad sectors and is unresponsive to a zero fill — then you will have to look for a specific utility available from
your hard disk manufacturers' website to undertake this. I would only recommend this as a final step and
even then it may not save your hard drive.
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B SYSTEM RECOVERY

This section covers methods of recovering data and/or control of Windows after a major system error. Also
refer to the Windows Errors section for more details of troubleshooting the source of such problems.

RECOVERING FROM CORRUPTED REGISTRY

After any changes you make to Windows XP, if your system is crashing and you are having major problems
booting into Windows, it is typically because the Windows Registry contains incorrect or corrupted settings.
If you can't boot into Windows to use System Restore or Erunt to restore your system or registry, follow one
of the steps below:

*  During bootup, keep pressing the F8 key and you'll soon see a range of options, including to "Load last
good configuration'. Select it and your computer should boot into Windows hopefully devoid of the
recent changes you made which have caused problems; or

= If you have a recent Restore Point, but can't boot to the Windows desktop for some reason, keep pressing
F8 during bootup, but this time choose the option to 'Boot into Safe Mode' (See further below). In Safe
Mode you can access System Restore by going into Control Panel>System and selecting the System
Restore tab, and following the method outlined further above to restore an old restore point; or

* Alternatively you can press F8 repeatedly at bootup once again, and this time select to boot into 'Safe
Mode with Command Prompt, and at the command prompt which opens type
"\ Windows\ System32\ Restore \ rstrui.exe" (without quotes) then press Enter to open System Restore.

For more details on how to recover from a corrupted Registry, see this Microsoft Article.

SAFE MODE

Safe Mode is an important Windows XP mode which only loads up the bare essentials required for Windows
to function. Third party drivers, graphical enhancements, startup programs, unnecessary processes etc. are
all skipped and only the minimum required to display and use Windows and access your drives is provided.
Safe Mode is provided precisely for troubleshooting purposes and not for general usage. The idea is that by
reducing the number of software variables involved in Windows it is easier to identify the cause of a
problem. You can read the full details of Safe Mode options in this Microsoft Article.

To access Safe Mode do the following:

1. Make sure there are no CDs in your CD/DVD drives and Reboot your PC
As your PC starts booting up keep pressing the F8 key and you will soon reach the Windows Advanced
Options menu where you can see a range of options, each described in detail in the article linked above.

3. Select the safe mode option you prefer — for most purposes I recommend the default 'Safe Mode' option
which loads the least number of device drivers.

4. You will reach the Windows Desktop which will be shown at lower resolution, color bit-depth and with
no graphical enhancements. The words 'Safe Mode' will appear around the edges of the screen to inform
you that you are running a cut-down version of Windows XP. If you cannot enter Safe Mode, this is the
sign of a more serious problem, and you will need to see the Recovery Console section further below.

The main use for Safe Mode is to determine whether your device drivers or installed software are the source
of a problem you are currently experiencing. Because Safe Mode does not load any of your installed third
party device drivers - instead using the default versions built into Windows XP - and because Safe Mode
does not load up any startup programs or services into the background, this gives you the opportunity to
determine whether your software or one (or more) of your startup programs is causing problems.

If you couldn't boot into Windows XP normally, but you can in Safe Mode for example that is a clear sign
that one of your recently installed driver(s) or software are the causes of the problem. You can choose to
remove the software or drivers completely by going to Control Panel>Add/Remove Programs and
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uninstalling them from there. Alternatively you can experiment by using MSConfig (See the Microsoft
Configuration Utility section) to temporarily disable suspected startup items and/or services (by unticking
them) and reboot into normal Windows to see if this resolves your problem.

If you made a change to a system setting or the Windows Registry that would normally prevent you from
booting into Windows, you can undo the setting in Safe Mode, or revert to an earlier Restore Point, or restore
a Registry backup here.

If however you find that you cannot boot into Safe Mode, or are having similar problems in Safe Mode as
you are in normal Windows — for example your graphics are garbled or show glitches — then the problem is
likely hardware-based such as overclocking, excess heat, permanent damage to a component/faulty
component(s), related to a BIOS setting or incompatibility, or requires use of the Recovery Console to fix.

Finally, a major use for Safe Mode is the removal of malicious software such as viruses or spyware, or for
any other type of file which Windows says is 'in use' during normal Windows. Many of these will load into
the memory areas of Windows that cannot be unloaded during normal Windows XP operation. However in
Safe Mode there are no such protected memory areas, and no startup programs or services are loaded with
Windows, so this is the best way of removing such troublesome software. Enter Safe Mode and either
manually enter Windows Explorer and delete the troublesome file(s), edit your startup items or Services to
remove unusual or harmful entries (See Startup Programs and Services sections); or run a suitable scanner in
Safe Mode to find and remove any malicious software (See PC Security section).

RECOVERY CONSOLE

The Recovery Console is an important repair and recovery tool built into Windows XP that allows you to do
such things as check for faults on your drive and repair the Master Boot Records. You can read the full
description of the Recovery Console, as well as its available commands and options in this Microsoft Article.
The main use for the Recovery Console is when other methods of data recovery or troubleshooting have
failed, and you simply cannot boot into Windows, even in Safe Mode.

The quickest way to access the Recovery Console is to do the following;:

1. Insert your Windows XP CD into your main CD/DVD ROM drive.

Reboot and go into your BIOS. Set the 'First Boot Device' (or similar) option in the BIOS to CDROM and
reboot.

3. As your PC starts booting up, keep pressing the F8 key until you see the message 'Booting from
CDROM'. If this doesn't work, you should use a Windows XP Bootdisk instead (See the Installing
Windows section).

4. The blue Windows Setup screen will eventually appear.

5. If you are running a SATA or RAID drive configuration, make sure to press F6 when prompted during
the loading of Windows Startup, and have your SATA/RAID driver floppy disk handy, as if these are
not loaded up the recovery console will not be able to identify see' your hard drive(s) properly and/or
mistakenly identify them as corrupt volumes when they are not.

6. Once in Windows Setup, press R to access the Recovery Console.

7. If prompted, press a number that corresponds with your Windows installation - the default is 1. Enter
your Admin password if required, or leave blank if you haven't set an Admin password for Windows
XP, and press Enter.

8. Once the Recovery Console opens, there are a range of commands you can use. Just type "Help" (without
quotes) and press Enter, and a list of commands will be shown. To see the options for each command in
more detail, type the command followed by "/?" (without quotes). For more details of these commands
and their uses, see this Microsoft Article.

Note, if you cannot access your hard drive using the Recovery Console due to an incorrect Admin password,
try the utility covered under the Resetting your Login Password section further above.
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The most common methods of attempting to repair a Windows installation in the Recovery Console in order
of use are:

= Use the CHKDSK /R command to do a drive check and fix any errors if possible. If CHKDSK says the
drive is unreadable or there are too many errors, make sure that if you have a SATA/RAID setup, you
loaded the appropriate SATA/RAID drivers from a floppy during Windows Setup loadup.

» Use the LISTSVC command to list all current services and drivers and their startup status. Use the
DISABLE or ENABLE commands to enable or disable particular services which you think are related to
the problem. E.g. Enable RPCSS Service_Boot_Start tells windows to set the RPCSS service to start at
Windows Bootup, in case you had accidentally disabled this vital service in Windows.

»  Use the FIXBOOT command to repair the boot sector of the drive.

»  Use the FIXMBR command to repair the Master Boot Record of the drive.

If you find the drive still doesn't boot up into Windows, you may just have to return to the Recovery
Console, and use the CD and Copy commands to go to various locations on the drive and start copying
across data either to the faulty drive (to replace a missing or corrupted file for example), or from the faulty
drive (to back up data before reformat).

Although the Recovery Console is a very useful tool, it still may not resolve some hard drive errors or
problems. In such cases you can try using a Repair Install of Windows which if successful should fix your
Windows without any data loss. Chances are however that if the Recovery Console or a Repair Install don't
work, your drive has experienced too much corruption and/or has too many bad sectors to recover your
Windows; you will simply have to reformat your hard drive and reinstall Windows.

SYSTEM FILE CHECKER

The System File Checker is another built-in function of Windows XP that allows the system to go through
and check all the major protected Windows XP system files against the original versions stored on a valid
Microsoft Windows XP CD. This is extremely handy if you suspect corrupted/tampered system files that are
leading to unusual Windows behavior. Full usage instructions for the System File Checker can found in this
Microsoft Article.

To access the System File Checker follow this procedure:

1. Go to Start>Run and type "SFC /scannow" (without quotes) then press Enter to start an immediate scan
of your system files.

2. The System File Checker will go through all your important system files and make sure they have not
been altered in any way. Where major system files are corrupted or shown to be different from original,
they will be replaced with the originals from your \ Windows\ System32\ Dllcache\ directory and/or your
Windows XP CD.

3. If prompted to reboot your PC, reboot as required.

Note that you can use the switches /scanonce (to scan after the next reboot) or /scanboot (to scan on every
reboot) instead of /scannow. If you choose /scanboot and then want to stop a scan after every reboot at some
point, use the /revert switch.

For more details of how to recover deleted or damaged information on your hard drive see this Hard Drive
Recovery Article. In general the methods covered above are the most common and practical ways of both
backing up your important information, as well as recovering from data damage or loss.

K190009y 19 dnypeg

Copyright © 2007 Koroush Ghazi 2 9


http://www.microsoft.com/resources/documentation/windows/xp/all/proddocs/en-us/bootcons_chdir.mspx
http://www.microsoft.com/resources/documentation/windows/xp/all/proddocs/en-us/bootcons_copy.mspx
http://www.webtree.ca/windowsxp/repair_xp.htm#How%20to%20Repair%20Windows%20XP%20by%20Installing%20Over%20top%20of%20Existing%20Setup:
http://support.microsoft.com/kb/310747/EN-US/
http://www.pcstats.com/articleview.cfm?articleid=1139&page=1
http://www.pcstats.com/articleview.cfm?articleid=1139&page=1

e..uenm_-.u.ng-_-. THE TWEAKGUIDES TWEAKING COMPANION

BIOS OPTIMIZATION

The BIOS (Basic Input/Output System) is a program held on a small ROM chip on your motherboard. It
provides the instructions for what your PC should do as soon as it turns on. Your BIOS is independent of
your Operating System, which means that it is not affected by which operating system you use, or which
version of drivers you've installed, or what your settings are in Windows for example. The BIOS supersedes
all of that, and your drivers and operating system will load after the BIOS has already loaded up. The BIOS
controls a range of hardware-related features and is the middle-man between your CPU and other devices.

If there is an incorrect setting in your BIOS - that is a setting which is not optimal or correct for your
hardware configuration — then you will have problems regardless of what you change in Windows, or which
driver versions you install. Importantly, the BIOS is best configured correctly before installing Windows, as
this reduces the number of unnecessary services and drivers which Windows may install, and helps reduce
the potential for IRQ conflicts.

B BIOS POST SCREEN

As your BIOS starts to load, the first thing it does is the Power-On Self Test (POST), a diagnostic program
which checks your components and makes sure everything is present and working OK. The POST sequence
is usually extremely fast; you will only really notice it if it stops when encountering an error. POST error
messages can be a bit obscure, but usually give you a lead as to where to look in your BIOS settings. A quick
general guide to what the startup error beeps mean is this POST Error Codes, but a more accurate
description specific to your hardware is usually found in your motherboard's manual.

If you have no POST errors you will see your PC's startup screen, which shows such information as your
BIOS type (e.g. Award BIOS), the key to press to access your BIOS settings (e.g. DEL, ESC or F2), the type of
processor and its speed, RAM amount and RAM test results, drive information, etc. Note that if any of this
information is incorrect, it may be that your hardware is extremely new and hence not recognized correctly
by the BIOS, you've overclocked your PC too far, or you have bad hardware or incorrect BIOS settings.

B BIOS SETTINGS

To access the detailed settings in your BIOS, you typically need to press a particular key (the Delete key for
example) repeatedly as your system is booting up. If your BIOS has a password then you'll have to enter it
first to access your BIOS settings; if you've forgotten the password, then try this BIOS Password Site. Once in
your BIOS screen you will see a multitude of settings — the layout of the BIOS, and the names of the various
settings vary greatly depending on the particular motherboard brand and model you own.

It is not possible to go into detail here about all the possible settings, and how you can tweak your BIOS - it
would simply take too much space to cover properly. The best reference source is Adrian Wong's Definitive
BIOS Optimization Guide (scroll down to find the 'Free Access' link to the guide). It covers all the common
BIOS settings in detail, and combined with your motherboard's manual it allows you to undertake the very
important task of optimizing your BIOS settings before doing any Windows tweaking. I cannot stress the
importance of making sure all the major settings in your BIOS are correct for your particular hardware setup
and that you've disabled unnecessary devices and options. It may take some time but it ensures maximum
performance and stability, and no amount of software tweaking can overcome a badly set up BIOS. If you're
planning on reinstalling Windows XP, the Interrupt Requests section further below contains one very
important reason why the BIOS is best tweaked before Windows installation.

B BIOS UPDATES

The BIOS is actually written on a rewriteable ROM chip, which means that it can be updated (or 'flashed’)
with new information. Motherboard manufacturers often release new BIOS versions that can improve
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performance, stability and compatibility, add new features or modify existing features, and fix known bugs.
These new BIOS versions are available for download on the manufacturer's website. I can't list all the
manufacturer websites here, as there are far too many (and the links often change) however if you have a
look through your motherboard manual you should see a relevant link to the appropriate website.

Download the latest BIOS for your exact motherboard brand and model number and follow the instructions
on the site to Flash (reprogram) the BIOS chip on your motherboard with this new BIOS version. A word of
warning — flashing the BIOS is not to be taken lightly. If something does go wrong then your PC may not
boot up and you may have to take your motherboard to a dealer to have the memory chip replaced. While
this is rare, when updating your BIOS make sure you follow the instructions provided to the letter.

B FIRMWARE UPDATES

Your motherboard is not the only device which has a BIOS. Many components - indeed most major
electronic equipment like TVs and DVD players - have their own BIOS chips. The software on these chips is
typically referred to as Firmware, and all firmware can be updated using the correct equipment and
software. For consumer electronic equipment this is usually done by a qualified technician, but for PC
components, it can be upgraded in much the same way as flashing your BIOS. You will need to check your

manufacturer's website for more recent versions of the BIOS/firmware you require, and any specific
instructions or software necessary. However the most common firmware updates are for CD/DVD drives. If
you want to find out more about these updates, see The Firmware Page. A firmware upgrade can help
resolve problems like difficulties reading from a particular disk type, 'disk not detected' errors, and other
issues. Just like BIOS flashing it involves an element of risk, so please read carefully before proceeding.

B INTERRUPT REQUESTS (IRQS)

Interrupt Requests (IRQs) are the way in which all of your major system devices get the CPU's attention for
instructions/interaction as often as necessary. There are at least 16 IRQs (numbered 0 - 15) in a PC, with most
newer PCs having 23 or more IRQs. To view your current IRQ allocation go to Control
Panel>System>Hardware>Device Manager and under the View menu select 'View Resources by Type', then
select the 'Interrupt Request' item. You will see all the devices currently active on your PC arranged by IRQ
number, starting at IRQO [System Timer]. Each IRQ has a priority assigned to it as to which gets the CPU's
attention first when several are competing at once. While Windows XP is designed to allow several devices
to share an IRQ, you may have problems or reduced performance if two or more major devices (such as the
sound card and graphics card) share the same IRQ. To minimize IRQ sharing, try the tips below.

DISABLE UNUSED DEVICES

Under Windows XP, as this Microsoft Article explains, ACPI (Advanced Configuration and Power Interface)
compliant systems - which is all modern PCs - will have their IRQs automatically reallocated by Windows
upon installation. Even if you manually reassign them in the BIOS (if the option exists), Windows XP
typically assigns them back to the default IRQs it has chosen. This default assignment of the IRQs is done
when Windows XP is first installed, and eight IRQs (IRQs 0, 1, 2, 6, 8, 9, 13 and 14) are automatically
reserved for critical system devices on all PCs and cannot be altered or reassigned. The best way to ensure
that you are less likely to end up with shared IRQs (and potential problems) is to disable any unused devices
in the BIOS before installing Windows XP. Some examples of common devices that can be disabled are:

»  Serial Portl (COM1)

»  Serial Port2 (COM2)

= Parallel Port (LPT1)

=  Game Port

»  Midi Port

» Secondary IDE Channel
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Disabling unused devices not only frees up unreserved IRQs and reduces the chances of sharing, it can also
speed up bootup time noticeably. Clearly if you already have, or plan to have, a piece of hardware connected
to any of these Ports, or need to use a particular device, then you should not disable them. For example if
you have a printer which connects to the Parallel Port (LPT1) then disabling the Parallel Port in the BIOS will
simply mean your printer will not function. If you have two or more IDE-based drives which connect to an
IDE channel, then you cannot disable that IDE channel and expect the drives to work. You can always re-
enable these devices in the BIOS at any time, so this is by no means a permanent disabling of particular
devices. However you should only disable devices in the BIOS that you are certain will not be used during
your normal Windows usage.

MOVE CONFLICTING DEVICES

If you are using an existing installation of Windows XP you can still attempt to reduce IRQ sharing. Note
however that on certain motherboards particular IRQs are shared by default and cannot be changed. For
example on many Intel-based motherboards IRQ16 is often shared by both the AGP Port (Graphics card) and
the USB Host Controller (USB Peripherals) - this is unavoidable and usually does not result in any problems.
In such cases where you feel there may be a conflict or reduced performance, your only course of action is to
physically move one of the items to another location on your system. In the example above, it would be best
not to use a USB device on the particular USB Host Controller that is shared on IRQ16 to ensure optimal
graphics performance. As another example, if your sound card is sharing an IRQ with your graphics card,
physically shift the sound card from one PCI slot to another free one.

DISABLING ACPI

If the above methods do not work, there is one final method of reallocating IRQs short of reinstalling
Windows. Since ACPI is one of the reasons why Windows XP automatically allocates IRQs, if you disable
ACPI you can manually allocate and rearrange IRQs and hence remove any IRQ sharing. I strongly
recommend that you do not disable ACP], as the side effects are much worse than any problems IRQ sharing
could cause. ACPI is there for a reason - disabling it can effectively destabilize your system and cause your
components not to function correctly. The instructions provided below are for the sake of completeness, and
for the truly desperate or the very curious:

1. Backup all your important data before attempting this procedure as it is highly risky.
Go into your Control Panel>System>Hardware>Device Manager and under the Computer component,
double-click on the 'ACPI Uniprocessor PC' (or similar ACPI) device.

3. Click the 'Update Driver' button, then select 'Install from a list or specified location'.

Select 'Don't search. I will choose the hardware to install'

5. Untick the 'Show compatible hardware' box, and in the list below click on the 'Standard PC' option and
select Next.

6. The non-ACPI drivers will be installed and you will need to reboot your machine, perhaps several times,
to redetect all your hardware components. Make sure to disable any ACPI options in your BIOS.

7. You can now use any BIOS options available to manually assign IRQs to particular devices. Note that it
depends on your particular BIOS as to how much flexibility you have in assigning IRQs to all the devices
on your system. Disabling ACPI doesn't suddenly add any new BIOS options.

b

I can only repeat that disabling ACPI will cause a lot of problems, and you may not be able to return to using
ACPI unless you reformat and reinstall Windows XP completely. Please undertake these steps at your own
risk, as they are not recommended at all.

If after all of the above procedures you still have major difficulties which you feel are attributable to IRQ
sharing, you will have to simply reformat/reinstall Windows XP - making sure to first correctly configure
your BIOS of course.
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INSTALLING WINDOWS

If you are going to do a full reformat and reinstall of Windows XP on your hard drive, follow the procedures
in this section to ensure the correct setup of your hard drive and optimal installation of Windows.

B PREPARING TO INSTALL WINDOWS

Here are some important things you should do before formatting your hard drive:

Scan for viruses and other malicious software — See the PC Security section.

Backup your data and passwords - See the Backup & Recovery section.

Download and back up all the latest drivers for your hardware - See the Driver Installation section.
Download and back up the various utilities we will be using later in this guide - See the various sections
of this guide such as the System Specifications, TweakUI, Windows Registry and Backup & Recovery
sections for example.

Create some Windows XP Bootdisks if necessary - See further below.

6. Read this Microsoft Article on partitioning and formatting hard drives.

L

ot

Here's a checklist of things you should have handy for a smooth installation of Windows XP:

*  Your original Windows XP CD.

*  Your Windows XP Product ID Number.

* Anearlier 'Full Version' CD of Windows if you are using a Windows XP 'Upgrade Edition' CD.

*  Your Windows XP Bootdisks.

*= Any drivers which have to be installed during the Windows installation process - e.g. some
motherboards require a floppy disk with SATA and/or RAID drivers to be used during the XP
installation process in order to detect your hard drive correctly and set it up correctly. Check your
motherboard package contents for such disks, or create them as instructed in the motherboard manual.

*  Your motherboard manual, a printout of this guide, and any other associated articles or guides below
which you may need. Remember, it is not recommended that you connect to the Internet immediately
after installing XP, ideally you should have offline/hard copies of these guides.

* CDs/DVDs/Floppy Disks containing the latest drivers for your hardware. These should have been
downloaded earlier, but in some cases you may only have the original driver disks that came with the
hardware.

= All your backups as well as any applications and games on CD/DVD. Also make sure to have software
serial numbers or registration details handy.

* Pen and paper for recording passwords, registration numbers or other important information.

Once you've gathered as much of this material as possible around you, familiarize yourself with all the
information below before beginning the actual formatting and installation process.

SLIPSTREAMING WINDOWS XP SP2

If you own an older Windows XP CD that does not contain SP2 already built into it, you can create a new
Windows XP CD that incorporates all the files from SP2 using a process called 'Slipstreaming'. When a
slipstreamed XP CD is used for installation it automatically installs SP2 along with the rest of Windows XP,
and hence you won't need to run SP2 separately after installation, nor do you need to worry about any
outdated drivers/files being installed on your system first, or any SP2 installation problems. It's a detailed
process, but relatively straightforward when you use this Windows XP Slipstreaming Guide or NLite (see

below). Using a slipstreamed CD is the recommended method for installing Windows XP SP2, but is not
vital, so if you don't feel comfortable doing it you can skip this step.

smopurp) Surpreisug

Copyright © 2007 Koroush Ghazi 3 3


http://support.microsoft.com/?kbid=313348
http://www.tacktech.com/display.cfm?ttid=295

e..uenﬂmu.ng-_-. THE TWEAKGUIDES TWEAKING COMPANION

NLITE

NLite is a free utility for customizing Windows XP prior to installation. It allows you to select the
components you wish to remove from Windows, as well as things you would like to add, such as SP2, the
latest graphics drivers, SATA/RAID drivers and so on. Once you have integrated the relevant components
and removed the components you don't need, NLite generates an ISO file which you can burn onto CD and
use as your Windows installation disk.

I encourage you to experiment with NLite. Personally, I am a traditionalist and I still recommend installing
Windows XP as normal, then manually installing the relevant drivers. This is the only way to guarantee that
things work as intended - some NLite users have found there are issues with odd behavior after installation
of an "NLite-ned" Windows, so while it is an easier way of doing things it is by no means foolproof and
requires a fair bit of research and effort. I also recommend against removing core Windows components like
Internet Explorer, as these are often necessary for Windows to function correctly. Don't fall into the trap of
thinking that it is cool to strip out virtually every component of Windows and replace it with a third-party
alternative - often times the Windows version of an application is not only required, it is actually the best
method of viewing particular content.

However NLite is a very handy utility and well worth downloading and investigating. It won't be covered in
detail here as the user interface is quite intuitive to use, and if you need additional help check the NLite
Forums. With some time and effort, and in conjunction with the information presented throughout this
guide, you can create your own customized NLite Windows XP install disk which has everything the way
you want it.

B FORMATTING THE HARD DRIVE(S)

Before commencing the formatting of your hard drive to prepare it for Windows XP installation, read
through the details below on the various options available to you when formatting a hard drive. Take the
time to research this aspect of Windows installation carefully.

NTFS VS. FAT 32 FILE SYSTEMS

During the formatting of your hard drive, you will be asked whether you want to use the NTFS (NT File
System) or FAT32 (File Allocation Table) File System for the drive. This is an important choice and the
answer generally depends on your requirements:

Use FAT32 if
*  Your hard drive is smaller than 32GB.
*  You want to install more than one operating system on your computer.

Use NTFS if

*  Your hard drive is larger than 32GB and you are running only one operating system on your computer.
* You want enhanced file security.

*  You need better disk compression.

For more details of the differences read this FAT & NTFS File Systems Article. Essentially NTFS is a newer,
more stable and much more secure file system that has several benefits FAT32 doesn't. For example, if you
format your hard drive in NTFS and password protect it, it is more difficult to access the information on the
drive without the correct password (but still possible - see Backup & Recovery section above). As for the
speed difference, for larger drives it is negligible. For more details on the features of NTFS, read this NTES
Tech Article. In my opinion the benefits of NTFS make a strong case for formatting your drive in NTFS,
unless you have a very small drive or want to install more than one Operating System on it - particularly an
older version of Windows (See Dual Boot/Multiboot System below).
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CONVERTING EXISTING FAT32 DISK TO NTES

If you already have a FAT32 drive and don't want to reformat just to use NTFS, you can still convert the
drive to NTFS using the Windows Convert tool - however note that this may result in a sub-optimal cluster
size, especially for drives formatted in FAT32 under older versions of Windows. To set an optimal cluster
size you will have to read this Converting Fat32 to NTFS Guide.

The following is the simple (but not optimal) method if converting an existing Windows XP FAT32
installation:

1.  Go to Start>Run and type "cmd" (without quotes), then press Enter.
In the Command Prompt which opens, type "Convert C: /FS:NTES" (without quotes) and press Enter.
Substitute the correct drive letter in place of C: above if it is different.

3. Enter the name of your hard drive when prompted. If you don't know the name of the drive, type "Vol
driveletter" (without quotes - e.g. Vol C:) to find it out.

4. Reply Y to each of the prompts. Reboot if prompted.

This will take some time to complete, so leave your system alone until the process is finished.

MULTIPLE PARTITIONS

During the formatting of your hard drive, you have the option to create one large partition which takes up
all available space on the drive, or create several smaller partitions of various sizes on the drive. These
partitions can hold different information, such as separate Operating Systems (See Dual Boot/Multiboot
System below) or simply fence off different parts of your hard drive under the same Operating System. For
detailed instructions on the potential advantages, disadvantages and optimal method for partitioning, see
this Partition Strategy Guide.

In practice my personal recommendation is that you create a single partition using all the available space on
your hard drive, on which you install Windows XP using NTES as the sole operating system. In my
experience this will provide the most stable, trouble-free setup for a home PC. Multiple partitions do not
result in performance gains, since it is always much faster to have two or more hard drives than a single
drive with multiple partitions. On a single hard drive the first partition is always the fastest, and
performance is still limited by how fast the single hard drive head can seek (move around to read or write)
information. It can't be in two places at once, whereas with two hard drives, each hard drive's head can seek
information independently, such as one drive reading game information while the other concurrently
reads/writes virtual memory information in the pagefile.

However it can be beneficial to use multiple partitions for file storage or backup purposes — that is one
partition holding your files and documents separate from the other partition(s) which hold Windows and
your programs. This can be useful for example in allowing you to reformat your Windows partition while
still retaining your files on the second partition. If you do choose to have multiple partitions, install
Windows on your first partition as that is the fastest, and in general keep your games and programs on the
first partition as well for maximum performance. And keep in mind that having multiple partitions is not a
good substitute for having actual physical backups of your important data on CD or DVD. Hard drives can
and do become physically corrupted and this affects data on all partitions on the drive.

If you use multiple partitions and you are after a utility that will make partition management easier, the

most reputable one is Norton Partition Magic. It is not free, and I will not be covering it in detail here,
however if you wish to undertake complex partitioning of your hard drive(s) it is a worthwhile investment.

DUAL BOOT/MULTIBOOT SYSTEM

If you want to set up your system so that each time you bootup you get the choice of two or more Operating
Systems to use - such as Windows XP and Windows 98 - read this Microsoft Article for instructions. There
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are no performance benefits in doing this — it is normally done if you use software that only works under
another operating system for example. Once again, unless you specifically require this functionality I do not
recommend a multiboot system. See the Windows Installation chapter of the TweakGuides Tweaking
Companion for Vista if you wish to create a Vista/XP dual boot.

RAID CONFIGURATION

RAID (Redundant Array of Independent Disks) is a common method of configuring multiple hard drives to
perform better and/or provide better protection against data loss than a single hard drive. The concept is
fully explained in this Wikipedia Article, including the various RAID levels which can be used, such as
RAID 0, RAID 1, RAID 5 and RAID 0+1. To set up a basic RAID array you will need two or more hard
drives, preferably of the same size and speed, and a motherboard with RAID support. You will then need to
set up your drives in the appropriate RAID configuration using your motherboard's BIOS (include any RAID
BIOS options) - see your motherboard's manual for instructions.

The most commonly used RAID array is a pair of similar drives in RAID 0 formation, which provides the
best all-round performance at minimal cost. RAID 0 usually beats any single hard drive configuration in
terms of speed, particularly for gaming, due to there being two independent drive heads constantly seeking
data in place of one. However RAID 0 also provides absolutely no fault tolerance at all, meaning if one of the
drives suffers a serious error you lose all your data on both drives since the data is split evenly across both
drives. Therefore if you really do require protection against data loss, I recommend a RAID 5 configuration
which is more costly but far safer.

While setting up certain RAID arrays (such as RAID 0 and RAID 5), you will need to determine a Stripe Size
to be used. In general, if you are uncertain of the size to choose, use the Auto setting (if available), or a 64kb
stripe. For gaming purposes, you may consider a smaller stripe size of 16kb, as in my experience this can
assist in reducing stuttering in games.

In any case once you have connected your drives and set up your RAID array using the options in the
motherboards BIOS, you will need to have a floppy disk handy with the correct RAID drivers prior to
starting the Windows installation procedure. Then during Windows Setup startup, press the F6 key when
prompted at the bottom of the screen, and enter your driver floppy when prompted again and load up the
RAID drivers, along with any other drivers (such as SATA drivers) necessary. If you miss this step, the hard
drives will not be detected by Windows as one large hard drive, and you will not be able to install Windows.

B FORMATTING AND INSTALLING WINDOWS

At this point you are ready to begin the actual format and installation process, which differs depending on
whether you're using a brand new or freshly formatted hard drive as opposed to a hard drive with an
existing installation of Windows. See the relevant section below:

NEW HARD DRIVE

If you have a new or reformatted hard drive, the entire procedure for formatting the drive and installing
Windows XP is relatively straightforward. Follow these steps:

1. If it is not already in your system, connect the hard drive to your system by following the instructions
that came with the drive. Typically this involves plugging into the back of the drive both a power
connector and either a wide IDE ribbon cable, or a thin SATA cable.

2. Start your system, go into your BIOS and make sure the hard drive is being detected, whether on one of
the IDE Channels, or as a SATA device - whichever is relevant to the particular type of hard drive and
channel it's connected to. If the hard drive is not detected at all in the BIOS, you cannot install Windows
XP on it. Look around the BIOS and make sure you've enabled the channel on which the drive is
connected. You may have to re-check your drive cabling (i.e. SATA/IDE cable and power cable), and
also whether any small switches on the back of the hard drive are set correctly (e.g. the main hard drive
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is typically set as the Master on the Primary Channel). In some cases (mainly for SATA or SCSI drives
and/or RAID configurations) you will have to insert a driver disk into the floppy drive to load up
appropriate hard disk drivers during Windows installation, so have those handy if need be and proceed
with the next step.

Insert your Windows XP CD into your CD/DVD drive, and reboot your system.

Upon rebooting your system, since the hard drive does not have an operating system installed, the
computer will skip loading from it and instead will attempt to boot from the next boot device - which
should be the Windows XP disk in the CD/DVD drive. This should lead to the blue Windows Setup
screen. If that doesn't occur, check your BIOS settings to ensure that firstly the relevant CD/DVD ROM
drive is being detected as present on your system and that any option for 'First Boot Device' or 'Second
Boot Device' (or similar) is set to CDROM.

From this point onward, you should follow this step-by-step: Windows XP Pro Installation Guide or
Windows XP Home Installation Guide as relevant. These excellent guides cover the procedure in far
more detail (including screenshots for every step of the way) than I can do here due to space
considerations. You should ideally have a printout of these guides handy for use during the installation.

HARD DRIVE WITH EXISTING INSTALL OF WINDOWS

If you have a hard drive with a current installation of any version of Windows on it, follow the steps below
to begin a reformat and reinstallation of Windows XP. Note you shouldn't just install Windows XP over an
existing installation of Windows - start afresh with a full reformat of your hard drive and a fresh installation
of Windows XP otherwise you will get sub-optimal results and experience many problems:

1.

Insert your Windows XP CD into your CD/DVD drive.

Reboot and go straight into your BIOS settings. Set the 'First Boot Device' (or similar) option in the BIOS
to CDROM. Reboot your system.

As your PC starts booting up keep pressing the F8 key repeatedly until you see a message saying
'‘Booting from CDROM' (or similar).

The blue Windows Setup screen will eventually appear.

From this point onward, you should follow this step-by-step: Windows XP Pro Installation Guide or
Windows XP Home Installation Guide as relevant.

Make sure that you choose to format the hard drive and do a clean installation of Windows XP. Again,
do not install Windows XP over an older version of Windows as an 'upgrade' installation (not to be
confused with the Windows XP Upgrade Edition which is fine) - start with a new installation of
Windows XP.

WINDOWS XP BOOTDISKS

If you still can't get to the Windows Setup screen using the instructions above, you can download a
Windows XP Bootdisk image from the Microsoft site for your particular version of Windows XP:

Windows XP Home Windows XP Professional
Windows XP Home Windows XP Pro
Windows XP Home with SP1 Windows XP Pro with SP1
Windows XP Home with SP2 Windows XP Pro with SP2

Make sure that the version you download matches your Windows XP CD exactly — that is if your Windows
CD doesn't say Service Pack 2 or Service Pack 1 on it, don't download that version of the bootdisk. Usage
instructions for the bootdisks are in this Microsoft Article.

If you still have problems booting into Windows setup, or you just want an older version of a bootdisk, go to
this Bootdisk Site to download free copies of various bootdisk versions.
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WINDOWS PRODUCT ACTIVATION &
WINDOWS GENUINE ADVANTAGE

B WINDOWS PRODUCT ACTIVATION

One of the first things you will notice after first installing Windows XP is the Windows Product Activation
(WPA) notice. Even if you skip Activation at Windows startup and go to the Windows Desktop, a little
popup balloon in the System Tray tells you that you have 30 days left to activate Windows XP, and when
you click on it, it provides various options for activation.

Windows Product Activation is a protection system Microsoft uses to ensure that Windows piracy is
reduced. If you're interested in the facts about Windows Activation, how it works and what parameters it
checks on your system I recommend you read this detailed Windows Product Activation Guide and this
Technical Details of Activation document.

Ideally if you've just installed Windows XP I recommend that you don't change any of your hardware - aside
from attaching some peripherals. Major hardware changes are best made prior to XP installation. By 'major
hardware' I am referring to the motherboard, CPU, graphics card, the hard drive - the components within
your PC case. If however you are aware that your hardware setup may undergo some further changes
shortly, it is recommended that you don't activate Windows XP right away. You have 30 days within which
to bed down your final hardware configuration. Activating before your hardware setup is finalized could
see you having to re-activate repeatedly, including having to call Microsoft to complete Activation.

If you are certain that the major hardware components of your system are not going to change soon and/or
that you are not going to reinstall Windows XP again shortly, then go ahead and activate XP. Otherwise
ignore the constant nagging Activation gives you and wait until your system configuration is finalized
before going through with Activation. Microsoft views multiple activations in a very short period of time as
suspicious - precise details of this are in the Windows Product Activation guides linked above.

Something you should do after you have activated Windows XP is to backup your wpa.dbl file, found in the
\WINDOWS \system32 directory. This file is the Windows Product Activation system file, and should your
installation of Windows XP become corrupted and you need to attempt a recovery (See Backup & Recovery
section), you can use this backed up file to help in restoring your system.

B WINDOWS GENUINE ADVANTAGE

Microsoft has recently implemented an additional anti-piracy feature into Windows called Windows
Genuine Advantage (WGA). Any time a Windows install attempts to connect to Windows Update or
download certain Microsoft updates, it may be asked to validate itself to make sure it is a legitimate copy. If
validation fails, the user cannot download updates from Windows Update, and can only download critical
security updates through the Microsoft Download Center or through the Automatic Update service (See the
Control Panel section below).

If you are having problems with WGA on a legitimate installation of Windows, visit the Windows Genuine
Advantage Diagnostic Site. In particular, if you use Firefox as your main browser, Microsoft has released a
Firefox plugin to allow WGA to work on this popular browser.

Please note I will not provide any information on how to view or change your Windows Product Key, or
how to bypass Windows Product Activation or Windows Genuine Advantage. If you experience problems
with these particular features on a legitimate installation of Windows XP, the only correct course of action is
to contact Microsoft Technical Support for your particular country.

Copyright © 2007 Koroush Ghazi 3 8

a8ejuBApY SUIMUID) SMOPUIA 2P UOIIRATIOY JONPOI] SMOPUIA



http://www.microsoft.com/piracy/activation.mspx
http://aumha.org/win5/a/wpa.htm
http://download.microsoft.com/download/2/1/6/21654b16-6c81-4d96-9390-5203cd43d07d/WindowsProductActivationTechnicalMarketBulletin.doc
http://www.microsoft.com/genuine/downloads/WhyValidate.aspx
http://www.microsoft.com/genuine/downloads/WhyValidate.aspx
http://www.microsoft.com/downloads/Browse.aspx?DisplayLang=en&nr=20&categoryid=7&sortCriteria=date
http://www.microsoft.com/genuine/diag/
http://www.microsoft.com/genuine/diag/
http://www.microsoft.com/genuine/downloads/Validate.aspx
http://www.microsoft.com/worldwide/

e..uenm_-.u.ng-_-. THE TWEAKGUIDES TWEAKING COMPANION

DRIVER INSTALLATION

Device drivers are the software which give instructions to your system on how to deal with particular
hardware. Graphics drivers for example tell your graphics card what to do in various situations, such as
during 3D applications and games, as well as translating information to and from your CPU. While
Windows comes with built-in driver support for virtually any type of common computer hardware, and
hence most of your hardware will operate in Windows even without installing drivers, the built-in drivers
are neither optimal, nor do they guarantee stability under certain situations. Thus, you need to download
and install the latest device drivers for your hardware to make sure your entire system performs optimally
and with stability.

The instructions below cover both the initial installation of drivers on a fresh install of Windows, as well as
how to install drivers at any time on an existing install of Windows XP, and some general tips to clarify
which types of drivers should be installed and why.

B DRIVER INSTALLATION ORDER

The first thing you should do with your fresh installation of Windows XP is to install the core system
software and drivers that are vital in helping to run XP optimally. Installing these prior to anything else, and
in the correct order, is key to reducing the chance of any problems and also ensuring peak performance.

Note that during installation of these drivers, if you are prompted to reboot at any time, you must do so to
allow proper driver installation. The reason for this is that some driver files are currently loaded into
memory areas that are used by the system and protected from being overwritten by a different version. Thus
they cannot be replaced without Windows first marking them for replacement, rebooting to remove them
from memory, and subsequently replacing them with the newer version upon successful loadup of
Windows. Therefore whenever Windows asks you to reboot after installing any driver or application, you
should do so as soon as possible.

I recommend you download the following software and drivers in advance of reformatting and reinstalling
Windows XP as you should not attempt to connect to the Internet or browse any sites at this point. If you
have a permanent connection to the Internet and it is already enabled straight after installing XP, first follow
the procedure in Step 8 further below to turn on the built-in Windows XP Firewall before following the rest
of these steps. If you are using NLite (See Installing Windows section), make sure to read this section and
download the latest versions of all the relevant drivers below, however obviously once you've installed XP
using your NLite install disk with integrated drivers, you don't need to follow these steps again.

The initial core software installation process is provided below in order of first to last, starting immediately
after you've installed Windows XP.

STEP 1 - SERVICE PACKS

Install the full version of Windows XP Service Pack 2 (SP2). SP2 is a compilation of important updates for
Windows XP, and you can read about exactly which updates it contains here. SP2 also contains all the fixes
contained in SP1, so you don't need to install Windows XP SP1 before installing SP2. I recommend that you
download the full 266MB SP2 package in advance from here: Windows XP SP2. Back it up somewhere safe
for use in this step. Quite obviously if you used a Windows XP CD which already has SP2 incorporated into
it to install Windows, such as a Slipstreamed or NLite CD (See the Windows Installation section), then you
don't need to undertake this step as all the relevant SP2 files were automatically installed along with
Windows XP.
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STEP 2 - DIRECTX

Install the latest version of DirectX from here: Microsoft DirectX. DirectX 9 is already built into Windows XP
SP2, but you will need to install the very latest version of it to ensure maximum performance, security and
compatibility with the latest programs and games. In fact many recent games come with the latest build of
DirectX9.0c on their disk, so check to see if that is the case and save yourself the extra download. Note that
DirectX10 is not compatible with Windows XP and can only be run on Windows Vista.

STEP 3 - DRIVER SIGNING

Prior to installing any other drivers go to Start>Control Panel>System>Hardware and click on the 'Driver
Signing' button. In the Driver Signing Options screen, select 'Ignore - Install the software anyway and don't
ask for my approval' and tick the 'Make this action the system default' box. Click OK when done. This
ensures that even if your drivers are not Windows Hardware Quality Lab (WHQL) Certified they will be
installed. WHQL certification indicates that Microsoft has tested the drivers and certified them to work with
Windows XP. However WHQL certification is by no means a guarantee of stability or quality, and many
important drivers are not WHQL certified because of the large fee Microsoft charges for testing. Almost all
unsigned/uncertified drivers are perfectly fine to use, so just because a driver isn't WHQL certified doesn't
mean it will cause problems. You should instead judge a driver based on the reputation of the site you
downloaded it from, and any release notes that come with the driver, as well as feedback from other users.

STEP 4 - MOTHERBOARD DRIVERS

Install your motherboard chipset drivers. These are very important in achieving optimal, trouble-free
performance, as well as providing additional motherboard-specific functionality such as onboard audio,
onboard Network adapter, etc. The motherboard driver package varies depending on which particular
motherboard chipset type you run:

=  For Intel motherboards, download and install the latest Intel Chipset Software, also known as the 'INF
Update Utility'. You should also download and install the Intel Application Accelerator if you use IDE
hard drive(s), or the Intel Application Accelerator RAID Edition if you have a RAID drive setup.
Alternatively, install the Intel Matrix Storage Manager for RAID setups on recent Intel chipsets.

=  For VIA motherboards, download and install the latest VIA Hyperion Drivers. To find out more about
these drivers read my VIA Hyperion FAQ.

=  For Nvidia motherboards, download and install the latest nForce Drivers.

= For SiS motherboards, download and install the latest S5iS Chipset Software. Note that there are several
separate SiS chipset drivers - they don't come in a unified package. You should only download and
install the relevant drivers that support features on your particular chipset. For example, the 'SATA &
RAID' drivers should only be installed for chipsets that have SATA/RAID support.

Note that the motherboard chipset type is not the same as the motherboard's brand. The chipset type is
based on the company that manufactures the actual chipset architecture used in the motherboard. The
motherboard's brand is based on the company that buys this chipset, packages it with certain features and
sells it under its own brand name. For example, a 'DFI NForce4' motherboard is manufactured by a company
called DFI, using Nvidia's NForce4 chipset. See the System Specifications section for a list of utilities which
can help you determine your motherboard's exact chipset type if in doubt.

Also note that the motherboard chipset drivers are not the same as a motherboard BIOS (See the BIOS
Optimization section above). The motherboard chipset drivers are Windows drivers that control the way the
motherboard communicates through its various components under Windows, the same as graphics drivers
or sound card drivers for example. The BIOS on the other hand is not dependent on Windows at all and
operates at the machine level to control the motherboard's behavior the second your PC starts booting up.
The latest versions of both the BIOS and the motherboard drivers is recommended, but at the very minimum
the latest version of the motherboard chipset driver is strongly recommended.
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Some motherboards come with built-in 'onboard' audio and video. If you don't have a plug-in (i.e. separate)
graphics card and/or sound card and want to use these onboard features, you may need to install additional
drivers specific to your motherboard chipset, as well as altering the relevant BIOS settings for these functions
to work correctly. Search the chipset manufacturer's websites above, or the motherboard manufacturer's
website (see your motherboard manual for the web address) for these additional drivers and install them as
part of this step. In particular see your motherboard's manual for details of how to enable or disable these
onboard features. For example if you have a separate plug-in sound card you should disable any onboard
audio for optimal performance and minimal conflicts.

STEP 5 - GRAPHICS DRIVERS

Install your graphics card video drivers. These vary depending on the chipset type of your graphics card:

* For ATI graphics cards, download and install the latest ATI Catalyst Drivers. For details on how best to
install and set these up correctly read my ATI Catalyst Tweak Guide.

= For Nvidia graphics cards, download and install the latest Forceware Graphics Drivers. For details on
how to install and set these up correctly, see my Nvidia Forceware Tweak Guide.

*= For SiS graphics cards, download and install the latest S5iS GPU Graphics Drivers. Note that some SiS
graphics cards don't have Windows XP drivers available - use Windows 2000 or NT drivers instead.

= For S3 graphics cards, download and install the available S3 Graphics Drivers. Note that you can
download non-XP S3 graphics drivers here, but there may be problems with these under XP.

*  For Matrox graphics cards, download and install the latest Matrox Graphics Drivers.

*  For XGI graphics cards, download and install the XGI Graphics Drivers.

=  For motherboards with onboard graphics cards, the drivers for these are usually contained with your
specific chipset driver, or available as a separate download from your motherboard manufacturer. See
Step 4 above for more details on onboard functionality.

Note that as with motherboards, graphics chipsets are usually sold to different manufacturers who then
package them together with certain features and capabilities and market them under their own brand name.
The important thing to know is the manufacturer of the chipset on which your graphics card is based — for
most graphics cards this will be either Nvidia or ATI. For example, an Asus 7800GTX graphics card uses an
Nvidia chipset (the 7800GTX GPU) put together and sold by the company Asus.

The drivers found on the CD that comes with your graphics card are typically quite old by the time you get
them, so download and install the latest versions of these drivers from the links above. Note that installing
these 'Reference’ chipset drivers will not cause any problems on the majority of graphics cards regardless of
their brand. You don't have to use manufacturer-specific drivers unless your graphics card has special
features that do not appear to be functioning correctly with the reference drivers. In the first instance install
the generic Reference drivers from above, then if you believe any functionality has been removed or
impaired, consider installing the manufacturer-specific driver instead. In terms of performance, stability and
compatibility the latest Reference drivers are the best to use.

STEP 6 - SOUND DRIVERS

Install your Sound card's audio drivers. These vary depending on the brand of the sound card you are
running. Only the major brands are covered below:

=  For Creative sound cards, download and install the latest Creative Audio Drivers.

=  For Turtle Beach sound cards, download and install the latest Turtle Beach Audio Drivers.

=  For Hercules sound cards, download and install the latest Hercules Audio Drivers.

* For AOpen sound cards, download and install the latest AOpen Audio Drivers.

*=  For motherboards with onboard audio (e.g. AC '97 Audio), the drivers for these are usually contained
with your specific chipset driver. See Step 4 above for more details of onboard functionality.

uoTje[[e)SU] IALI(]

Copyright © 2007 Koroush Ghazi 41


http://ati.amd.com/support/driver.html
http://www.tweakguides.com/ATICAT_1.html
http://www.nvidia.com/content/drivers/drivers.asp
http://www.tweakguides.com/NVFORCE_1.html
http://www.sis.com/download/
http://ranger.s3graphics.com/xplib/?license=accept
http://ranger.s3graphics.com/swlib/
http://www.matrox.com/mga/support/drivers/latest/home.cfm
http://www.xgitech.com/sd/sd_download.asp
http://us.creative.com/support/downloads/
http://www.turtlebeach.com/site/support/ftp.asp
http://ts.hercules.com/eng/index.php?pg=files_faq
http://download.aopen.com.tw/Default.aspx

O.IJE ARSI e s

THE TWEAKGUIDES TWEAKING COMPANION

Note that if your sound card comes with an installation CD you must use that first before updating your
sound card drivers with the latest downloaded version. This is especially true for Creative soundcards - you
cannot install the downloaded drivers until you have first installed the drivers on the bundled driver CD.

STEP 7 - PERIPHERAL DRIVERS

Connect any remaining devices to your system (e.g. Mouse, Printer, Digital Camera) and test their
functionality. If they appear to work fine and all the major functions which you would use are intact, then I
suggest you do not install a new driver for them. For example, if you connect an optical mouse and it
appears to have sufficient functionality, do not then install the drivers that come on the CD with the mouse,
or download and install new drivers. The reason for this is that such drivers typically need to load into the
background at Windows startup and usually add to overall resource usage, increase boot times, and quite
often don't add anything of real value to the device's function. One of the many benefits of Windows XP SP2
over other Windows versions is that it supports a wide range of recent devices by default without the need
for additional drivers.

However should your device not function correctly, or a feature that you need to use appears disabled, you
will need to install the latest driver for that device. I recommend you go to the device manufacturer's website
and download the latest available drivers rather than using the older drivers that come on the CD with the
device. There are far too many device manufacturers to list here, but the website address is usually
prominently listed on the device's box and/or in the manual. Where possible follow the device installation
instructions in the device's manual (or on its website) for the best method of installation. Typically this
involves connecting the devices to your machine one by one, and when Windows XP detects them and
prompts for drivers, insert the appropriate driver disk or point Windows to the directory where you have
downloaded the latest driver files for the device.

STEP 8 - FIREWALL, WINDOWS UPDATE & .NET

You will need a connection to the Internet for this step. That means your network adapter or modem must
be installed and set up correctly — refer to your modem/network adapter's documentation as each has unique
setup procedures and requirements. You must also have your ISP (Internet Service Provider) details handy
(e.g. username, password, configuration scripts, access number, proxy settings, port numbers, etc.). Once
you have installed the modem or network adapter, and prior to connecting to the internet, you must enable a
Firewall. A firewall prevents malicious access to your machine via the Internet, and your network device
may already have a built-in firewall. However to start with, enable the Windows XP Firewall if you're not
sure.

To enable the default Windows XP Firewall, which is recommended for most purposes, do the following:

1. Go to Start>Control Panel>Network Connections.
In the Network Connections box, right-click on the connection you want to use for connecting to the
Internet and select Properties.

3. Go to the Advanced tab, click the Settings button and select On to enable Windows XP's built-in Internet
Connection Firewall and click OK. If you have third party Firewall software you wish to use, install it
and enable it instead. Either way make sure a Firewall is activated before you connect to the Internet.

Now you can safely connect to the Internet, but do not visit any other website, nor check your email, or
download any programs. Go directly to the Windows Update website, either by clicking the Windows
Update icon in your Start menu, or by going to Internet Explorer>Tools>Windows Update, or by clicking this
Windows Update link. Once on the Windows Update site, click the 'Custom' link and wait for the scan to
finish. If you have any problems with Windows Update, see the Internet Explorer section below. Note that
Windows Update will only work on Internet Explorer by default - it will not have full functionality on other
browsers. See the Internet Explorer section for more details of Windows Update.
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You will notice that after selecting a Custom scan, all the 'High Priority Updates' items have automatically
been added to your 'Review and install updates' list. It is important that you install all of these critical
updates for security, stability and compatibility purposes. Under the 'Optional Software' section, you should
also add any fixes or updates you see which are relevant to the programs or features you use or wish to use.
Note in particular that certain programs and drivers have a user interface which has been developed using
Microsoft's .NET Framework. This means that for these drivers to function correctly, you will need to install
.NET on your machine. You can download and install the latest NET Framework through Windows Update,

or download it separately here: .NET Framework Version 3.0. ATI graphics card users in particular will find
that the latest ATI Catalyst graphics drivers require .NET 2.0 or higher for the Catalyst Control Center to
work.

Finally add in all 'Optional Hardware' updates shown, as these are important updates of drivers for the
hardware on your system. They are all safe to use and will only be available for installation if they are newer
than the drivers you are currently using for your device(s). You can (and should) install newer versions of
hardware drivers over these versions when they become available.

Once you've added all the relevant updates, click the 'Install Updates' button. It may take quite some time
for the various updates to download and install depending on your internet connection. Reboot as often as
prompted. Don't install any other applications or games, and don't browse any other websites yet - go
straight to the PC Security section.

B GENERAL DRIVER INSTALLATION
THE LATEST DRIVERS

The drivers installed on your system need to be kept up to date, so regularly check all the sites linked to
above and make sure you have the latest versions. To check the current driver version on a particular
component, go to Control Panel>System>Hardware>Device Manager and for each device, right-click on it
and select Properties, then under the Driver tab look at the Driver Provider and Driver Version details.
Alternatively, check the System Specifications section of this guide for automated system tools which can
give you this information.

I usually announce new driver releases on the front page of Tweakguides.com so check there regularly for
download links, details of the changes in the latest drivers and my recommendation for whether you should
install them or not.

Before installing any new drivers, make sure to go to 'Add or Remove Programs' under the Control Panel
and uninstall any previous drivers for your device, then reboot Windows, and install the new version.

INSTALLING NON-EXECUTABLE DRIVERS

Device drivers in .EXE format only need to be executed to automatically install the drivers. However drivers
in archived format (i.e. .ZIP, .ACE, .TAR, .RAR) must have their contents extracted (using WinZip, WinRAR,
WinACE or 7-Zip), and then follow the steps below to install them on your system:

Go to Control Panel>System>Hardware>Device Manager, and double click on the device to update.

Go to the Driver tab and click the 'Update Driver' button.

Select 'Install from a list or specific location' then click Next.

Select 'Don't search, I will choose the driver to install'

Click the 'Have Disk' button.

Click on the Browse button and go to the directory where you placed the latest drivers.

Highlight the relevant driver file (usually an .INF file) and click Next to install.

Reboot your system if prompted and upon reboot the device should be using the latest drivers. You can
check this by checking the driver tab in device manager again (Steps 1 & 2 above).

PN LD
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You can use the above procedure to manually update (or downgrade) any of your device drivers whenever
you download an archived driver package for any device.

GENERAL DRIVER TIPS

The following are my recommendations with regard to device drivers:

= It is usually fine to install non-WHQL drivers (See Step 3 above for details), as long as they are from
your device manufacturer (e.g. Nvidia, Intel, Creative), or from a reputable third party source (e.g.
Omegadrivers).

*  Only install beta drivers if they are from your device manufacturer, and only if the release notes (or user
feedback) states that they resolve a specific issue you are currently experiencing. Beta drivers carry the
risk of causing additional system problems.

* Do not install alpha (pre-beta) drivers, as these are highly risky. This includes 'leaked' drivers and/or
heavily modded drivers. Don't be fooled by promises of large performance gains from the manufacturer
or other users - be patient and wait for a solid beta or final release version before installing such drivers.

= If you play recent games or use recent applications, try to keep your system up to date with the latest
drivers. While the latest drivers don't necessarily contain performance improvements, they do contain
bug fixes, resolutions to compatibility issues, and improvements to the driver interface among other
things. More often than not, problems with recent games are fixed by installing the very latest drivers -
whether graphics, sound, or motherboard drivers.

= If on the other hand your hardware is quite old and/or you don't use the very latest games or
applications, you should examine the latest drivers and if no fixes or improvements are listed for your
particular hardware or software, then you can stick with an older driver set.

In general, even if you don't install the latest drivers regularly, you should try to keep an eye on what is on
offer, and how it may affect you.
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PC SECURITY

Whether starting with a clean install of Windows XP or tweaking an existing installation, one of the first
steps in tweaking actually involves scanning all your current data for viruses and other kinds of nasty
intruders such as trojans and spyware and securing your PC. Ideally this must be done before you do any
reformatting/reinstallation, backup any data, or any tweaking. That way you can be sure that what you do
from this point onward will not all be wasted due to a virus messing up your system and making you go
through the whole process again. Do not skip this section.

There is a wide range of malicious software (also called 'malware') which can infect your system and cause
problems. The major categories of these are covered below, along with detection and removal methods.

B VIRUSES & WORMS

Viruses are small programs that load onto your computer without your permission and without your
knowledge of their real function. They are called viruses because just like a human virus they are designed
to replicate themselves and cause damage, attaching themselves to normal programs and files and spreading
to other host computers. Viruses range from the mischievous to the truly harmful, and while none of them
can cause physical damage to your computer, they can destroy valuable information, cause a range of
system problems, and waste resources.

Worms are a variation of viruses, with the primary difference being that they generally do not attach to other
programs.

Virus scanners serve a valuable role in finding these hidden viruses and worms - as well as some other
common malware - and removing them from your system. A virus scanner is an essential part of any system,
and you run a major risk if you don't have one installed on your system: it is your first line of defense against
serious infection. To start with, by regularly running Windows Update and installing all available Critical
Updates, your system will have a good level of protection.

The Windows Malicious Software Removal Tool is a regularly updated free tool provided through Windows
Update. Once it is downloaded and installed it does an automatic scan of your entire system for the most
common pieces of malicious software and removes them if detected. You can also download and run the
latest version of the tool at any time from the link above. However you will need a dedicated virus scanner
software which can perform regular full scans of your system. I personally use and recommend AVG
Antivirus Free Edition. AVG strikes a good balance between effectiveness, ease of use and minimal system
intrusiveness. However AVG is not the only good virus scanner around - there are several good free
scanners which you can try, though some of them are only free for a trial period:

Avast

AntiVir

NOD32

PC-Cillin (also: Free Online Scan)

There are many arguments about which virus scanner is 'the best', but any of the ones listed above should do
a suitable job. I have yet to see security experts agree on which single scanner is the most efficient one at
detecting and removing every virus and worm so don't hold your breath waiting. I used to use Norton
Antivirus - a common choice on many systems - but found that it basically took over my entire system and
took a great deal of work in reining in its intrusiveness, hence I do not recommend it at all. I firmly believe
that there is no point crippling your system's functionality and speed just to protect it from viruses. If you
are currently using Norton Antivirus, I recommend that the next time you reformat and reinstall Windows,
you try one of the scanners above and see how much easier they are to use, and how much less intrusive
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they are. Nortons is by no means the most effective virus scanner available, and it is certainly not the most
efficient or user-friendly.

The following is information on how to set up the recommended AVG Antivirus Free Edition software for
optimal performance and minimal intrusiveness in Windows XP.

AVG ANTIVIRUS

After you download, install and run AVG Antivirus Free Edition, make sure you click the 'Check for
Updates' button on the main screen and download all the latest updates for AVG from the Internet. AVG
will install these updates automatically once they have been downloaded. From here you can configure your
protection options by clicking the 'Control Center' button on the main screen. I recommend that you don't
have any of AVG's background protection options enabled as these can conflict with games and applications,
generally slow down Windows by using memory and CPU resources as well as slowing down reads/writes
to the hard drive. To disable this functionality go into the AVG Control Center and do all of the following;:

=  (Click once on the Scheduler item, and in the bottom of the screen click the 'Scheduled Tasks' button.
Double-click on each of the scheduled tasks listed and in the box that opens, untick all available options
to disable regularly scheduled scanning, updates etc.

=  (Click once on the Shell Extension item in the Control Center, and on the bottom of the screen select the
Deactivate button to remove AVG from Windows context menus etc.

= Double-click on the Email Scanner item in the Control Center, and click the 'Disable Plugin' button.

* Double-click on the Resident Shield item in the Control Center and untick all the options under the
Properties tab to disable background scanning.

The final step in removing all the background tasks is to disable the unnecessary AVG-related services and
startup items. These take up resources even after you have disabled much of the background functionality in
AVG itself. Remove the 'Avgcec' item (avgcc.exe) from your startup and disable the 'AVG?7 Alert Manager
Server' service. Note however that you should set the '"AVG7 Update Service' to Manual for AVG's Internet
Update functionality to work, otherwise you will not be able to successfully update AVG. See the Services
and Startup Programs sections for details on how to disable services and startup items.

This may seem like a lot of trouble to go to, but as I have mentioned Virus scanners are notorious for causing
conflicts and slowdowns, and most people don't realize that their virus scanner may be the cause of long
startup times, as well as stuttering or crashes in games for example. AVG Antivirus is one of the less
intrusive virus scanners I have used — Norton Antivirus doesn't even give you the option of disabling many
of its resource-hogging background tasks for example.

Once all the background and system-intrusive features of AVG have been disabled, you must now manually
scan for viruses regularly. Make sure to update the virus definitions often (at least once a week), and click
the 'Scan Computer' button in AVG once a week or more to run a full scan of your system and ensure it is
clear of major malware. See the General Security Tips further below for ways of preventing a virus infection
without crippling your system.

B TROJAN HORSES

A Trojan, short for trojan horse, is a malicious program that is often installed on your system under the guise
of being another program. Trojans differ from viruses in that they typically attempt to steal information from
your system such as passwords, or control certain aspects of your PC without your knowledge, all for the
benefit of the distributor of the trojan.

Trojans differ from viruses in many ways, and many trojans are not detected by virus scanners, so you need
a dedicated trojan scanner as well. I personally use and recommend A-Squared Free to scan for trojans. It is
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one of the best free trojan scanners, however you can also try the following - though some are only free for a
limited period:

The Cleaner

Trojan Hunter
AVG Antispyware

The following is information on how to set up the recommended A-Squared Free trojan scanner for optimal
performance in Windows XP.

A-SQUARED

To start with, make absolutely sure you are downloading A-Squared Free Edition as the other A-Squared
versions are only free for the first 30 days. After installation of A-Squared, as long as you're running it under
an Administrator account, you can set the new 'A-Squared Free Service' to Disabled as it is not needed.

Each time you run A-Squared, click the 'Update Now' button on the main Security Status screen. The
program will download all the latest updates. Fortunately the more intrusive aspects of A-Squared, such as
‘Background Guard' background scanning, are not available in the free edition, so we do not need to
configure/disable them. To set the depth of scanning used, click the 'Scan PC' option on the left of the main
screen, and either select Smart Scan or Deep Scan - I recommend Deep Scan which is longer but much more
thorough. Now whenever you want to run a scan using A-Squared, you only need click the 'Scan Now'
button on the program'’s main screen.

Note that A-Squared may find software which it classifies as Riskware, but is not actually a virus or a trojan.

For example on my system it found the PasswordProtected.exe and mirc.exe installation files as riskware - both
are legitimate applications and not necessarily malicious, they just carries greater risk in usage if your
system is compromised. To disable riskware detection go to the Scan PC screen, select 'Custom Scan' and
you can untick the 'Alert Riskware that is often used by Malware' option. During scanning, you may also

find Heuristic ArchiveBombs in archived game files for example; again these are usually totally harmless.

B SPYWARE & ADWARE

Spyware is similar to a Trojan, in that it is software that is usually installed on your system purporting to
have different functionality, or as a component of a useful program. Just like a trojan it transmits information
about you, such as your passwords, Internet usage behavior etc. to the distributor of the spyware. Adware is
a form of spyware that is less malicious as it is mainly used to target online advertising, however again it is
installed without your permission. In either case this software breaches privacy and security and uses
system resources and bandwidth for no useful purpose whatsoever.

A spyware/adware scanner will find and remove them from your system. I personally use and recommend
Ad-Aware 2007. It is very easy to use and available as a completely free download. You may also wish to try
these free spyware/adware scanners:

Spybot
Windows Defender

Both of the above are also free and make good alternatives, or can even be used in conjunction with Ad-
aware to detect and remove all spyware/adware. Note that the bulk of spyware/adware found by these
scanners is not always malicious, and typically consists of tracking Cookies - small files that keep
information on your user preferences for a particular site. These have no real impact on performance or
security, contrary to popular hysteria. However some spyware, such as keyloggers, are malicious and will
compromise your security for things like online banking, so in general you should find and remove all
spyware and adware from your system.
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BAD SPYWARE/ADWARE SCANNERS

There are a wide range of spyware/adware and malware scanners which purport to remove malicious
software, but ironically they contain malware themselves, or are bad knock-offs of a good scanner, or even
worse. Consult these lists if you plan on installing any malicious software scanners other than the ones
recommended in this guide:

Spyware Warrior Suspect List

2-Spyware Corrupt List

The following is information on how to set up the recommended Ad-Aware scanner for optimal
performance in Windows XP.

AD-AWARE 2007

After installing Ad-Aware 2007, it should automatically update to the latest resource file. If not click the
Update button on the front page. After this, you can find the new service Ad-Aware installs, called
appropriately enough 'Ad-Aware 2007 Service', and set it to Manual so it only runs when Ad-Aware is being
used. To set up Ad-Aware for the most effective and least intrusive scanning performance follow these steps.
First click the Settings button on the left side of the main screen, then:

*  Under the Scanning tab, make sure a green tick is against every available option except 'Suppress failure
warnings', 'Run scan as background process', and 'Suppress progress bar during scan'. In particular
make sure to deactivate 'Ad Watch' as it is a background monitoring function which may cause conflicts
with programs or games, and use up resources when it really isn't necessary.

* Under the Auto Scans tab disable the first two options, select ' No Automated Scan' for both the start-up
options, and under Safety I recommend ticking all the options available to prevent unintended deletion
of any files.

= Under the UI tab I recommend only having a green tick against the 'write protect system files' option -
everything else can have a red cross. You can set the menu animation, skin and language options to suit
your taste.

* Under the Log Files tab I recommend ticking the 'Create log files' option and ticking all other options
available, so that detailed logs can be kept in case something goes wrong and you want to diagnose the
issue.

Click the Save button when done to save your settings. Click the Status button on the left side of the screen
to go back to the main page. To start a scan, click the 'Scan Now' button and I generally recommend a 'Smart
Scan' for most occasions. If you suspect an infection, or want to be extra careful, select 'Full Scan' which takes
longer but is more thorough. Once the scan is completed, you will see any urgent objects which should be
removed under the 'Critical Objects' tab. The objects under the 'Privacy Objects' tab are not dangerous, but
are fine to remove as well.

Make sure you regularly update Ad-Aware's reference file and also do a manual scan after any heavy
Internet browsing, especially after visiting unfamiliar or risky sites, and at least once a week.

B ROOTKITS

A Rootkit is similar to a virus or trojan horse, but is specifically designed to mask its presence on your PC to
make it easier for an intruder to access your machine and conduct malicious activity. The problem with a
rootkit is that it is specifically designed not to be detected, and actively works to remove telltale signs of
itself so that most scanners cannot see it. There are however specific tools being designed to find and remove
rootkits, with varying success, and the best free ones at the moment are Rootkit Revealer and Sophos Anti-
Rootkit.
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However since one of the most common rootkits currently circulating is actually installed on legitimate Sony
music CDs (as part of their fight against piracy), you should also download and use the free Aries Rootkit
Remover from Lavasoft. Run the program, click Perform Scan' and you will see whether you have this
rootkit installed. Note that to circumvent the installation of such rootkits from Sony music CDs, make sure to
disable the Autoplay functionality for CD/DVD drives (See TweakUI section).

Advice for using Rootkit Revealer and Sophos Anti-Rootkit is provided below.

ROOTKIT REVEALER

Download Rootkit Revealer and run the main executable file which starts the scanner. There is no need to
change any options. Make sure you close down all background programs and open applications/games, then
click the Scan button and allow the scanner to scan your files. You should have no discrepancies found, but
if any are found check the Rootkit Revealer Forum for more details of how to identify whether it is a
legitimate threat or not.

While it is less likely that your system will become infected with a rootkit, and hence it is not necessary to
scan as regularly for them, I still recommend using Rootkit Revealer every few weeks if you visit risky sites
or install suspicious software often.

SOPHOS ANTI-ROOTKIT

This is a relatively simple tool to use, but once again it is recommended you use it often. Simply start the
program, make sure all three options are ticked, then click the 'Start Scan' button. As with Rootkit Revealer,
you will need to do some research (on Google for example) for the items found as they are usually not
rootkits.

B BROWSER HIJACKERS

A certain category of malicious scripts attempt to alter certain aspects of your Internet browser's behavior,
such as the default home page, the title bar of the window, additional toolbar icons - all without your
permission. These scripts are typically called Browser Hijackers.

Aside from the usual malicious software scanners which may find the source of the hijacking, there is a
specific tool designed to detect and remove hijack attempts called HijackThis. This tool is slightly more
advanced than the average virus scanner, and trickier to use, however it may be your last hope if your
browser is exhibiting undesirable behavior.

HIJACKTHIS

To use HijackThis, download the program and run it, then click the 'Do a System Scan and Save a Logfile'
button to begin a scan of your system. When the scan is complete you will see a list of entries - don't panic,
these are not all browser hijack attempts or malware. Almost all of these entries are related to legitimate
startup items and modifications you may have made to your browser, such as installing a messaging
program. Some entries are startup items necessary to run at Windows startup. To understand what each
entry relates to, read this HijackThis Tutorial as well as the Startup Programs section of this guide to
determine what should be kept and what should be removed. If you don't have the time or patience to
manually determine what should or shouldn't be removed, you can either click the 'Analyze This' button on
the results page, or post the contents of the Hijackthis.log file to this automated HijackThis Logfile Analyzer
to get an indication of what is safe and what is not.

If you find that certain items are not necessary, or are malicious, then place a tick mark against every such
item on the main HijackThis list after a scan (left-click on the small box next to each item), then click the 'Fix
Checked' button. HijackThis will remove these items from your startup, but note that it keeps a backup of
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your changes under the Config>Backups section of the program, so if you need to undo anything you can
highlight a backup and click the Restore button to return to the state you were in before.

To keep HijackThis updated, make sure you are online then click the Config button, click the "Misc Tools'
button and use the scroll bar on the right to scroll down to the bottom of the options list. Click the 'Check for
update online’ button to check for a newer version of HijackThis and be sure to download and install any
available updates.

B GENERAL SECURITY TIPS
BACKGROUND SCANNING VS. MANUAL SCANNING

There is no definitive answer as to whether you should enable or disable the background scanning
functionalities of the various scanners covered above (where applicable). Background scanning provides
greater protection from malicious software by both blocking their installation and/or providing the earliest
detection of their activities. However by the same token, the methods used by these scanners to detect
malicious software in the background can and will conflict with various games and applications, and
generally slow down your system by scanning all reads/writes to your hard drive. It all depends on whether
you're willing to (or need to) sacrifice performance and stability for greater security.

For the average PC used in a home environment, I strongly recommend disabling all background scanning
options in all your scanning software, both to maintain high performance and importantly to minimize any
conflicts or issues with your applications and games. Most games developers now explicitly provide the
same recommendation themselves in the installation and usage instructions for their games, so it is not just a
personal belief of mine. Instead I recommend doing regular manual scans using the various scanners above.
The frequency should vary based on how often you visit risky or new sites, and install various software, but
on average I recommend a full manual scan with each of these scanners at least once a week. Furthermore,
follow the tips below to reduce your chances of picking up any malicious software in the first place.

FIREWALLS

I feel the built-in Windows Firewall is sufficient - when combined with the information in the rest of this
guide - in protecting against system intrusion (See the Control Panel section for XP Firewall setup details). It
prevents external intruders from accessing your system, as long as you do not open lots of Ports and/or have
lots of Exceptions. It also allows what it feels is necessary outgoing traffic, and asks you to choose whether to
block particular connection attempts (such as those initiated by games or programs). This is one of the
reasons why I recommend the built-in Windows Firewall, since it is the least troublesome to use, particularly
for online gamers and the average home user.

However you do have other options if you want greater security. There are several commercial Firewall
packages you can purchase and install, and my personal recommendation if you want a third party firewall
is ZoneAlarm. The basic ZoneAlarm Firewall is available as a free download, but note that I don't
recommend the more elaborate versions of ZoneAlarm, such as ZoneAlarm Internet Security, as they can be
too intrusive and hinder normal Internet usage.

Finally, note that your Network Device may come with a hardware firewall which you can configure. For the
average home user who is using a Network Router, you can access your device's settings by going to
http://192.168.1.1 - but check your device's manual for specific details and if in doubt do not change any
settings as you may wind up not being able to connect to the Internet.

Below are my tips for minimizing your exposure to malicious software:
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EMAIL USAGE

* Avoid opening any emails from unfamiliar senders, especially if the subject of the email seems
suspicious or inappropriate. Delete these emails immediately.

= Never save or open an attachment from a suspicious email. Specifically, never save or open any .ZIP files
from such emails even if you're intensely curious about what's inside, and quite obviously never run any
other files which are attached, such as .SCR, .EXE, .BAT or even .JPG or .GIF files. These files are almost
always fake, and what you believe is a harmless file actually turns out to be malicious software which
you have just inadvertently installed on your system. The most common method infection for malicious
software is accidental installation by users.

= If you open an unfamiliar email, don't ever click anywhere within the email. Some emails even have text
which is actually an image, and clicking anywhere on these will launch an undesirable link. Delete these
emails immediately.

*= Don't ever click any links which supposedly remove you from a mailing list — these are used by
spammers to verify that the email address is 'live’ (i.e. a real person is receiving and opening their spam)
and hence you will receive even more spam. For the same reason, never send any kind of reply to spam
emails however tempting it might seem.

* Never click on any 'verification' links. If you receive an email purporting to be from your bank, financial
institution, or PayPal for example, never click on any links they provide, however genuine they may
appear. Real institutions never use email to ask you to verify important details. The scam emails usually
refer you to a fake mirror image of your financial institution's website where they trick you into
revealing your credit card number and password on a phony login screen (called phishing). Links in
emails can be 'masked' — that is they can seem real but the actual link is different to the underlined
hyperlink text shown. If you aren't sure if you actually do need to verify your details with an institution,
close the email, open a new browser window and manually type in the known web address of your
institution into your browser address window, and check for any notifications there.

* Never install any 'security patches' or 'important updates' that have supposedly been emailed to you
from Microsoft or a software vendor or financial institution for example. Once again companies like
Microsoft never send out updates or patches via email — always refer to the secure Windows Update site
or the companies' homepages for updates. Again, never follow any provided links to an 'update site’,
manually type in the link to your software provider and check for updates there.

* Never click on links (or type them into your browser) that contain just an IP address at the start (e.g.
http://68.203.11.34). These links don't provide a site name because the name would tell you the site is a
scam site, or not what it purports to be. Also, never 'check’ such a link by going to it.

For Outlook Express users see the Outlook Express section later in this guide for details of how to set up OE
to filter most spam and also prevent harmful files from being easily accessible in emails.

INTERNET BROWSING

» I strongly suggest you always run the very latest version of Internet Explorer to ensure maximum
security. This means you must have installed Windows XP SP2, and also have visited the Windows
Update site recently and installed all the critical updates available.

* Consider using Mozilla Firefox as your daily browser, as it is both free to use and very secure, and
allows customization to block ads and scripts. For more information see my Firefox Tweak Guide.

* Avoid visiting sites that purport to provide free pirated software, free music, movies, pornography etc. —
basically anything that seems too good to be true. Aside from often being illegal, these sites don't
actually contain anything of value, they are just fronts to get your traffic and earn money from
advertising clicks or referrals to other websites which then continue the cycle of advertising and false

referrals. Aside from the annoyance, such sites will often install malicious software on your system.

* Never install any certificate, software or plugin for your browser that does not come from a reputable
site. Even if a website insists that you must install certain software in order to view their content or
perform a function, ignore or cancel all such attempts unless the site is reputable and familiar to you.
The most common software you require for Internet multimedia functionality are the Macromedia Flash
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and Shockwave players, which you can install safely by downloading the latest versions directly from
here: ShockWave Player and Flash Player.

» If a site tells you that you will be connected to a secure encrypted server, once connected you can verify
this by looking in your browser's address bar and seeing https:// in front of the address (note the
difference between http:// and https://). To verify the credentials of a supposedly secure site before
entering any sensitive details, double-click on the padlock icon which appears in the Status Bar of your
browser and make sure the certificate is verified as being issued to the web address or name of the
company you believe it to be (e.g. Microsoft.com). If there is no padlock the site is not fully secure.

See the Internet Explorer section later in this guide for more details of how to configure Internet Explorer.

PEER-TO-PEER, MESSAGING AND IRC PROGRAMS

* If you use peer-to-peer (e.g. Emule or Bittorrent), instant messaging (e.g. ICOQ, MSN or AIM) or Internet
Relay Chat (IRC) programs (e.g. mIRC) which can send and receive files directly to others, you must
carefully go through their configuration options and ensure that you are not sharing files or directories

which contain potentially sensitive information such as passwords or licenses. If you must swap files
using such programs, I strongly recommend that you create a new empty folder and only allow
download and upload access to this folder. Then place copies (not originals) of all the files you wish to
share into that folder, and disallow access to any other directory or drive on your system.

» Change your messaging/IRC settings so that you do not automatically accept downloads, upload
requests or messages from people who are not on your contact list.

* Do not download or install any software which purports to allow you to steal other peoples’ passwords
or serial numbers, lets you 'store’ your passwords/serial number, or lets you 'hack email accounts' for
example. Ironically these are usually trojans designed to steal your passwords and serial numbers.

* Before downloading a file from a peer-to-peer program you can usually tell if a file is real or fake by the
number of people who are sharing it: the less people available to share a particular file, the more likely it
is that it is either another file with a deceptive title, or worse it is a virus or trojan. However there is no
guarantee that any file is legitimate or indeed free of infection.

Sharing and downloading files over P2P is one of the most risky things you can do on your machine because
you are downloading directly from another person's machine, and it is strongly recommended that you
minimize your exposure to such programs. If you insist on engaging in a lot of file sharing then I
recommend that you enable all the background scanning functionality in the scanning utilities discussed in
this section. This will reduce your performance, but you will need this extra level of protection.

In general whenever you believe you've downloaded a suspicious file or program, or if you've been
browsing risky sites on the Internet or engaging in a lot of P2P file swapping, at the end of your session close
all open applications and run a thorough manual scan of your system with all the scanners mentioned in this
section just to be safe.

ENCRYPTING FILES

If after reading all the tips in this section you suddenly feel the urge to protect certain files on your system
even more carefully, you can do so by using Windows XP's built-in File Encryption technology on systems
formatted with NTFS. To encrypt a file, open Windows Explorer, go to the file you want to encrypt and
right-click on it, then select Properties. Click the Advanced button at the bottom of the General tab, and
select 'Encrypt contents to secure data' and click OK then Apply. You may be shown the option to encrypt
the entire folder, in which case select to do so for maximum security but note that all the folder's contents
will also be encrypted. Now only a user with your account password and login can access the file. For all
other users the file will remain encrypted and inaccessible. You can give access to other users manually by
going back into the file's Properties>Advanced and clicking on the Details button and adding in a user.

For more detailed Windows XP security information, read the Microsoft Windows XP Security Guide.
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BALANCING SECURITY VS. PERFORMANCE

My final thoughts on PC security are that despite the panicky warnings security experts provide, I really
don't believe you have to have multiple scanners running in the background slowing down your machine
and crippling your Internet functionality to keep you protected - just like you don't have to drive at 15 mph
just to avoid having accidents on the road. At the end of the day it is up to your specific needs as to how
secure you make your system. For the average home user all I believe that is required is some basic
knowledge, common sense and reasonable caution. By using the advice and software recommended above
you can remain protected against any harmful effects from malicious software without sacrificing any

performance whatsoever.
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MEMORY OPTIMIZATION

This section covers the optimization of the memory subset on your system. When talking about the 'memory
subset' I am referring to a combination of your CPU's L1 and L2 Caches, your physical RAM, your graphics
card's Video RAM, your Windows Memory Management and your Virtual Memory settings. These
components when combined have a major influence on your system's performance and stability. If there is a
sub-optimal setting or unstable configuration for any one of these components the entire memory subset is at
risk of unsettling your machine, leading to constant errors, sudden reboots, crashes to desktop, freezes and
even data corruption.

Each component of the memory subset is dealt with separately below, however I urge you to read and
understand how all of these components work.

B CPUL1AND L2 CACHE

The CPU Level 1 (L1) and Level 2 (L2) Caches are memory chips that cache (buffer) information for faster
usage by the CPU, since the CPU is the fastest component in your system. These CPU Caches assist in
temporarily storing the information in anticipation of reading/writing by the CPU. They vary in size
depending on your CPU, but essentially they are physical chips that you should not have to worry about.

Windows XP and your associated hardware are designed to automatically detect the size of these caches and
use them optimally as long as you have them enabled in your BIOS. That is, if options relating to the use of
CPU L1 and CPU L2 Cache are present in your BIOS, never disable them unless troubleshooting. Aside from
BIOS settings, there is a SecondLevelDataCache Registry setting for manually adjusting your CPU's L2
Cache setting. Although harmless, it is no longer provided here as it has been proven to have no impact -
Windows XP will already be using the correct L2 Cache size for all modern CPUs.

In general since the user has no control over the CPU's L1 and L2 caches (aside from ensuring that they are
enabled in the BIOS), this is one area of the memory subset you should not worry about unless you are
troubleshooting a memory-related problem. For example, a CPU with a faulty cache may exhibit strange
behavior such as constantly returning data errors and CRC errors. In these cases I recommend you
temporarily disable the caches and see the Benchmarking & Stress Testing section to find out how to run a
CPU-specific stress test to isolate whether the CPU is the source of such problems.

B PHYSICAL RAM

This is probably the most well-known part of the memory subset. RAM (Random Access Memory) usually
comes in sticks composed of multiple memory chips adding up to a certain size (such as 256MB or 512MB).
Physical RAM, much like your hard drive, holds information in storage that can be read from and written to
by your system components. It is a temporary holding area for data, and is constantly being accessed when
your machine is on. However the advantage of RAM is that it is much, much faster than any hard drive, so
optimal RAM usage means faster and smoother performance for your system. There are three main factors
affecting RAM performance: RAM size, RAM speed and RAM timings. Each is covered below.

RAM SIZE

This is the amount of RAM in Megabytes. The main impact of having more RAM is that - when combined
with appropriate Virtual Memory and cache settings — your system will perform more smoothly. This is
because data has to be loaded from your hard drive less often as more of it is stored in RAM. This makes it
easier to access rapidly by your CPU and the rest of your system. There are no RAM size tweaks; essentially
if you have a low level of RAM (e.g. 256MB) then you should consider getting some more if you constantly
experience stuttering and long pauses in games for example. Many recent games require up to 2GB of RAM
to perform optimally without stuttering or displaying frequent loading pauses.
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RAM SPEED

This is the frequency at which RAM operates (in MHz) much like the speed at which a CPU operates. The
higher the RAM's speed, the faster it can undertake the operations it needs to perform. Each stick of RAM
has a speed rating, which is the speed up to which a stick of RAM is certified to safely operate. However the
actual speed a RAM module is running at on a particular system varies depending on how fast it is set to
operate in the BIOS and your Front Side Bus/HyperTransport speed. For example, a DDR PC3200 RAM
module can operate at up to 400MHz (2x200MHz) while staying within specifications. However on an
overclocked system it may actually be operating at a higher speed. Alternatively, if you're running it on a
motherboard where the main Bus is only 266MHz (with a 1:1 Memory Divider ratio) the RAM will only run
at 266MHz, well below its 400MHz potential (See the Overclocking section for details). The bottom line is,
the faster the RAM's actual speed, the faster it reads and writes information and the better your
performance. The speed rating is not the same thing as the actual RAM speed - it is only an indicator of how
fast it can potentially perform and has no direct bearing on performance. However the more the RAM's actual
speed surpasses its rated speed, the greater the chance for instability. Note that running RAM below its
speed rating will not cause any problems, it just means you're not working the RAM to its maximum
potential.

RAM TIMINGS

These are composed of several variables, set in your BIOS, which determine not the frequency of the RAM
module (RAM speed), but the latency of the RAM - that is, the amount of time it waits between updating
various signals. For example the RAS (Row Access Strobe) and CAS (Column Access Strobe) latency settings
measure in nanoseconds the delay in sending signals which specify firstly the row in which a particular
memory cell is located, and then the column. The lower the RAM timings in nanoseconds, the less time the
RAM rests between these operations, and hence the faster it performs, but the greater the chance for errors
and instability. Just like speed ratings, RAM modules come with recommended timings already encoded in
their Serial Presence Detect (SPD) on a special chip. These SPD settings are used by default by your system
unless manually changed in the BIOS, and when used with the recommended speed rating (See RAM Speed
above) ensure maximum stability.

If you want to improve the performance of your RAM and your entire system, you can lower its timings
and/or increase its speed - see the Overclocking section and the Benchmarking and Stress Testing sections for
more details.

B VIDEO RAM

Video RAM (VRAM) is the memory on your graphics card and the size of this is usually quoted in MB as
part of the graphics card's specifications (e.g. 128MB Radeon 9800 Pro or 512MB 7800GTX). This RAM acts as
a buffer to store graphics information much the same as system RAM does for general information. For this
reason the VRAM is also called the Frame Buffer, in that it holds graphics 'frames' ready to send to your
monitor through the RAMDAC (RAM Digital to Analog Converter) that converts the digital signals to an
analog image viewable onscreen. Just like physical RAM, VRAM has a speed in MHz, and a latency in
nanoseconds, with the higher the speed and the lower the latency the better the graphics performance.
Unlike physical RAM, altering the latency of your VRAM is tricky, though still possible. The speed in MHz
can also be altered up or down using an overclocking utility, with the faster the speed the higher the
performance, but once again the greater the chance of graphical glitches and freezes. See the Overclocking
and Benchmarking and Stress Testing sections for more details of graphics card overclocking.

B WINDOWS MEMORY MANAGEMENT SETTINGS

Another important part of your memory subset is the Windows Memory Management settings. These are
software settings which include the System Cache and related Windows Registry entries. This is an area with
the most tweaking potential, and all the major memory management settings are covered below:
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DISK CACHE

The Windows Disk Cache size can be set through the System component of the Control Panel (See the
Control Panel section), in the Windows Registry, or by using a utility like Cacheman. This setting controls
how much RAM is set aside to assist in buffering information written to and read from your hard drive(s) to
achieve faster information transfer. The optimal setting for most systems is the default 'Programs' option
under Memory Usage in Control Panel>System, or the 'Balance' option in Cacheman. Selecting the 'System
Cache' option ('Maximize throughput..."' in Cacheman) may result in drive errors for some people, and is also
really designed for server applications - that is, machines which are constantly writing/reading from the
hard drive - and hence it is strongly recommended that it not be used for home PC users.

ICON CACHE

Windows keeps a copy of all your most commonly used icons in its icon cache, speeding up the display of
these icons (on the Windows Desktop for example), rather than fetching them directly from each executable
or file every time you view them. You can assign the number of icons to hold in the cache by editing the
Registry entry below:

[HKEY LOCAL MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer]

Max Cached Icons=2000

Edit this STRING value to set the maximum number of icons which can be cached. A value of 2000 should be
optimal for most systems.

GENERAL MEMORY SETTINGS

There are several registry settings that are presented as controlling various memory usage behaviors in
Windows. Over time these have proven to be wuseless. Specifically these are the
DisablePagingExecutive, IOPageLockLimit and AlwaysUnloadDLL entries. If you have already
applied these, don't worry as they are totally harmless, but they appear to be unnecessary and non-
functional, so I have removed them from this guide. If you still want to apply these tweaks because you feel
they have some impact on your system, you can use Cacheman (See below).

WINDOWS PREFETCHER

The Windows Prefetcher creates prefetch files for the most commonly used programs, and attempts to use
these to more efficiently seek and load up data. You can configure it through the following Registry entry:

[HKEY LOCAL MACHINE\SYSTEM\CurrentControlSet\Control\Session Manager\Memory
Management\PrefetchParameters]

EnablePrefetcher=3
The allowable values for EnablePrefetcher are:

0 - Disable Prefetcher

1 - Application launch prefetching

2 - Boot prefetching

3 - Both application and boot prefetching

The default is 3, which should be fine for most systems. Note that if the Task Scheduler service is Disabled
(See the Services section), much of the Prefetcher functionality becomes disabled. If you wish to use full
prefetcher functionality, do not disable the Task Scheduler service.

I personally leave the Prefetcher registry setting above at its default of 3, and set the Task Scheduler service
to Disabled. This means the prefetcher won't create application prefetch files under the Window \ Prefetch
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directory. I also clear all out existing prefetch (.PF) files in that directory. I have found that this provides for
the fastest Windows bootup time, and yet does not noticeably increase my game or application loading
times. Experiment to see if this is the case on your system, or try a value of 2 in the prefetcher registry entry
above. If you don't see any benefits, then simply re-enable the Task Scheduler service and/or reset the
prefetcher value to the default. The relevant prefetch files will be automatically recreated and optimal within
a few days of using your system.

CACHEMAN

Cacheman is a free utility that provides a user-friendly interface for making most of the memory and cache-
related changes covered above, and in the Windows Registry section. To access Cacheman, download
Cacheman 5.50 default distribution from the Cacheman Website, install it and then launch the program.
Cacheman is in no way an essential tool, as most of the important tweaks can be performed using the
Registry Editor and TweakUI. However Cacheman does provide a simple interface for making these changes
for those not willing to edit the Registry - just make sure to follow the recommended advice for each setting
as shown in this section, and also do not enable any 'memory recovery' features of Cacheman, nor do you

need to have it run at Windows startup for the settings to work.

B VIRTUAL MEMORY IN WINDOWS XP

Virtual Memory in Windows XP is different to that under the previous Windows 95/98/SE/ME series. No
matter how much physical RAM you have in your system, your Windows XP Virtual Memory (also called
the Swapfile or Pagefile) settings will have a significant impact on your system's performance.

The information provided here is based on the definitive Virtual Memory in Windows XP Guide and
RojakPot's Virtual Memory Optimization Guide. These guides give you an excellent insight into how Virtual
Memory works in Windows XP. I recommend that you read them both if you want to gain a clearer
understanding of what virtual memory is, and why most of what you may believe concerning virtual

memory and 'freeing up RAM' are not quite true. What follows below are my personal recommendations for
Virtual Memory configuration based on a combination of the above guides and my own experience.

To access your Virtual Memory settings, go to the Control Panel>System>Advanced>Performance>Settings>
Advanced>Virtual Memory section and click the Change button.

CLEARING THE PAGEFILE

Before setting a new pagefile size, first clear your existing pagefile. To do this select the 'No Paging File'
option and click the Set button, then reboot your system. This step does two things: first it deletes the
pagefile, fixing any potential pagefile corruption which can occur after a bad shutdown (remember this tip
for future troubleshooting purposes); and secondly it ensures that any new pagefile you create will start off
as a single unfragmented contiguous block on your hard drive for optimal performance, which will remain
unfragmented in the future. Note that if you have any problems booting up into Windows due to a lack of a
pagefile during this step, enter Windows in Safe Mode (See Backup & Recovery section) and continue the
setup procedures for Virtual Memory from there.

SETTING THE PAGEFILE - PARTITIONS

Once you've cleared your existing pagefile, you can now set a new pagefile. Which drive or partition this
pagefile should be located on is based loosely on the following rules:

One hard drive and one partition: The pagefile can only be located on the primary partition of your hard
drive.

One hard drive and multiple partitions: Make sure the pagefile is placed on the first partition as this is the
fastest partition. This should also be where your Windows install is located. Placing it on another partition
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does not simulate the benefits of having two hard drives since the read head of the drive can still only seek
information from one place at a time. Highlight the logical drive where you want the pagefile to be placed
under the Drive window.

Two or more physical hard drives: You should put the main pagefile on the drive that doesn’t contain your
Windows installation and applications/games. This will reduce hard drive head movement on the main disk
and speed up access to the pagefile on the other disk. However if one drive is faster than the other, then I
generally suggest that you put the pagefile on the faster drive, particularly if you have low system RAM (i.e.
the pagefile is accessed more often). Highlight the drive where you want the pagefile to be placed under the
Drive window. Note, this advice doesn't apply to RAID configurations, as Windows sees multiple drives in
RAID configuration as a single large hard drive, and you cannot choose which drive to place the pagefile on.

RECOMMENDED PAGEFILE SIZE

After selecting the location of the pagefile, you can then determine its size in MB. In the Virtual Memory
settings screen select the 'Custom Size' option. Although there are many differing opinions on how big the
pagefile should be, one rule every Windows XP expert agrees on is never 'disable’ your pagefile regardless of
how much RAM you have. Windows XP needs a pagefile in order to operate correctly. Setting the pagefile to
zero or a tiny size does not speed up your performance by 'forcing' XP to use physical RAM. Windows XP's
memory management does not work that way - refer to the guides above for more details.

To determine the optimal pagefile size you should ideally see how much memory your most memory-
intensive programs use and then set the pagefile to comfortably accommodate this. A rough and ready way
of doing this is to configure your Task Manager as specified under the Task Manager section, then run what
you believe is your most memory-intensive application or game and use it for a period of time. Then without
quitting the game or application, bring up the Task Manager and check the peak memory usage figure for
the largest process under the Processes tab - this should indicate how much memory the program usually
needs. Also after a period of time using various applications and games on your system, open up Task
Manager and go to the Performance tab, then check the Peak figure under the 'Commit Charge (K)' section -
this is approximately the maximum amount of memory in KB required so far by your system. These will
give you an indication of how much total memory you need when going through the next step.

For most people however accurately working out which is the most memory intensive application or game,
and more importantly predicting the amount of memory future software will require is tedious if not
impossible. Therefore I provide a simple general recommendation which is both safe to use on all systems,
regardless of how much RAM you have, and provides good performance:

Set the Initial and Maximum pagefile sizes to 2560MB each - i.e. allocate 2.5GB for the pagefile.

This may seem like quite a lot, but the reason for this is that recent games now require a lot more real and
virtual memory to function correctly, even if you have 2GB of RAM. Having a larger pagefile size does not
hurt performance as such; it only takes up a bit of additional disk space. So on balance my recommendation
is to play it safe.

Once you've adjusted your Virtual Memory size settings click the Set button and reboot if required. Your
pagefile will now be in a single fixed unfragmented file, created closer to the start of the hard drive for faster
performance. There will be plenty of headroom for memory-intensive applications and games and you
should notice smoother performance. It will not become fragmented in the future.

Note that the common advice about the pagefile being 1.5 x RAM or some other multiple is not intuitively
correct. Consider the situation where you only have 128MB of RAM: setting the maximum pagefile size to
1.5 x 128MB = a 192MB pagefile, which when combined with your 128MB of system RAM gives Windows
only 320MB of total available memory for Windows XP which is obviously not anywhere near enough
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memory for modern games and applications. In effect it is about how much fotal memory (RAM + Pagefile)
that should be made available for Windows to operate efficiently.

If at the end of all this you still have doubts about what to do, or you run into any problems, you can either
further increase the fixed pagefile size (make sure to reset to 0 first, then reboot); set a 'semi-permanent’
pagefile which has an Initial size equal to your current system RAM, and a Maximum size which is high, e.g.
3072MB; or failing all of the above, simply revert back to the 'System Managed Size' setting to let Windows
manage the pagefile size. Whatever you do, don't set a zero pagefile.

MORE RAM

Remember, the optimization of your Windows pagefile is primarily to improve loading times, prevent 'out
of memory' errors and provide smoother performance in games and applications. If after all the tweaking
possible in this guide you find that is still not the case, you will simply have to increase the amount of
physical RAM in your system and/or consider purchasing a faster hard drive. For example, 256MB or even
512MB of RAM is now generally insufficient for current games to run smoothly in Windows XP regardless of
any virtual memory tweaking you undertake.
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DRIVE OPTIMIZATION

This section covers the primary means by which you can improve and maintain the performance of your
hard drive(s) in Windows. However many aspects of drive performance are covered in other sections. You
should have already:

» Formatted the drive correctly (See Installing Windows section).

* Made sure to have the correct BIOS settings (See BIOS Optimization section).

* Installed the latest motherboard drivers (See Driver Installation section).

» Have correct Windows settings (See Control Panel and Memory Optimization sections).

Follow the rest of the instructions in this section to make sure your drive(s) remain fast and responsive.

B WINDOWS DISK INDEXING

This is a performance tip that I strongly recommend you implement. The Windows Disk Indexer constantly
indexes all files on your machine to allow for faster searching using the Windows Search function for
example. Since most people don't search their machine very often, having Disk Indexing enabled provides a
performance hit for no good reason, and also increases fragmentation. Follow these steps to turn off the
Windows Disk Indexer to improve hard drive performance and responsiveness:

Go to Windows Explorer, right-click on your hard drive name (e.g. C:) and select Properties.

Untick the "Allow Indexing Service to index this disk for fast file searching’'.

Select 'Apply changes to [Drive letter]\, subfolders and files' in the subsequent prompt.

Your system will now go through and remove all indexing on existing files, and not index any new or
moved files in the future - this will speed up drive read/writes and general responsiveness. Ignore any
‘errors’ which are shown, this occurs simply because some files are in use or protected and can't have

e

their properties changed to remove indexing - this is normal.

Make sure you also disable the 'Indexing Service' service as it is no longer necessary when disk indexing is
removed from your hard drive (See the Services section).

B WINDOWS DISK DEFRAGMENTER

As information is written to, and deleted from, your hard drive, parts of individual files will become
fragmented and physically spread out all over the hard drive. This increases the time your hard drive takes
to access information when using Windows or any application. The greater the fragmentation of the drive,
the greater the stuttering and loading pauses you will also experience in games for example.

Windows Disk Defragmenter (Defrag) is a built-in utility that performs a very important function: it puts all
these file fragments back together with each other in the same location on the disk and also attempts to pack
them closer to the start of the drive to speed up reading and writing to these files. This reduces loading times
and greatly reduces annoying loading pauses and stuttering. To access the Windows Defrag utility, go to
Start>Run and type "Dfrg.msc" (without quotes) and press Enter, or look for the Disk Defragmenter icon in
your Start>Programs>Accessories>System Tools menu. Make sure there are no open applications or games
running in the background and then in the Defrag window simply click the Defragment button to begin
defragmentation. Do not do anything else while this process is being completed. It may take quite a while to
complete so be patient. The longer it takes, the more good it is doing your drive. If tweaking a new install of
Windows, make sure to run Defrag immediately after installing the system drivers and core software as this
will move all the important system files to the start of your hard drive where drive access is fastest.

Note that for any defragmentation program to work, whether Defrag or a commercial package, you must
have 15% or more free drive space to give the program room to temporarily relocate files as it defragments.

uonezrumgd( dALI(]

Copyright © 2007 Koroush Ghazi 6 0



http://www.microsoft.com/resources/documentation/windows/xp/all/proddocs/en-us/snap_defrag.mspx

e..uenﬂmu.ng-_-. THE TWEAKGUIDES TWEAKING COMPANION

BACKGROUND DEFRAGMENTATION

By default, Windows also defragments your hard drive in the background whenever your system is idle. It
does this to maintain optimal layout of your important files, such as your boot files. That is why you may see
hard drive activity even when there are no programs or games running in Windows. This is fine, since it
does not interfere with your programs or games - it only occurs when the system is truly idle. You can
disable this behavior if you really wish by using Cacheman for example, but this is not recommended. The
other source of background drive usage is the Disk Indexer, which you should disable (See above).

B ADVANCED DEFRAGMENTATION

If you want to do a more thorough defragmentation of your hard drive and get better results you will have
to look beyond the built-in Disk Defragmenter in Windows XP - even Microsoft admit this in this Microsoft
Article. There are several applications which can defragment a disk in more efficient ways, and also
defragment files which the Windows Defragmenter cannot move, such as system files (the green blocks in
Defrag). The benefits are spelt out more clearly in this White Paper. Note that the Windows pagefile will not
become fragmented if configured correctly as detailed in this guide (See Memory Optimization section), so
pagefile fragmentation is not an issue.

PAGEDEFRAG

To defragment your system files for free, you can use the PageDefrag utility. It is fairly simple to use, and
upon launching it you can see at a glance how many fragments your major systems files are in - to be
optimal they should all be in 1 fragment each. To run a defragment using PageDefrag, launch the program
and click the 'Defragment at next boot' option, then reboot. This will defragment your major system files,
which can only be done at boot time - something which the regular Windows defragmenter cannot do.
However even the author of PageDefrag suggests you use it in combination with other defragmentation
software such as a commercial package, or his own Contig utility.

DIRMS & BUZZSAW

If you are an advanced user, you can try the Dirms and Buzzsaw defragmentation utilities. These utilities are
free but require re-registration every 30 days. They also require a bit more work in figuring out and using, so
they are not covered here in detail, and are not recommended for the average user.

For ease of use and maximum safety, I recommend commercial defragmentation software for most users,
since these usually come with detailed instructions, are fully automated and fairly foolproof. Since
defragmenting involves lots of file movements, sometimes sensitive system files, it is important that the
software you use to defragment be rock-solid.

DISKEEPER

My personal preference is for Diskeeper, since the default Windows Defragmentation program is simply a
cut-down version of Diskeeper anyway. The differences between Diskeeper and the Windows Defrag utility

are covered in this document. However PerfectDisk should be just as good for most intents and purposes.
The latest versions of these popular defragmentation utilities are easy to use and achieve good disk
performance.

While Diskeeper isn't free, you can download and try it for 30 days for free from the Diskeeper Site - see if it
makes a difference on your machine. Importantly, when downloading and installing this trial version make
sure you choose the Pro Premier Edition as that is the edition that has all the functionality we need,
including the I-FAAST and Invis-Tasking features (see below). Once it is installed, it will take the place of the
Windows Disk Defragmenter, so if you click the regular Defrag icon it will also launch Diskeeper.
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Below is more detailed advice on how to set up and use the recommended Diskeeper defragmenter
optimally. Note that earlier versions of Diskeeper may differ in the location of particular functions, but the
general advice remains the same for such earlier versions.

To perform a defragmentation at any time, first close all open applications and games, then start up
Diskeeper and follow these steps:

1. Click on the logical drive you want to defragment, and select Analyze.

Once the drive analysis is over - the progress is shown in the bottom right corner - click on the 'Volume
Map View' drop box and look at the results in both File Performance and File Structure views, paying
attention to the color legend shown at the bottom. In general, the more red and pink areas you see, the
more benefits defragmentation will give.

3. Right-click again on the logical drive and select Defragment.

4. Once the defragmentation is over, you will see that the layout shown under the 'Volume Map View' File
Performance section has changed, showing a defragmented (blue) drive. If you can still see pink areas,
see the boot time defragmentation instructions below. Note that any areas of cross-hatched green and
white are normal reserved system areas, typically for the Master File Table (MFT).

To configure your Master File Table (used only by NTFES drives) optimally, follow these instructions:

Open Diskeeper and click the 'Configure Diskeeper' item on the left of screen.

Click the 'Diskeeper Configuration Properties’ option.

Select the 'Frag Shield..." option, then click the Edit button which appears in the right pane.

Scroll down the list, and near the bottom you will see your MFT usage for each drive - pay particular
attention to the Percent Used' figure. If it is at or close to 100%, you may need to select the 'Configure the

L e

MEFT to the recommended size' option (if not already selected) to allow Diskeeper to provide more space
for your Master File Table, then click Submit at the bottom of this page. This prevents the MFT from
becoming fragmented as more programs are installed on your system, and will result in optimal drive
performance.

5. If on the other hand your MFT is well below 100%, leave it on the 'Do not configure the MFT' option,
scroll down and click the Cancel button.

The MFT is the large area displayed as a green and white cross-hatched block, and by default Windows can
reserve 12.5% or more of your total drive space to allow the MFT to grow without becoming fragmented.
This space cannot be reduced. You should regularly check to make sure your MFT is allowed enough space -
especially after installing lots of files or a large application/game. If Diskeeper recommends increasing your
MEFT size, I suggest you do as it says and allow the new recommended size. The Master File Table is
important in accessing your files, and programs like Diskeeper can help make sure that your MFT is kept
defragmented for optimal drive performance.

To defragment certain system files such as the MFT, you must do a 'boot time defragmentation’. This is
because some files are protected system files and can't be moved while they're loaded up in Windows. To do
a boot time defrag using Diskeeper, follow these instructions:

1. Open Diskeeper and highlight the logical drive where your pagefile resides.
Right-click on that drive and select 'Boot-Time Defragmentation'

3. In the box that opens, tick the 'Enable boot time defragmentation...' box and select 'Run boot time
defragmentation the next time this computer is manually rebooted'. Then tick all available options
except 'Produce the summary log file'.

4. Click the Apply button, and then OK and a boot-time defragmentation is now scheduled. Note if you
ever want to cancel this, simply follow steps 1-3 above but this time simply untick the 'Enable boot time
defragmentation...' box and click Apply.
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5. Reboot your system and upon rebooting Diskeeper will commence defragmenting system files for
optimal performance.

Do not disturb this process and at the end of it press ESC to boot back into Windows. Upon booting back
into Windows I recommend doing a manual defragmentation of your drive again with Diskeeper. While for
the most part a boot time defrag should be safe, there is an element of risk involved so firstly I don't
recommend that you do it often, and secondly make sure you have a recent backup of all your important
data before doing one. If you run into problems after a boot time defrag, see the Windows Recovery Console
under the Backup & Recovery section for further assistance.

The Diskeeper Professional Premier version contains a technology called [-lFAAST which is not available in

other versions of Diskeeper. It is basically an advanced analytical method, and to set it up you will need to
go into Diskeeper, right-click on your drive and select I-FAAST, then firstly enable the new Automatic
Defragmentation feature (see below) by clicking its link on the left side of the box and selecting the
appropriate checkbox, then going back to the I'lFAAST section and using the default option to run I-FAAST
whenever Diskeeper believes it is beneficial. -FAAST can result in an improvement in drive performance,
but whether you want to invest in the Premier version of Diskeeper to be able to use it is up to you.

The latest version of Diskeeper also includes the new Invis-Tasking Automatic Defragmentation feature
which helps Diskeeper run in the background, defragmenting your drive on the fly to prevent
fragmentation. You should enable it to start with (see above), and then if it appears to be interfering or
causing stuttering in games for example, disable it and stick with running manual defragmentation jobs.

To remove additional Diskeeper background programs which may unnecessarily use system resources, in
the Windows Registry remove the 'Diskeeper Systray' startup entry (Dklcon.exe) - see the Microsoft
Configuration Utility Section for details on how to do this. Furthermore if you don't run Diskeeper often
then you can disable the Diskeeper service for day-to-day usage. However this service must be set to
Automatic for Diskeeper to work properly, so I generally suggest leaving it at its default of Automatic - see
the Services section.

If you run into any problems, check the Diskeeper FAQ. If don't like Diskeeper, you can try PerfectDisk, but
at the end of the day if you don't want to pay for a commercial defragmentation program, the normal
Windows Defragmentation utility along with PageDefrag for system file defragmentation. is sufficient. I do
recommend at least trialing Diskeeper for a few weeks to see if it makes a real difference on your system, as
proper defragmentation can make a substantial difference to things like stuttering in games.

B FREQUENCY OF DEFRAGMENTATION

Whether using the Windows Defragmenter, or a commercial package I strongly suggest you get into the
habit of defragmenting often, specifically after you:

» Install or delete a new application or game.

» Install a system driver (e.g. graphics or audio driver).
* Delete or add any large files.

* Run Windows Update or install a Windows patch.

Neglecting to defragment your hard drive after a major drive operation such as those listed above may see
your applications or games take longer to load, exhibit frequent stuttering and pausing, and generally
reduce your hard drive's performance. There is no need to defragment daily or hourly, and indeed you
shouldn't just defragment on a set time schedule. Manually defragmenting regularly also reduces the time it
takes to defragment your drive, so that each time you do it, it should only take a few minutes at the most,
even for a large drive, since only small portions of files need to be rearranged.
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H BOOT OPTIMIZATION

By default Windows already detects and optimizes your Windows bootup time by placing the files required
in optimal positions on the disk. This is done frequently, however I recommend that you do this process
manually after you install major system drivers (See Regular Maintenance section). This is best done using
Bootvis.

BOOTVIS

Bootvis is the Boot Visualizer tool from Microsoft, which shows information about the type of programs,
drivers and services that are loaded up during your Windows startup procedure, and how long each one of
them takes. This information can be very useful in identifying precisely what is taking the most amount of
time at bootup, and if necessary lead to uninstalling or altering hardware and software which is causing any
long delays. Bootvis does more than just analyze the startup procedure — it can also optimize it by laying out
the required files in an optimal pattern for faster bootup times. This usually results in dramatically faster
loading of Windows, and that is the primary purpose to which we will put Bootvis. To access Bootvis
download it from this Bootvis Download Site and install it.

Before you use Bootvis however you should note that although it is a Microsoft-produced utility, it was
removed from the Microsoft Bootvis Page a while ago for an unspecified reason. The likely reason is that it
can cause problems on certain systems, although it is unclear which particular types of systems. Systems
with HyperThreading (HT) or Dual Core CPUs are one possible source of incompatibility with Bootvis,
although many users with such systems - including me - report using Bootvis without any problems. The
bottom line is that you should backup your data before using Bootvis, just in case.

Note that for Bootvis to operate correctly, the Task Scheduler service needs to be set to Automatic (see the
Services section). This is very important, otherwise Bootvis will not complete its Boot Trace or Optimization
tasks after rebooting.

ANALYZING SYSTEM STARTUP

To analyze your system with Bootvis, run the program and go to the Trace menu, then select 'Next Boot +
Driver Delays'. Let Bootvis reboot the system, and on rebooting wait patiently for Bootvis to pop back up
when it's finished analyzing. It will display several graphs that shows the various startup components laid
out sequentially in time shares. Make sure to use the scroll bars to look at the various graphs in their
entirety. If you want to identify which programs are associated with particular applications or drivers,
consult the Microsoft Configuration Utility section for more details.

OPTIMIZING SYSTEM STARTUP

To optimize your bootup procedure using Bootvis, first go to your \ Windows\ Prefetch folder and delete the
entire contents. Then start Bootvis, go to the Trace menu and select 'Optimize System'. Once again let Bootvis
reboot and wait for it to restart after the reboot. It will say 'Optimizing System' for a while. Once this is done
you can reboot your system and observe that your bootup times will now be much faster. Ideally any time
you install new drivers or add new pieces of hardware to your system you should redo the entire Bootvis
procedure to maintain an optimal startup time.

Note that if you do not want the Windows XP prefetcher to create lots of prefetch files for various
applications then make sure to set the Task Scheduler service back to Disabled and delete everything except
for Layout.ini in your \ Windows\ Prefetch folder after finishing all of the above steps. In theory these prefetch
files are meant to help in improving loading times for applications, however in my experience they simply
increase the overall Windows startup time in exchange for barely noticeable improvements in application
and game loading times. The Layout.ini file is the main file Windows needs to maintain optimal boot layout.
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THE CONTROL PANEL

This section covers all the options available under the default Windows XP Control Panel, which is the
central place to change most of Windows XP's settings. I cannot go into each section of the Control Panel in
great detail due to space considerations however all the important settings are covered and my
recommendations for each are safe to use on most systems unless you have very special requirements. Take
the time to go through this section carefully as it is important for XP performance and functionality.

B ACCESSIBILITY OPTIONS

There are a range of features here that can be used to accommodate different keyboard usage styles, make
Windows easier to see on screen, or provide audible notification of events for example. Quite obviously
which settings you choose will depend on your individual requirements. If you want to find out more about
these options go to the Windows Accessibility Page. For the majority of users who do not need to use any
accessibility functions, make sure that every option under each of the tabs is unticked for maximum
performance and minimal interference with the functionality of games and applications. For example, if the

‘Sticky Keys' option is left enabled, it is known to cause unintended interruptions in some games.

B ADD HARDWARE

This utility allows you to go through a set of procedures for adding a new piece of hardware to your system.
In most cases though, since Windows XP is a plug-and-play operating system, and as long as you have Plug
and Play' enabled in your BIOS (See the BIOS Optimization section) and the 'Plug and Play' service set to
Automatic (See the Services section), all you need to do to add any new hardware is to connect it to your
system and XP will detect it, and either automatically install basic drivers for it, or if it can't determine the
type of hardware, request that you insert a driver disk. Follow Step 7 under the Driver Installation section. I
strongly recommend that before adding any new piece of hardware, you spend some time and read through
the installation instructions which come with the hardware, as some have unique requirements for optimal
installation which may be different to what you might expect, and in some cases the default Windows XP
driver will not function as well as the latest specific drivers for the device.

B ADD OR REMOVE PROGRAMS

The main use for this utility is not so much for the addition of new software - that typically only requires
that you insert the installation CD/DVD into your drive and follow the procedures from there, or the
execution of the software's setup executable file. Rather this tool is most useful for looking at the software
and drivers currently installed on your system and quickly being able to remove ones that are no longer
needed. It is always a good idea to go through this list periodically and remove software that hasn't been
used for a long time. You can sort this list in various ways by going to the top right corner and for 'Sort by’
selecting either Name, Size, Frequency of Use or Date Last Used.

On the left side of the screen, you will see the major functions available under this utility. We've covered the
addition and removal of software so far. You can also 'Add/Remove Windows Components', which is
covered in the Cleaning Windows section. The final option is the ability to 'Set Program Access and Defaults'
that is covered below.

SET PROGRAM ACCESS AND DEFAULTS

Click the 'Set Program Access and Defaults' button, and on the next screen you can choose from two presets
(Microsoft Windows or Non-Microsoft), or as I recommend, click on the third Custom option. Next, click the
double down arrows to the right of Custom. Here you can set the default Web Browser, email program,
media player, instant messaging program and Java virtual machine.
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For example, if you want to make Mozilla Firefox the default Internet browser instead of Internet Explorer,
as long as you already have it installed on your system the option to select it as the default should appear
here. Select it, and make sure a tick appears in 'Enable access to this program' next to it. You can disable
access to Internet Explorer by removing the tick in the 'Enable access to this program' box next to it as well.
This won't uninstall Internet Explorer, it simply removes access to it, which is not recommended. I
recommend you select 'Use my current Web browser' instead which should be fine for most purposes and
ensure a tick appears next to all browsers below it so that you can access them all as need be.

Although Microsoft has incorporated this feature as a result of charges relating to monopolistic behavior,
bear in mind that quite often you must use a Microsoft product for optimal trouble-free usage. For example,
only Internet Explorer can access the Windows Update site properly by default, and only Windows Media
Player can provide optimal playback of .WMA files. Other methods to access these sites and files do exist,
and they are covered in the Internet Explorer and Windows Media Player sections of this guide, but they are
not necessarily as secure, so don't disable access to these default applications for that reason. Instead
configure them correctly as detailed later in this guide. In all cases I recommend selecting 'Use my current...'
and allowing access to all the components beneath. There is one exception - if you want to disable access to
Windows Messenger as part of removing it from Windows, untick the 'Enable access to this program' box
next to it, as it has no other use.

B ADMINISTRATIVE TOOLS

There are seven main administrative tools under this category. Some of them may not be available if you run
Windows XP Home. In particular if you are running Windows XP Professional, you will also have access to
the Group Editor, but that is covered separately in the Group Policy section. If you have installed the .NET
Framework on your machine, you will also have access to the NET Config and NET Wizard tools. I cannot
go into detail about all the functions of these administrative tools because they are capable of a great many
things, as described in this Microsoft Article. However, I provide brief details of the primary Administrative
Tools and point out their most useful aspects for the average home PC user below.

COMPONENT SERVICES

This tool allows system administrators the ability to deploy and administer component services applications
or automate administrative tasks. For our purposes, the only real usage is the Event Viewer and the Services
components, both of which also have separate tools to allow direct access to them - see each of these below.

COMPUTER MANAGEMENT

The main unique use for the Computer Management tool is the Disk Management sub-component, which
you can access by double-clicking on the Storage item in the left pane and then clicking on the Disk
Management (local) item that appears underneath it. You will then see your hard drive(s) listed in the top
right pane, with all your available drives (including CD/DVD drives) listed in the bottom right pane.

If you want to change any of the drive letters on your system - for example if you want to swap your
CDROM drive from D: to E: or just change it to a new letter like Z:, you can do so here by right-clicking on
the drive letter in the bottom right pane and selecting 'Change Drive Letter and Paths', then highlighting the
drive letter which appears, and selecting the Change button, and assigning a new drive letter.

If you want to convert a hard disk from a Basic to a Dynamic volume, you can do so here by right-clicking
on the Disk 0 (or Disk 1, etc) box in the bottom right pane, and selecting 'Convert to Dynamic Disk'. Dynamic
disks can emulate a RAID array - that is they can span multiple drives as though they are one large drive.
The features of Dynamic Disks are discussed in this Microsoft Article. Note that dynamic disks are a storage
type not supported on Windows XP Home Edition or earlier versions of Windows. It is not recommended
that you convert your disk from basic to dynamic, because even though you can covert back to a basic disk
you will lose all your data. If however you have a specific reason to use this function, the option is here.
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DATA SOURCES (ODBC)

This tool lets you add and configure drivers for managing access to data on various database management
systems. Unless you use databases extensively on your machine, you can ignore this tool. There are no
general functions for this tool that can be discussed here. Note that this is the same tool as the Data Sources
(ODBC) item in the main section of the Control Panel.

EVENT VIEWER

The Event Viewer tool shows a list of events under the Application, Security and System categories. These
events are recorded by Windows over time, and reflect information alerts, warnings and errors that have
occurred to date. You can view the (limited) details of an event by double-clicking on it. Event Viewer can be
used to troubleshoot an event if you haven't had the chance to see an error message — for example because
your system rebooted before you could read it. More details are provided in the Windows Errors section.

LOCAL SECURITY POLICY

This tool allows you to establish and alter security-related settings. This is best left at default and I
recommend that you do not change any of these settings unless directed to by a Network Administrator or a
Technical Support expert.

PERFORMANCE

This tool allows users to examine the various performance variables on their system, such as CPU usage or
page file usage in graphical and numerical form. You can add components to the display by clicking the
large '+' button above the graph. A more user-friendly interface can be added to the Performance Monitor by
downloading the Microsoft Performance Monitor Wizard.

SERVICES

This tool is extremely useful in configuring service usage under Windows XP. Changes to settings made
under this tool can affect performance, stability and XP functionality quite noticeably, so see the Services
section dedicated to explaining these features in more detail and showing you how to optimize them.

That covers the initial look at all the administrative tools in Windows XP. As mentioned, certain tools are
covered in more detail later in this guide due to the need to use them often. Generally though, aside from the
Services utility and Event Viewer you should not need to access the administrative tools very often and great
caution should be used when changing any settings with them.

B AUTOMATIC UPDATES

The Automatic Updates function in Windows allows your machine (when connected to the Internet) to
periodically check for updates on the Windows Update website and depending on the options you set here,
download and install them as necessary. When set to Automatic here, Windows will check for updates as
often as you specify, and if an important update for your system is found it will download and install it for
you at the same time. If you specify 'Download updates for me, but let me choose when to install them',
Windows will download the updates but only install them when you choose. Neither of these two options is
recommended, as updates may be downloaded at inconvenient times (e.g. during the playing of an online
game), and without your explicit consent. Although no Microsoft updates are harmful, I still recommend
you keep tight control over the downloading and installation of Windows Updates.

Instead, if you feel as though you will forget to check the Windows Update site regularly, and want to be
told whenever important updates are available, select the 'Notify me but don't automatically download or
install them' option. That way you will be told when an important update is available, but you can still
choose if/when to download and install it.
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My personal preference (and the most optimal for performance and privacy) is the final option: "Turn off
Automatic Updates'. This means the Windows Update service will not constantly run in the background,
taking up resources, and at the same time you can simply check the Windows Update website manually
every few days to see if you should download any important updates.

Note that under Windows XP SP2 the 'Automatic Updates' service must be set to Automatic to allow you to
access the Windows Update website, even if you set Automatic Updates to Off here.

B DATA SOURCES (ODBC)

This tool is discussed under the Administrative Tools entry above, and has exactly the same function.

B DATE AND TIME
DATE AND TIME

Set the current date and time under this tab.

TIME ZONE

Select the time zone that applies to you, and also tick the 'Automatically adjust clock for daylight savings'
option. This means that whenever daylight savings changes in your area, the clock will be automatically set
forward or back as appropriate - handy if you rarely remember when daylight savings actually occurs.

INTERNET TIME

Unless having the precise system time is important to your Windows usage, untick the 'Automatically
synchronize with an internet time server' to reduce any interference during your internet use (e.g. during
online gameplay). Instead of this you can manually update the clock every once in a while under the Date
and Time tab. See the Services section for details on how to disable the Windows Time service as well if you
disable this functionality here..

B DISPLAY
THEMES

You can switch between the Windows Classic theme, which makes XP look like previous versions of
Windows, or select the unique Windows XP theme. You can also save any changes you make to Windows
XP's look by creating a custom theme and saving it. Selecting the Classic theme will provide some memory
savings due its less graphically intense nature, however if you prefer the Windows XP theme I recommend
you use it regardless. There's no reason why you should tweak the aesthetics of Windows XP away for no
major performance gain. You spend a great deal of time looking at the XP interface, so on balance a few MB
of memory sacrificed to make the interface easier on the eyes is not that bad - uglier does not equal better in
this case. See the Visual & Convenience Tweaks section for details of how to add more themes.

DESKTOP

Select a Wallpaper you would like to display in the background of the Windows Desktop. If the default ones
listed in the preview pane are not to your liking, you can choose one from an existing picture anywhere on
your hard drive or from an inserted CD/DVD by clicking the Browse button. Note that if you want to
minimize memory usage and speed up bootup time, you should either not use a wallpaper at all, or
preferably select a wallpaper that is the same size as your desktop and less intricate — that is a picture with a
smaller file size.

Click the 'Customize Desktop' button and untick the 'Run Desktop Cleanup Wizard every 60 days' option to
minimize its annoying intrusion. You can also select whether to display or remove the My Documents, My
Computer, My Network Places and Internet Explorer icons from your Desktop. Removing these icons
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(unticking them) here will not disable their functionality - it will simply remove their icons from the
Windows Desktop. Note that if for some reason you wish to remove the Recycle Bin from the Desktop see
the Group Policy section or the Windows Registry section for the relevant tweak.

You may wish to change the appearance of any of the major system icons that appear on the Desktop. You
can choose to alter their appearance by highlighting them in the scroll list below, selecting 'Change Icon' and
assigning a new icon in their place.

Under the Web tab, you can choose to have Internet-based content displayed on your Desktop. Tick the My
Current Home Page' box if you want the home page specified in Internet Explorer to be used on the Desktop.
Alternatively, click the New button and you can assign a different URL for the page used on your Desktop.
For performance reasons I recommend against having any active web content on your Desktop, so I suggest
unticking all of the boxes on this page.

SCREEN SAVER

I recommend you set the screen saver to None. Modern CRT and LCD monitors do not require screen savers
to protect them from 'burn-in' (permanent image imprinting), and unless you enjoy the novelty of a screen
saver, it is unnecessary. If you have any other type of monitor or display you may want to enable the
screensaver to prevent static images becoming temporarily or permanently imprinted on the screen. For
example, some LCD monitors/TVs may exhibit a temporary residual imprint of a long-displayed static
image, and of course Plasma screens are more susceptible to burn in and should be protected by using a
fully animated screensaver. Note that the settings under the Power button are covered under Power Options
further below.

APPEARANCE

I personally prefer the Windows XP Style for Windows and buttons. This uses a small amount of extra
memory over the Windows Classic Style, but looks much nicer in my opinion and has no significant impact
on performance. If you are genuinely struggling (e.g. running 256MB of RAM), then you may notice the
difference by switching to the Windows Classic Style. You can adjust the individual elements of the desktop
theme by clicking on the Advanced button, selecting the element you want to change from the drop-down
list, and adjusting its properties accordingly.

Under the Appearance tab, click the Effects button, and I recommend unticking the 'transition effects', 'show
shadows under menus' and 'show window contents when dragging' options here for maximum
responsiveness on the desktop. However once again if you particularly like these effects you can leave them
enabled without any major impact. LCD users may want to enable ClearType here - see ClearType further
below for details.

SETTINGS

You may find two monitors listed under the Display list. This is normal for some graphics cards, even when
only one physical display is currently attached. Select the Screen Resolution you want for the Desktop, and
the Color Quality to go with it. Note that some recent programs and games may experience problems if the
Desktop is anything less than 32 bit Color quality, so 32 bit (if available) is recommended for maximum
stability and compatibility. The performance degradation is insignificant on your Desktop.

If you click the Advanced button under the Settings tab, you will be taken to the control panel for your
graphics card. While many sections of this screen differ based on your particular graphics card, all graphics
cards share the following common elements, which are described below:

Under the General tab, the DPI (Dots Per Inch) setting determines the relative size of everything on your
screen. If you run at extremely high or extremely low resolutions for example, you can change the DPI to
scale the elements of your screen to a more suitable size without having to change your resolution. The
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default of 96 DPI is recommended for most people. I also recommend selecting the 'Apply the new display
settings without restarting' option, as you do not need to restart your machine each time you change a
display setting.

Under the Adapter tab, you will find the details of your current graphics adapter (i.e. your graphics card). If
the details are incorrect, this could indicate a poorly installed or incorrect graphics and/or motherboard
driver, or modified hardware.

Under the Monitor tab, you can set the Refresh rate used by your monitor for the current screen resolution. I
strongly recommend that you first tick 'Hide modes that this monitor cannot display', then select the highest
refresh rate listed. The refresh rate determines how many times per second the image onscreen is redrawn.
The higher the setting, the more times the screen is 'refreshed’, and the less strain there is on your eyes. It is
strongly recommended that you use a utility called Refresh Force to force the highest possible refresh rates at
each resolution on your system. This utility is easy to use, and is supported by all graphics cards. It is
covered in more detail near the bottom of this page of my ATI Catalyst Tweak Guide. Note that most LCD
displays generally refresh at 60Hz, which is fine since LCD-based displays work on a different principle and
don't need a high refresh rate - see this page of my Gamer's Graphics & Display Settings Guide.

Under the Troubleshoot tab, move the slider under 'Hardware acceleration' to the far right, and tick 'Enable
write combining'. This ensures maximum performance, and you should only change these if troubleshooting
a specific graphics-related problem.

Under the Color Management tab, select the color profile that matches your monitor model and click the 'Set
As Default' button. If there is no profile listed for your monitor, click the Add button and select one which
matches your monitor model, or if none seem appropriate, insert your monitor's driver CD, browse to your
CDROM drive and find the correct .ICM file, then click Add. The color profile ensures your monitor displays
colors as they are intended to appear.

CLEARTYPE

For users of LCD panels and other display devices that may require some enhancement to make text appear
sharper and clearer on screen, particularly when using non-native resolutions, Microsoft has an option called
ClearType you can enable by going to your Display properties (See above), selecting the Appearance tab,
clicking the Effects button, and changing the 'Use the following method to smooth edges of screen fonts' to
ClearType. However, to fully customize ClearType you need to use this Microsoft Online ClearType Tuner;
or download and use the ClearType PowerToy Utility. In either case, ClearType greatly improves font

display quality by reducing jaggedness, so it is recommended you use it if you run an LCD display.

GRAPHICS CARD CONTROL PANEL

For full details on how best to configure the remaining graphic card-specific elements of Display Properties,
for ATI graphics cards you should refer to my ATI Catalyst Tweak Guide, and for Nvidia cards you should
refer to my Nvidia Forceware Tweak Guide. Also check my Gamer's Graphics & Display Settings Guide.

When you're done altering the settings in Display Properties click the Apply button. Then go back to the
Themes tab, click the 'Save As' button and select a new name and location to save your customized theme.

B FOLDER OPTIONS

GENERAL

Under the General tab, select 'Use Windows classic folders' to get rid of the lumped-together 'common task’
icons. The choice is yours of course, but this guide assumes you are using the classic folders view when
giving directions on accessing features. If necessary you can use classic folders while following this guide,
and then switch back to the default XP folder view once you're finished.
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Select 'Open each folder in the same window' to reduce open windows.

Select 'Double-click to open an item (single-click to select)' as this is the default method most Windows users
are familiar with, and the one which is assumed when providing descriptions in this, and most other guides.
Again, you can always switch to the other method once you have completed using this guide.

VIEW

I recommend you tick the following options:

* Display file size information in folder tips

= Display simple folder view in Explorer's folder list
* Display the contents of system folders

* Do not cache thumbnails

*  Show hidden files and folders

*  Show and manage the pair as a single file

= Remember each folder's view settings

* Show encrypted or compressed NTES files in color

It is recommended that the following are unticked for best performance and functionality:

* Automatically search for network folders and printers (don't untick if you are on a Network)
= Hide extensions for known file types

* Hide protected operating system files

* Launch folder windows in a separate process

*  Show popup description for folder and desktop items

*  Use simple file Sharing

Any remaining options can be ticked or unticked according to your tastes.

FILE TYPES

You can view and change which tools will open particular file extensions by default. For example, scroll
down to the TXT extension (text documents) and highlight it. In the details below you can see that the
default tool for opening .TXT files is Notepad, and if you click on the Change button you can choose another
application as the default. Sometimes certain installed applications will quietly change these to suit their
own needs without asking you, so check back here if you find your files opening with something other than
the application you want to use and make changes as appropriate.

OFFLINE FILES

I recommend you untick 'Enable Offline Files'. You'll still be able to view saved/cached web pages offline. If
the option is unavailable, it is because you have Fast User Switching enabled (See User Accounts below), in
which case you can ignore this section.

B FONTS

This item displays the contents of your \ Windows\ Fonts folder, which contains all your currently installed
system fonts. Fonts are the various types of text styles used by a variety of programs such as word
processors, paint programs and the Windows Notepad for example. You can install a new font simply by
copying its .FON or .TTF files into this folder, or by going to the File menu and selecting 'Install New Font...'
and pointing to the directory where the new font files reside. Note that TrueType is a font technology that
ensures good scaling and that what is displayed on your screen should come out exactly the same on your
printer. Other types of fonts may look slightly different in different applications and/or when printed and/or
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when using different font sizes. To find out more about fonts, go to the Microsoft Typography Website. A
good site that contains additional fonts you can download and install for free is Simply The Best Fonts.

B GAME CONTROLLERS

This tool allows you to add or remove gaming controllers on your system. This typically includes gamepads,
joysticks and game simulation hardware. Note that although often used in PC games, the mouse and
keyboard are not classed as 'game controllers' here - they have their own separate setup tools in the Control
Panel (see Keyboard and Mouse below).

Note that most joysticks require something called Calibration - a process under the device's Properties which
tells Windows when the joystick is at absolute dead center, when it is at far right, far left, etc. If this is not
done then often you will find the joystick may be unresponsive in certain directions, or it will constantly be
read by Windows as moving in one direction when it is actually dead center, and so on.

The majority of game controllers have their own software for installing and setting up the device, however
firstly I recommend clicking the Add button in the Game Controllers section and using the closest device
description which matches your device. If then during gameplay you find your device is not functioning at
all, or missing certain functionality, you should then install and use the device-specific software. This will
minimize the background resource usage that specialized device drivers often bring with them.

Finally, if you play certain games only using the keyboard and mouse combination, and you find your
character is displaying strange movement behavior (e.g. constantly moving with no user input), then
physically disconnect all game controllers from your system (excluding keyboard and mouse) and reboot,
then relaunch the game.

B INTERNET OPTIONS

This setting in the Control Panel simply brings up the Internet Explorer 'Internet Properties’ box. There is no
difference between accessing it here and accessing from within Internet Explorer, so see the Internet Explorer
section for full details of how to configure these options. Note if you are using another browser as the system
default browser then clicking this item will still bring up the Internet Explorer 'Internet Properties' box - this
is normal and cannot be changed.

B KEYBOARD

Under the Speed tab, I recommend you set the 'Repeat Delay' slider to the far right and also set the 'Repeat
Rate' slider to the far right. This will increase the responsiveness of the keyboard in Windows XP. You can
also adjust the 'Cursor Blink Rate' to your taste, and then click OK to apply. You can test these settings in the
box provided to see if they suit you. Note you can further customize the cursor's blink rate and width under
the Display tab of the Accessibility Options item in Control Panel.

B MOUSE

I only cover the basic mouse settings here, and most of the settings in this section can be adjusted to taste. If
you have installed a special mouse driver for your mouse, you may see different settings under this screen,
however the settings below should still be available on most systems with a mouse.

POINTERS

I recommend you untick 'Enable Pointer Shadow" at the bottom.

POINTER OPTIONS

I recommend ticking the 'Enhance pointer precision' option before you adjust your pointer speed. This
option enhances the acceleration/deceleration of your mouse to provide for larger movements when you
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move the mouse fast, and finer movements when you move the mouse more slowly, allowing more
precision. I recommend unticking the 'Display pointer trails' option to reduce mouse 'lagginess' unless you
have an older or less clear screen and have difficulty keeping track of mouse movements.

WHEEL

If your mouse has a mousewheel, you can increase the wheel's responsiveness by increasing the number of
lines it will scroll on each turn of the wheel. Even an increase from the default of 3 to 4 will make a subtle,
but noticeable difference if you previously found the mousewheel relatively unresponsive.

INCREASING USB SAMPLE RATE

If you have a USB mouse and want to increase the rate at which it takes samples of its current position -
thereby increasing accuracy and responsiveness - check this USB MouseRate Switcher. Please note there is
some risk involved as it affects all USB devices, so follow the instructions closely before implementing.

B NETWORK CONNECTIONS

Because of the sheer variety of network connection hardware, and the potential for doing more harm than
good, altering your Network Connections settings is not a simple procedure and I will not be covering it in
detail in this guide. If you have a Dialup connection - that is 56K or lower connection speed - then read this
Dialup Modem Tweak Guide for more details. If you have DSL or Cable, use the information from this
DSL/Cable Tweak Guide or the advice on for guidance. If you are on a network, consult your Network
Administrator before attempting to alter any of the Network Connection settings, and be very careful about
which settings you implement from this guide, especially those under the Services Utility and Folder
Options sections.

In general, I recommend that you do not alter your network-related settings, as more often than not, your
connection will end up being slower rather than faster, and in many cases you may lose Internet
functionality. Most network connections require specific procedures to set up optimally, and these are
usually documented in the device's instructions which is the best place to look for tips and advice.

QOS PACKET SCHEDULER

The following is recommended for home dialup and Cable/DSL users (but not for Network or Shared users).
Right-click on the device you use to connect to the Internet, and select Properties. Go to the Networking tab,
and under the 'This connection uses the following items' list, make sure the Internet Protocol (TCP/IP) option
is available and ticked. Now select every other item listed, including the 'QoS Packet Scheduler' and select
the Uninstall button to remove them. None of these are required for regular Internet usage by a single non-
networked machine, and removing them will reduce unnecessary resource usage. Should they be needed
again you can always simply reinstall them from here at any time. Note if you disable the QoS Packet
Scheduler you should also disable the 'QoS RSVP' service (see Services section). Neither are required for the
average home Internet user.

WINDOWS FIREWALL

Under the Advanced tab click the Settings button and turn the Windows Firewall On (as advised
previously), unless you have third party firewall software already installed, in which case activate that
instead. To find out more about Firewalls see the PC Security section.

B NETWORK SETUP WIZARD

This wizard will take you through the steps required to connect a network device, including any device that
connects your machine to the Internet. You can follow the steps in the wizard to connect your device,
however I generally recommend you follow the instructions that come with your device instead, along with
instructions from your particular Internet Service Provider (ISP).
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B PHONE AND MODEM

As mentioned under Network Connections above, because of the variety of modems that can be used to
connect to the Internet, or to other electronic devices, I cannot provide specific setting recommendations here
for each device. Check the links under Network Connections above for more details.

As with installing any other type of peripheral device under Windows XP, typically the best installation
procedure is to simply connect the device to your system, and wait for Windows XP to identify the device
and install the default drivers. However in the case of modems I recommend installing the latest available
drivers or at the very least the drivers which come on the device's driver CD. If you have any doubts about
what settings to use once the device is installed, I strongly recommend leaving them at their defaults.
Changing these settings can see your modem or device not function correctly, and hence you may not be
able to connect to the Internet. Note that devices listed under Phone and Modem may include devices
loosely identified as 'modems' such as mobile phone/PDA data hookups.

B PORTABLE MEDIA DEVICES

If you have a portable media device connected to your system, such as an MP3 player, you can manage the
device here. It is recommended that you refer to your device's instructions as to how best to configure it for
connection and usage with Windows.

B POWER OPTIONS
POWER SCHEMES

You can set the periods of time after which your monitor, your hard drive and/or your entire PC go into a
power-saving standby state to conserve energy. You can select an appropriate preset scheme such as
'Portable/Laptop' or 'Always On', or you can customize the settings yourself.

Unless you have a power-limited device, such as a laptop running on batteries, I recommend selecting
'‘Always On'. If you are often away from your machine for extended periods of time while it is left on, select
a reasonably long turn-off time such as 'After 2 hours'. That way your system is not constantly powering up
and powering down, which doesn't really save much energy in the end and can increase wear and tear on
components.

Note, if you find that on certain systems functions such as AMD CPU's "Cool n Quiet" are not working
correctly, set this the power management preset to anything other than Always On to prevent problems.

ADVANCED

I recommend unticking the 'Always show icon in the taskbar' option to remove the unnecessary power icon
in the system tray. If you don't use system standby, or if security is not a concern then I also recommend
unticking 'Prompt for password when computer resumes from standby'. In the Power Buttons section, select
the action you want for 'When I press the power button on my computer'. Once again, if you don't want to
use standby, and just want your machine to shut down when you press the power button, I recommend
selecting Shut Down from the list for the most trouble-free results.

HIBERNATE

I recommend not using Hibernation and hence I suggest you untick the 'Enable Hibernation' option here.
Hibernation uses a great deal of disk space to store the state of your machine at the time of hibernation -
equivalent to your physical RAM size in hard disk space - and for optimal stability I recommend that you
start each computer session with a clean bootup. This will reduce the possibility of memory-related
problems and crashes.
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UPS

If you have a power supply that is specifically classified as an Uninterruptible Power Supply (UPS), you can

configure it here. Most people do not have UPS power supplies, and if you're not sure whether you have one
then it's almost certain that you don't hence you can ignore this section. See the Services section for more
details about how to disable the UPS Service as well if you don't have a UPS power supply.

B PRINTERS AND FAXES

This section allows you to view all connected printers and faxes, and add or remove such devices. It is
recommended that you refer to the particular device's instructions for optimal setup information under
Windows XP as each can differ.

Importantly, note that if you have disabled the 'Print Spooler' service then any printer on your system will
not function. Make sure the 'Print Spooler' service is set to Automatic if you want to use a printer.
Furthermore if you have disabled the port to which the printer is connected in the BIOS or in Device
Manager (e.g. LPT1 or a specific USB Host Controller), perhaps to free up an IRQ, then once again your
printer will not function - you will have to re-enable it. Finally, if you are connected to a network printer and
you have followed my service configuration recommendations under the Services Utility section - which as
noted are not intended for networked computers - then your network printer may not be detected by
Windows. See the detailed Services guides to work out which exact services are necessary for your system.

B REGIONAL AND LANGUAGE OPTIONS
REGIONAL OPTIONS

Select the language format that suits your particular region of the world. You can also set your country at the
bottom, and it is recommended that you do so to allow all your software to be able to customize options and
text displays to suit you, not just in Windows XP itself, but also in all the games and applications you use. If
you wish to customize any specific settings, such as data/time display formats, currency formats etc. click the
Customize button and do so accordingly. If you've selected the appropriate country though, the defaults
shown here should already be correct.

LANGUAGES

Click the Details button. In the 'Text Services and Input Languages' box that appears, select the default input
language.

If you only ever use one particular text service on your machine for each language, such as Keyboard (the
default, and a necessary service), then remove any other text services displayed under each language (such
as Speech Recognition) as they take up additional memory. Do this by highlighting the displayed text service
in the Installed Services box, and click on Remove.

Alternatively, if you want to Add a text service, or configure these advanced text services for various
functionality, see this Microsoft Article for more details. Remember, the use of advanced text services takes

up memory and can reduce system performance, so only enable these functions if you really use them often,
and not just as a novelty.

In the preferences section below it, if you have more than one text service installed you can click on the
'Language Bar' button (otherwise it is unavailable). I recommend selecting 'Close the language bar' to
remove it from your desktop unless you specifically need it there. If you do use more than one language
often, I still recommend closing the Language Bar, and instead assign keyboard shortcuts for switching
between these languages, by clicking on the 'Key Settings' button here. This is a much more efficient method.

Under the Advanced tab of the 'Text Services and Input Languages' box, unless you use any advanced text
services such as speech or handwriting recognition, tick the "Turn off advanced text services' option. If you
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do wish to use advanced text services, and also want them to be available to all your programs and
applications, then tick the 'Extend support of advanced text services to all programs'. Click Apply and OK to
go back to the Regional and Language Options box.

Back under the Languages tab of the Regional and Language Options box, unless you use a right-to-left
language (such as Arabic or Thai), or an East Asian language, then make sure both boxes under the
Supplemental language support area are unticked. This removes unnecessary files from your hard drive.

ADVANCED

Select the language you want for non-unicode programs. Since Unicode basically allows most modern
programs to adapt their menus and dialogs to your system's default language, this setting only applies to
older non-unicode programs. These older (non-unicode) programs will use the Code page conversion tables
listed to convert from other languages to your preferred language. While you can choose to remove or add
(untick or tick) various conversion tables in this section, I recommend against doing so as this can affect the
correct language display of any older programs you use. Some of the conversion tables are greyed out as
these are installed by default for Windows XP and cannot be removed.

If you want to make the settings you have modified in the Regional and Language Options box the default
for every user account created on this system as well as the current account, tick the 'Apply all settings to the
current user account and to the default user profile' box. I recommend that you tick this option, but it is not
essential that you do so.

B SCANNERS AND CAMERAS

This section will allow you to manage any digital image devices such as scanners or digital cameras
connected to your machine. Refer to your device's manual for specific setup recommendations. Typically
you will simply need to attach your device, turn it on and either Windows XP will detect it and install basic
(but adequately functional) drivers. I recommend that only if you are having problems accessing the device,
or with any of its important functionality, that you install device-specific drivers or software. Otherwise the
default Windows XP drivers are the most efficient and minimize background resource usage.

B SCHEDULED TASKS

The Scheduled Tasks utility allows you to set up particular tasks that your machine will then run at a
predetermined time and in a predetermined sequence. To create a new task, click the 'Add Scheduled Task'
entry, and the Scheduled Task Wizard will commence, allowing you to detail the task to be run. You can also
view and edit existing scheduled tasks in this panel. I recommend you go to the Advanced menu and select
the 'View Hidden Tasks' option to ensure all scheduled tasks are shown. I personally do not recommend
having any scheduled tasks. Regular system maintenance for example is best carried out manually, at
intervals determined by frequency of use and not set periods of time (See the Regular Maintenance section).
Note that the "Task Scheduler' service must be set to Automatic for scheduled tasks to function.

B SECURITY CENTER

The Windows Security Center unifies access to, and monitoring of, major security-related Windows settings
on your system. Primarily these are the Windows Firewall for protecting against externally-initiated
intrusions into your system, Automatic Updates which ensures notification and/or installation of important
Windows XP updates as they are released by Microsoft, and Virus Protection which works in conjunction
with your virus scanner to make sure your system is free of infected files which can compromise your
system's security, stability and privacy.

Each of these areas and appropriate recommendations is covered in the relevant section of this guide: the
Windows Firewall is covered in the Windows Firewall section below; Automatic Updates is detailed in the
Automatic Updates section above; and Virus Protection is covered under the PC Security section above. The
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Security Center is simply a means of gaining access to all of these and changing some of their settings in a
central location. As such, it's not actually a dramatic improvement in security - simply one that makes users
more aware of the types of things they have to monitor and change to maintain system security.

The one setting which I do find very annoying and I recommend you change is the Virus Protection setting.
In the 'Virus Protection' box in the Security Center click the Recommendations button. In the
Recommendation box which opens, I suggest you tick the box at the bottom. This will prevent Windows
from constantly reminding you that your virus scanner's reference file is out of date, or that your virus
scanner is not found, or that it is not currently active. For starters many popular antivirus programs are not
supported by this feature. Secondly, it should be part of your regular maintenance procedure to manually
update your virus scanner and run manual scans as often as possible. Finally, as I recommend throughout
this guide, having a virus scanner running in the background can and will reduce your system performance
for marginal gains in security. For all intents and purposes as long as you follow the other recommendations
in this guide your system should be quite secure and clear of malicious software. If however you are
genuinely forgetful and your virus scanner appears to be supported by this feature, you may wish to keep
the monitoring function of Virus Protection enabled.

Note the Windows Security Center won't function fully if the 'Security Center' service has been Disabled (See
the Services section). I recommend that the 'Security Center' service be set to Automatic to begin with, then
adjust your settings as recommended above, then disable the 'Security Center' service again as it is not
necessarily to continually access the Security Center to maintain security on your system. That is, disabling
the 'Security Center' service will not disable the Windows Firewall, Automatic Updates or Virus scanner
functionality at all. Also see the PC Security section of this guide for more tips on how to secure your PC.

B SOUNDS AND AUDIO DEVICES
VOLUME

Adjust the volume to suit your taste, and make sure the Mute option is unticked. I recommend ticking the
'Place volume icon in the taskbar' option as adjusting the volume is something you may do often in
Windows, so this provides quick access by placing a speaker icon in the System Tray. I will cover the settings
under the Advanced button a bit later below, as part of my instructions for optimal sound output.

Under the Speaker settings section, you can independently adjust each speaker's volume level by clicking the
Speaker volume button. In general this volume can be adjusted under the Volume tab as described above, so
you only need use this section of the Sound options if you want to adjust the speakers to have different
volume levels each - which is generally not recommended.

I recommend you click the Advanced button here, and under the Speakers tab select the type of speaker
setup you are using, such as Headphones or Desktop Stereo Speakers. Choose the setting closest to your
particular setup. Under the Performance tab, move the 'Hardware acceleration' slider to the far right. This
ensures full use of your sound hardware's features. Only reduce the slider by one or two notches if you are
troubleshooting sound problems in a game for example. Move the 'Sample rate conversion quality' slider to
the far right. This ensures optimal sound quality, and there is no performance difference between the various
settings on this slider as such.

SOUNDS

You can assign different sounds to particular system events in this section. Click on the Program event (e.g.
‘Start Windows') and either scroll through the list of default system sounds in the Sounds list below and
select one, or click the Browse button to find a sound file elsewhere on your system which you can use. Press
the Play button to hear a preview of the sound.

I strongly recommend that you disable as many system sounds as you can, as they take up system memory
by being loaded into RAM at startup. In particular I recommend disabling sounds for 'Start Windows' and
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‘Exit Windows' to both reduce memory usage and speed up booting up and shutting down Windows. Also
note that many programs such as Windows Messenger and Norton Antivirus add sub-entries to this section
and include their own specific sounds, even if you uninstall them later on. Go through the entire list
carefully and disable all unnecessary sounds.

You can quickly disable all system sounds by selecting the 'No Sounds' item under the Sound scheme area -
this doesn't turn off sound on your system, it simply removes sounds effects from all the various system
events thereby reducing memory usage by these sounds. If you want to keep sounds for certain important
events, such as Default Beep or System Notification, I recommend you apply the same sound to several
similar events. For example, on my system I use the Exclamation.wav sound for all warning and alert events
(i.e. Asterisk, Critical Stop, Default Beep, Exclamation, New Mail Notification and System Notification). That
way if Windows runs into a problem or provides a warning/notification I can still hear an audible indicator
of it, but by using the same sound for each my memory usage is greatly reduced.

Once done, Save these new settings by clicking 'Save As..." and entering a new name.

AUDIO, VOICE

Make sure the default device in each of these categories is your primary sound hardware then tick 'Use only
default devices' to minimize problems and conflicts with any other sound devices on your system.

OPTIMAL SOUND CONFIGURATION

My suggested method for configuring your Sound settings for optimal sound output is provided below:

1. Click the first Advanced button under the Volume tab of the Sounds and Audio Devices box.
Alternatively, simply double-click on the Volume icon in the system tray.

2. In the Volume Control dialog box that appears, go to the Options menu and make sure the 'Advanced
Controls' option is ticked.

3. Select the Properties setting under the Options menu, and in the box that appears select your main
sound output device in the Mixer Device list. Select Playback in the next section. Place a tick against
every item in the list shown, and click OK. Back in the Volume Control window, you will notice it has
expanded to show Volume, Balance and Mute options for every audio output method on your system.

4.  Go to the master Play Control (far left) and adjust the master Balance setting. Unless you specifically
need an offset balance, the neutral (absolute middle) position is recommended.

5. Make sure the 'Mute All' option is unticked

6. Set the master Volume level to around the center position on the slider, then play a high quality music
or audio file on your system (not CD Audio as that uses independent sound) and adjust your speaker
hardware's physical volume controls until the sound level is correct.

7. Click the Advanced button, and if available to you (depending on your sound hardware) adjust the Bass
and Treble settings to taste. If you don't have Digital Output from your sound hardware, make sure the
'Digital Output Only' box is unticked, otherwise you will not hear any sound. Click Close when done.

8. Now go to the Wave output method in the Volume Control box and make sure the Mute option is
unticked. Again, while playing some music on your system adjust the Wave volume and your speaker
hardware volume control together until the combination suits your taste and has the least amount of
background noise/hiss. The Wave output method is the output method used by most games,
applications and audio playing software so it's important to set it up correctly and at a tolerable level.

9. Go through and adjust all the other sound output methods' Volume and Balance settings to taste. To
further reduce background noise and hissing, I recommend muting (tick the Mute option) for every
sound output method you do not regularly use. Input devices, such as Line-In, TAD-In and Microphone
in particular can significantly contribute to background hissing, so mute them until needed.

10. Once done, go to the Options menu and select Properties, then untick all the sound output methods
except those that you will be adjusting the properties for quite often. This will not disable these
methods, only remove them from displaying in the Volume Control box, making it more manageable

Copyright © 2007 Koroush Ghazi 78

[ueJ [01U0D) YT,




e..uenﬂmu.ng-_-. THE TWEAKGUIDES TWEAKING COMPANION

the next time you open it. At a minimum I recommend you leave the Play Control and Wave items
ticked, as these are used most often on all machines.

If you have a complex speaker setup or third party audio software you may wish to use that to adjust
equalizer settings for example. In which case after you've followed the advice above go into that software
and conduct more setting tweaks as necessary.

Importantly, if your sound hardware has any Environmental Audio or Special Effects settings in your sound
card-specific software (such as the EAX Control Panel in the AudioHQ for Creative sound cards), open these
settings and disable all effects. These additional effects typically cause problems in games and can distort
music and other audio played back on your machine.

B SPEECH

This utility allows you to configure the speech recognition and text-to-speech capabilities of Windows XP. To
use speech recognition, you will require an input device (i.e. microphone) connected to your system. To use
text-to-speech functionality, you don't require anything other than audio playback hardware such as a sound
card and speakers/headphones. You can select the voice style used to convert text to speech, and adjust its
speed here. Note that this functionality must be supported by the program or game you are using if you
want it to work. Also note that in most games or applications where you can enable a synthesized voice (e.g.
Unreal Tournament 2004), you should be able to adjust the characteristics for this voice in this section of the
Windows Control Panel since it is likely using the default Windows voice engine. If you want to download
additional synthesized voices to use see this Text-to-Speech Voices site.

B SYSTEM

This is an important section of Windows XP, and each of the tabs under System Properties is covered below:

GENERAL

If any of the details displayed are incorrect then it is a sign of a bad install, new/unsupported hardware, IRQ
conflicts, poorly installed/incorrect drivers or overclocking problems. In general if your system is
functioning correctly then the information in this section should be correct. You may notice your CPU's
speed rating is shown slightly higher or lower than its actual rating - this is normal.

COMPUTER NAME

Leave the Computer Description field blank, or use a generic description. To change your computer name,
click the Change button. In both cases I strongly recommend against placing anything uniquely identifiable -
such as your real name or address - in these fields. Unless you are part of a network of computers (the
Internet doesn't count as a network), there is no need to alter your Network ID, nor the Workgroup you
belong to. If you are part of a network, consult your System Administrator before attempting to change any
of the settings above as it may result in problems or completely dropping out from the Network.

HARDWARE

If you have any hardware that is not being detected correctly try the Add Hardware Wizard. As previously
recommended, click the Driver Signing button and select 'Ignore - Install the software anyway and don't ask
for my approval'. Tick 'Make this the system default'. Despite what Microsoft says, most drivers are OK if
unsigned and there is no problem at all with them as long as they are from a reputable manufacturer, such as
ATI, Nvidia or Intel for example.

DEVICE MANAGER

Click the Device Manager button, go to the View menu and select 'View Devices by Type' and also tick the
‘Show Hidden Devices' option. You will see all the devices connected to your system at the moment, most of
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which are physical devices, some of which are virtual devices. Devices with a yellow question mark or
exclamation mark next to them will need further troubleshooting to correctly identify and install. Typically
this involves ensuring the device is correctly attached to your system, then double-clicking on the device in
Device Manager, selecting Update Driver under the Driver tab, and following the prompts to install or
reinstall the correct driver for the device. You may also need to install any software that came with the
device to correctly use it. See the Windows Errors section for more details of Device Manager error codes.

You should disable devices that you don't regularly use to speed up windows and free up resources. Ideally
this should be done first in the BIOS (See the BIOS Optimization section). However, to disable a device in
Device Manager, double-click on the device and select ‘Do not use this device' under the Device usage area.
A red cross will appear next to it. Make sure to only disable devices you knowingly do not use. If in doubt
leave them enabled, or re-enable them if you experience any unusual behavior.

Go to the View menu and choose 'View Resources by type', then expand the 'Interrupt Request (IRQ)" item.
Make sure each major device in your system (graphics card, sound card etc.) is on a separate IRQ from other
major system devices. See the BIOS Optimization section for more details on IRQ sharing.

OPTIMIZE DRIVES

To optimize the performance of your hard drive(s), first make sure you have installed the correct
motherboard drives for your particular motherboard, as the drive controllers on your motherboard require
these for optimal operation, as well as special functions like RAID - see the Driver Installation section.

Next, go to the Disk Drives section in Device Manager and expand it. Right-click on each hard drive
available, select Properties, and under the Policies tab make sure 'Optimize for Performance’ is selected. If
available, also tick the 'Enable Write Caching on the disk' option. The aim is to allow the hard drive to use a
Cache — a small area of memory set aside specifically for the hard drive — to speed up reading and writing to
the drive. Note that these options may not be available to be changed here if you are using a SCSI, Serial
ATA (SATA) and/or RAID configured hard drives. If you are using such a configuration, select the 'SCSI
Properties' tab and make sure that both 'Disable tagged queuing' and 'Disable synchronous transfers' are
unticked for maximum performance.

To optimize all system drives, in Device Manager go to the IDE ATA/ATAPI Controllers' section and
expand it. Right-click on each sub-controller listed and select Properties and see the relevant section below:

Parallel ATA Controller: This controller affects all PATA drives, which includes all current CD/DVD drives,
and any IDE hard drives you have connected to your motherboard. Go to the 'Primary Channel' and
‘Secondary Channel' tabs, and under the 'Transfer Mode' section of each check the current speed. The Ultra
DMA 4 mode is the fastest for any channel with a CD/DVD drive, and Ultra DMA 6 mode is the fastest
possible for any channel with only an IDE hard drive. Note that this speed may be limited due to one of
more of the following reasons:

*  Your motherboard does not support Ultra DMA 6 or Ultra DMA 5 modes (See your motherboard
manual) - these are also called ATA 133 and ATA 100 respectively.

*  Your BIOS is not configured correctly to enable the highest speed (See BIOS Optimization section).

* You are sharing a hard drive and a CD/DVD drive on the one channel (Move the Hard drive(s) to
primary, CD/DVD drive(s) to secondary channel).

*  Your hard drive(s) or CD/DVD drives don't support the highest transfer mode available on your
motherboard.

Also make sure that if a particular channel is empty in your system that you disable it in your BIOS to free
up an IRQ and also reduce bootup time - again, see the BIOS Optimization section for full details.
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Serial ATA Controller: This controller affects all SATA drives connected to your motherboard, if your
motherboard has SATA ports and you are using SATA hard drive(s). Go to the 'Primary Channel' and
‘Secondary Channel' tabs, and under the 'Transfer Mode' section of each check the current speed. All SATA
Generation I drives (SATA) should show a maximum speed of 1.5Gbps (150MB per second), and all SATA
Generation II drives (SATA II) should show a maximum speed of 3.0Gbps (300MB per second). All available
option boxes should be ticked here for maximum performance. Note that the 'enable command queuing'
option may not be available if your hard drive doesn't support it, but if it does, you should tick it.

If your SATA hard drive is not set to the highest mode possible for its type, then you have not set up your
BIOS correctly or you have not installed the correct SATA motherboard drivers.

Furthermore, no hard drive or CD/DVD drive from the past few years should be running in PIO or Multi-
word DMA mode as these will significantly reduce your drive speeds.

Most recent hard drives come with a technology called SMART - if available and enabled in the BIOS. This
technology prevents drive errors and provides diagnostic information. To further diagnose any hard drive
problems for non-RAID configuration hard drives using SMART, use a utility like PassMark Disk Checkup.
Finally, see the Drive Optimization section of this guide for more drive optimization tips.

REMOVE UNUSED DEVICES

For each device that has ever been connected to your system, Device Manager will retain a range of entries in
the Windows Registry relating to the device type, and the drivers and settings it used. That way if it is ever
reconnected it can be quickly recognized again. However there are times when you have permanently
discontinued the use of a device and you want to clean out the Device Manager of these unused devices. To
firstly view unused devices in Device Manager, do the following:

1. Open a Command Prompt by going to Start>Run and type "cmd" (without quotes) then press Enter.
Once the MS DOS prompt is open, type the following lines exactly as shown, pressing return after each:

Set devmgr show nonpresent devices=1

Devmgmt .msc

3. You can now type "exit" (without quotes) and press Enter in the command prompt window to close it.

4. In the Device Manager window that opens go to the View menu and select 'Show Hidden Devices'. Now
start looking through all the devices. Devices in gray are usually old/unused and safe to remove by right
clicking on each one and selecting 'Uninstall'.

5. In particular, you might find several entries under the Monitors section from previous graphics driver
installations. You can typically delete all the greyed out entries but at least one un-greyed entry should
remain. You may also find old entries for previous graphics cards under the Display Adapters section
that again can be removed. Remember that even with only one monitor connected there may be two
entries for some graphics cards, one of which is the Secondary - this is normal.

6. You should not remove any Microsoft devices such as those under the Sound section, or devices that
you are unclear about.

7. Once done, you can close Device Manager the usual way and the next time you open it up it will not
shown unused devices until you again use this method to do so.

Use this method with great caution. In particular I recommend you create a new System Restore point
beforehand. At the same time however if you do accidentally uninstall a hardware device which is currently
connected to your system, in many cases you can simply disconnect and reconnect the device, or reboot
Windows, and it will be redetected by Windows and the appropriate drivers installed again — so this method
doesn't permanently remove any device nor prevent it from future usage.
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Back under the Hardware tab of System Properties, click the 'Hardware Profiles' button and for optimal
bootup speed have only one hardware profile and choose 'Select the first profile listed if I don't select a
profile in..." and set the time to 0 seconds.

ADVANCED

The Advanced tab of System Properties has three major areas of settings - Performance Settings, User
Profiles Settings and Startup and Recovery Settings - these are covered separately below:

Performance Settings

Visual Effects: For fastest performance, I recommend unticking everything except 'Use visual styles on
windows and buttons' and 'Use drop shadows for icon labels on the desktop'. That will reduce usage of
system resources for graphical effects, while still retaining the majority of Windows XP's trademark
appearance.

Advanced: In the Processor scheduling section select the Programs option for optimal performance on most
systems. The 'Background Services' option will only improve performance on systems where multiple
programs are often run together.

Under the Memory usage section, once again select the Programs option. The 'System Cache' option is
primarily for servers, where more memory is used to speed up disk access at the expense of available
memory for programs. Importantly, data corruption may occur under certain conditions if the 'System
Cache' option is enabled, so it is strongly recommended you do not select it.

For optimal settings under 'Virtual Memory', see the Memory Optimization section for full details.

Data Execution Prevention (DEP): This is a new technology introduced with Windows XP SP2 that uses
software and (where supported) hardware detection of programs that try to access and run code from
designated 'mon-executable' memory areas. Full details of it are in this Microsoft Article. In practice DEP
protects against viruses that have become resident on the system and which then try running malicious code

from such areas. When Windows DEP detects an attempt to launch an executable from a non-executable
memory area it will shut the program down and provide a notification that it has done so. Hence if you are
experiencing crashes or problems in games for example, unless you see Windows give you a specific DEP-
related warning, it is unlikely that DEP is the cause of the problem.

By default when Turn on DEP for essential Windows programs and services only' is selected, DEP
protection is only enabled for programs that choose to work with DEP, along with Windows system files.
This is the minimum form of DEP protection. You can choose to extend this protection to all programs by
selecting "Turn on DEP for all programs and services except those I select' - and then choose which programs
to manually exclude from DEP by using the Add and Remove buttons.

I recommend leaving DEP at its default setting ("Turn on DEP for essential Windows programs and services
only') as it is not problematic on most machines and helps reduce any potential damage from virus activity
on your computer. However if you want to change your DEP settings in more depth, including the total
disabling of DEP, you can do so by editing your Boot.ini file (To access Boot.ini see the Microsoft
Configuration Utility section). The entry to change in Boot.ini is the /NoExecute= option. By default it is set to
/NoExecute=Optln however you can change the Optln value to one of the ones below to change DEP's
implementation:

OptOut - Applies DEP to all processes and you must then set which programs are excluded manually. This is
the same as the "Turn on DEP for all programs and services except those I select' option above.
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AlwaysOn - Provides full DEP coverage for your entire system. If you are concerned about potential virus
activity on your system and want maximum protection you can use this setting, although older software
may have problems with it.

AlwaysOff - This option turns off DEP completely. It is not recommended unless you are having a lot of
problems with program crashes even after thoroughly cleaning your system by following the advice under
the Virus Cleaning section of this guide.

My personal setting is the Windows default of /NoExecute=OptIn and so far I have had no issues or problems
with DEP. However if you are having DEP problems /NoExecute=AlwaysOff should fix them temporarily,
although I don't suggest it as a long-term solution.

User Profiles Settings

Back under the Advanced tab of System Properties, click the Settings button under User Profiles, and
examine the profiles stored on your computer. There will always be at least two profiles - the Administrator,
and the default User profile here. If you are absolutely certain any other profiles are no longer in use, you
can select them and press Delete to remove them from the system.

Startup and Recovery Settings

Under the Startup and Recovery section, click the Settings button. For a system with a single operating
system, select "Microsoft Windows XP [Home/Professional]" /fastdetect' in the list presented. For a system
with multiple operating systems, select the one that you want to boot up by default each time you start your
machine. If you only have one operating system, or you don't want to select a different operating system
each time you boot up, untick the 'Time to display list of Operating Systems' option. Tick the 'Time to
display recovery options when needed' option and select at least 10 seconds if not more. This is the amount
of time you'll get to choose the type of bootup from the recovery menu after a bad system crash.

Click the Edit button and change the timeout= value in the second line to =0. You can also change the
/NoExecute= setting here as covered under the DEP information above. When done, save and exit the text
editor and the changes will be made to your Boot.ini file in you base directory. Under the 'System failure'
section untick all three options for optimal performance, and the 'Write Debugging Information' option
should be set to None. That way if you run into problems you'll see the error displayed (usually a Windows
Blue Screen of Death (BSOD) message) and your system won't automatically reboot. At the same time you
won't get lots of logfiles and dumpfiles of the event cluttering up your hard drive. Re-enable these options if
troubleshooting a vague problem, or if Technical Support personnel ask you to provide these files. See the
Windows Errors section for more tips.

Environment Variables

Under the Environment Variables screen I suggest you leave all the listed variables at their default settings.
These should only be changed if instructed by a particular program or by Technical Support, and even then
you should record the original settings in case something goes wrong.

Error Reporting

Click the Error Reporting button and select 'Disable Error Reporting' and tick 'But notify me when critical
errors occur'. This will prevent your system continually informing Microsoft of errors occurring on your
system, but at the same time will still show you important system messages and errors for notification and
troubleshooting purposes.
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SYSTEM RESTORE

Only select 'Turn off System Restore' if you feel very confident about your Windows expertise. System
Restore can take up a great deal of disk space, however I recommend that you leave it enabled since it can
save you a great deal of heartache if things go wrong. See the Backup & Recovery section for more details of
how to use System Restore to backup your system state. Also see the Cleaning Windows section for details
of how to delete older restore points to reduce the amount of disk space used up by System Restore. If you
choose not use System Restore, see the Services section for details on how to disable the 'System Restore'
service to save on system resources.

AUTOMATIC UPDATES

See the more detailed Automatic Updates section above for information on this functionality. I recommend
‘Turn off Automatic Updates' and instead use the manual method of regularly checking the Windows
Update site for updates.

REMOTE

I strongly recommend that you disable (untick) the available options in this section for security and
performance reasons. Only re-enable these options if specifically asked to do so by a trusted Technical
Support person who requires remote access to your machine. Allowing remote access pretty much lets
someone else access your machine and all its various files and settings as though they were sitting in front of
your PC, so clearly it can compromise your security if left enabled.

B TASKBAR AND START MENU
TASKBAR

The Taskbar is the bar which sits at the bottom of your screen and contains your Start button, buttons for any
open programs, and the System Tray. Most settings in this section can be chosen to suit your taste.

I recommend ticking the "Lock the taskbar' option to prevent accidentally moving or resizing the taskbar.

I also recommend you initially untick 'Hide Inactive Icons' so that you can see all the programs which are
loading in the background in your System Tray area. I recommend you disable most if not all of these - See
the Startup Programs section for more information on disabling startup and background programs. If you
want to eventually enable 'Hide Inactive Icons', perhaps to hide an annoying but necessary icon in the
system tray (such as the 'Safely Remove Hardware' icon), tick the option and click the Customize button to
select precisely which applications to always hide in the system tray, which to always show, and which
should be hidden when inactive. Again, I recommend no applications be hidden when inactive, or hidden at
all, unless you are absolutely certain they are essential. Many application or game incompatibilities and
crashes can be due to one of these background programs. Hiding them will make it harder to troubleshoot
problems in the future.

START MENU

I recommend you select the 'Start Menu' option here to use the Windows XP default menu system. It has
many advantages over the Windows Classic menu system. If you select this option click on the Customize
button next to it. Under the General tab, choose settings to taste. If you want to remove the Frequently Used
Programs listing normally available on the Start Menu under the pinned items, set the 'Number of Programs
on Start Menu' option to 0 and click the 'Clear List' button.

Under the Advanced tab, I recommend you tick 'Open submenus when I pause on them with my mouse' to
speed up menu access, and untick 'Highlight newly installed programs'.
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Under the 'Start Menu Items' section, I recommend you tick the following:

* Enable Drag and Dropping

* Run command

* Search

* System Administrative Tools - Display on the All Programs menu

We need all of these features enabled when using this guide, and I recommend keeping them enabled
afterwards also. The other settings in this section can be ticked or unticked according to your needs.

When finished, click the Apply button and your changes will be made to the Start Menu.

B USER ACCOUNTS

Windows XP allows multiple users to have varying levels of access to the same machine. By creating a
separate User Account, each user can store their own settings, keep their own documents private, and have
limited access to the system-wide settings on the same computer.

My recommendation is that unless you have several people using the computer and each need separate
accounts, you should only use one Administrator-level user account for fastest performance. That way you
don't need to worry about logging into and out of two or more separate accounts (the Administrator and a
lower level User account) just to make system changes and install/uninstall system software. Some recent
software, as well as many games, require administrator-level access to use properly.

However security experts will tell you that this is very risky. It is true that using an Administrator level
account by default carries some risks with it, but I believe the risks are minimal as opposed to the
performance and convenience benefits, especially when you set up your system using the methods in this
guide. However if security is a concern, create a separate account for day to day use with more limited
access so that if your regular account is compromised by a malicious program, it cannot be used to change
important system-wide settings. Remember though that you have to be logged in as the Administrator to
make the majority of changes in this guide, as well as being able to use certain programs and games

properly.
FAST STARTUP - SKIPPING LOGIN SCREEN

If you have only one user on your machine, to have the fastest startup in Windows XP you can bypass the
Login screen altogether by doing the following:

1. Click 'Change the way users log on or off' and tick 'Use the Welcome screen', and untick 'Fast User
Switching'.

2. Go back to the main User Accounts screen and click the Guest account, and then click the 'Turn Off the
Guest Account' button.

3. Delete any other accounts other than your primary one on the main User Accounts screen by clicking
each one and selecting 'Delete the Account'.

4. Click on your main account, and if your account has a password select 'Remove my Password'.

Note, untick 'Fast User Switching' if you have only one account, or don't switch users often. Click 'Apply
Options' to finish, then see the advanced section below.

B USER ACCOUNTS - ADVANCED

Aside from the User Accounts tool in the Control Panel, you can access a further set of user account features
by going to Start>Run> and typing "Control Userpasswords2" (without quotes) then pressing Enter. The
following are details of the settings in this advanced user accounts tool:
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USERS

If you have only one User account and you left your password field blank during Windows installation you
shouldn't be prompted for a username and password each time you bootup XP. This is the method I
recommend for the fastest (though less secure) way to bootup. However, if you have several user accounts
with associated passwords, but want one of those accounts to automatically log on to XP at bootup without
being prompted for a password, go to the Users tab and untick 'Users must enter a username and password
to use this computer’, and click Apply. In the new dialog box that appears, enter the username and password
for this 'autologon' user. Now each time you bootup Windows this user will automatically login to Windows
- but this is not as fast as not have a password in the first place. It all depends on your particular security
needs. I personally prefer the fastest way possible and have never had any security issues.

In general you should remove all user accounts from the list of 'Users for this computer' except for the
Administrator and the individual accounts for known users of your PC. Accounts such as ASPNET (the
.NET Framework account) can safely be removed by highlighting them and clicking the Remove button. The
less accounts you have on your machine, the safer and more optimal your machine will be. Furthermore, as
soon as you have two or more accounts, your system will prompt you to select an account on the welcome
screen when booting up Windows, so if you find this has suddenly happened to you, you will need to
remove any additional accounts recently created.

You can also change the access level of individual accounts here by highlighting them and selecting the
Properties button. Go to the 'Group Membership' tab and you can select the level of access they have. Aside
from the Administrator and your own user account, you should ensure all other accounts have 'Standard
User' or 'Restricted User' level access, not Administrator level access.

ADVANCED

Under the Advanced tab, select the Advanced button under the 'Advanced user management' section. Select
the Users folder in the left pane, right-click on the 'Help Assistant' account, select properties and make sure
the 'User cannot change password’, Password never expires' and 'Account is disabled' boxes are ticked for
security purposes. You should do the same for the Support and Guest accounts. The only time you should
enable these accounts is if someone you trust such as Microsoft Technical Support, asks you to do so.

Under the 'Secure logon' section, if you want to increase your security you can tick the 'Require users to
press CTRL+ALT+Delete' option. This will mean that users have to press the CTRL, ALT and DEL keys
together to bring up a logon prompt which then allows them to enter their username and password for
logging into Windows. This adds one extra layer of security however it can also be an inconvenience so I
don't recommend it unless you need extra security.

B WINDOWS FIREWALL

The Windows Firewall is an important security feature that has been significantly upgraded with Windows
XP SP2. A firewall is a barrier between your machine and anything that attempts to connect to your system
from outside. Unless you are using a separate software firewall, it is strongly recommended that you use the
Windows Firewall.

In the General tab under the Window Firewall settings, I recommend you select On, and untick 'Don't allow
exceptions' for maximum functionality. Exceptions are instances of connections to your machine that you
have consciously authorized, such as connections for online games or messaging programs. To completely
disallow exceptions however will mean many of your online games and utilities will not function correctly.

Whenever you launch an application or game which requires external access to your machine, you will be
prompted by the Windows Firewall whether you want to 'Keep Blocking' the attempt, to Unblock it, or to
'‘Ask Me Later'. The simple rule is that you should only allow exceptions for (i.e. only Unblock) applications
or games which you use often, and which you know should definitely require Internet communication with
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your machine, and which you trust. If a program that should have no need for Internet connectivity
suddenly raises the firewall's alert without providing a sound reason, I recommend you 'Keep Blocking' it -
at least until you can find out more about it through some Internet searching, or by reading its
documentation.

Under the Exceptions tab of the Windows Firewall settings you can see all the applications and games which
you are currently allowing access to your machine. Remove any which you are no longer using, or which
you do not know or trust. You can do this by unticking them and/or highlighting them and selecting Delete.
For more details on exceptions, see this Microsoft Article.

A particular trusted application or game might require that you open a specific Port. A 'port' in this context
is like a small doorway into your machine, so opening a port also lessens your machine's security. However
some programs must have access through a specific port to be able to communicate with your machine. If
the application or game which requires the open port is on your Exceptions list then highlight it, otherwise
select 'Add Program' and add it to the list, then highlight it. Then select the 'Add Port' button and enter the
port number and protocol exactly as specified by the application or game's manual, help documentation or
technical support personnel. Remember that certain trusted programs simply cannot function without
appropriate access through the correct port, so this must be done from time to time. Technically speaking
though, the more ports you have open, the less secure your machine is — so remove all open ports for
programs you have not used in a while.

Finally, the Advanced tab of the Windows Firewall settings contains a range of options that you can alter to
allow or disallow greater access to your machine. I strongly recommend you leave these at the default
settings, and only alter them if required by an often-used and trusted application or game. Almost all games
and applications should function correctly without the need to alter any of the Advanced settings. If you
want to know more about them refer to the articles linked above.

See the PC Security section for more details of both preventing and detecting infection by malicious
software, and other security tips which can help you secure your PC. See the Windows Errors section for
potential solutions to Windows Firewall problems.

B WIRELESS NETWORK SETUP WIZARD

This feature is new to Windows XP SP2, and launches a Wizard that takes you through the steps of
connecting a security-enabled wireless device, such as a Bluetooth device. In many cases a wireless device
shouldn't require additional drivers, however if necessary you may have to install them from your device's
driver disk or its website.

That ends the recommendations and descriptions for the Control Panel utilities and tools.
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STARTUP PROGRAMS

Windows XP loads a range of programs and services into memory at Windows startup to facilitate faster
access to their functions, or programs reliant on these functions, when you first go to use them. However
many of the startup programs can be removed as they are not necessary for the specific functionality you
require, they can cause conflicts with other programs and use up additional resources for no good reason.
The process of identifying and removing unnecessary startup items requires some patience and
troubleshooting using the tools and methods covered in this section.

B MICROSOFT SYSTEM CONFIGURATION UTILITY

Windows XP comes with a built-in utility for additional tweaking and troubleshooting of your system. This
tool is usually hidden, in that no icon is provided for it by default. To access it, go to Start>Run and type
"MSConfig" (without quotes) and press Enter. The main use for the Microsoft Configuration Utility
(MSConfig) is to provide a brief snapshot of key system variables, and perform some
diagnostic/troubleshooting of your Windows startup, as detailed in this Microsoft Article. Details of each

section of the utility are provided below.

GENERAL

This section shows the current status of system startup procedures. The default is Normal, which loads up
all your device drivers, services and startup items. However if you disable any startup items or alter system
variables using MSConfig, the Selective startup option becomes highlighted, showing which processes and
items have been changed. You should only use Selective startup mode for temporary troubleshooting
purposes - see the Services section for details on how to correctly disable unnecessary services for example.

If at any point you want to troubleshoot your system, and only want the essential services and drivers to
load up with Windows, select the Diagnostic Startup item. This can help you determine if a problem is
hardware or software based. This is similar to starting up using Safe Mode - see the Backup & Recovery
section for more details.

There is an option here to start System Restore (if the System Restore service is enabled) by clicking the
Launch System Restore' button. See the Backup & Recovery section for details of System Restore
functionality.

The 'Expand File' button provides a utility for extracting archived files from cabinet files (. CAB) such as those
on the Windows XP CD. By selecting the location of the cabinet archive, and the specific file required, you
can extract and restore individual files from the Windows XP CD in case the installed ones are corrupted or
deleted. This is much more handy than having to reinstall Windows completely. There are other methods of
repairing a Windows installation such as using the System File Checker - see the Backup & Recovery section.

SYSTEM.INI & WIN.INI

These sections allow you to see and change the entries stored in the System.ini and Win.ini files, which
typically reside in your \Windows directory. Unlike previous versions of Windows, Windows XP does not
use these files at startup anymore. The contents of these files are usually only required by older 16-bit
applications. As such, you should leave all the entries under these tabs at their default settings, as there are
no performance gains to be had by editing them.

BOOT.INI

This section allows you to see and change the entries stored in the Boot.ini file, which sits in the base
directory of the hard drive you have installed Windows XP on (typically directly under the C:\ directory).
This file determines what XP should do at startup time if there are multiple partitions and/or operating
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systems on your system, and any options to display prior to loading up Windows. In general you should not
change this file otherwise you may have problems booting into Windows.

I recommend that you make sure all options under the 'Boot Options' area as well as those found under the
'‘Advanced Options' button are unticked for the fastest startup. These options are provided to remove certain
features from Windows at startup primarily for troubleshooting purposes:

/SAFEBOOQOT - Ticking this option will force Windows to boot into Safe Mode (See Safe Mode under the
Backup & Recovery section) the next time you restart.

/NOGUIBOOT - This option prevents the Windows XP startup screen (the scrolling bar) from appearing
prior to the Windows Desktop loading up. This won't make any real speed difference, but if you find that
screen annoying this is how to remove it.

/BOOTLOG - Generates a log of the bootup files in your hard drive's base directory, handy if you are
troubleshooting an error which occurs during Windows bootup.

/BASEVIDEO - This option will force Windows to load up in standard VGA mode - that is no graphics
drivers will be loaded up. This can be useful for troubleshooting if you feel your graphics drivers are the
source of a problem.

/SOS - Ticking this option will remove the Windows Startup screen, allowing you to see what goes on
'behind the scenes' as Windows starts up, such as which drivers are being loaded up.

The two settings you can safely edit in Boot.ini are the timeout and /NoExecute settings. The timeout setting
should be set to 0 seconds for fastest bootup. However it can't be set below 3 seconds in MSConfig, so you
must go to the Boot.ini file, open it with a text editor such as Windows Notepad, and edit the timeout= line to
timeout=0, then save and exit the file.

The /NoExecute= option controls the way in which Data Execution Prevention (DEP) functions in Windows.
To alter this setting you must again go to the Boot.ini file and manually edit it with a text editor. The options
available for /NoExecute are covered in more detail under the Control Panel section of this guide.

SERVICES

This section shows all the services currently installed on your system, and their present status - that is
whether they are running or stopped. If you want to quickly determine whether a service is necessary or not
for troubleshooting purposes, you can untick a service here and it will not load up the next time Windows is
booted. However this is not the recommended method for permanently disabling services. The most useful
feature here is the ability to tick the 'Hide All Microsoft Services' box, and hence quickly see all the third
party services which are installed on your system by software other than Windows. Many, if not all of these
services can be disabled to reduce memory usage and in particular speed up bootup time. See the Services
section for full details on how to correctly configure your Windows Services.

STARTUP

This section shows all the programs which load into system memory upon booting up your system (aside
from Services). Many of these startup items are unnecessary and you will gain performance and most
importantly stability from removing them from your Windows startup. The hard part is determining which
startup items are absolutely necessary, and which aren't. Unfortunately there are no rock-solid rules for
doing this. Each individual startup item has to be assessed on each system to see whether it is truly
necessary in providing certain functionality for a specific program, or whether it is a useless entry which can
be safely removed without any negative impact. Follow the instructions below to correctly identify and
remove unnecessary startup items.
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B STARTUP PROGRAM IDENTIFICATION AND REMOVAL

Follow these steps to correctly identify and if necessary disable startup items:

1. Identify which programs the startup items relate to: Look at the entry under the Command column in
the list - it usually provides the directory and name of the file ((EXE, .BAT or .DLL) being run at startup.
If necessary expand the column so you can see the full path and filename by clicking on the divider
between the Command and Location headers and dragging it to the right. The combination of the
directory name and filename should tell you which program the file relates to.

sweror ] dnyeig

2. Identify what a startup item does: If you want to know exactly what the particular startup item does,
search one or more of the following databases using the exact filename:

SysInfo Definitive Startup List (mirrors: here and here)

WindowsStartup Online Search
ProcessLibrary

Or do a Google search using the exact file name. Note that some startup items can be viruses or trojans
for example and hence their name and source will be obscure on purpose, or may appear like a genuine
Windows XP system file. If you look through the sites linked above, you should be able to find the
program the item relates to and a brief description, including any special removal methods if required.

3. To prevent a startup item: Launch the source program, and look through its options for settings like
'Load with Windows', 'Load at startup’, 'Enable System Tray', 'Enable Shell Integration', and so on. See if
you can disable the startup functionality this way - if you can do without the functionality - as it is the
preferred method. If this works, you're done - the startup item should now be removed upon rebooting
your system. If you can't find any such options in the program(s), continue with the steps below.

4. Temporarily disable a startup item: For diagnostic purposes you can temporarily disable a startup item
by unticking its entry under the Startup tab in MSConfig. This prevents it from loading the next time
you boot up, but does not permanently remove it from the Window Registry. If you then experience any
adverse conditions, or lose particular functionality which you require, you can easily re-enable the item
by ticking it again in MSConfig. If after a while you notice the startup item seems unnecessary you can
remove it permanently using the next step below.

5. Permanently remove a startup item: Once you've decided which startup programs can be permanently
removed then the correct way to permanently remove them is to use the Windows Registry Editor. To
open the Windows Registry Editor, go to Start>Run and type "Regedit" (without quotes) and press
Enter. This opens the Registry Editor, and for more details on its usage see the Registry Editor section.
Entries for startup items are usually stored under the following keys:

[HKEY CURRENT USER\Software\Microsoft\Windows\CurrentVersion\Run]
[HKEY CURRENT USER\Software\Microsoft\Windows\CurrentVersion\RunOnce]
[HKEY LOCAL MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Run]
[HKEY_LOCAL_MACHINE\ SOFTWARE\Microsoft\Windows\CurrentVersion\RunOnce]

Right-click on the name of the entry you want to remove and select Delete. It will be removed from the
Registry and will not load up each time you boot into Windows. Of course you should make sure that
you follow all the steps above so that you don't remove a necessary startup item, since there is no undo
function in the Registry Editor. Alternatively you may wish to use a registry editing tool like
RegCleaner to edit your startup items, as that allows backing up of removed entries (See the Windows
Registry section) or Windows Startup Inspector (See below). However in a worse case scenario where
you have removed the startup item for a program you shouldn't have, you can always simply uninstall
then reinstall that program and the required startup item(s) will be recreated.

Finally, some startup items require special additional steps to completely remove from your startup. For
example the CTFMON startup item, which relates to an unnecessary 'alternative user input text input
processor' function for the Microsoft Office suite, requires following the procedures detailed in this
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Microsoft Article to completely remove. Simply removing its startup item from the registry will not remove
it as it is recreated every time you run an MS Office application.

If you find that the steps above are too complex or time-consuming, then there are free automated startup
item identification and removal utilities you can use. These are covered below.

WINDOWS STARTUP INSPECTOR

Windows Startup Inspector is a basic startup identification utility you can use to make the task easier.
Download and install the program, then launch it. You will see all your startup items listed on the main
screen. Now make sure you have an active Internet connection, and click the Consult button in the top
menu. The program will connect to its Online Database and try to provide information for each of your
startup items - click on each startup item to see the details. While details may not be available for every
startup item, there is a handy 'Find More on Google' link at the bottom of the information panel, which when
clicked automatically initiates a Google search using the startup item's exact name - very useful.

If you want to disable a startup item using Windows Startup Inspector, simply click the green tick mark next
to the startup item's name, and when the tick mark has been removed click the Apply button at the top of the
screen. Close Startup Inspector and reboot for the item to be removed from your startup.

AUTORUNS

Autoruns is a much more advanced and highly useful startup identification and removal utility. Download
the program, extract its contents to an empty folder and run the Autoruns.exe file to start it. You will see a
large number of items which are automatically loaded up at Windows startup - far more than most other
utilities will ever show. Most of these are required for various programs to run, and a large proportion of
them are Microsoft startup files which Windows absolutely needs to function correctly.

To correctly identify and remove the truly unnecessary items will still take some work. To start with, to hide
the Microsoft items which should all be necessary for XP to function properly, go to the Options menu and
tick the 'Hide Microsoft Entries'. You will then need to use the resources and instructions in this chapter to
identify the remaining items. You can also right-click on each item and select 'Google..." to automatically
initiate a Google search on that particular item. Once you believe you've identified an unnecessary item,
untick it in Autoruns and it will not be loaded up the next time your reboot Windows. However unticking
an item does not permanently remove it from your system, so it is a good way of testing to see if an item is
truly unnecessary. If you then find that you can do without the relevant item and you're sure it's
unnecessary, right-click on it and select Delete to permanently remove it.

HIJACKFREE

HijackFree is an advanced free utility which provides details of all running processes, startup programs,
services, even the open Ports and ActiveX controls currently in use by your system, all in one neat GUL. It is
intended for advanced users who have some knowledge of what they're looking for. You can choose to do
an automated online analysis of your data by clicking the 'Online Analysis' button at the top right of
HijackFree, however note that the results can be confusing as it often lists both the good and bad potential
uses for particular services/processes/files, but it can make it look like you're actually infected with a
particular virus or spyware when you're not. If you've followed the instructions in the PC Security chapter
you can generally ignore these malware warnings - unless an item is listed as solely being bad.

Whichever method you use, it is important to stress that while removing unnecessary startup items
improves Window startup times, reduces memory usage and most importantly prevents program conflicts
with other applications and games, if in doubt, do not remove a startup item. Follow the detailed procedures
above to identify and troubleshoot any startup item, but if you cannot determine its precise nature after all
your efforts, and you've done a thorough scan of your system using the tools covered in the PC Security
chapter, then leave it to run at Windows startup otherwise you may experience even more problems.
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SERVICES

Services are programs that run in the background and support specific functionality in Windows XP. They
can be initiated by Windows itself, or they can be installed and initiated by third party programs. They may
start automatically at bootup (Automatic), they may be triggered to start by the launching of certain
programs or functionality (Manual), or they can be blocked from running altogether (Disabled). The aim of
editing your services is to prevent unnecessary programs from taking up system resources, slowing down
your bootup time, and possibly conflicting with your games and applications.

B SERVICES UTILITY

The Services Utility gives you the ability to edit your Service configuration. To access the Services Utility,
you can either go to Control Panel>Administrative Tools>Services, or you can go to Start>Run and type
"Services.msc" (without quotes) and press Enter. This opens the Services Utility that lists all installed
services, tells you whether they are currently running or not, and whether they're set for Automatic, Manual
or Disabled startup. A brief description of each service is also provided.

MICROSOFT SERVICES

The best guides to refer to on the topic of correctly configuring your services are the BlackViper Service

Configuration Guide and The Elder Geek Services Guide. These guides contain many pages of details on
precisely what each service does, and a range of service configurations for differing needs, from default to
hardcore. I urge you to refer to one of these guides for more details if at any time you are curious as to what
a particular service actually does.

Any Microsoft services not listed in the guides above, or in my list further below should generally be set to
Manual, however if certain Windows functionality doesn't seem to be working for you, or particular
device(s) are not functioning correctly, you may have to reset them to Automatic. Spend the time to research
and refine your service configuration using a dedicated Service Guide. For identifying and configuring non-
Microsoft services, see further below.

On the next page I provide my recommended Windows XP service configuration which should leave you
with all the functionality of Windows XP which most users require, while at the same time stripping down
many of the unnecessary services. It should be safe for most users - it is similar to the 'Safe' settings in
BlackViper's guide. However if you are connected to a network of other computers, have exceptional needs,
or an uncommon setup then do not use my configuration - refer to the services guides above and spend the
time to customize your service settings appropriately. The advice below suits a standalone Windows XP
machine for general home use with standard hardware and peripherals.

I must stress however that if in doubt do not alter or Disable a Windows Service. Create a System Restore
point first before altering your services as well. If you want to return to your default services settings, see the
guides linked above, or this Microsoft Article.
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Cryptographic Services

DCOM Server Process Launcher
DHCP Client

Distributed Link Client Tracking
DNS Client

Event Log

IPSEC Services

Logical Disk Manager

Network Connections

Plug and Play

Print Spooler

Protected Storage

Remote Access Connection Manager
Remote Procedure Call (RPC)
Security Accounts Manager
Shell Hardware Detection
System Event Notification
System Restore Service

Task Scheduler

Telephony

Themes

Windows Audio

Windows Firewall/Internet Connection Sharing
Windows Management Instrumentation

Automatic Disable
Application Layer Gateway .NET Runtime Optimization Service
Automatic Updates ASP.NET State Service
COM+ Event System Clipbook

Error Reporting Service

Fast User Switching Compatibility
IMAPI CD-Burning COM Service
Indexing Service

Infrared Monitor

Machine Debug Manager

NetMeeting Remote Desktop Sharing
Network DDE

Network DDE DSM

Network Location Awareness (NLA)
Performance Logs and Alerts

Portable Media Serial Number Service
QoS RSVP

Remote Desktop Help Session Manager
Remote Registry

Routing and Remote Access
Secondary Logon

Security Center

Smart Card

SSDP Discovery Service

TCP/IP NetBIOS Helper

Telnet

Terminal Services

Uninterruptible Power Supply
Volume Shadow Copy

WebClient

Windows CardSpace

Windows User Mode Driver Framework
Wireless Zero Configuration

WMI Performance Adapter

SIDIAIIG

NON-MICROSOFT SERVICES

You may notice that your services list has several services that are not listed in the services guides or in my
list above. This is because particular programs and drivers, such as the graphics drivers, antivirus programs
and system utilities, install their own unique services. These services power some of their specialized
functionality, but as with many of the Microsoft services some of these can be set to Manual or even
Disabled to reduce background resource usage and prevent conflicts.

The best way to identify unnecessary non-Microsoft services is to run MSConfig (See the Startup Programs
section), go to the Services tab and tick the 'Hide All Microsoft Services' box. Any remaining services visible
are those that have been installed by third party software. To determine which of these are unnecessary, you
will have to work out which software package has installed the service. In most cases it is fairly obvious. The
'ATI Smart' service for example is clearly related to the ATI graphics drivers, while 'AVG Update' is clearly
an AVG Antivirus service.

IDENTIFYING NON-MICROSOFT SERVICES

To correctly identify which program a service relates to, and in particular which file is launching it, follow
these steps:

1. In MSConfig, having ticked the 'Hide All Microsoft Services' box, write down the exact name of each
non-Microsoft service (e.g. AVG7 Update Service).
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2. Go to Start>Control Panel>Administrative Tools>Services and find the same services in this listing.

3. Double-click on the name of each non-Microsoft service and in the details screen for that service, look
for the 'Path to executable’ box. It contains the actual filename of the program being executed with the
service. For example, the '"AVG7 Update Service' service has the path "C:\PROGRA~1\Grisoft \AVG
Free\avgupsvc.exe”. Write down the filename (i.e. avgupsvc.exe).

4. Search one or more of the following databases using the exact filename:

Uniblue Process Library
NetworkTechs Process Library
SysInfo Startup List

ProcessLibrary

Or do a Google search on the filename. This process is extremely similar to that of identifying startup
items as covered in the MSConfig section.

As with Microsoft Services, you should be able to Disable a range of these services as they are not necessary.
In some cases, Manual is the correct choice, and in other cases Automatic must be chosen otherwise the
relevant program will not launch or will have problematic functionality. If in doubt, leave a non-Microsoft
service on its default setting.

Services are an area of ongoing debate. Some experts will suggest that tweaking services is pointless and
unnecessary and can cause more problems than it resolves, while others will argue that patently unnecessary
services should be disabled, as there is no point allowing something to take up resources if it is not needed.

In my opinion the bottom line is that if you use the resources and instructions above, you should be able to
identify and disable truly unnecessary services without any problems (e.g. the 'Smart Card' service), and
experience faster bootup times, and less likelihood of program conflicts and errors. However as always if
you are not confident in what you are doing, or don't have the time or patience to do the research and sort
out your services properly, then leave your services on their default Windows configuration. It may not be
optimal, but you may will prevent a lot of problems in the long run.
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CLEANING WINDOWS

As you use your system in day-to-day activities, a vast range of temporary, backup and unnecessary files
build up on your hard drive. Most temporary files are automatically deleted whenever you close an
application, or whenever you shut down Windows. Unfortunately many of them aren't, and over time they
can build up, taking up a lot of disk space and generally making a mess in your directories. The main reason
to clean Windows is to free up additional drive space, reduce clutter and prevent file version conflicts.

B DiIsK CLEANUP

The Disk Cleanup utility provides the ability to automatically find and remove unnecessary Windows files,
old System Restore points, and unwanted Windows components. To access the Disk Cleanup utility go to
Start>Run and type "Cleanmgr.exe" (without quotes) and press Enter, or look for it under your
Start>Programs>Accessories>System Tools menu.

The Disk Cleanup utility has several functions, which are covered below:

REMOVE UNNECESSARY WINDOWS FILES

To remove unnecessary Windows files at any time, open the Disk Cleanup utility and under the main Disk
Cleanup tab make sure the following are ticked:

» Recycle Bin

* Setup Log Files

»= Temporary Files

» Catalog files for the Content Indexer

Also tick the 'Temporary Internet Files' option if you want to clean out your Internet Explorer cache. If you
are short on disk space you can tick the 'Compress Files' option, however I recommend against this as disk
compression can be time consuming and will reduce your overall performance in Windows XP, increasing
the frequency of fragmentation. Click OK when done, and OK again. This will remove a lot of unnecessary
files on your system and may take a while. These files will be moved to the Recycle Bin by default.

ADD OR REMOVE WINDOWS COMPONENTS

To add or remove Windows XP components under the 'More Options' tab click the 'Clean Up..." button
under the 'Windows Components' section. In the 'Windows Components' box that opens, items with ticks
next to them are currently installed. You can install additional items by ticking them, and untick any existing
components that you want to remove. Note that some items, such as Windows Messenger or Internet
Explorer, cannot be fully uninstalled this way - unticking them only removes the shortcut to the program
which is not much use.

When you highlight certain components, you may see a Details button appear on the bottom right. Click it to
see which particular sub-components you can select to install/keep/uninstall. For example, if you highlight
the Accessories component, click Details and you will see two types of sub-components - Games and
Accessories. Highlight the Accessories sub-component and click Details again, and you'll see the full list of
Windows accessories installed on your system. Untick the ones that you know you do not need or use, and
tick those which you want to install or keep. If in doubt, do not install or uninstall any items. Items that are
already ticked are currently installed, and leaving the tick mark against them won't see them installed again
— it just means you wish to keep them.

Once you're finished, click OK until you are back at the main Disk Cleanup utility screen and click Next.
Any changes will see the relevant components installed/uninstalled as specified. Note that you may be
prompted to insert your original Windows XP CD if you've chosen to install a new Windows component.
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To access a more detailed list of the components you can install or uninstall on your Windows, do the
following:

1. Go to your \ Windows\ Inf directory and open the Sysoc.inf tile with Windows Notepad.
Do a search for all occurrences of the word ,hide, and replace them with ,, - make sure there are no spaces
around, or in between, the commas.

3. Save the file and close it.

smopurp Suruear)

Now when you go into the Windows Components section under Options in Disk Cleanup, you will see

many more items listed. Note that some of them - such as those shown with grey box icons - are important
system files which may result in problems if removed. Be very careful here as to what you add or remove. If
you really want to strip out a large number of Windows components, I recommend using NLite instead (See
Installing Windows section), that way these components will never be installed in the first place.

REMOVE OLD SYSTEM RESTORE POINTS

To remove all System Restore points other than the most recent Restore point, thereby freeing up a great
deal of disk space, under the 'More Options' tab click the 'Clean Up..." button under the 'System Restore'
section. Click Yes on the subsequent prompt, then click the OK button.

ADVANCED DISK CLEANUP USAGE

You can access more disk cleanup options by going to Start>Run, typing "cleanmgr /sageset:1" (without
quotes) and pressing Enter. In the dialog box which opens, tick the items you wish to clean - I suggest all
except 'Compress old files' - and then click OK. To execute this extended cleanup at any time, go to
Start>Run and type "cleanmgr /sagerun:1" (without quotes) and press Enter.

B RECYCLE BIN

The Recycle Bin provides a storage area for deleted files and acts as an additional layer of protection against
permanently deleting files on your system. This section covers the optimal configuration of this essential
Windows tool, as well as methods of permanently deleting files and recovering deleted files.

CONFIGURATION ADVICE

If you don't want deleted files to automatically move to the Recycle Bin and instead want them permanently
deleted every time, right-click on the Recycle Bin icon on your Desktop, select Properties and under the
Global tab tick the 'Do not move files to the Recycle Bin. Remove files immediately when deleted' option. I
don't recommend that you do this, since the Recycle Bin is useful insurance to have against accidentally
deleting important files.

I recommend you untick the 'Display delete confirmation dialog' option under the Global tab of the Recycle
Bin Properties. This will stop Windows from asking you each and every time you want to delete a file
whether you really want to do it — instead the file will go immediately into the Recycle Bin when deleted.

If you have enabled the Recycle Bin, but at any time want to delete a file and not have it moved to the
Recycle Bin first, highlight the file(s) and press SHIFT + DELETE. You will be asked to confirm this action
each time, but this will delete them immediately without placing them in the Recycle Bin.

You can specify the maximum amount of disk space the Recycle Bin can take up at any time by adjusting the
slider under the Global tab of the Recycle Bin Properties. I recommend allowing enough disk space so that
should you delete several large files on your system you can still recover them if necessary. Typically around
2GB is sufficient for most people. Work out what percentage of your drive that would be, and apply it here
(e.g. 2GB of an 80GB drive = around 3%). To see the exact amount of maximum space allocated, click the tab
that has your hard drive's name.

Copyright © 2007 Koroush Ghazi 9 6



e..uenﬂmu.ng-_-. THE TWEAKGUIDES TWEAKING COMPANION

RENAMING OR DELETING THE RECYCLE BIN

You can rename the Recycle Bin or even delete it by using this tweak. Open the Registry Editor and go to:

[HKEY_CLASSES_ROOT\CLSID\{645FFO40—5081—lOlB—9F08—OOAA002F954E}\ShellFolder]
CallForAttributes=0x00000000(0)

Attributes=50 01 00 20
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First double-click on the CallForAttributes DWORD and change its value to 0. Then double-click on the

Attributes DWORD and change its value to 50 01 00 20 to add a Rename option to the Recycle Bin
icon's context menu (when you right-click on Recycle Bin, the Rename option now appears). To add a Delete
option as well, change the valueto 70 01 00 20. You will have to reboot your machine for this tweak to be
implemented. It is strongly recommend that you do not delete the Recycle Bin.

B CCLEANER

CCleaner (Crap Cleaner) is a utility which can automatically find and remove a wide variety of essentially
useless files from your system. It can be downloaded from the CCleaner Site, and is completely free to use.
CCleaner automates a task that you can perform manually to some extent (see further below), but which
takes longer to do by hand; CCleaner finds and removes a range of files with common extensions identifying
them as unnecessary files (e.g. . TMP, .BAK, .OLD) and also files which reside in known temporary or rubbish
folders. It excludes important backup/temporary files that should not be deleted, and if used with caution it
is usually quite safe in removing only unnecessary files.

CONFIGURATION ADVICE

To use CCleaner safely and optimally, run the program and click on the Options button, and first adjust the
following settings:

1. Under the Settings section, untick all available boxes as none are vital to running CCleaner correctly.
Under the Cookies section, in the left pane are a list of cookies CCleaner will automatically delete if the
Cookies option is ticked under Internet Explorer and/or Firefox on the main CCleaner screen. Select
which cookies you would like to keep by highlighting it in the list and moving it using the '->' arrow to
the 'Cookies to keep' list.

3. Under the Custom section you can add particular files or folders which you would like CCleaner to
delete. This can be useful if a particular program keeps creating specific unnecessary folders which
CCleaner wouldn't normally pick up as rubbish.

4. Under the Advanced section I suggest unticking everything except 'Only delete files in Windows Temp
folders older than 48 hours' which should be ticked for maximum safety, along with the 'Show prompt
to backup registry issues'.

5. If you're not sure if you're running the latest version of CCleaner at any time, click the 'Check for
updates now..." link at the bottom right corner to see if a newer version of CCleaner is available.

To start the cleaning process, first make sure you close all open applications to prevent conflicts if CCleaner
tries to delete actively used files. Then open CCleaner and under the Cleaner>Windows tab make sure to
untick anything which you don’t want deleted. For example, if you use Internet Explorer you should check
to make sure you untick any components which you wish to keep (e.g. untick 'Temporary Internet Files' if
you don't want your IE browser cache cleaned out). Note that you should only tick the options under the
Advanced list at the bottom if you know what you are doing, otherwise they are all best left unticked.

Next, under the Cleaner>Applications tab CCleaner lists all your installed applications which it can help
clean up. Once again, make sure you untick anything you wish to keep. If in doubt, untick it. For example, if
you have a browser like Firefox installed, make sure you untick any portions of it which you don't want
'cleaned’ (e.g. untick the 'Internet Cache' option).
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ANALYZING AND DELETING UNNECESSARY FILES

Once you have all the relevant options ticked, click the Analyze button and after a while CCleaner will come
up with a list of files it wants to delete. At this stage nothing has been deleted yet, so scroll through the list
and make sure no files which you wish to keep are listed. Most of what CCleaner removes is not needed by
the average user, but each person differs in what they want, so review the list carefully. The files typically
found unnecessary by CCleaner include Most Recently Used (MRU) lists (i.e. the path to the last few
documents you opened in a particular application), log files, temporary setup files for drivers and
applications, and browser cache files.

If you have any doubts, or want some of these files kept, go back to the Windows and/or Application tabs
and untick any areas you don't want CCleaner to clean and click Analyze again. Once you're happy to
continue click the 'Run Cleaner' button to permanently remove the listed files.

Finally, the Issues function in CCleaner attempts to find redundant Registry and File system entries. To start
with, tick all the options available and then click the 'Scan for Issues’ button. A whole range of "issues" may
be found, however I strongly recommend against using this section of CCleaner unless you know exactly
what you are doing. I generally believe registry cleaning is best done by RegCleaner or RegSupreme (See
Windows Registry section) which are far more foolproof in detecting registry errors and fixing them.

B MANUAL DRIVE CLEANING

Below is the manual method for cleaning out the more obvious redundant files in your system. If you don't
trust an automated cleaner and want to be certain you only delete unnecessary files, follow these steps:

1. Close all open applications and games as some of these may have created temporary files that cannot be
deleted because they are in use. Restart your system just to be certain.

2. Make sure you empty your Recycle Bin. Also ensure that the option to move files to the Recycle Bin is
enabled. This will provide protection against accidentally deleting a necessary file in the next few steps.

3. Open Windows Explorer and navigate to the following directories on the hard drive where you have
installed Windows. Delete any files or subdirectories beneath them, but not the directories themselves:
\Documents and Settings \ [your username]\ Local Settings\ Temp\

\ Windows\ Temp \

4. Go to \Windows\ and delete all the $NtUninstall directories. These are directories which allow you to
uninstall Microsoft updates typically from Windows Update. Unless you've also installed a Beta
Microsoft product (e.g. IE7 Beta), it is highly unlikely you will ever need to uninstall a Microsoft patch,
so deleting these directories is fine. Note that you should not delete the $/f Mig$ directory.

5. This step involves finding files with file extensions that identify them as redundant. Go to Windows
Search (Start>Search) and select 'All files or folders' to bring up the search box. In the first box, enter the
following text and press Enter. In each case delete all incidences of files with these extensions:

*BAK
* TMP
*OLD

6. Delete any files you know are not needed anymore, such as older versions of downloaded driver
packages, setup files from downloaded programs, log files and so on. You can also usually delete (or
backup) files found under the \ Windows \ Downloaded Installations directory.

7. Note, if any files cannot be deleted because they are in use by Windows, reboot your system and go into
Safe Mode (See Backup & Recovery section). From there you should be able to delete any file.

That covers the bulk of unnecessary files on your system. Importantly: do not empty your Recycle Bin just
yet - reboot your system and use it for a while just to be sure the files you have deleted are genuinely no
longer needed. If in doubt, use CCleaner instead of doing things manually.
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TASK MANAGER

The Windows Task Manager is a utility that allows you to view important real-time information about
which applications and processes are running on your system. You can also see how much memory, CPU

usage and network bandwidth is being consumed at present by these various processes. As an information
and troubleshooting tool it is invaluable. To access the Task Manager at any time, press the CTRL, ALT and
DELETE keys together, or go to Start>Run and type "Taskmgr" (without quotes) and press Enter.

The Task Manager's primary use is to allow you to attempt recovery from system lockups and crashes.
Whenever a program stops responding you can attempt to launch the Task Manager (CTRL+ALT+DEL) and
under the Applications or Processes tab you can select the offending task or process and select 'End Task' or
'End Process', usually regaining control of your PC without the need to reboot. If the Task Manager does not
appear after pressing CTRL+ALT+DEL several times then your system has 'hard locked’, meaning a reboot is
required to regain use of your computer. See the Windows Errors section for more help if that is the case.

B CONFIGURATION ADVICE

To customize the Task Manager so that it displays the specific system information you want to see, go to the
View menu and under it click the 'Select Columns..." option. You will be presented with a dialog box that
allows you to select a range of items that can be displayed as columns under the Processes tab of the Task
Manager. I recommend that at the very least the 'CPU Usage' and 'Memory Usage' items be ticked. These
will show you for each process the proportion of the CPU's resources the process is currently using, and how
much system memory (RAM + Virtual Memory) it is using. I recommend also ticking the 'Peak Memory
Usage' item as well, as this will show you just how large a particular process has been at some point. We
discuss the reason for this in the Memory Optimization section when ascertaining Virtual Memory usage.

Next, go to the Options menu and make sure the 'Show 16-bit tasks' setting is ticked, then under the
Processes tab make sure the 'Show processes from all users' option is also ticked. This ensures that all
running programs and processes will be shown. Note that at any time if you cannot see any menu items or
tabs in the Task Manager window, simply double-click anywhere on the borders of Task Manager and it will
revert to its normal view. Also note that you don't usually require the 'User Name' column, however if you
are on a PC with multiple users you can enable this functionality by making sure the 'Fast User Switching
Compatibility' service is set to Automatic (See Services section).

B RESOURCE USAGE MONITORING

One use for Task Manager that I find myself turning to often is that of monitoring my startup state. That is,
the programs and processes which are running in the background after a fresh bootup, and the amount of
memory being used. After a fresh bootup immediately open Task Manager, and click on the Processes tab,
then examine the following areas of Task Manager:

PROCESSES

Check the list of running processes - there should be as few as possible. For example, I have 16 processes
running after bootup (including Task Manager itself); that is the bare minimum I could get down to after
tweaking and removing unnecessary startup items and services. Note that certain processes can appear
multiple times — this is fine for svchost.exe for example, since it is the Service Host process and as such runs
groups of several Windows services. However some processes may be initiated by a virus or completely
unnecessary program, so see the Services and Startup Programs sections for details of how to identify the
programs behind these processes and how to disable or remove unnecessary ones.
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COMMIT CHARGE

Look at the total Commit Charge at the bottom of the Task Manager window. This shows the amount of
system memory (RAM + Virtual Memory) that has been used out of the maximum available. Although this
may grow dramatically after you have run several programs - and this is quite normal - the main point to
consider is that the first figure in the Commit Charge section should be quite low at Windows startup. My
Commit Charge at startup is around 115MB, which is the lowest I could reduce it to while maintaining all
required functionality. Once again, see the Services and Startup Programs sections for details on how to
reduce such resource usage. Minimizing memory usage at startup is not about 'freeing up' as much RAM as
possible. Rather, the aim is primarily to reduce the likelihood of program conflicts. The less information is in
memory prior to launching a large program, the less chance there is that program will attempt to access a
memory location that is already taken (resulting in a General Protection Fault or a Crash to Desktop for
example), and also the less pagefile usage you will experience. Most recent games manufacturers specifically
recommend that background programs and processes be minimized to prevent game conflicts for example.

CPU USAGE

Pay attention to the CPU usage for your system when it is idle — that is when you have no open games or
applications. It should be at or close to 0%, and the 'System Idle Process' process should have around 99%
CPU usage, indicating that the CPU has as minimal a load as possible. A CPU that idles correctly stays
cooler and uses less power. If your system is using significant CPU resources when supposedly idle, this
indicates that you have a background program(s) or process(es) which is/are unnecessarily drawing
resources and hence there is scope for you to improve performance by disabling it/them.

You can also open the Task Manager during the running of an intensive game or application and check the
CPU % being used by its process — for a single-core CPU it should be consistently at, or close to, 100% CPU
usage. If for some reason it is quite low, check to see if any other processes are drawing CPU resources, and
once again refer to the relevant sections of this guide to remove/disable unnecessary background programs.

Note that on systems with dual core or multi core CPUs, the CPU usage figure shown here may be lower,
since each core may share a proportion of the total load, hence overall CPU usage for a particular process
may only be around 50% for example. For more details see further below.

I do not recommend manually changing the process priority (right-clicking on the process and selecting Set
Priority>High for example) in order to increase performance. Such tweaks are more likely to increase system
instability, and should have no impact on an optimized machine since by default your current program
should have 100% CPU usage and the highest priority.

MEMORY USAGE

Examining the memory usage for each process can provide valuable information. If you have selected the
'Peak Memory Usage' item to add to the list of columns under the Processes tab (as recommended above),
you can combine that information with current Memory Usage to learn some interesting facts about the
performance of the processes over time. For example, you can open the Task Manager while running a
particularly intensive application or game and check to see how much memory its process is currently using,
and how much it has used at its peak so far. Compare these figures to the number on the right of the Commit
Charge figure at the bottom of the Task Manager window — which is the total amount of memory (RAM +
Virtual Memory) available to the system. If the game or application is using close to the total amount of
memory available on your system, you may have to increase the maximum size of your pagefile (See the
Memory Optimization section) otherwise you may experience crashes or 'Out of Virtual Memory' errors.

Note that whenever a program is minimized, i.e. shrunk down to the Taskbar, it will use less memory and
resources than normal. Therefore check the resource usage of a program when it is taking up the full screen
to get an indication of how intensive it is during normal usage.
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B SETTING PROCESSOR AFFINITY

Some desktop PCs contain a CPU with two cores - that is, a single CPU which is actually made up of two (or
more) separate CPU chips. Furthermore some Intel CPUs have a technology called HyperThreading, which
in effect emulates two physical cores on a single-core CPU. To check to see if you have a real or virtual dual
core system, go to the Performance tab of Task Manager. For single core systems you will only see one 'CPU
Usage History' graph display. For dual core and HyperThreading enabled systems you will see two (or
more) CPU graphs.

For a program to truly take advantage of both cores on a CPU, it needs to be multi-threaded. That means
several program 'threads' will run in parallel, with each thread assigned to a particular core to handle.
Alternatively, multiple programs can be run together much more smoothly on a dual core system, as each
program will be run as a separate thread. However most programs and games are not multithreaded, and
hence show no real benefits when run individually on a dual core system. Furthermore, while running
multiple programs on a dual core system can make better use of all available cores, other bottlenecks such as
the hard drive and system RAM may result in issues such as loading pauses, or memory conflicts.

Where programs show problems launching or running on a dual core system - and some games and
applications do indeed have such problems (such as RegCleaner) - then dual core users have two options.
For AMD Dual Core CPU users, install the AMD Dual Core Optimizer which resolves most of these issues.
For non-AMD users, or if the Optimizer doesn't seem to work, you will need to restrict the program to only
one of your CPU cores. This is called setting the Processor Affinity, and there are two ways to do this:

Setting Processor Affinity Manually: Launch the program in question, and as soon as it appears to be
loading, or immediately after it has loaded up, open the Task Manager. Under the Processes tab, find the
game/program's main process - this usually has the same name as the program itself - and then right-click on
this process, select 'Set Affinity' and in the box which appears, untick 'CPU 1' so that only 'CPU 0' is ticked.

Setting Processor Affinity Automatically: If you want to force the program to only use one of your CPU
cores automatically without having to manually use the method above each and every time you launch it, or
if the method above doesn't work, then download the file imagecfg.exe from this page (mirrors: here and here)
and put it into your \ Windows\ System32 directory. The file is safe to use, as it is a Windows NT system file.
However it is important to note that because imagecfg writes information to the header of the executable file
you use it on (thereby modifying it), it is recommended you first make a backup copy of the particular
executable you wish to apply it to. That way if you want to undo the imagecfg changes, you must restore the
backup of the executable - this is the only way to undo this procedure.

To then permanently set the affinity for a particular game or application, do the following:

1. Identify the program's main executable. To do this go to the program's launch icon, right-click on it,
select Properties and highlight and copy the text in the Target box. You may have to write the text down.

2. Make a backup copy of this executable first.

Go to Start>Run and type "emd" and press Enter. This will open up a new command prompt.

4. Inthe command prompt window type: imagecfg -a 0x1 followed by the text you copied from step 1
above (right-click in the command prompt box and select Paste). Also make sure to put quote marks

@

around the path. E.g.:
imagecfg -a 0x1 "c:/program files/RegCleaner/RegCleanr.exe”

5. Windows will now only allow that program to see and use one of the CPU cores each time it is launched
by using that particular executable. If you need clearer instructions, see one of the sites linked above.
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Once you have undertaken these steps, the best way to check to see if it has worked is, after launching the
program in question, to open Task Manager, find the program's main process, right-click on it, select 'Set
Affinity' and hopefully only one CPU will be ticked.

Alternatively if you're having problems with imagecfg, you can use this SetAffinity program instead.
Download and extract the contents to an empty folder, and move the madCHook.dll file to your
\ Windows\ System32 directory. Now run the setaffinity.exe file and a small wrench icon will appear in your
System Tray area. Clicking on this will bring up the interface where you can select to run a game with only
one CPU core, either temporarily or permanently.

For all other intents and purposes a dual core system will perform the same way as a single core system for
common tasks and tweaks. You should only use the steps above if you run into a problem which you believe
is associated with dual core CPU usage.

As you can see, the Task Manager has multiple functions as detailed above. Familiarizing yourself with its
various uses will help give you a good idea of what is happening on your system at any time. For example,
regularly checking active processes and memory usage will give you early warning of things such as virus or
spyware infections, since they often cannot be hidden from the Task Manager's Processes list or memory
usage statistics. If you see a sudden increase in memory usage at startup, or a new and unknown process
appears, or CPU usage increases at idle, you can be sure it is the result of a new program or service running
in the background. Most often this is the result of recently installed legitimate software adding a program or
service to your startup, and you should use the procedures in this guide to determine whether it is necessary
or not. If left unmonitored, your background resource usage can and will blow out, slowing down your boot
time and causing stuttering and potential program conflicts.
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WINDOWS REGISTRY

The Windows Registry is a central database for a range of system and program-related settings. Whenever
you change your Windows settings, add or remove components or install new programs and/or change their

settings, or even move or resize open windows, the registry will be updated with key pieces of information
marking these changes. This section covers the optimization and editing of the Windows Registry.

B CLEANING THE REGISTRY

The Windows Registry has thousands of entries, and some of these can become outdated or incorrect due to
changes in hardware and software, and even registry corruption. A registry cleaner's job is to trawl through
the registry and find invalid entries, such as entries that point to non-existent files. Since the registry loads
into memory at Windows startup, and controls a great deal of system behavior, the leaner and cleaner the
registry is the less space it takes up, and the less the likelihood for errors and strange behavior. There are two
main applications I recommend for cleaning the Registry: RegSupreme, or its free older version RegCleaner.

REGSUPREME

RegSupreme is an efficient and easy-to-use registry cleaner. To access RegSupreme, download it from the
RegSupreme Website and install it. Note that it is only free for a limited trial period. RegSupreme has an
extremely simple interface. There is no need to configure it in any particular way, you can begin using it to

clean the Windows Registry immediately. To begin a registry cleaning session, start RegSupreme - the first
time you run RegSupreme, it will prompt you to create/update RegSupreme's cache. You should click OK, as
this process needs to only be done once in every while and will speed up registry cleaning sessions a great
deal. Once RegSupreme's caching has been completed you can continue with the actual registry cleaning.

Click the 'New Scan' button, or if automatically presented with the scanning options, I recommend selecting
Aggressive - it is a thorough but safe method of searching through your registry for invalid entries. Click the
Start button and the registry scanning will commence. This may take a little while depending on how large
your registry is, but usually no longer than a few minutes. Once the scan is completed, nothing is deleted or
altered in the registry. To actually remove all the invalid entries found, you should go to the Select menu and
choose All to place a tick next to all the invalid items. Then click the Fix button to remove them - you will be
prompted for a name to give the automatic backup that is created. Should anything go wrong later on, this
backup can be restored at any time by opening RegSupreme, clicking on the Backup button, highlighting the
backup and clicking the Restore button.

Note that RegSupreme will sometimes find hundreds of 'invalid' files, but don't be distressed: this doesn't
mean your registry was a total mess. Rather, RegSupreme categorizes such harmless things as MRU (Most
Recently Used) registry entries as invalid, even though they are perfectly normal. For example, if you use the
WinZip archiving utility it will record the last few archives you accessed should you want to quickly access
them again. Of course they're better off being removed, but they will simply build back up again within a
matter of days, so don't be concerned if you run RegSupreme again later and still find lots of invalid entries.

REGCLEANER

RegCleaner is a much more versatile tool than RegSupreme, but can be a bit trickier to use. However unlike
RegSupreme it is completely free, whereas RegSupreme requires paid registration to continue using it after
the 30 day trial expires. The trick is finding a proper copy of RegCleaner to download, since the author no
longer supports this product, and it has been phased out of most sites. The version on MajorGeeks or this
RegCleaner Download Site should be the correct one to use. Make sure that once installed, the software
clearly says 'RegCleaner 4.3' at the top of the RegCleaner window otherwise you are not using the correct
version.
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Important: RegCleaner will not launch correctly, if at all, on Dual Core or HyperThreading CPUs. To
configure it to launch on such systems, you will need to set the Processor Affinity to one CPU - see the Task
Manager section further above for details of how to do this.

Before using the registry cleaning function in RegCleaner, start the program and under the Options>Registry
Cleanup>Method menu select Automatic, and under Options>Registry Cleanup>Ole Cleaner select 'Extra
Powerful'. This will use the most thorough (yet safe) registry cleaning method. Now to run the registry
cleaner, go to the Tools menu, and under the 'Registry Cleanup' section select 'Do Them All'. After a short
while RegCleaner will complete scanning your registry and will list the redundant entries it has found. They
should then all be removed automatically to a single backup file, which you can see under the Backups tab
of RegCleaner. Should there be any problems after running the registry cleaner, you can restore this backup
by selecting it and clicking the 'Restore Backup' button. The other functionality of RegCleaner is covered
under its various tabs below:

Software: The most important use for RegCleaner — and the one which sets it apart from RegSupreme - is the
ability to view software registry entries on your system (made by programs you have installed), grouped
together by the name of the company and/or software. To do this right-click on the name of a particular
entry. Click the 'Advanced Info' button, and it will show you all the individual registry keys and values that
relate to that particular piece of software. This is very handy, firstly if you want to see in one glance what a
program has installed in the various sections of your registry; and secondly if you uninstall a program but
some of its registry entries are left behind you can click on the item(s) here and select Remove Selected' to
completely remove all traces of it quickly and easily. Note that anything you remove from here will be
stored in the Backups section of RegCleaner, so if you run into problems restore the item from there.

Startup List: If you have read the details in the Startup Programs section about streamlining your Windows
startup entries, but don't wish to use the Registry Editor to remove particular startup programs, you can go
to the Startup tab in RegCleaner and it will list all your current Windows startup entries. You can then
remove particular entries by ticking them and clicking the 'Remove Selected' button. Again, anything you
remove from here will be stored in the Backups section of RegCleaner.

New File: New Files are the file types listed when you right-click somewhere like the Desktop, and under the
New context menu you can see a list of new files you can create. Remove the entries in this section that you
don't want to appear in the New Files context menu. As usual, anything you remove from here will be stored
in the Backups section of RegCleaner.

RegCleaner has several other functions which are more advanced, but as you can already see it is a very
powerful Registry editing and cleaning tool which is much easier - and safer - to use than the Windows
Registry Editor, and is completely free. This is one of the reasons why I recommend you install it even if you
use RegSupreme: ideally you should use the registry cleaner function in RegSupreme, and the registry
editing functions in RegCleaner together - they won't conflict with each other.

Should you run into a problem with any of your programs after using RegSupreme or RegCleaner simply
reinstall the particular program or driver that is giving you problems and the relevant registry entries will be
recreated. Clearly there was something wrong with the original installation of that particular application, so
a full reinstall is a good opportunity to prevent any potential problems down the path.

B COMPACTING THE REGISTRY

NTREGOPT

After cleaning the registry, and before we enter into any registry editing, there is a utility called NTRegOpt
that you should use to optimize the size and layout of the Windows Registry. If you have installed Erunt
then you will have already installed NTRegOpt. If not, or you're not sure, download it from the link above
and install it. Then run the NTRegOpt.exe file to start the program and click OK to begin the optimization
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procedure. It may take some time, so be patient. You will have to reboot for the optimization procedure to
complete. This process compacts your registry, further improving Windows startup times and memory
usage among other things.

B REGISTRY EDITOR

To access the Windows Registry Editor, go to Start>Run and type "Regedit" (without quotes) then press
Enter. You can also access the registry editor by typing "Regedt32" instead of Regedit, but Regedt32 is a
small program that simply runs Regedit anyway, so there is no difference between the two methods. For our
purposes, the main reason for editing the registry is to alter settings that cannot otherwise be changed using
the normal Windows interface. However the Registry Editor is not the only way to make changes to the
registry. You can also use a range of utilities like RegCleaner or TweakUI to change important settings in the
registry and undertake the majority of the performance and visual-enhancing tweaks in this guide. So if you
feel uncomfortable using the Registry Editor, you don't have to use it - there are other tools available which
provide a user-friendly interface and the safety of backups.

However learning to use the Registry Editor is important because it is a powerful tool, and unlike any other
utility designed to edit the registry, using Registry Editor provides the most direct access to the entire
Windows Registry and ensures that you are aware of precisely what has been changed each time, and where
it originally resides should you need to change it back. And of course there are still a few tweaks in this
guide (and others) that can only be done using the Registry Editor. I recommend you take the time to learn
more about using this important tool.

To use the Registry Editor correctly, open it and you will see what looks like a directory listing under 'My
Computer', with five folders starting with 'HKEY_' (e.g. HKEY_ CURRENT_USER). Under these Root Keys are
a series of sub-folders called Keys. Within each key there is at least one Value called (Default), visible in
the right pane of the Registry Editor window when you click on the key name. Typically there are several
other values underneath the Default entry. These values can be of several types, including STRING,
DWORD and BINARY values.

The most common form of registry editing involves changing the contents of values, or adding new values
under certain keys. Note that in this guide the key name and location is provided in square brackets [ ], and
the name of the value to be edited is shown underneath. The data to be entered into the value is given after
the '=" equals sign.

EDITING EXISTING ENTRIES

To edit an existing Registry entry using the details provided throughout this guide, follow the example
below to see the correct procedure:

[HKEY LOCAL MACHINE\SOFTWARE\Policies\Microsoft\Messenger\Client]

PreventRun=1
The text above indicates that to make this registry change, you should open Registry Editor and then:

1. Double-click on the HKEY LOCAL MACHINE root key (or click the '+' sign next to it) in the left pane of the
registry editor window. This will show every key sitting directly under it.

2. Next, you must open the SOFTWARE key, and so forth until you arrive at the C1ient key underneath.

3. At this point highlight the Client key by left clicking on it once, and in the right pane of the Registry
Editor window, look for a value called PreventRun.

4. Double-click on PreventRun and in the box that opens, click in the Value box, delete the current
number there, and enter a '1' instead.

5. Then click OK and the change has been saved — you can now close Registry Editor if you wish.
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CREATING NEW REGISTRY ENTRIES

You may need to create a new key or value as it does not exist by default in your registry. To create a new
entry from scratch correctly, follow this procedure:

1. Go to the particular area where you have been instructed to create the key.

Make sure you highlight the key name of the particular key under which the new entry is to be created.
If the new entry is a key, then right-click on the name of the key under which it must be created in the
left pane, and select New. If the new entry is a value, skip to step 4 below.

3. Enter the name for the new key and press Enter. It should now sit as a folder in the tree listing
underneath the key it was intended for.

4. If the new entry is a value, left-click on the name of the key under which it must be created, then in an
empty area in the right pane, right-click the mouse and select New, then choose the type of value it will
be (i.e. String, DWORD or Boolean). Enter the name for the new value and press Enter. Double-click on
the new value, and enter the data for the new value as recommended.

A more detailed guide to editing the Registry is in this Microsoft Article.

BACKING UP PORTIONS OF THE REGISTRY

The registry is an important component of Windows and it is crucial for you to understand that the Registry
Editor does not have an 'Undo’ function. Hence the best course of action prior to using the Registry Editor to
alter any part of the registry is to back up your important data and settings, as well as your entire Registry
(See the Backup & Recovery section for details). A more specific precaution is to make a backup of the
particular registry key(s) you are about to edit, especially if you don't feel confident about making the
change, or aren't sure how the change will impact on your system. That way if anything goes wrong you
don't have to go through a lengthy System Restore process — you can restore the individual key(s) that you
have changed quickly and easily. The steps to backing up a specific registry key are as follows:

1. In the left pane of the Registry Editor window, right-click on the name of the key that holds the settings
you wish to edit.

2. Select the Export option, and choose a suitably descriptive name and appropriate location for the file.
Make sure that the 'Selected Branch' option is ticked, so that only the particular key and all its sub-
components are saved, not the entire registry. The file will be saved with a .REG extension.

3. Once the relevant section of the registry has been saved, you can go ahead and edit the registry entries
underneath the key you've just saved.

RESTORING SECTIONS OF THE REGISTRY

If you experience any undesirable behavior after your registry changes - and remember that some registry
changes require a reboot before their effects can be seen - then you can restore the backup of your registry
keys by going to the place where you saved them, and double-clicking on the relevant .REG file. This will
overwrite the existing sections of the registry with the backed up versions, effectively undoing your changes
quickly and easily.

If you don't feel comfortable with the above method, or if you want to backup the entire Registry, see the
Backup & Recovery section for more details on the Erunt utility that automates this process.

B REGISTRY TWEAKS

Having learned how to edit the registry, you can now use a range of tweaks to optimize your system and
perform some changes to customize the appearance and functionality of Windows XP. While the majority of
registry tweaks are covered in this section, some which are specific to particular areas of Windows or
utilities are covered in their relevant sections elsewhere in this guide. For example, registry tweaks relating
to Internet Explorer are covered in the Internet Explorer section. Remember, most of the important tweaks
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can be performed with the tweaking utilities covered elsewhere in this guide, not just the Registry Editor.
Also note that some of these tweaks will require a reboot before they come into effect.

Below are a range of miscellaneous performance and convenience tweaks - implement the ones you want to
use. My recommended values are provided for the performance-related tweaks:

IMPROVE MENU RESPONSIVENESS AND SHUTDOWN SPEEDS

The following tweaks improve the responsiveness of Windows. The values shown for each are the
recommended values for your system. If you don't feel comfortable making these changes, use Cacheman
instead (See the Memory Optimization section).

[HKEY CURRENT USER\Control Panel\Desktop]

HungAppTimeout=4000

This STRING controls the delay before a hung application is allowed to terminate (each 1000 =1 sec).
WaitToKillAppTimeout=4000

This STRING controls the delay before windows finally starts to shutdown (each 1000 =1 sec)
MenuShowDelay=20

This STRING controls the delay before a menu or sub-menu pops open (each 1000 =1 sec)

AutoEndTasks=1
If enabled this STRING automatically closes all running applications when Windows shuts down.

INCREASE NTFS SYSTEM PERFORMANCE

These tweaks improve the performance of Windows systems that use the NTFS File System. See the
Installing Windows section for more details of NTES. If the following entries don't exist, create them and
assign the recommended values shown:

[HKEY LOCAL_ MACHINE\SYSTEM\CurrentControlSet\Control\FileSystem]

NTFSDisablelastAccessUpdate=1

This DWORD disables the constant updating of dates a file/folder was last accessed if set to 1. Using this
tweak can improve disk performance, but if recording file access times are important to you, you should not
undertake this tweak. This is particularly true for applications like third party disk defragmenters which
may prioritise file fragments based on file access times.

NTFSDisable8Dot3NameCreation=1

This DWORD disables support for old MSDOS 8-character filenames if set to 1. Note that if you disable this
setting, you may have problems installing some Norton programs. After you have installed and configured
all your Norton programs and rebooted your system, you can then disable this setting if you so wish.

PREVENT MSN MESSENGER FROM RUNNING

If you don't use the Windows MSN Messenger utility and want to prevent it from running - e.g. when it is
launched automatically by certain applications - then implement these changes to your Registry.
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[HKEY LOCAL_ MACHINE\SOFTWARE\Policies\Microsoft\Messenger\Client]

PreventRun=1
This DWORD will prevent MSN Messenger from running if set to 1.
PreventAutoRun=1

This DWORD will prevent MSN Messenger from popping up automatically if set to 1.

TURN OFF CD AUTOPLAY

By default Windows XP will automatically detect the presence of any CDs or DVDs inserted into CD/DVD
drives on your system. As soon as such disks are detected, any applications, audio or movies files on these
disks will automatically be launched. This Autoplay functionality can be annoying to some, and can also
lead to unwanted software being automatically installed (such as Rootkits - see the PC Security section). To
disable Autoplay functionality, make the following change:

[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\CDRom]

Autorun=0

Setting this DWORD to 0 disables Autoplay, setting it to 1 enables Autoplay. Note you can also temporarily
disable Autoplay behavior at any time simply by holding down the SHIFT key while inserting a CD or DVD.

TURN OFF WINDOWS XP BUILT-IN CD BURNING

Windows XP has a basic form of CD burning which although adequate is not good enough to replace the
functions of a dedicated burning package like the recommended Nero Burning ROM. If you are using a
third-party burning package you can disable the built-in XP burning functionality by doing the following;:

[HKEY CURRENT USER\Software\Microsoft\Windows\CurrentVersion\Policies\Explorer]

NoCDBurning=1

This DWORD disables the built-in Windows burning functionality if set to 1, but still allows other burning
software to work.
CHANGE THUMBNAIL QUALITY & SIZE

Whenever you view a folder with pictures in it, by default Windows will show the contents in Thumbnails
view. To change the size and quality of these thumbnails use this tweak:

[HKEY CURRENT USER\Software\Microsoft\Windows\CurrentVersion\Explorer]
ThumbnailQuality=50
To alter the quality of thumbnailed pictures displayed in Windows XP folders, enter a DWORD value in

Decimal view between 50 and 100. The larger the value, the better the thumbnail image but the slower the
thumbnailed images will load up.

ThumbnailSize=32

To alter the size of thumbnailed pictures displayed in Windows XP folders, enter a DWORD value in
Decimal view between 32 and 256. The larger the value, the larger the thumbnail but the slower the
thumbnailed images will load up.
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DISABLE THUMBNAIL CACHE

When displaying folder contents in Thumbnails view, Windows creates caches of thumbnailed images,
usually saved in files called Thumbs.db in each folder that has been viewed in Thumbnails view at any point.
Thumbnail caching helps speed up repeated viewing of these folders in Thumbnails view, but you can
disable thumbnail caching by doing the following:

[HKEY CURRENT USER\Software\Microsoft\Windows\CurrentVersion\Explorer\Advanced]

DisableThumbnailCache=0

Set this DWORD to 1 to disable thumbnail caching, or set it to 0 to enable thumbnail caching. If you disable
thumbnail caching you should also go to Windows Search and find and delete every instance of the file
Thumbs.db on your system as they are no longer necessary.

TURN OFF 'LOW DISK SPACE' NOTIFICATION

Once the free space on your hard drive falls below a certain percentage Windows XP will give you a 'Low
Disk Space' notification. To disable this, implement this tweak:

[HKEY CURRENT USER\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies\Explorer]
NoLowDiskSpaceChecks=1

Set this DWORD to 1 to turn off the notification altogether, which is recommended.

DISABLE BALLOON TIPS

Balloon Tips are the small yellow pop-ups that appear throughout Windows informing you of various facts
or functions. To disable these, implement this tweak:

[HKEY CURRENT USER\Software\Microsoft\Windows\CurrentVersion\Explorer\Advanced]

EnableBalloonTips=0
Setting this DWORD to a value of 0 turns off the balloon tips.

TURN OFF SYSTEM BEEPS

By default Windows XP makes beeping noises under certain situations, regardless of your Windows sound
settings. To alter this behavior, go to the following Registry entry:

[HKEY CURRENT USER\Control Panel\Sound]

Beep=Yes

Set this STRING to No to disable any system beeps that occur during Windows usage. Note that to disable
other Windows event-based sounds you will still need to go into Control Panel>Sounds and Audio Devices
(See Sounds & Audio Devices under the Control Panel section).

DISABLE WINDOWS KEY

If you want to disable the Windows Keys on your keyboard, perhaps because they are interfering in a game
you are playing, use this tweak:

[HKEY LOCAL_ MACHINE\SYSTEM\CurrentControlSet\Control\Keyboard Layout]

Scancode Map=
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Under the Keyboard Layout key (not Keyboard Layouts) create a new BINARY value called Scancode
Map and then double-click on it and click once in the top right hand side of the value data box and manually
type in the following values in the exact order as shown (note all the 0's are zeros, and no spaces are
necessary):

00 00 00 OO 00 OO OO OO O3 00 OO 00 OO 0O 5B EO 00 0O 5C EO 00 00 00 OO

You will need to reboot for this change to come into effect. If you want to reverse this tweak, delete the
above key and reboot.

CHANGE FOREGROUND APPLICATION PRIORITY

For users who usually run one major application or game at a time on their machine, you can set Windows
XP to give even higher priority in allocating resources to such 'foreground applications'. Follow the tweak
below to implement the change:

[HKEY LOCAL MACHINE\SYSTEM\CurrentControlSet\Control\PriorityControl]

Win32PriorityControl=38

Create a new DWORD called Win32PriorityControl and allocate a value of 38 to it in Decimal view.

That's just a small number of what I believe are the more useful registry tweaks. If you're in the mood for
more Registry tweaking, a large range of Windows Registry tweaks can be found in this Registry Tweaks for
XP Page. Note that some of them may not work correctly on Windows XP SP2, so please backup before
using any of them. I don't recommend implementing a large number of Registry tweaks at once, as this
makes troubleshooting difficult in the future. Select the ones that you feel are the most necessary for
performance and convenience sake, implement them and reboot. If your system remains stable and trouble-

free, implement a few new ones at a time, and repeat the process. Remember, there is no 'undo' for the
Registry Editor, so take the appropriate backup precautions as spelt out earlier.
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GROUP POLICY

The Group Policy editor is an Administrative Tool designed primarily for network administrators to alter
the way in which Windows XP behaves for groups of users on their network (See Administrative Tools
under the Control Panel section). It is only available in Windows XP Professional and not Windows XP
Home, but fortunately for Windows XP Home users the majority of the tweaks covered in this section can be
performed using other utilities, such as TweakUI. To access the Group Policy setting, go to Start>Run and
type "gpedit.msc" (without quotes) and press Enter. This will open the Group Policy editor, which shows
two main branches: 'Computer Configuration' and 'User Configuration'. Changes made under the 'User
Configuration' sections only affect the current user, while changes made under the 'Computer Configuration'
section apply to the entire machine and affect all users on that machine.

B GROUP EDITOR TWEAKS

Below are a range of tweaks that you can apply through the Group Policy editor. To change a setting, go to
the sub-folder shown and double-click on the setting in the right pane and then choose Enabled, Disabled or
'Not Configured' as required then click Apply. My recommended settings for each are provided in brackets,
however you should first click once on the setting you wish to change and in the Extended view you can see
a brief description of the setting to the left of it. If in doubt, do not change a setting - leave it at its default.

DISABLE SYSTEM RESTORE

Folder: Computer Configuration\ Administrative Templates\System \ System Restore\
Setting: Turn Off System Restore (Leave at default)

TURN OFF BUILT-IN XP CD BURNING

Folder: User Configuration\ Administrative Templates\ Windows Components\ Windows Explorer\

Setting: Remove CD Burning Features (Enabled)

Note: Still allows third party burning software such as Nero Burning ROM to work without problems.
PREVENT WINDOWS MEDIA DIGITAL RIGHTS MANAGEMENT FROM
INTERNET ACCESS

Folder: Computer Configuration\Administrative Templates\Windows Components\Windows Media
Digital Rights Management
Setting: Prevent Windows Media DRM Internet Access (Enabled)

REMOVE 'SHARED DOCUMENTS' FOLDER

Folder: User Configuration\ Administrative Templates\ Windows Components\ Windows Explorer\
Setting: Remove Shared Documents from My Computer (Enabled)

REMOVE SHUTDOWN/LOGOFF/RESTART MESSAGES

Folder: Computer Configuration\ Administrative Templates\System\
Setting: Remove boot /Shutdown /Logon / Logoff messages (Leave at default)

TURN OFF USER TRACKING (WILL ALSO DISABLE PERSONALIZED MENUS)

Folder: User Configuration\ Administrative Templates\ Start Menu and Taskbar\
Setting: Turn off user tracking (Enabled)
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PREVENT ACCESS TO WINDOWS COMPONENTS

Folder: User Configuration\ Administrative Templates\System\
Setting: Don't run specified Windows applications

Note: You can also prevent users from accessing the Registry Editor and Command Prompt in this folder.

TURN OFF CD/DVD AUTOPLAY
Folder: Computer Configuration\ Administrative Templates\ System\
Setting: Turn off Autoplay (Enabled)
DISABLE INTERNET EXPLORER SPLASHSCREEN
Folder: Computer Configuration\ Administrative Templates\ Windows Components\ Internet Explorer\
Setting: Disable Showing the Splash Screen (Enabled)
DISABLE WINDOWS MESSENGER

Folder: Computer Configuration\ Administrative Templates\ Windows Components\ Windows Messenger\
Setting: (Set both to Enabled)

Note: see the Registry Editor and Outlook Express sections for more details on how to turn off Messenger
and fix the associated 'Outlook Express slowdown' issue.

CUSTOMIZE INTERNET EXPLORER APPEARANCE
Folder: User Configuration\ Windows settings\ Internet Explorer Maintenance \ Browser User Interface\
Setting: (Personalize as desired)

REMOVE RECYCLE BIN ICON FROM DESKTOP

Folder: User configuration\ Administrative Templates\ Desktop\
Setting: Remove Recycle Bin icon from Desktop (Leave at default)

REMOVE MY DOCUMENTS ICON FROM DESKTOP

Folder: User configuration\ Administrative Templates\ Desktop\
Setting: Remove My Documents icon from Desktop (Enabled)

REMOVE MY COMPUTER ICON FROM DESKTOP

Folder: User configuration\ Administrative Templates\ Desktop\
Setting: Remove My Computer icon from Desktop (Leave at default)

Note: Use this tweak with caution as enabling it can cause a great many problems.

There are a range of other Group Policy tweaks you can undertake, so have a look through the other areas of
the Group Policy editor and see if there is anything you would like to change. However be very careful to
remember precisely what you have changed, because when troubleshooting problems people tend to forget
the changes they implemented in Group Policy and spend a great deal of time checking elsewhere, especially
since you can perform these tweaks in a variety of places.
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TWEAKUI

TweakUI is a free Microsoft utility that provides a convenient tweaking User Interface (UI) for safely
customizing many of Windows XP's hidden settings. It is easy to use and includes helpful instructions on
what the various settings do. If you don't feel confident in using the Registry Editor to make certain changes
for example, TweakUI allows you to change many of the same settings in a relatively foolproof way. To
access TweakUI, first download it from the Microsoft PowerToys site, then install it and launch it. To
navigate to the various areas of TweakUI, click once on the name of the section (e.g. General), and in the
right pane tick or untick the appropriate settings and then make sure to click the Apply button for every
section or sub-section you change. The effects of most changes will be visible immediately.

B CONFIGURATION ADVICE

TweakUI covers a large number of settings, and as such I can't possibly cover them all here. Below are a
selection of the more significant settings which I recommend people change in order to improve general
performance and functionality. These changes should be safe for almost every system, but obviously you can
undo them by reversing the changes in TweakUI should they not suit you.

GENERAL
Tick 'Optimize hard disk when idle'

GENERAL>FOCUS

Tick 'Prevent applications from stealing focus'

EXPLORER

Tick 'Detect accidental double-clicks'
Untick 'Maintain network history'
Untick 'Show Links on Favorites menu'
Tick 'Use intuitive filename sorting'

EXPLORER>SHORTCUT

Select None to remove the shortcut arrows from shortcuts

EXPLORER>THUMBNAILS

Move the slider to the far left for Image Quality
Select the smallest value (32) for Thumbnail size

EXPLORER>CUSTOMIZATIONS

To conserve memory use a relatively low setting like 200 folders

MY COMPUTER>AUTOPLAY>TYPES

To disable the Autoplay functionality of your drive(s), untick 'Enable Autoplay for CD and DVD Drives'.
Some malicious software such as Rootkits can be prevented from installing by turning off Autoplay (See PC
Security section).

TASKBAR AND START MENU

Untick 'Enable balloon tips'
Untick 'Warn when low on disk space'
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CONTROL PANEL

Untick all the Control Panel components you never use, or which are installed by third party programs and
are unnecessary. Note that this only removes their icons from the Control Panel and not the programs
themselves, and doesn't affect that program's functionality in any way. I recommend you do this tweak after
you have adjusted all the settings in the Control Panel (See the Control Panel section).

You should customize the remaining settings as you see fit.

Although TweakUI is very safe to use, don't change everything all at once, and don't change settings that
you are unclear about. If anything goes wrong, it may be difficult for you to figure out which change in
TweakUI is causing the problem, or has removed the functionality you want. Take it slow and change a few
things at a time, and if in doubt you shouldn't change something. Also have a look at the other XP PowerToy
utilities on the PowerToys site, as some of them are very useful.
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WINDOWS EXPLORER

Windows Explorer is the primary interface for manipulating files and directories in Windows XP. This
section covers many of the tweaks, customizations and useful tricks relevant to Explorer that you can
undertake. Importantly, there are many settings you can alter in Folder Options that have a direct impact on
what you can see when in Windows Explorer. These are covered under Folder Options in the Control Panel
section, so make sure you use the recommended settings there for maximum performance and functionality.
For example, by making sure that file extensions and system files aren't hidden in Folder Options, you will
be able to see these files in Explorer and perform some of the tweaks in this guide, as well as making general
troubleshooting easier. Below are a range of tweaks, tips and tricks for Windows Explorer:

SET EXPLORER'S DEFAULT STARTUP FOLDER

If you usually open Explorer from a shortcut, this tweak allows you to set which directory it will start in by
default when launched from that shortcut:

1. Right-click on the shortcut icon you use to launch Explorer and select Properties.
In the Target box replace the existing text with the following:

%SystemRoot% \ Explorer.exe /e, path
3. In place of path above you should enter the actual path to the directory you want open by default. For
example C:\ Windows or C:\ Documents and Settings etc. The path doesn't require quote marks around it.

4. Click OK, and now using this shortcut will open a Windows Explorer window in the directory specified.

Note that there are several other switches and options you can use in the Properties box to further customize
Explorer's default view as detailed in this Microsoft Article.

SPEED UP EXPLORER

The following tweak can improve the response time of Windows Explorer (and also Internet Explorer). Go to
the following key in the Windows Registry:

[HKEY LOCAL_ MACHINE\Software\Microsoft\Windows\CurrentVersion\Explorer\RemoteCom
puter\]

NameSpace

To prevent Windows Explorer from searching for remote scheduled tasks, under the Namespace key in the
left pane find the {D6277990-4C6A-11CF-8D87-00AA0060F5BF} key, right-click on it and select Delete
to remove it. To also prevent Explorer from searching for remote shared printers, delete the {2227A280-
3AEA-1069-A2DE-08002B30309D} key as well. This will speed up the time it takes for Explorer to open
and navigate. If you are connected to a network of computers do not undertake this tweak.

REMOVE 'SHARED DOCUMENTS' FROM MY COMPUTER

If you want to remove the 'Shared Documents' folders under My Computer use this tweak:

[HKEY LOCAL MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Explorer\MyCompute
r\NameSpace\DelegateFolders]

{59031a47-3f72-44a7-89c5-5595fe6b30ee}

Delete the key above by right-clicking on it in the left pane and selecting Delete. This will remove all the
superfluous 'Shared Documents' folders permanently.
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FORCE ALL COLUMNS IN EXPLORER TO BE VISIBLE

Sometimes when you open Windows Explorer or Explorer-based interfaces (and there are many, such as the
Registry Editor) there may be columns that are much too wide or narrow to show everything they contain.
To instantly force Windows to resize these columns appropriately press the CTRL key and the + (plus) key
together. This will instantly resize all columns so that even the largest value in each column is visible. This
may require you to expand the surrounding window or use the bottom scroll bar to see them all, but at least
there won't be any hidden or overly wide or thin columns. See the Visual and Convenience section for more
handy keyboard shortcuts.

RENAME MULTIPLE FILES

If you have a large number of files you want to rename, you can do it rapidly by doing the following;:

1. Highlight the group of files you want to rename in Windows Explorer. You can do this two ways:
* Hold down the SHIFT key and click on the first file in the group, then while still holding down shift,
click on the last file in the group and everything in between will also be highlighted.
» Hold down the CTRL key and click on any individual files you want to select until all the files you
want to select are highlighted.
You can also combine the two methods, i.e. SHIFT select a range of files, then use CTRL to remove or
add individual files to the highlighted ones.
2. Without clicking anywhere else, right-click on the first file you want to rename, and select Rename.
3. Enter a name for the file and press Enter.

Now all the remaining highlighted files will be renamed with the same name you gave the first file, however
they will also have a number in brackets after them. For example, if I rename the first in a series of files
Screen.jpg using this method, the remaining highlighted files will be renamed Screen (1).jpg, Screen (2).jpg, etc.

EDIT CONTEXT MENUS

Many programs insist on becoming a part of your context menus. A context menu is the little menu which
pops up when you right-click on a file, folder or icon for example, whether in Explorer-based views or on
your Desktop. Many of the entries in the context menu have been unnecessarily put there by programs you
have installed. The first step to getting rid of these excess entries involves opening the programs in question
and looking through their options to see if you can unselect any 'shell integration' or 'context menu' options
they have. If that fails, you can manually remove these entries by opening Registry Editor and following
these steps:

1. Before making any of these changes you should ideally have a full System Restore Point already, but
more specifically back up the registry keys which will be affected in this tweak (See the Windows
Registry section for details). The keys involved in this tweak are:

[HKEY CLASSES ROOT\ *]

[HKEY CLASSES ROOT\Directory]
[HKEY CLASSES ROOT\Drive]
[HKEY CLASSES ROOT\Folder]

2. Now, go to the following sub-folders and delete references to programs you know have set up offending
context menu entries. For example, on my system under:

[HKEY CLASSES_ROOT\*\shellex\ContextMenuHandlers]

I found the key Symantec.Norton.Antivirus.IEContextMenu that is a Norton Antivirus context
menu entry. I have no use for this so I deleted it.
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3. Below are all the places you should look in for any such entries:

[HKEY_CLASSES_ROOT\*\OpenWithLiSt]

[HKEY CLASSES ROOT\*\shellex\ContextMenuHandlers]

[HKEY CLASSES ROOT\Directory\shell]

[HKEY CLASSES_ROOT\Directory\shellex\ContextMenuHandlers]
[HKEY CLASSES ROOT\Drive\shell]

[HKEY CLASSES ROOT\Drive\shellex\ContextMenuHandlers]
[HKEY_CLASSES_ROOT\Folder\Shell]

[HKEY CLASSES ROOT\Folder\shellex\ContextMenuHandlers]

4. Asyou're removing all the unwanted program entries, you can test the effects immediately by checking
to see if the relevant entry was removed from the context menu. When you're done, you should see the
context menus devoid of the added rubbish.

Note: if any of the programs whose context menu entries you've edited or removed start displaying strange
behavior, or you accidentally deleted the wrong entry, restore the registry entries you backed up previously,
or just uninstall and reinstall that particular program. As long as you only delete program entries and none
of the default Windows entries, all the normal context menu items will still remain.

ADD 'COPY TO' AND 'MOVE TO' COMMANDS TO CONTEXT MENUS

If you want to add two useful commands to your context menus - namely 'Copy To' and ‘Move To', use the
tweak below:

[HKEY CLASSES ROOT\AllFileSystemObjects\shellex\ContextMenuHandlers]

Copy To={C2FBB630-2971-11d1-A18C-00C04FD75D13
Move To={C2FBB631-2971-11d1-A18C-00C04FD75D13

Create two new keys under the ContextMenuHandlers folder - that is, right-click on
ContextMenuHandlers and select New>Key twice and name them 'Copy To' and 'Move To' (without
quotes). Then left-click once on each folder, go to the right pane in Registry Editor and double-click on the
(Default) entry and assign the appropriate values shown above. This will create two new context menu
entries that allow you to right-click on files and either 'Copy To Folder' or 'Move To Folder' them to other
locations.

CONTEXT MENU EDITORS

Rather than manually editing the Registry, if you want to delete the main context menu entries, you can use
the free Context Menu Editor utility. If you want to add your own context menu folders and items, try
CMenu, a free context menu management utility.

FOLDER VIEWS NOT BEING SAVED

Sometimes when you change the way a folder's contents look, or its position on your Desktop, or the size of
the window it opens in, after a reboot the changes don't seem to have been saved. The first thing to do is go
to Control Panel>Folder Options and under the View tab make sure that 'Remember each folder's view
settings' is ticked. However even with this setting ticked you may inevitably end up with unsaved settings.
This can be due to corrupted registry entries brought on by a bad shutdown for example. The easiest way to
fix this problem is to open the Registry Editor and go to the following keys:

[HKEY CURRENT USER\Software\Microsoft\Windows\ShellNoRoam\BagMRU]
[HKEY CURRENT USER\Software\Microsoft\Windows\ShellNoRoam\Bags]

Right-click on each key (i.e. BagMRU and Bags) and select Delete to get rid of both of them. Reboot your PC
and open up each folder or window you want to customize. They will be back at their default appearance,
and you will need to adjust again them to suit your tastes. However this time after you reboot your PC the
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view settings should be exactly as you set them prior to the reboot. By deleting the registry entries above
Windows is forced to recreate them and in doing so get rid of corrupted entries. If you find you have to do
this very often, then see the tips throughout this guide for stabilizing your system. This is a clear sign that
your system is not completely stable, and is not normal behavior for Windows.

REPAIR INCORRECTLY DISPLAYED ICONS

By default Windows stores a range of commonly used icons in a cache to speed up their display on the
Windows Desktop for example. If you are experiencing problems with your icons displaying incorrectly, go
to your \Documents and Settings\[Username]\Local Settings\ Application Data\ directory and delete the file
IconCache.db. Reboot Windows and this file will be recreated afresh, resolving any icon incorrectly displayed.
Also see the Memory Optimization section for details of how to set the size of the Icon Cache.

MOVE THE MY DOCUMENTS FOLDER

By default the 'My Documents' folder is in a specified location, and moving it manually will not work. To
move the My Documents folder to another location, you must do the following;:

1. Click on Start, go to My Documents and right-click on it, then select Properties. Alternatively in
Windows Explorer find the My Documents folder under your \Documents and Settings\[Username]\
directory, right-click on it and select Properties.

2. Click the Move button and select a new location, then click OK.

3. Choose whether you wish to move your existing documents across to this location.

Alternatively you can just type the new path in the Target box. When you're done, Windows will now
recognize the new location as the home of My Documents. Note that you can also change the name of My
Documents to something else if you wish, such as simply 'Documents'.

MAKE THE MY DOCUMENTS FOLDER PRIVATE

If you want to password protect your My Documents folder, or in fact any folder which is unique to your
user account (such as My Photos, Favorites, Desktop, Start Menu), and you're using the NTFS file system,
you can do the following: Right-click on the folder in Explorer, select the Sharing tab and tick the 'Make this
folder private' box. Now the folder and all its subdirectories will be password protected with your user
password. If you're logged in as the Administrator, or you have not set a user password (for quicker logon to
Windows), this tweak won't do anything. If you try it, you'll be prompted to set a password, and unless
you're worried about others accessing your private folders, I do not recommend setting a password. Also see
the PC Security section for more details on how to protect files and folders using Windows Encryption.

DISABLE WINDOWS FILE PROTECTION

By default Windows XP protects a range of important system files from accidental deletion. This tweak
allows you to remove that protection - I strongly recommend against using it though:

[HKEY LOCAL_ MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Winlogon]

SFCDisable=0

Setting this DWORD to 1 will allow you to view, alter and delete protected system files. This is not
recommended as these system files are protected for a reason - to specifically prevent harmful changes or
deletions to core system files that can destabilize your system. Note you need to untick the 'Hide protected
operating system files' option under Control Panel>Folder Options>View to be able to see protected files in
Windows Explorer.
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CHANGE DEFAULT LOCATION FOR PROGRAMS AND COMMON FILES

To change the default location for the Program Files and/or Common Files folders, open Registry Editor and
go to the following key:

[HKEY LOCAL_ MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion]

ProgramFilesDir=C:\Program Files

Change this STRING entry to another path if you want to change where Windows points to by default when
installing new programs.

CommonFilesDir=C:\Program Files\Common Files

Change this STRING entry to another path if you want to change where Windows points to by default when
installing common files for programs.

Reboot Windows to bring the changes into effect. Keep in mind that using this tweak may result in problems

with existing installed programs and file associations, as well as running Windows Update. You may have to
manually move some of the existing program folders to the new location for them to work correctly.

That concludes the Windows Explorer section.
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INTERNET EXPLORER

Internet Explorer (IE) is the most popular Internet browser in the world today. Although it may not always
be the most efficient or most secure browser available, many Windows users are extremely comfortable and
familiar with Internet Explorer, and also know that it is the one browser upon which all Internet content will
display as intended. Even if you use an alternate browser as your main browser, you will need to use
Internet Explorer from time to time because certain websites will not display or function properly on other
browsers. The best example of this is Microsoft's own Windows Update website which is only fully
functional and secure when viewed with Internet Explorer.

While I recommend that you begin trialing alternatives to Internet Explorer (See Other Internet Browsers
further below), Internet Explorer is a fast, efficient browser, and you should not feel you have to use another
browser if you are happy with IE. This section deals with the best way to set up Internet Explorer so that you
retain both functionality and security as well as performance.

B INTERNET EXPLORER 6 & 7

Even though Internet Explorer 7 is no longer a beta product and is the latest official version of IE - and all
users are advised to upgrade to it - instructions are provided here for both Internet Explorer 6 and 7, since
many users are still using IE6. Much of the advice below applies to both versions, however where
information is specific to IE7 I have denoted it separately in bold. If you wish to have both versions on your
PC at the same time, try the instructions here to use IE7 separately without having to install it over IE6.

B CONFIGURATION ADVICE

Open Internet Explorer, go to the Tools menu and select 'Internet Options' — note this is the same as if you go
to Control Panel and choose 'Internet Options'. Below are my recommendations for the important settings
under each tab of Internet Options in Internet Explorer:

GENERAL

Under the 'Home Page' section, you can set the page that opens by default whenever you start Internet
Explorer. If you don't want any homepage to start when IE is opened, click the 'Use Blank' button. If you
want to set the website you are currently viewing as your homepage, click the 'Use Current' button. If the
home page will not change and remains stuck on an undesirable page, see the PC Security section.

Under the' Temporary Internet Files' section (Browsing History in IE7) select the Settings button. Under the
'Check for newer versions of stored pages' section select 'Automatically'. This will decrease loading times but
does not guarantee that you always see the very latest content on the sites you visit. If at any time you want
to see the latest version of a page regardless of your settings here, press CTRL + F5 when in Internet Explorer
and the page will be forced to reload with the latest information available.

I recommend assigning 80MB of disk space for the Temporary Internet Files folder. This cache will help
speed up your browsing by storing major portions of web pages (such as graphics and flash animations) on
your hard drive. A cache which is much too large, aside from taking up more disk space, may actually end
up making site loading slower because IE has to search through it for existing entries, while one which is too
small will not greatly help in speeding up browsing.

Under the History section, select the number of days you want a record of your visited sites to be kept. If
you don't want a history of visited sites to be kept at all, click the 'Clear History' button and set Days to 0.

IE7 - Search: Internet Explorer 7 allows you to select which search engine you use when entering search text
in the Search box available in IE7's toolbar. Google is the recommended and default setting here. If you want
to add another search engine, click the Find more providers link at the bottom.
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IE7 - Tabs: Internet Explorer 7 adds Tabbed Browsing functionality. New web pages and popups can be
opened as tabbed pages within the current browser window, rather than opening a new browser window for
each new page. You can enable or disable this functionality here, and control how new windows appear
using such functionality. In general I recommend enabling tabbed browsing and setting all new windows to
open as tabs, as aside from the convenience this also reduces memory usage - new tabs use less memory than
new incidences of IE browser windows.

SECURITY

I recommend the Medium-high level of security. Any higher is up to you, but bear in mind this will prevent
some websites from functioning as designed. This can be a good thing if the website is harmful or annoying,
but as many websites have genuinely useful interactive content which may be blocked by higher settings,
this can be a bad thing. If you want to be more selective, click the Custom Level button and manually select
each security function. For security purposes it is strongly recommended that you upgrade to IE7 as it has
more robust Security Features.

PRIVACY

I recommend the 'Medium High' level for the best security/functionality compromise here. To be even more
selective, click the Advanced button and tick 'Override automatic cookie handling'. Third-party Cookies can
be Blocked without any major issues, as these are usually from advertisers. First-party Cookies on the other
hand can be useful (e.g. for holding login details for forums, or recording visual settings for particular sites),
and blocking them can impair a site's functionality. If you do decide to block all first party cookies, click the
Edit button under the Websites area. This will allow you to block or allow specific website's cookies. For
example, if you set a High or Very High privacy setting this will block almost all cookies, but you can still
allow specific sites' cookies (such as those of TweakGuides.com) by adding it to the list of allowed sites.

As of Windows XP SP2 this section of the Internet Explorer options has a 'Pop-up Blocker' section. If you tick
the 'Block pop-ups' box, the built-in pop-up blocker becomes enabled. Pop-ups are browser windows that
are launched without your permission, 'popping up' in various locations and in various sizes. Enabling the
pop-up blocker is highly recommended to prevent them. Click the Settings button to make adjustments to
the pop-up blocker. Under the 'Notifications and Filter Level' section at the bottom I recommend unticking
both 'Play a sound when a pop-up is blocked' and 'Show Information Bar when a pop-up is blocked' as these
can get very annoying if left enabled. Under the 'Filter Level' I recommend the Medium level so that most
ad-related pop-ups are blocked, however legitimate pop-ups should be shown.

In fact regardless of your Filter Level settings, the best way to guarantee that pop-ups are shown for the sites
which you know have legitimate pop-ups is to enter their address in the 'Address of Web site to allow' box,
and then click the Add button. This will add the site to the list of 'Allowed Sites' shown below it. For
example your Internet banking site may need to show legitimate pop-ups to function correctly - enter the site
address in simple format (e.g. TweakGuides.com) and add it to the list. For more information about the pop-up
blocker, click the 'Pop-up Blocker FAQ' link at the bottom of this section of Internet Explorer, and a help file
with more details will open.

CONTENT

If enabled, the 'Content Advisor' allows you to attempt to filter out and control access to websites that
contain offensive material/language. The settings here are obviously determined by tastes and tolerances,
but for most adults I don't see why Content Advisor needs to be enabled. If however you do wish to use the
content advisor, click the Enable button and work your way through the settings under the various tabs,
then click Apply to enable the advisor. Please be aware that the advisor is not a fail-safe Internet filter, it only
uses content advice from the ICRA (Internet Content Rating Association).
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Certificates are quite important, but also too complex to get into here. The best thing to do is not to alter any
of the settings in this section. Click on the Certificates button, and under 'Intended Purpose’ select All. Now
use the small arrows just below that box to scroll across to the 'Trusted Publishers' tab. Make sure the entries
in this box (e.g. Microsoft Corporation) are companies you know and have actually chosen to trust. Double
click on each certificate to see more details. Highlight a certificate and click Remove if you don't trust it.

Click the Autocomplete button next. Autocomplete can be useful, but if other people have physical access to
your PC, it can be very dangerous, as others can accidentally or intentionally see which websites you've
visited, what data you've entered on online forms, and even what your username and password is on sites
which require login (e.g. Internet forums or online stores). In such cases I recommend that you untick all
forms of Autocomplete and click the Clear Forms and Clear Passwords button as well for maximum safety.
Otherwise if you are the sole user of the PC, I recommend ticking the 'User names and passwords on forms'
box and unticking the other boxes. This allows you to maintain user names and passwords for faster logging
in on Internet forums and the like. This could be considered a security risk but again it is important to have a
balance of security and functionality, not just be skewed to one extreme.

Under the 'My Profile’ button I don't recommend creating and maintaining a profile of yourself on your PC,
especially if it contains information such as your phone number, address, work details etc. If a profile exists I
suggest deleting it by going into Outlook Express and selecting 'Address Book' under the Tools menu,
clicking on 'Shared Contacts' and highlighting your profile(s) in the right pane and selecting Delete. A profile
is not necessary for the most part, and is a security risk that can be avoided without much inconvenience.

IE7 - RSS Feeds: In Internet Explorer 7 if a website you're viewing has RSS capability, you will see the
orange RSS icon in the Status Bar. You can then click the orange icon to view the feed, or subscribe to it and
specify how often news feeds are automatically sent to you.

CONNECTIONS

Set up all information in this box as provided by your Internet Service Provider (ISP). Under the 'Local Area
Network (LAN) Settings' area, click the LAN Setting button and select the 'Automatically Detect Settings'
option.

PROGRAMS

Set the programs used to taste. If Internet Explorer is your default browser and you don't have any other
browsers installed, untick the 'Internet Explorer should check to see whether it is the default browser' option.
This will both decrease Internet Explorer's startup time, and also prevent conflicts with other browsers if you
are using an alternate browser as your default browser. Note if you press the Reset Web Settings' button it
only sets your home page and search options back to their defaults - this is not recommended.

Click the 'Manage Add-ons' button and in the box that opens select 'Add-ons currently loaded in Internet
Explorer'. Add-ons are small programs that enhance Internet Explorer's functionality for specific purposes
such as showing movies in a browser window or playing back a particular audio codec. The list below
shows add-ons that are currently loaded up in Internet Explorer starts, and by highlighting an add-on you
can select either to enable or disable it - however you cannot uninstall them here. For the most part you
should minimize the number of add-ons that load with Internet Explorer, since they take up resources and
can also cause conflicts. Many programs, such as media players or messaging programs insert add-ons
which are rarely used or undesired, and you should select the 'Add-ons that have been used by Internet
Explorer' option at the top of this list to see every possible add-on that IE can use on your system. Note that
some add-ons may also be inserted by malicious software - see the PC Security section. Go through and
disable the ones that seem unnecessary. Then if during browsing you notice a site which you like is not
showing its content correctly, you can re-enter this list and re-enable the relevant add-on if need be.
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Note that you can download a Range of Add-Ons which provide useful additional functionality, such as
spell checking. Many of these add-ons are free and operate similar to Extensions for Firefox, making Internet

Explorer more customizeable.

ADVANCED

Below are my specific recommendations for important settings in this section.
Tick the following settings:

» Disable script debugging

» Disable script debugging (Other)

* Enable Install on Demand (Internet Explorer)
* Enable Third Party Browser Extensions

= Use Passive FTP

»  Use smooth scrolling

= Check for publisher's certificate revocation

»  Check for signatures on downloaded programs
* Do not save encrypted pages to disk

= UseSSL 2.0

=  UseSSL 3.0

»  Warn about invalid site certificates

*  Warn if forms submittal is being redirected

Untick the following settings:

* Automatically check for Internet Explorer Updates

= Display a notification about every script error

* Enable Install on Demand (Other)

* Enable offline items to be synchronized on a schedule

* Enable Personalized Favorites menu

*  Empty Temporary Internet Files folder when browser is closed

IE7 - Advanced Settings: The same advice as above applies to the IE7 settings of the same name. In addition:
I recommend that you Tick the following in IE7:

* Do not save encrypted pages to disk

* Enable native XMLHTTP support

= Enable Integrated Windows Authentication

»  Phishing Filter - Turn on automatic website checking

=  Warn if POST submittal is redirected to a zone that does not permit post

and make sure the following is Unticked in IE7:

»  Allow active content from CDs to run on My Computer
= Allow active content to run in files on My Computer
» Allow the installation of ActiveX controls that have invalid signatures

The remaining settings in this section (whether IE6 or IE7) can either be left at default or set to taste. If in
doubt, leave them at their default. Once you've changed these settings, click the Apply button, exit the
settings and try out a few of your favorite web pages. If they do not function properly or to your taste then
you may have to change specific security or privacy settings until you are comfortable with the balance
between Internet security, privacy and functionality. Make sure to also read the Internet Browsing tips in the
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PC Security section, as your web browser can't protect you from malicious software if you don't take
appropriate precautions.

Tirs & TWEAKS

The following are some useful tweaks and customization to make Internet Explorer 6 easier to use:

STREAMLINED INTERNET EXPLORER VIEW

One of the common criticisms of Internet Explorer is that it is too bulky, and that other browsers take up far
less real estate on the screen. I have been using a customized view of Internet Explorer for years now which I

believe streamlines the Internet Explorer window to provide maximum viewable space yet quick access to its
important functionality. My method for customizing it is provided as follows (note, does not work in IE7):

Ll e

10.

Open Internet Explorer, go to the View menu and under the Toolbars menu untick 'Lock the Toolbars'.
Still in the View menu, under the Toolbars sub-menu untick the Links item.

Once again in the View menu, under the Toolbars sub-menu select the 'Customize...' option.

In the 'Customize Toolbars' box, select 'No text labels' in the "Text Options' box, and select 'Small icons' in
the 'Icon Options' box at the bottom.

Highlight each function's icon in the right pane that you do not need displayed and click the Remove
button. Make sure to also highlight each 'Separator' item and click Remove as well. You can also add
new icons from the left pane, and use the Move up and Move Down buttons to rearrange the icons in the
right pane into the final order you wish them to take on the toolbar. Try and minimize the number of
icons shown to only those that you use often. Once done, click Close.

Back on the Internet Explorer main screen, left-click and hold on the far left side of the icon toolbar (the
thin vertical rectangle) and drag the entire bar up next to the Menu toolbar, then let go.

Do the same for the Address Bar, this time moving it up to the right of the Icon toolbar, so that all the
components (Menu, Icons, Address Bar) are on one line.

Use the thin vertical rectangle on the far left of each toolbar to slide it left or right until they all fit
together without any large gaps or overlaps. If you need additional space, right-click on the word
'‘Address' in the Address Bar and untick the 'Go button' to remove it.

Once you've completed resizing the toolbars and adding/removing elements, go to the View menu, and
under the Toolbars sub-menu place a tick next to the 'Lock the Toolbars' option to prevent accidental
resizing/movement in the future.

To gain even more space at the bottom of Internet Explorer, you may want to turn off the Status Bar by
going to the View menu, and unticking 'Status Bar'.

This new format may take some getting used to, but it provides the maximum amount of viewable browser
space, while at the same time still providing you with all the menu options, all the important icons, and a
decent-sized Address Bar for entering/viewing URLs. Note that this format best suits people who display
their Desktop at 1024x768 resolution or higher. Internet Explorer 7 does not allow such customization.

CHANGE OR DISABLE INTERNET EXPLORER CLICK SOUND

Every time you navigate anywhere using Internet Explorer, or for that matter in Windows Explorer, you will
hear a 'click' sound. To disable this clicking sound, or to change it to another sound follow these steps:

Ll e

Go to Control Panel>Sounds and Audio Devices>Sounds.

Under the Program Events list, scroll down to 'Start Navigation' under the '‘Windows Explorer' section.
Left-click on 'Start Navigation' to highlight it.

To disable the sound completely go to the sounds list below and select [None] at the very top of the list,
then click Apply.

To change the sound, pick another more suitable sound from the list, or click the Browse button to find
another sound file on your hard drive to use - remember, the larger the sound file the more memory is
used (See Sounds & Audio Devices under the Control Panel section). Click Apply when done.
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Note that changing or disabling this sound will affect both Internet Explorer and Windows Explorer equally.
Further note that the default click sound is called Windows XP Start.wav.

INTERNET EXPLORER LAUNCHED FROM SHORTCUTS

The most common annoyance reported by Internet Explorer 6 users involves the apparently ever-changing
size of Internet Explorer windows - they never seem to stay the way you want them. The following
information deals with possible ways to resolve this problem, depending on how you launch an Internet
Explorer window.

To determine the size of the window which opens up when you launch Internet Explorer from a shortcut
(i.e. a Desktop icon or menu entry), you will need to configure the specific Internet Explorer shortcut you
use. If you use the default Internet Explorer desktop icon, or the default one in the Start Menu, their
configuration cannot be altered. Follow the steps below to configure the default window behavior for IE:

1. Right-click on the Internet Explorer Desktop icon and select 'Create Shortcut'. A new shortcut will
appear on your Desktop with a name like 'Internet Explorer (2)".

2. Go to Control Panel>Display Properties and select the Desktop tab.

3. Click the 'Customize Desktop' icon, select the General tab, and under Desktop Icons untick 'Internet
Explorer'. This will remove the default Internet Explorer desktop icon (which cannot be configured),
leaving you with the shortcut you just created (which can be configured). Rename this shortcut to
"Internet Explorer" (without quotes).

4. Right-click on the new Internet Explorer shortcut and select Properties.

5. Under the Shortcut tab, select Maximized from the Run box to run Internet Explorer as a maximized
full-screen window each time you start it. Alternatively, select Minimized if you want it minimized on
start up, or select 'Normal Window" if you want a custom size. Click Ok.

6. If you've selected 'Normal Window' in the Run box, to select the default window size for Internet
Explorer, launch Internet Explorer from the shortcut and resize and position the window exactly the
way you want it, then select File>Close. The next time you open Internet Explorer from this shortcut it
will open exactly the same size and in the same position.

You can now copy this shortcut to other places, such as into menus, in place of existing ones if you want to
guarantee that these settings are used every time you launch Internet Explorer from a shortcut.

INTERNET EXPLORER LAUNCHED FROM HYPERLINKS

Another annoyance is the size of the Internet Explorer window which opens when you click on a hyperlink.
You can set the default size for this window by doing the following:

1.  Start Internet Explorer, and go to a web page with visible hyperlinks.

Left-click on a hyperlink while holding down the SHIFT button — this ensures that it will open in a new
Internet Explorer window.

3. Now hold down the SHIFT key and move and resize this new window however you like it. If you want
to size it so it fills the entire screen, don't use the maximize button - resize it manually until it's the same
size as a maximized window.

4.  Still holding SHIFT, click on the File menu and select Close — don't use the close button on the top right
corner of the window.

Internet Explorer should now use these settings whenever a new Internet Explorer window is launched from
a hyperlink. Note that if your system isn't saving window sizes or positions after a reboot, see the 'Folder
Views Not Being Saved' solution under the Windows Explorer section.
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If none of these methods work for you, there are utilities available which can force Internet Explorer to open
every window fully maximized every time such as Autosizer, however I do not recommend these because
they have to keep running in the background and hence take up system resources and may cause conflicts,
all for the sake of a minor annoyance which can either be fixed by doing the above or by using another
browser like Mozilla Firefox if it really bothers you that much.

CHANGE INTERNET EXPLORER DEFAULT DOWNLOAD DIRECTORY

By default Internet Explorer uses the same directory path to save files whenever you download a file from
the Internet. You can change this default path at any time by opening the Registry Editor and going to:

[HKEY CURRENT USER\Software\Microsoft\Internet Explorer]

Download Directory=C:\Documents and Settings\User\Downloads

This STRING specifies the default directory where IE will save downloaded files. Enter the path to wherever
you want the new default to be.
REMOVE 'LINKS' FOLDER IN FAVORITES

Another common annoyance of Internet Explorer 6 is its insistence that a folder called 'Links' be kept in your
Favorites listing. Every time this folder is deleted, it will be recreated the next time Internet Explorer is
launched. To get rid of it permanently, use Registry Editor and go to:

[HKEY CURRENT USER\Software\Microsoft\Internet Explorer\Toolbar]

LinksFolderName=Links

To delete Links for good, edit this STRING so that it equals a blank (empty) value. Now go into your
Favorites and delete the Links folder (right-click on it and select Delete) and it won't reappear ever again.
CUSTOMIZE INTERNET EXPLORER TITLE BAR

If you want to customize what is displayed at the top of each Internet Explorer window (typically the name
of the site followed by Microsoft Internet Explorer), go to:

[HKEY CURRENT USER\Software\Microsoft\Internet Explorer\Main]
Window Title=Microsoft Internet Explorer
Create a new STRING called Window Title (there is one space between the two words), and assign
whatever text you wish to use. The next time you launch a new Internet Explorer window this text will be
displayed at the top of IE.

INCREASE MAXIMUM SIMULTANEOUS DOWNLOADS

By default Internet Explorer only allows 2 downloads at a time. This is the Internet Standard for maximum
number of simultaneous connections to a server. You can increase this value beyond 2 by going to:

[HKEY CURRENT USER\Software\Microsoft\Windows\CurrentVersion\Internet Settings]
MaxConnectionsPerl 0Server=0x00000005(5)

MaxConnectionsPerServer=0x00000005 (5)

Create two new DWORD keys with the names shown above. To assign values to them, double-click on each
one and before entering a value, make sure to select the Decimal view option. Then enter the maximum

number of simultaneous downloads you want in the 'Value data' box (e.g. 5) and click Ok when done. The
number shown in the right pane for these keys will be displayed in Hexadecimal format first followed by the
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normal Decimal value in brackets - make sure the value in the round brackets is the maximum number of
connections you want. Note that increasing the maximum number of simultaneous connections to a server is
technically a breach of Internet Standards, so if you experience any problems reset these values to 2.

DISABLE INTERNET EXPLORER SEARCH ASSISTANT

When you click the Search button or press CTRL + E to use the Search function in Internet Explorer, by
default this brings up the Search Assistant interface. This interface is annoying, and can be improved by
using the Registry Editor and going to:

[HKEY CURRENT USER\Software\Microsoft\Internet Explorer\Main]

Use Search Asst=No

To use a custom search sidebar (See below) and get rid of the somewhat annoying default interface, turn off
Search Assistant by setting this entry to No. Note that the 'Main' registry key may not exist in your registry,
so in Registry Editor right click on the 'Internet Explorer' key, select New>Key, and call it "Main" (without
quotes). You will then have to create a new STRING value in the right pane called "Use Search Asst"
(without quotes, and remember to include a space between each word), double click on it once created and
give it the value "No" (without quotes).

USE CUSTOMIZED INTERNET EXPLORER SEARCH ASSISTANT

If you have disabled the default Internet Explorer Search Assistant, you can customize the search sidebar to
have a Google search interface instead for example. To do this, open the Registry Editor and go to:

[HKEY CURRENT USER\Software\Microsoft\Internet Explorer\Main]
Search Page=http://www.google.com

Search Bar=http://www.google.com/ie

[HKEY LOCAL_ MACHINE\SOFTWARE\Microsoft\Internet Explorer\Search]

SearchAssistant=http://www.google.com/ie
Create or change all of these STRING entries to the values shown above to implement this tweak.

CHANGE INTERNET EXPLORER ADDRESS BAR SEARCH ENGINE

By default you can perform an Internet search by entering a word in the Internet Explorer Address Bar, as
long as under the Tools>Internet Options>Advanced section in IE the option 'Just display results in the main
window' or 'Display results, and go to the most likely site' is selected. Internet Explorer will use the
Microsoft Network (MSN) search engine to perform the search. To use a better search engine such as Google
open Registry Editor and go to:

[HKEY LOCAL MACHINE\SOFTWARE\Microsoft\Internet Explorer\Search]

CustomizeSearch=http://ie.search.msn.com/en-us/srchasst/srchcust.htm

Changing the STRING value to that shown above will allow Internet Explorer to use other search engines.

[HKEY CURRENT USER\Software\Microsoft\Internet Explorer\SearchUrl]

Provider=gogl

This STRING determines the search engine used if a customized search engine is allowed (See above). The
values which correspond to other search engines are listed below:
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Msn - MSN (default) Lksm - LookSmart Aols - AOL
Yaho - Yahoo Askj - Ask]Jeeves Infs - InfoSpace
Alta - AltaVista Nets - Netspace

You can also change the search provider by launching Internet Explorer, opening Search (CTRL + E or click
the magnifying glass), clicking the Customize button, then clicking the 'Autosearch Settings' button. Select
your Address Bar search engine provider there. Note that you may have problems searching from the
address bar if you use a proxy or some Firewall software. Also note that whichever provider you choose for
the search bar, the search will still be processed through MSN initially, which will then pass the search to the
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chosen search engine and show the results in that engine. This behavior can't be changed.

B REPAIRING INTERNET EXPLORER

If you're experiencing difficulties with Internet Explorer, the first thing to do is to double-check your settings
in detail. However sometimes Internet Explorer's behavior can be so inexplicable as to leave you wondering
what exactly is going on. Since Internet Explorer is a core component of Windows XP, it cannot be
completely uninstalled or deleted from your system and then reinstalled 'cleanly' (unless you use NLite - see
the Installing Windows section). You can however attempt to fix the problem by doing one of the following:

SCAN FOR MALICIOUS SOFTWARE

Many viruses, trojans, spyware, browser hijackers and other types of malicious software can significantly
alter your Internet Explorer behavior - such as changing your default home page or the number and size of
IE Windows which open. You should run through the procedures under the PC Security section of this
guide to begin with before embarking on any major Internet Explorer repairs.

REINSTALL INTERNET EXPLORER

If you suspect a corrupted system file, you can use the System File Checker to scan for and repair all such
files. The System File Checker will require that you have your original Windows XP CD handy. See the
Backup & Recovery section for details.

Alternatively, you can trick Windows into thinking Internet Explorer 6 isn't installed, and this will allow you
to reinstall Internet Explorer over the top of your existing installation (which isn't normally possible). To do
this, open the Registry Editor and go to the following key:

[HKEY LOCAL_ MACHINE\SOFTWARE\Microsoft\Active Setup\Installed Components\
{89820200-ECBD-11cf-8B85-00AA005B4383}]

IsInstalled=1

Change or create this DWORD setting to =0 and click OK. Now go to the Microsoft Internet Explorer
Homepage, download the correct full version of Internet Explorer and install it. Once completed, go to
Windows Update and install all the available patches and updates for Internet Explorer once again. These
steps should resolve any issues you are having with Internet Explorer if the cause was a corrupted file or

registry entry. If they don't then see below.
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TEMPORARY INTERNET FILES FOLDER

If you're having problems with Internet Explorer while browsing the Internet, such as freezes or laggy
behavior, it may well be that the Temporary Internet Files folder is the culprit. If you've previously tried to
manually delete files from there, or even tried moving or deleting the entire folder, this may trigger
problematic behavior in Internet Explorer which can only be resolved by doing the following:

1. Empty your Internet Explorer cache by opening Internet Explorer, going to Tools>Internet Options and
clicking the 'Delete Files' option, ticking the 'Delete all offline content' on the next screen and click OK.
Also click the 'Delete Cookies' and 'Clear History' buttons while you are there.

2. Reboot your PC and make sure you don't open Internet Explorer or Windows Explorer, or anything
which accesses them.

3.  Go to Start>Run and type "Cmd" (without quotes) then press Enter. This opens a Command Prompt.

4. Type "CD\" (without quotes) at the prompt to take you to the root directory.

5. Open Windows Task Manager (CTRL + ALT + DEL) and under the Processes tab highlight the Explorer
process and click 'End Process'. The desktop will vanish, but this is normal.

6. Go back to the command prompt, and copy or type the following text (including the quotes) into the
command prompt and press Enter:

del "%userprofile%\local settings\temporary internet files\content.ie5\"

7. Answer 'Y' when prompted if you want to delete the file.
8. Go to the Windows Task Manager again and click on the File Menu and choose 'New Task (Run)..." and
type "Explorer” (without quotes) and hit Enter. This will reload the desktop.

Doing the above will delete the Index.dat file which lies in your Temporary Internet Files folder and in doing
so it will be recreated with the correct references to your cached internet files the next time you open Internet
Explorer. Any strange browser behavior should be resolved.

DNS CACHE ISSUES

Whenever your browser tries to load up a page on the Internet, it has to access a Domain Name System
(DNS) server to resolve or translate the text address you use (e.g. www.Google.com) into the actual IP
address for the website (e.g.: 216.239.57.99). As you can see, the concept of having text for an address rather
than a bunch of numbers makes remembering addresses a lot easier for users.

However since your browser needs to check DNS addresses each time it loads any web pages, the browser
speeds up this process by caching (locally storing) the addresses you use for a period of time so that next
time you try to go to the same address it uses the IP address it has cached rather than looking it up again on
a DNS Server. Unfortunately if a site is down temporarily, or has recently moved, then your DNS cache may
store the site as being inaccessible for a while even if it comes back online shortly afterwards, and therefore
every time you try to connect to it for several hours you will get an error message.

To resolve any DNS problems with web pages not loading up at all or loading up with outdated
information, go to Start>Run and type "CMD" (without quotes) and press Enter to open a new Command
Prompt window, then in the Command Prompt type "ipconfig /flushdns" (without quotes) and press Enter.
This will clear your DNS cache. Furthermore, to make sure that your browser never stores a 'negative' DNS
cache entry —i.e. one which says a site is inaccessible — then go to the Registry and do the following:

[HKEY LOCAL MACHINE\SYSTEM\CurrentControlSet\Services\Dnscache\Parameters]

MaxNegativeCacheTt1l=0
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If the value above doesn't exist, create it as a new DWORD and assign it a value of 0 so that no negative DNS
entries can be kept in the DNS cache.

You can also set the length of time in 'Time To Live' (TTL) for a 'positive' (or working) DNS cache entry to
remain active before being updated. To do this, in the Registry go to:

[HKEY LOCAL_ MACHINE\SYSTEM\CurrentControlSet\Services\Dnscache\Parameters]

MaxCacheTt1=10800

If this entry doesn't exist, create it as a new DWORD and assign it a value which measures (in seconds) the
total Time To Live for the positive cache entry. Make sure to enter the amount of seconds in Decimal — not
Hexadecimal — view. Also do not set this value too low as your DNS cache will effectively become useless
and browsing will take longer. A value of between 3 and 6 hours (10800 — 21600 seconds) should be fine.

B WINDOWS UPDATE

Windows Update is an essential website which you should access regularly to download and install
important updates for Windows. To access Windows Update at any time, open Internet Explorer and go to
the Tools menu, then underneath select Windows Update. Alternatively, if you want to create a shortcut or
bookmark to it, the address is Windows Update. If you are having problems accessing the site through the
common methods above, you can try accessing it using a secure server through this link: Windows Update
Secure. Note that the secure link differs by having https:// instead of http:// in the address. Note also that
Windows Genuine Advantage does not allow pirated copies of Windows to fully access updates on
Windows Update - see the Windows Product Activation & Windows Genuine Advantage section for details.

WINDOWS UPDATE USAGE

Whenever you access Windows Update I strongly recommend that you click on the Custom button instead
of the Express method. This is because Custom allows you to see what updates are available, and you can
select which you want to install. Once you've clicked on Custom you will see Windows Update scanning
your machine and after a while it provides a list of updates. If the scanning doesn't seem to stop, or you have
problems getting Windows Update to work, see further below.

Now click on the 'Review and Install Updates' option and make sure all the High Priority security-related
updates are selected - these should be installed on any Windows XP installation. However you should then
check the 'Optional Software' and 'Optional Hardware' links on the left and go through the list of optional
updates. These updates include important application updates, newer versions of drivers for the hardware
on your system, etc. and I recommend that you first follow the procedures in the rest of this guide to update
your drivers, and then if these driver updates still appear you should install them as well. They won't cause
any harm to your system and you can always manually install newer versions over them.

If you feel adventurous (or impatient) and want to see any pre-release software in Windows Update, click on
the 'Change Settings' link under Options and place a tick against the 'Show beta products and related
updates' item and click the 'Apply Changes Now' button.

SECURITY PATCH LINKS AND RELEASE DATES

Microsoft usually releases new drives and software updates as necessary, but they have a set release
schedule for security patches - typically they are released together on the first Tuesday of every month. To
find out when the next update is due, check the Microsoft Security Bulletin Site. You can find the direct
download links to major security updates on the Windows Security & Updates Download Site.
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WINDOWS UPDATE ON OTHER BROWSERS

Browsers other than Internet Explorer cannot access Windows Update correctly by default. If you use Firefox
or Opera for example, you will need to use an updating service like WindizUpdate. This site should be safe
enough to download updates from, however I recommend using Internet Explorer and the proper Windows
Update site to ensure maximum security and minimum delay in obtaining critical updates for Windows.
Also see the Windows Product Activation & Windows Genuine Advantage section of this guide for an
official Microsoft Firefox plugin to validate the browser for WGA.

REPAIRING WINDOWS UPDATE

Windows Update can exhibit strange behavior such as endlessly scanning your machine but never providing
any list of updates, or gives strange error codes. The following are some things you can try to repair
Windows Update:

1. Try the secure Windows Update address: Windows Update Secure.
If Windows Update seems to scan forever, or no updates appear, see this Microsoft Article.

3. If you are experiencing specific Windows Update errors such as error code 0x800A138F, see this
Windows Update Fails. There is no single fix for all error codes and each one has several methods you

can try to resolve the issue.

And as always, remember to run Windows Update at least once a week and install all important updates to
maintain the security of your PC. Alternatively keep an eye on the front page of TweakGuides.com as I
provide details of the latest patches, and when to check Windows Update for Microsoft patch release days. If
you are absolutely paranoid and need to make sure you have the latest patches and updates, see Automatic
Updates under the Control Panel section and turn it on.

B OTHER INTERNET BROWSERS

By now you may be wondering if there are other browsers you can try which may overcome some of the
inherent problems of Internet Explorer. The simple answer is yes, there are other browsers which are free
and easy to use, and in some ways better than Internet Explorer. The two most popular alternate browsers
are the Opera Browser and Mozilla Firefox.

My personal preference is for Firefox. It is an excellent, stable, optimized Internet browser which is
completely free and well-supported. It runs without any problems alongside Internet Explorer, and this
gives you the opportunity to try it out to see if you prefer it. The main advantage of Firefox over Internet
Explorer is that Firefox is infinitely more customizable. It is also easy to setup and use: when you first install
Firefox it imports your Internet Explorer bookmarks so that you can begin using it straight away without the
need for significant customization. If you want to find out more about Firefox and undertake some tweaking
I recommend you read my complete Firefox Tweak Guide. You have nothing to lose by trying Firefox out.
However there is no overwhelming reason you should switch from Internet Explorer if you are comfortable
using it. IE is already fairly optimized for Windows XP since it is a core Windows component, and hence
typically very fast to load up. Page loading times are also extremely fast, and almost all Internet content
around the web is designed specifically to display correctly on IE. Most importantly, I do not recommend
removing Internet Explorer from Windows (e.g. by using NLite) as it is necessary to view certain sites
correctly, and with full functionality and security.
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OUTLOOK EXPRESS

Outlook Express - which is not to be confused with the full version simply called Outlook - is a useful email
and newsgroup program. It should meet all your basic email needs, but it also has some features people
rarely get around to configuring or using. This section covers the main Outlook Express settings and tweaks.
Note, if you don't have the latest version of Outlook Express use Windows Update to update it to the latest
version for security and functionality reasons.

B CONFIGURATION ADVICE

The first thing to do is optimize Outlook Express' basic settings for efficient, trouble-free operation. Open
Outlook Express, go to the Tools menu and select Options. Below are my recommendations for the
important settings under each tab of Options:

GENERAL
Tick 'When starting go directly to my Inbox folder'
Untick 'Automatically Log on to Windows Messenger'

Note if you have removed Windows Messenger from your system, you may also have to apply the Outlook
Express slowdown fix (See below) otherwise Outlook Express can take a long time to load each time it starts.
READ

Untick 'Automatically download message when viewing in the preview pane'

This is recommended for security reasons.

RECEIPTS

Read receipts tell the sender of a message whether a message has been opened by the recipient. I personally
don't like sending or receiving read receipts. They can be quite annoying, and whether you want to use them
is up to you, but for the 'Returning Read Receipts' section I recommend selecting 'Notify me for each read
receipt request’. That way you know when someone has sent an email to you with a receipt request, and you
can choose whether to accept the request when you open the email.

Secure receipts are similar, but might be more useful if you're sending a very important message and you
want to make sure that the recipient has opened the message, and that the message arrived at the other end
unaltered. Otherwise the same settings apply.

SEND
Tick 'Send messages immediately’

Untick 'Automatically put people I reply to in my Address Book'

Making sure that you don't add everyone to your Address Book is one way of preventing any viruses on
your system from emailing everyone in your Address Book with the virus. I recommend instead either
writing down email addresses or keeping existing emails from various people so you can reply to them.

COMPOSE, SIGNATURES, SPELLING

There are no specific recommendations for these tabs. Configure them to suit your taste. If you want to know
what any of these features do, right click on them and click 'What's this' or press F1 for Windows Help.
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SECURITY

The security features in Outlook Express are reasonable in protecting against most viruses and malicious
code sent in emails. However you need to know how they work and configure them correctly.

There is an option to select either the 'Internet Zone' or Restricted Sites Zone' for your default email
behavior. When in Internet Zone mode, HTML-based emails with active content will display their content
just like a web page in Internet Explorer. In fact the security settings you choose under the Security tab in
Internet Explorer Options also apply to Internet Zone email content. When in Restricted Sites Zone mode,
Outlook Express will disable active content from HTML-based emails, which is much more secure, but
reduces email functionality. I recommend running in Restricted Sites Zone mode, as most HTML-based
emails nowadays are spam or malicious.

Tick 'Warn me when other applications try to send email as me'

Tick 'Do not allow attachments to be saved or opened that could potentially be a virus'. This will protect you
against attachments, the vast bulk of which are dangerous, unsolicited email viruses. See the PC Security
section for tips on how to prevent infection through emails. If you receive an attachment from an address
you know, it may still be a virus which was auto-mailed from that user's account, so double-check with the
sender if you're genuinely unsure of whether to save or open the attachment. If it is a legitimate attachment,
then close the email, open Options and untick this setting, go back and open up the email and save the
attachment, then make sure to retick this option afterwards.

Note that certain file types (e.g.: .EXE files) are automatically blocked with this setting enabled. To configure
which other types of files are affected when this setting is ticked, go to Control Panel>Folder Options>File
Types, highlight a file extension and click the Advanced button. Select 'Confirm open after download' to add
the file type to the unsafe file list which Outlook Express uses to block attachments when this setting is
enabled. Again remember that some file types are permanently on the unsafe list and cannot be taken off.

Tick 'Block images and other external content in HTML email' - once again for security reasons.
You shouldn't have to change the remaining settings in this section.

CONNECTION

Uses the same settings as Internet Explorer, so see the Internet Explorer section.

MAINTENANCE

I recommend the following settings to reduce wasted disk space:

Tick 'Empty message from the Deleted Items folder on exit'.
Tick 'Purge deleted items when leaving IMAP folders'.
Click the 'Clean Up Now' button and select Compact to reduce existing wasted space immediately.

If you are wondering where your emails are physically being saved, then the following option will show you
email store directory:

'Store Folder' — This is the location of your emails and Outlook Express folder settings. Typically it is the
\Documents and Settings\[username]\ Local Settings\ Application Data\Identities\{ID String}\ Microsoft\ Outlook
Express directory.

Once you've changed all the settings you wish to change in Outlook Express, click the Apply button and exit
the settings screen. You will need to close and relaunch Outlook Express for some of the settings to come
into effect.
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B TIPS & TWEAKS

BACKING UP EMAILS

If you want to back up the emails you've saved in Outlook Express, follow these procedures:

1. Open Outlook Express, go to Tools>Options and open the Maintenance tab.
Click the 'Store Folder' button and highlight the directory path shown with your mouse (right-click on
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the text and choose Select All).

3. Right-click again on the highlighted text and select Copy.

4.  Go to Start>Run and right-click in the box. Select Paste, then click OK. This opens an Explorer window
in the folder where Outlook Express holds your emails and email folders as .dbx files.

5. The folder names should be self-explanatory. Select individual .dbx files where you stored emails and
copy them to another location for backup purposes.

RESTORING EMAILS

To restore these emails back into Outlook Express at any point, say after a reformat of Windows, follow
these procedures:

1. Open Outlook Express, go to File>Import>Messages.
Select 'Microsoft Outlook Express 6' from the list (or whichever version of OE you saved the messages
under).

3. Select Import mail from an OE6 store directory' and click OK.

4. Browse to the directory where you backed up your Outlook Express messages as .dbx files. Click OK,
then click Next.

5. Click All Folders, select Next, then select Finish. Your messages should be restored as you saved them.

You can also use these Import and Export functions in Outlook Express to save and restore your Address
Book, Email account and Newsgroup account data. These aren't detailed here, but the procedure is similar to
that outlined above.

FILTERING SPAM

Spam is unsolicited email with useless and often offensive content. Outlook Express has some built-in
features which can be used to sort mail automatically and prevent spam. Note that these features won't work
for IMAP and HTTP (i.e. Web-based) email accounts such as Hotmail. Use these tools for your POP3
accounts such as the ones your ISP provides. To access and configure these tools:

1.  Open Outlook Express and go to Tools>Message Rules and select Mail.

Click the New button to create a new rule. The New Mail Rule window will open.

3. Select a condition for your rule. For example, we will choose 'Where the message is more than size'. We
can set the size parameter for this rule in Step 5.

4.  Select the action for the rule. For example, 'Move it to the specified folder'".

5. Set any parameters required for the rule by clicking on the blue underline text in the Rule Description
box. For example, we will click on the Size text and choose 40KB as our size limit for the rule set up in
step 3. We will click on the Folder text and choose Deleted Items.

6. Give the rule an appropriate name, such as 'Large email filter' and click OK.

7. In the Mail Rules window, put a tick next to this new rule and click the Apply Now button. If you want
to add more parameters or change the rule, click the Modify button, and go back through steps 3 — 6
above until you're happy.

8. Create as many rules as you like, and arrange them in order of priority/application to new messages by
using the Move Up and Move Down buttons.
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Now when you check for new emails, the above rule will automatically check each email's size and if it is
over 40KB, will redirect it to your Deleted Items folder automatically. You can have a quick look in there
after checking your mail and see if it's anything you want to keep, otherwise just empty the deleted items
and you've cleared some hefty spam straight away. Create more rules once you identify patterns in your
email. For example I was getting a lot of spam emails with phony virus screensavers attached. So I set up a
new rule which automatically deletes from my mail server any emails with 'Screensaver' in the message
body (so I don't even download them).

Of course you can do a lot more with Message Rules, such as block certain individuals, block any email
accounts from particular domains (such as MSN, Yahoo or AOL), etc. Experiment with the tool as it is more
useful than most people would believe. To begin with set the action for any rule to redirect flagged mail to a
separate folder you set up and see if any legitimate mail is getting caught up by the rule. Also, create
multiple layers of rules to finely sift through the mail and get rid of the genuine rubbish.

REMOVE SPLASH SCREEN

The following is a simple tweak which skips the blue Outlook Express splash screen when Outlook Express
is loading up. To perform this tweak, open Registry Editor and go to:

[HKEY CURRENT USER\Identities\{numbers}\Software\Microsoft\Outlook Express\5.0]

NoSplash=1

Create this new DWORD value and set to =1. Delete the entry if you want to regain the splash screen.

B REPAIRING OUTLOOK EXPRESS

If you find that your Outlook Express is behaving oddly, there are a few things you can do to resolve it:

SLOWDOWN ISSUES

If you have disabled MSN Messenger then you may experience slowdowns when launching Outlook
Express. To resolve this problem, implement the following change to your Registry:

[HKEY LOCAL_MACHINE\SOFTWARE\Classes\CLSID]

{FB7199AB-79BF-11d2-8D94-0000F875C541}

Find this key and under it select the folder IniProcServer32. In the right pane of the Registry Editor
double-click on the (Default) entry at the top and completely delete the data it contains. Now do the same
for the LocalServer32 folder as well. This prevents the slowdown which some users experience with
Outlook Express when MSN Messenger has been disabled.

SCAN FOR MALICIOUS SOFTWARE

Many viruses, trojans, spyware, browser hijackers and other types of malicious software can significantly
alter your general Internet behavior, including the way Outlook Express behaves. You should run through
the procedures under the PC Security section of this guide to begin with.

REINSTALL INTERNET EXPLORER

If you suspect a corrupted system file, you can use the System File Checker to scan for and repair all such
files. The System File Checker will require that you have your original Windows XP CD handy. See the
Backup & Recovery section for details.
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Alternatively, you can trick Windows into thinking Outlook Express isn't installed, and this will allow you to
reinstall Outlook Express over the top of your existing installation (which isn't normally possible). To do
this, open the Registry Editor and go to the following key:

[HKEY LOCAL MACHINE\SOFTWARE\Microsoft\Active Setup\Installed Components\
{44BBA840—CC51—11CF—AAFA—OOAAOOB6015C}]

IsInstalled=1
Change or create this DWORD setting to =0 and click OK. Now download the latest full version of Outlook

Express 6 and reinstall it. Once completed, go to Windows Update and install all the available patches and
updates for Outlook Express once again. These steps should resolve any issues you are having with Outlook

Express if the cause was a corrupted file or registry entry.

B OTHER EMAIL CLIENTS

I personally find Outlook Express to be just fine for my email needs, even though I receive a lot of emails
and am targeted by a lot of spam (since I publish my email addresses freely on my site). However, it is
important to understand that if you are not happy with Outlook Express, you do have other options. To start
with, the standard free webmail sites Yahoo, Hotmail and GMail are not only useful in providing you with
free email addresses, they also provide good built-in protection against viruses and spam, though if you run
into problems you are usually on your own - their tech support is minimal at best.

If you want an actual free email program to replace Outlook Express, you can try Windows Live Mail which
is Microsoft's own replacement for OE. I also suggest you check out Mozilla Thunderbird - it is both very
customizable and also offers more methods of blocking spam. Finally, you should examine the tips provided
in the PC Security section of this guide for simple ways you can prevent the spread of spam and malicious
software.
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WINDOWS MEDIA PLAYER

Windows Media Player is Window XP's built-in utility for playing music and movies. The latest version of
Windows Media Player is available as a free download from the Windows Media Player Homepage. I
recommend that you update to the latest version of Windows Media Player for security purposes and then
follow this section of the guide to see how to configure it for optimal performance and privacy.

Windows Media Player has many great features and is actually a very efficient, feature-packed media
player, but is often dismissed as being 'bloated' or 'spyware'. In actuality it is smaller and more efficient than
some popular media players, and if configured correctly should provide good privacy. Below I run through
the various sections of Windows Media Player, providing recommended settings for each of the important
options under each tab. Any settings not covered are left up to your personal preference as they have no
significant impact on performance or privacy. If you don't like Windows Media Player, some alternative free
players are covered at the end of this section.

B WINDOWS MEDIA PLAYER 10 & 11

The latest official version of Windows Media Player is WMP 11. It is recommended that you upgrade to this
version as soon as possible. However because there are many people who are still using WMP 10, most of
the instructions below apply equally to both versions as they are very similar. I have included WMP 11-
specific details clearly highlighted in bold.

Note that if you've installed Windows Media Player 11, and you don't wish to use its new online music store
functionality and/or if you aren't going to control any portable media devices connected to your PC with
WMP11, you can disable the 'Windows Media Player Network Sharing Service'. If you're not sure, leave it
set to Automatic. See the Services chapter for more details.

B CONFIGURATION ADVICE

Open Windows Medjia Player, go to the Tools menu and select Options. If it is running in Skin Mode, right-
click on the top left corner of the player and select Tools>Options. Each section below refers to the tabs under
the Options page.

PLAYER

Tick the 'Once a month' option under 'Check for updates’, so that the player doesn't constantly search for
updates when you are connected to the internet. Tick 'Download codecs automatically' so that if you attempt
to play a media file for which you don't have the correct codec (and you are online), Windows Media Player
will automatically attempt to download the required codec and install it so you can play the file. See the
Audio and Video Codecs section below for more information.

Under the 'Player settings' section make sure to untick the following for maximum privacy:

* Add music files to Media Library when played
* Prompt me to back up my licenses
= Connect to the Internet

WMP11 - Miniplayer: WMP 11 adds the ability to automatically launch into Mini Player mode (see further
below) for files containing certain text in their filename.

RIP MUSIC

Click the Change button and select the directory where any music or media copied from an audio CD to
your hard drive is placed. Under the 'Rip Settings' section make sure to untick the 'Copy protect music'
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option as well as Rip CD when inserted. Choose the audio format you prefer - MP3 is strongly
recommended - and the audio quality you prefer - 160Kbps or above is recommended for good quality
audio.

To use WMP to convert any audio tracks you want from a non-protected Audio CD to .WMA or .MP3 format
do the following;:

Insert the Audio CD in your drive.

Close and restart Windows Media Player to make sure it detects the CD.

Maximize WMP so you can see the track listing.

Go to the File menu, select CDs and Devices>Rip Audio CD, or click the Rip button at the top of the
screen.

Ll e

5. Put a tick against the tracks you wish to rip and click the 'Rip Music' button at the top right.

There are far better ripping tools out there like Fasy CD-DA Extractor, however Windows Media Player is
free and easy to use, and if you follow the instructions in the rest of this section to turn off its Digital Rights
Management copy protection, the audio files you produce should be fine to use.

DEVICES

Select each playback device and click the Properties button. Adjust settings as appropriate, however for your
speakers, make sure the playback device is your main sound card, and if you have a 24-bit capable sound
card (e.g. SoundBlaster Audigy 2, 4 or X-Fi series), tick the 24-bit box for optimal sound during CD audio
playback. For your Display properties, you can alter the aspect ratio if it appears to be wrong. For most
standard 4:3 monitors, an aspect ratio of 1.000 is optimal.

Make sure to untick the 'When deleting playlists from devices, also remove their contents' option.

Click the Advanced button to alter the settings for audio and video file conversions when being transferred
to/from devices and set to suit your tastes.

WMP11 - BURN

Windows Media Player 11 allows you to also burn music to CD/DVD. To burn a disc, open WMP in full
view, click the Burn tab at the top of the screen, and an interface for arranging files for burning appears. In
the Tools>Options menu WMP11 also has a new tab which allows you to control settings such as the burn
speed and quality (sample rate) of the music burnt. Note if you don't want the audio or video data to be
converted into a lower sample rate, tick the 'Do not convert' option to prevent quality degradation.

PERFORMANCE

I recommend selecting 'Detect connection speed' and 'Use default buffering' in this section. Under the 'Video
acceleration' section click the Advanced button, and place a tick against every option (except Use Overlays
under 'Use video mixing renderer') in the subsequent dialog box. If you run into any difficulties with display
of video clips or DVDs, you can reduce video acceleration and change settings to experiment.

LIBRARY

The Media Library is not a necessary function of Windows Media Player, and for optimal privacy and
security untick every option on this page. Click the 'Monitor Folders' button and remove every folder
displayed by highlighting the folder name in the box and clicking the Remove button - no folders should
remain listed in the Folders box. In the two KB boxes, enter 9999 (the largest amount possible) so that
Windows Media Player doesn't attempt to automatically add files below this size to your Media Library.
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WMP11: Make sure to untick at least the 'Delete files from computer when deleted from library' option, and
indeed all the other options in this section should be unticked for maximum privacy and to prevent
alteration or accidental deletion of your media files.

PLUG-INS

Plug-ins are various modules which add functionality to Windows Media Player and can be added, removed
or configured here. For example, you can install a free and highly useful Microsoft plug-in for Windows
Media Player called TweakMP. You can download TweakMP from the Microsoft TweakMP Page, and full
installation and usage instructions are also provided there. Alternatively you can download the Windows
Media Bonus Pack which contains TweakMP and a range of other free plugins and add-ons for WMP.
Additional plug-ins can be found at the Plug-ins for Media Player site, and elsewhere on the Internet,
however make sure you trust the source of the plug-in before installing it, and if you run into any problems
with any of them highlight the suspected plug-in and click the Remove button to uninstall it.

PRIVACY

This is an important area of Windows Media Player which causes users a lot of concern. There is a fear that
by using Windows Media Player, Microsoft is spying on your media usage behaviors. This is not true,
however to ensure that none of the media on your hard drive is altered, or any information about it reported
back to Microsoft, follow the recommended settings in this section. To begin with untick every option on this
page. None of them are necessary and in fact all of them (except for 'Set clock on devices automatically') may
breach your privacy in some way. Click the 'Clear History' and 'Clear CD/DVD' buttons as well.

As an added precaution, I suggest that you make sure all of your media files (e.g. .MP3, .MPG and .AVI files)
are all write protected. To do this, in Windows Explorer go to the folders where your media files are stored
and highlight all of them (see Windows Explorer section to see how to select multiple files at once), right-
click on them, select Properties and place a tick in the 'Read Only' box. By write-protecting all your media,
Windows Media Player can't alter them or add any identifying information.

Finally, for Windows XP Professional users see the Windows Media Digital Rights Management (DRM)
tweak in the Group Policy section of this guide and enable it to prevent Windows DRM from accessing the
Internet when you use Windows Media Player. This significantly enhances your privacy.

WMP11: I recommend that all available options on this page be unticked for maximum privacy and once
again to prevent alteration of your media files.

SECURITY

Most of your security settings from Internet Explorer will be used when using Windows Media Player
online, but untick the 'Run script commands when present’ option under the Content section. You might also
want to tick the 'Do not run script commands..." option to increase security on web pages which use media
player functionality, but this may impair such functionality.

FILE TYPES

Manually select which types of files will be associated with Windows Media Player in this section. For
example, if you have a tick against the 'Movie file (mpeg)' option, double-clicking on an .mpeg/.mpg file will
automatically launch it in Windows Media Player. Untick any files you do not want to automatically be
played by Windows Media Player when launched. This doesn't affect Windows Media Player's ability to
play such files, only the default file associations in Windows (See Folder Options under the Control Panel
section for more details on viewing and changing file associations).
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DVD

If you have a DVD drive on your system and use Windows Media Player to play DVD movies, you can
adjust the settings in this section to suit your needs. In particular click the Advanced button and select your
preferred speaker/audio setup.

NETWORK

Configure this section according to your needs. I personally have all the streaming protocols ticked, and
under the 'Streaming proxy settings' section for each protocol I recommend clicking the Configure button
and selecting 'Autodetect proxy settings'. This ensures maximum compatibility with all forms of streaming
media on the Internet.

GRAPHIC EQUALIZER

Windows Media Player comes with a fairly decent graphic equalizer. To alter it, go to Full View mode in
WMP, and under the View menu select Enhancements>Graphic Equalizer. While you can use a range of
presets, | recommend selecting the individual slider movement option - the top option on the far left - and
then customizing the settings to suit your tastes. For reference, my personal settings from left to right for
each slider are: 4 6 4 0 1 2 2 4 6 9. Furthermore you can enable SRS WOW effects by selecting
View>Enhancements>SRS WOW Effects.

WINDOWS MEDIA PLAYER SKINS

You can customize the way Windows Media Player looks through the use of skins. These skins can change
the appearance and visible functionality of Windows Media Player. There are several skins which already
come with the player. You can view them by opening Windows Media Player, and under the View menu
select 'Skin Chooser'. In the Skin Chooser box you can click on each skin to see a preview of it in the right
pane. If you want to try a skin out, click the 'Apply Skin' button. If you want to get new skins, you should
connect to the Internet and then either click the "More Skins' button, or go to a site such as The Skins Factory
to download more free skins. Some skins will install automatically when you download them, but if you

download a skin file in .WMZ format you can manually install it so that it appears in the Skin Chooser by
putting the .WMZ file into your \Program Files\ Windows Media Player\ Skins directory. Note that using more
complex and elaborate skins can take up slightly more memory and CPU power when you run Windows
Media Player, so if you want to ensure the fastest performance and least resource usage simply set the skin
to something like Classic or 9SeriesDefault.

In fact as of Windows Media Player 10, my preferred look for WMP is to switch to Full Mode, and simply
use the resizing bar at the bottom right of the player to shrink it down to the smallest size possible. This
gives a rectangular translucent blue media player which is attractive and compact yet functional and uses
minimal RAM. In 'Mini Player' mode WMP uses even less resources.

MINI PLAYER MODE

One of the neat features of Windows Media Player is the ability to shrink it down into a 'Mini Player'
interface which sits in the Windows Taskbar. To activate this, right-click on an empty area of your Windows
Taskbar and under the Toolbars sub-menu select the 'Windows Media Player' option so a tick appears next
to it. Now open Windows Media Player and click the Minimize button on the top right of the player
window. The player will minimize and sit in your Taskbar with a handy interface which allows access to all
the major functions of the player, and whenever you want to maximize it again click the Maximize button on
the bottom right of the player.

Not only is this a neat feature, but more importantly while sitting in the Taskbar the player also uses much
less memory as well, less than that of most other media players. CPU usage is normal, typically being in the
3-6% range, which is less than or equal to other popular media players. You can also access WMP's seek
functionality by hovering your mouse over the mini player, and using the slider bar which appears at the
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bottom of the visualization box. To maximize WMP again either double-click on the mini player or click on
the small Maximize button at the bottom right of the mini player.

B AUDIO & VIDEO CODECS

A Codec (Compressor Decompressor) is a program which allows audio or video to be compressed and
decompressed to or from the original format for which it is designed. Compressed files use special
algorithms, and it is the codec which can encode/decode these algorithms. If you can play or record
audio/video in a particular format, you have a codec for that format already installed on your system.

To view and adjust the codecs already installed on your system, do the following;:

1. Go to Control Panel>Sounds and Audio Devices>Hardware
Double-click Audio Codecs or Video Codecs to see the relevant codec lists.

3. Click on the Properties tab and you will see all the currently installed codecs on your system. To see
more details about each one, double-click on it.

4. To disable an audio codec for troubleshooting purposes, double-click on it and select 'Do not use this
audio codec’; to remove it highlight the codec and click the Remove button in the main list.

5. Video codecs cannot be temporarily disabled, but they can be removed by highlighting them and
clicking the Remove button in the main list.

If you want to uninstall a non-standard codec, the best way to remove them is to go to Control Panel>Add or
Remove Programs and look for the codec name in the list shown. More details of common codecs can be
found in this Codecs for Windows Media Player article. I don't recommend completely removing a codec as
several programs may be dependent on it. In particular do not remove any unfamiliar or default Microsoft
codecs. If you do, you can re-download the default codecs for Windows Media Player as a package from
Microsoft Codecs.

If you are having problems and want to determine if any of your codecs are broken you can use the Codec
Detective which will list broken codecs and generate a text file which you can examine or send to a tech
support person or post on an Internet forum for further help.

PROPRIETARY FORMATS

The most common third party codec required to play back videos found on the web is DivX, which once
installed will allow all your media players to play back DivX content. However there are certain types of
media which won't normally play back on Windows Media Player or other common media players due to
proprietary issues. The QuickTime .MOV and the RealPlayer .RM formats are two types of files which
require special codecs and are usually viewable using their respective players: QuickTime Player and
RealPlayer. However if you don't want to install these players, and instead want to view these audio/video
files on Windows Media Player, or other players (see below), you should install the Real Alternative and
QuickTime Alternative codecs.

B OTHER MEDIA PLAYERS

There are several alternatives to using Windows Media Player, including the following popular free media
players:

WinAmp
QuickTime Player
RealPlayer

DivX Player

While I can't go into too much detail about each of them here, they are each good players, and it depends on
your personal preference as to whether you choose them over Windows Media Player or not.
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MEDIA PLAYER CLASSIC

There is a free generic media player which can play back most formats, including proprietary formats, and is
also both easy to use and utilizes very little system resources. It is Media Player Classic and requires no
installation - the entire player is in one .EXE file. It also requires no tweaking as such, it is ready to be used
immediately without any issues. Give it a try as it is a great alternative to the other players, and you may
even end up preferring it over Windows Media Player or any other media player.

This concludes the Windows Media Player section.
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VISUAL & CONVENIENCE TWEAKS

This section covers a range of miscellaneous tips and tweaks which are designed to allow you to further
customize the appearance of Windows XP, as well as improving XP functionality. None of the tweaks in this
section is necessary for ensuring that you have a fast, stable system, however many of them will save you
time or make using Windows XP more enjoyable, so they are still worth considering. Please note that some
of these tweaks can also be performed by a range of tweaking and customization utilities covered elsewhere
in this guide, such as TweakUI, so you don't have to use the Registry Editor for example if you don't want to.

B TIPS & TWEAKS
REMOVE TEXT FROM DESKTOP ICONS

To remove the text beneath an icon on your Desktop, follow these steps:

1. Right-click on the icon whose title you want to remove and select Rename
Instead of entering any characters in the text box, hold down the ALT key and type 255 (ALT +2 + 5 + 5).
Note you need to use the NUMPAD number keys for this to work (i.e. the numbers to the right of your
arrow keys, not the ones at the top of the keyboard).

3. When you release the ALT key the title will be blank, and you can press Enter to accept this. Blank titles
are usually denied under Windows, but not when done this way as it inserts a special blank character.

4. For every other icon whose title you wish to remove do the same as above. Note however that since no
two icons can have the same name, for each subsequent icon you'll have to add an additional ALT 255 to
the end of the string you enter. That is, to blank a second icon name you'll need to hold down ALT and
type 255, release, then hold ALT and type 255 again, then release and press Enter. For a third, you'll have
to type ALT 255, ALT 255, ALT 255, and so on.

If you want to regain the icon names you will have to manually edit each icon's name to whatever you want.

REMOVE THE BOX AROUND DESKTOP ICON TITLES

If you have applied the 'Remove text from desktop icons' tweak above and you still see a faint box where the
text was, you can remove that box by doing the following:

1. Go to Control Panel>System>Advanced and click the Settings button under Performance.
. Tick 'Use drop shadows for icon labels on the desktop' under the Visual Effects tab and click OK.
3. Check your desktop. The boxes should be gone, regardless of whether you removed the text or not. If
they're still there, right click on the desktop, look under 'Arrange Icons By' and make sure there's no tick
against 'Lock Web Items on Desktop'.

CREATE DESKTOP ICONS FOR SHUTDOWN OR RESTART

Instead of clicking Start>Turn Off Computer and selecting Shutdown or Restart, you can create desktop
icons which automatically shutdown or restart your PC with just a double-click. This tweak makes use of the
Shutdown.exe command line to create a new shortcut as follows:

SHUTDOWN ICON

Right click on an empty area on your desktop.

Select New>Shortcut.

In the first box of the Create Shortcut Wizard, type "Shutdown -s -t 00" (without quotes). Click Next.

Call the shortcut something descriptive like 'Shutdown' and click Finish.

To add the finishing touch, right click on this new icon, select Properties, click the Change Icon button

A

and select an appropriate icon.
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REBOOT ICON

Follow the same steps as for the Shutdown Icon, but substitute the following steps in place of the
corresponding ones above:

3. Inthe first box of the Create Shortcut Wizard, type "Shutdown -r -t 00" (without quotes). Click Next.
4.  Call the shortcut something like 'Restart' and click Finish.

Note that double-clicking on these icons will commence shutdown or restart of the PC straight away without
any warning. If you want a countdown before a shutdown or restart, substitute a time in seconds in place of
the '00' entries in the shortcut properties above (e.g. 'Shutdown -s -t 10' gives 10 seconds warning before
shutting down). Also note that once the shutdown or restart process begins it can't be aborted. If you want
more command line switches which can be used with the shutdown command, go to Start>Run and type
"emd" (without quotes) and press Enter, then type "shutdown" (without quotes) in the command prompt.

CREATE DESKTOP ICON TO LOCK THE COMPUTER

Just as you can create Shutdown and Restart icons, you can also create an icon which locks your computer
immediately and requires that a user login again before gaining access. To do this, follow these steps:

1. Right click on an empty area on your Desktop.
. Select New>Shortcut.
3. In the first box of the Create Shortcut Wizard, type "Rundll32.exe User32.dll,LockWorkStation" (without
quotes). Note there is no space between the comma and LockWorkStation. Click Next.
4. Call the shortcut something like "Lock PC" and click Finish.
5. To add the finishing touch, right click on the new icon, select Properties, click the Change Icon button
and select an appropriate icon.

Now whenever you click this icon your PC will instantly be locked, and can only be accessed by the user
entering a correct password in the Login box. Note you can also lock the computer at any time by pressing
WINDOWS + L. Also note that if you have an account with no password, locking the desktop is pointless as
anyone can login by just leaving the password field blank and clicking OK to log back in.

SAVE DESKTOP ICON POSITIONS

This tweak is a personal favorite of mine. Basically it allows you to save the current positions of your
desktop icons so that if the icons are rearranged or moved you can restore them back to these original
positions at any time. To give you this added functionality in XP, do the following:

Download the file Layout.zip (mirror: here) and extract the contents to an empty directory.

Copy the file Layout.dll to your \ Windows \ System32 directory.

Double-click on the Layout.reg file to automatically make the appropriate changes to your Registry.

Go to your Desktop and arrange all your icons as you would like them to be saved.

Once done, right-click on the Recycle Bin and select the new 'Save Desktop Icon Layout' option. The
positions of all the icons are now saved. You can move the icons around freely and whenever you want
them restored to their original saved positions, right-click on Recycle Bin again and select 'Restore

AN

Desktop Icon Layout'.

This tweak is particularly handy if you're installing new graphics card drivers for example and your
Desktop icons get messed up, or you change resolutions and they get bumped around, or if you accidentally
move an icon while trying to double click on it.
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CHANGE DESKTOP ICON SIZE

You can alter the size of Desktop icons by using this tweak as follows:

[HKEY CURRENT USER\Control Panel\Desktop\WindowMetrics]

Shell Icon Size=32

The value of this STRING entry determines the size in pixels both for the height and width of desktop icons.
The smaller the value, the smaller the desktop icon. The default value is 32, which is a 32 x 32 pixel icon.
Create the entry if it doesn't exist and assign the desired value, then reboot Windows to implement it.

SET SPACING BETWEEN DESKTOP ICONS

To adjust the spaces between your desktop icons, you can manually move them. However if you've chosen
automatic spacing (Right-click on the Desktop and select Arrange Icons by>Auto Arrange) then you can
adjust the vertical and horizontal spaces placed between each icon by doing the following:

1. Right-click on the Desktop and choose Properties to bring up the Display Properties box.
Select the Appearance tab, then the Advanced button.

3. Under Items select 'Icon Spacing (Horizontal)' and 'Icon Spacing (Vertical)' and edit their values to
determine how many pixels are placed between the icons. The defaults are 43 pixels between icons.
Smaller values squeeze them closer together, higher values spread them further apart.

4. If your Desktop icons are aligned to the Desktop grid, you may have to right-click on your Desktop, go
to Arrange Icons By>Align to Grid and untick it, then go back and retick it for the icons to reposition to
the new spacings.

REMOVE 'SHORTCUT TO...' FROM NEW SHORTCUTS

Whenever you create a new shortcut, the words 'Shortcut to..." appear in front of the shortcut's name. To
remove this default prefix for new shortcuts, open Registry Editor and change the following:

[HKEY CURRENT USER\Software\Microsoft\Windows\CurrentVersion\Explorer]
Link=00 00 00 00
Create this BINARY value if it doesn't exist and set it equal to 00 00 00 00 to remove the 'Shortcut to..." prefix
in front of new shortcuts. Reboot Windows to implement the change.
CREATE A CUSTOM POPUP MENU ON THE TASKBAR
To put your favorite shortcuts all under one easy-to-access pop-up menu on the taskbar, do the following:
Open Windows Explorer and create a new folder wherever you prefer.
Put shortcuts to all your favorite programs, pictures, documents, songs etc. in this folder.
Right-click on an empty area of your Taskbar, and choose Toolbars>New Toolbar.

In the New Toolbar dialog box, browse to where you created your new folder with all the shortcuts,
highlight the folder and click OK.

L

You will now have a new item on your Taskbar with the name of the folder you created earlier. Click on the
double arrows just above its name and you'll get a popup menu of all the programs you can now quickly
access. If you want to remove this folder from the Taskbar, right click on an empty area of the Taskbar and
select Toolbars, and untick the folder's name from the list.
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B CuUusTOM WINDOWS THEMES

One of the biggest benefits of Windows XP over other Windows versions is that you can customize
Window's Graphical User Interface (GUI) or 'skin' as much as you want. By default XP comes with two main
Visual Styles - Windows Classic Style and Windows XP Style. You can choose either of these by going to
Control Panel>Display Properties>Appearance and selecting one under the 'Windows and Buttons' section.
Note that you must have Themes enabled to do this; you can enable Themes this by going to Control
Panel>System>Advanced, click the Settings button under Performance and on the Visual Effects tab make
sure there's a tick next to 'Use visual styles on windows and buttons'. Aside from the built-in themes you can
also download new official ones like the Zune or Royal Noir themes.

Microsoft has not made it easy to modify or install any unofficial styles beyond those which it provides. You
will need specialized tools and some detailed information on how to download and install custom themes,
or to create your own. Full details can be found in this comprehensive Windows Customization Guide.

WINDOWBLINDS

If you want full details of how to customize Windows, see the guide above. However to install a custom
theme quickly and easily, you can use two methods outlined here. The first involves using an automated
utility called WindowBlinds. The basic version of this program is free and implements most aspects of a
theme. Once you have installed WindowBlinds you can download a wide range of free custom themes from
WinCustomize, GetSkinned or DeviantArt for example. Note however that WindowBlinds needs to run in
the background in Windows for the theme to work, and can therefore increase resource usage. If you don't
like this I recommend the method below which is trickier but less resource-intensive.

UXTHEME MULTIPATCHER

If you want to use a manual method which does not involve a program running in the background like
WindowBlinds does, try the free UXTheme MultiPatcher. You will need a theme file which in 'MSStyles'
format, such the ones listed here at GetSkinned. This means the downloaded theme package has to have at
least one .MSSTYLES file for Windows to see it and use it. Installing UXTheme MultiPatcher does involve an
element of risk because it replaces a core Windows system file, so follow these instructions to install it:

1. Make sure to backup your uxtheme.dll file in your \WINDOWS\system32 directory to a floppy disk or
CD. This is a vital step, so don't miss it - see step 3 below.

2. Run UXTheme and follow the prompts. Your uxtheme.dll file will have its Windows File Protection
removed and will be patched to allow custom themes, then you should reboot as required.

3. If you find you cannot reboot your system to get back into Windows, go to the Windows Recovery
Console (See Backup & Recovery section) and copy your backed up uxthemedll to the
\ Windows\ System32 directory and reboot - clearly UXTheme doesn't work with your system.

4. Typically you should extract the contents of your custom theme package to sit under the
\WINDOWS\ Resources\ Themes\ directory.

5. Go to Control Panel>Display and select the Appearance tab. Under the 'Windows and Buttons' scroll
box, select the new theme.

GLASS2K

If you want to make any of your themes appear transparent and glasslike, you can download and use the
free Glass2K program. It allows you to add any level of transparency to any window as well as the Taskbar.
Give it a try as it is simple to use, however note that it needs to run in the background to work.

As a final note, if you have low amounts of system RAM I recommend you steer clear of installing complex
themes via any method as they may make your system less responsive and increase loading times and
stuttering in applications and games.
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B KEYBOARD & PROGRAM SHORTCUTS

Most people know that you can use the keyboard to speed up access to common commands and functions in
Windows XP. Some people use these keyboard shortcuts a great deal, others rely mainly on their mouse for
everything. This section contains the majority of the most useful Windows XP keyboard shortcuts, and even
some shortcuts you can type in the Start>Run box to gain quick access to useful utilities in Windows. I
recommend you get used to using some of these regularly as they quickly become second nature.

MICROSOFT ON-SCREEN KEYBOARD

If you are having problems using your keyboard you can bring up the Microsoft Onscreen Keyboard utility
by going to Start>Run and typing "OSK" (without quotes) then press Enter. The virtual keyboard will be
displayed, allowing you to use your mouse to click on virtual keys as though you were using a keyboard. To
make things easier, position the OSK somewhere convenient and then select 'Always on Top' under the
Settings menu in the Onscreen keyboard so you don't constantly have to switch back and forward between
tasks to use it.

Note if you can't click the left mouse button to select keys, under the Settings menu select 'Typing Mode' and
then select the 'Hover to Select' option. Now you can just place your mouse cursor over a key on the
Onscreen Keyboard and it will register as an entry. Set the length of time needed to hover over a key before
it registers as an entry (values in seconds between 0.00 and 1.00 second).

MOUSEKEYS

If instead of your keyboard you are having problems using your mouse, you can enable the Windows
MouseKeys functionality by going to Control Panel>Accessibility Options>Mouse and ticking the 'Use
MouseKeys' box. Alternatively you can press CTRL + Left SHIFT + NUMLOCK to activate this functionality.

MouseKeys allows you to use the Numpad keys - the numerical keys on the far right of your keyboard - to
move the mouse cursor around on screen.

COMMON KEYBOARD SHORTCUTS

CTRL+A - Select all

CTRL +C - Copy selected item(s)

CTRL + X - Cut selected item(s)

CTRL +V - Paste copied/cut item(s)

CTRL+Z - Undo last action

CTRL +Y - Redo last action

SHIFT + DEL - Deletes item, bypasses Recycle Bin

CTRL + ESC - Open Start Menu

ALT +TAB - Switches between active programs

CTRL + ALT + DEL - Opens Task Manager

ALT +F4 - Closes program or opens 'Shut down computer'
SHIFT + LEFT CLICK - Select multiple items at once within a range
CTRL + LEFT CLICK - Select multiple items at once individually
TAB - Steps forward through screen elements
SHIFT + TAB - Steps backward through screen elements
F1 - Open Help function

F2 - Rename/Enter text for item

F3 - Search key

F5 - Update/Refresh active window

F11 - Toggle Fullscreen mode

SHIFT + F10 - Open Context Menu for item

ALT + SPACEBAR - Open Windows Properties menu

SHIFT + CD/DVD INSERT - Hold Shift while inserting a CD/DVD to prevent Autoplay
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WINDOWS KEY SHORTCUTS

WINDOWS Show Start Menu

WINDOWS + D Minimize/Restore all Windows
WINDOWS +E Open Windows Explorer
WINDOWS + F Open Windows Search
WINDOWS + L Lock Workstation

WINDOWS + R Open Start>Run box
WINDOWS +U Open Accessibility Utility
WINDOWS + BREAK Open System Properties
WINDOWS + F1 Open Help & Support

PROGRAM SHORTCUTS

The following are file names you can insert into shortcuts or in the Windows Run box (Start>Run).

ADMINISTRATIVE TOOL SHORTCUTS

Services.msc
Gpedit.msc
Comexp.msc
Eventvwr.msc
Secpol.msc
Perfmon.msc
Compmgmt.msc

Services Utility

Group Policy Editor
Component Services
Event Viewer

Local Security Policy
Performance Monitor
Computer Management

ACCESSORIES SHORTCUTS

Cmd Command Prompt

Calc Calculator

Cleanmgr.exe Disk Cleanup Utility

Dfrg.msc Disk Defragmenter

Notepad Notepad

Pbrush Paint

Wmplayer Windows Media Player

Wordpad Wordpad

Wupdmgr Windows Update
CONTROL PANEL SHORTCUTS

Control
Sysdm.cpl
Devmgmt.msc
Desk.cpl
Main.cpl
Timedate.cpl
Inetcpl.cpl
Mmsys.cpl

Control Panel

System Properties
Device Manager

Display Properties
Mouse Properties

Clock Properties
Internet Properties
Sounds & Audio Devices

DIRECTORY SHORTCUT

If you want to get to a particular directory folder, go to Start>Run and type the name and path of the folder
in the Run box, then press Enter. Windows Explorer will open up in that directory instantly. If you don't
specify the full path, Windows Explorer will open up at the first incidence of that directory. You can also
assign this path to a shortcut and use it to open Windows Explorer there by default whenever the shortcut is

used - see the Windows Explorer section for details.

That covers our look at visual and convenience tweaks and tips. Clearly you can do a lot to customize and
tweak your Windows XP, so experiment with it to get it looking and feeling exactly the way you want.

SDUSIUDAUOY) 39 [ENSIA

Copyright © 2007 Koroush Ghazi

148




O.IJE ARSI e s

THE TWEAKGUIDES TWEAKING COMPANION

OVERCLOCKING

When people want additional performance from their machines, they may undertake a procedure called
Overclocking. Overclocking is the process of increasing the clock speed of a component in your PC. The
‘clock’ referred to is a specialized oscillator pulsing with a frequency that determines the rate at which a data
processor can perform instructions. A 3 Gigahertz (GHz) CPU for example has a frequency of oscillation of
around 3 billion pulses per second by default. The theory of overclocking is simple: increase this clock speed
and you'll increase the rate at which instructions are performed, leading to a faster PC. Overclocking is
possible on a range of hardware components including CPUs, Graphics cards, Motherboards and RAM.

There is also another way of overclocking which doesn't really involve increasing the clock rate: altering
timings. Memory-based components such as system RAM and Video RAM have latency timings - rest
periods between operations measured in nanoseconds. By decreasing the latency time, a memory component
can be made to wait less between completing specific operations and hence function faster.

So why is overclocking possible or even necessary? Why aren't the hardware components you buy not
already performing to their absolute maximum potential? Well ironically the reason for that is just the same
as the reason why Windows XP has so much scope for optimization and customization: the many different
circumstances under which the hardware will potentially be used. Because components are expected to work
in diverse environmental conditions and be put to vastly different tasks, hardware manufacturers ensure a
safe headroom is provided so that in adverse conditions the component can still operate safely and with
stability. Overclocking takes up this slack by pushing the component beyond manufacturers' specifications.

Of course when you push a component beyond its recommended specifications the component requires
ideal conditions to continue operating with stability. That usually means more cooling on/around the
component, since any cooling device it already uses is only really designed to deal with stock operation. The
component also requires stable voltage from the Power Supply either directly or through the motherboard.
Often to achieve a stable overclock the component may also require additional voltage, which in turn can
add to heat and hence raise the cooling requirements even further. Furthermore, the additional heat being
dissipated from one component may cause other nearby components to overheat. As you can see
overclocking is not as simple as it first sounds, and there are often complex interactions involved both at the
hardware and software level which must be taken into account to achieve proper stability.

B BENEFITS AND DRAWBACKS

Before going into any more detail about overclocking it is important to discuss the advantages and
disadvantages of overclocking objectively, so you don't undertake it without knowing what you're getting
yourself into:

BENEFITS

* Increased performance - this is of course the primary reason why people overclock. The degree to which
performance improves depends on the component(s) being overclocked, how far they are overclocked,
and whether they are the hardware most relied upon by particular games and applications. The
performance difference can be anywhere from negligible up to 25% or even more.

» Bragging rights or 'coolness factor' attached to overclocking - some people gain a great deal of
satisfaction and prestige in having the fastest machine, or the highest overclocked component, or the
highest benchmark score. Or they may simply feel they are extracting the most out of their hardware by
overclocking it. Some people also enjoy the tinkering and hobbyist aspect of overclocking and hardware
modification. In that way it's a lot like tweaking.
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DRAWBACKS

* There will be costs in providing additional cooling - in almost all cases you will have to purchase
additional cooling for your system in the form of more efficient heatsinks and/or more fans, a case with
more space or better airflow, or even specialized equipment like water cooling or phase-change cooling
units. Of course if you start out by planning your system carefully, you can minimize the additional
costs by beginning with the right components.

* The component, and therefore your entire system, may become unstable and crash randomly - without a
doubt the number one cause of problems in games and applications is overclocking. People often refuse
to acknowledge that their overclocking is the cause of the problem, and mistakenly blame Windows,
their drivers or the game or application instead. Different programs react differently to overclocking.
Some can tolerate much higher levels of overclocking on particular components, some cannot tolerate
any overclocking at all; it all depends on how stressful the game or program is, and how stable or
unstable the overclock actually is.

= DPotential data corruption if certain components are pushed beyond their limits - pushing components
like the CPU or RAM beyond their limits on your system can result in instability leading to data
corruption, up to and including the loss of all your hard drive data. Often this data corruption can occur
subtly over time without any indication or warning.

* [Excessive heat can damage or permanently kill a component - since computer hardware is based on
sensitive electronic equipment, if a hardware component is not kept adequately cool (and even in some
cases if it is) it can be permanently damaged or destroyed through overclocking. It happens quite often,
especially with graphics cards, so it is not as rare as you might think.

= Overclocking automatically voids the warranty on the component - hardware manufacturers make it
clear that overclocking beyond recommended clock speeds or timings will instantly void your warranty.
This also goes for any physical modifications to the hardware such as changing its cooling. A warranty is
only designed to cover unmodified hardware operating within specifications.

* Opverclocking reduces the life span of the component - since the component is working beyond
specification and working hotter and faster than it was designed to handle, most components will have
reduced life spans. This can vary from a reduction of a few months to a few years, depending on the
extremity of the overclock, the quality of the components and how well the components are kept cool. A
mild overclock typically has little or no practical impact on the life expectancy of a component; an
extreme overclock can drastically reduce the error-free life of a component.

So far the disadvantages appear to far outweigh the advantages of overclocking. This is not strictly true, it all
depends on how far you overclock a component and how much performance you can gain in return, as well
as the quality of the hardware itself. Don't get me wrong; I'm not suggesting you categorically shouldn't
overclock. But I do feel that it's important to point out that it is not a simple or even beneficial procedure at
all times. Despite everyone urging you to overclock your system you should weigh up the options rationally
and either choose to avoid overclocking due to potentially modest performance gains and/or the strong
likelihood of instability/damage; or alternatively research the topic thoroughly and invest appropriately to
achieve a good balance of performance, stability and safety.

The bottom line is if you can't afford to replace a vital system component should it get damaged, do not
overclock it. If your CPU or graphics card dies for example and you can't replace it your entire computer
becomes unusable, so it is not something to be taken lightly just because people egg you on to do it.

B METHODOLOGY

Below I discuss how to overclock key system components. The precise details will vary depending on your
particular hardware configuration and BIOS options. The information below is only indicative and should
broadly give you an idea of the types of steps involved in overclocking. Importantly, before commencing any
overclocking you must make sure you are totally familiar with the exact brand, model and specifications of
your major hardware components. If necessary refer to any packaging or manuals which came with your
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system, and more importantly see the System Specifications chapter for links to tools which can help you
identify your components and their precise capabilities in detail.

Also make sure that before changing any BIOS settings for the purposes of overclocking that you record
your existing BIOS settings. This is because in some cases when overclocking beyond the point of stability,
you will have to reset your BIOS (or it may reset automatically) back to its factory default settings, losing any
customized settings you've put in. So make sure you document what the major BIOS settings are which
you've altered through any general BIOS customization.

CPU OVERCLOCKING

Overclocking a CPU on most systems involves increasing the Front Side Bus (FSB - for Intel CPUs) or
HyperTransport (HTT - for AMD CPUs) speed of your motherboard in your BIOS. The FSB/HTT is the main
pathway (Bus) between your major system components, and as its speed increases, information is
transferred back and forth more rapidly between all your major components working off this bus speed.
However there are certain problems with increasing the FSB/HTT. To start with, some components running

off this bus, such as your PCI devices (e.g. a Sound card) operate at a much lower bus speed by default, so
your motherboard has special dividers/multipliers or even a Lock to maintain the bus speeds at or close to
their default. Importantly, your system RAM may rely on the main Bus speed to determine its speed in
conjunction with some form of divider/multiplier.

Your CPU also has a Multiplier, which as the name suggests sets the CPU speed in MHz as a multiple of the
main Bus speed. For example on a system with an effective Bus of 200MHz and a CPU that has a multiplier
of 20 gives you a CPU speed of 20x200 = 4000MHz = 4GHz. Note that some CPUs have their multiplier
locked at the hardware level, which means you can't actually change it. The Multiplier and the Bus speed
can be used together to achieve a performance result in conjunction with the RAM speed.

RAM OVERCLOCKING

Increasing the speed of your RAM is dependent on a number of factors. Overclocking refers to the process of
increasing the clock speed of a component; in the case of system RAM this involves raising the system Bus
speed and/or changing the memory divider/multiplier and/or simply raising the RAM's Frequency directly
to alter the RAM's speed in MHz - depending on your available BIOS options. However you can also alter
the Timings (or Latency) of a memory chip such that it refreshes faster between operations, meaning less
waiting time between each operation and hence faster performance. Changing timings is not overclocking
strictly speaking, since you are not increasing any clock speeds, but in general terms it has similar
performance-boosting potential.

People often ask whether increasing RAM speed or lowering latency is the better option. This White Paper
by Corsair covers the issue, but there is no set answer - it all depends on your system and the applications
and games you most commonly run as to the precise combination of RAM speed and RAM latency which
will perform best and with greatest stability, so you will have to experiment. Generally speaking,
applications or games which have large amounts of non-graphics information to transfer to the CPU and
back will benefit more from greater RAM speed, which provides more bandwidth. On the other hand
applications and particularly games which primarily require very complex calculations with repeated access
to information in memory will benefit more from lower RAM latency. Obviously some games require both,
so there is no clear-cut answer.

RAM overclocking also depends a great deal on how many sticks of RAM you have, their quality, and how
‘matched’ they are. Because your RAM sticks work together, if you have two or more sticks of RAM in your
system, you must try and ensure that firstly they are all equally matched in terms of rated speed and
timings, and secondly that they should ideally be from the same brand and model of RAM. RAM sticks can
vary in quality and performance, so having mixed brands or types of RAM can lead to a variety of problems
- even when running at default speeds.
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GRAPHICS CARD OVERCLOCKING

The following is a modified summary from my ATI Catalyst Tweak Guide and Nvidia Forceware Tweak
Guide. It applies to all graphics cards regardless of brand, however if you are an ATI or Nvidia graphics
card user please read through the relevant guide above for full details.

The modern graphics card is a lot like a small computer by itself. It has a Graphics Processing Unit (GPU)
which is the graphics equivalent of the CPU, it sits on a motherboard-like Printed Circuit Board (PCB), and
has its own Video RAM (VRAM). And just like a computer system, the components on a video card can be
overclocked to increase performance. Overclocking a graphics card involves increasing the frequency of the
GPU (also called the Engine or Core) and/or the Video RAM (also called VRAM or Graphics Memory). You
can overclock one or both of these components, with varying results based on a number of factors, but
generally resulting in an increase in performance the higher you overclock each component. To overclock
your video card, ideally you'll need a tool which allows you to change the clock speeds of the Core and the
VRAM - refer to the guides above for links and instructions.

Overclocking your video card is similar to CPU overclocking and RAM overclocking combined - simply
increase the clock speed of the Core/Engine, and/or the clock speed of the Graphics Memory, both of which
are measured in MHz. The Core generates graphics data, and depending on your CPU and the rest of your
system specifications, increasing the core speed can result in a small or large performance improvement. The
Video Memory transfers information to/from the Core, and increasing its speed can once again improve
performance either slightly or significantly, in conjunction with your Core speed and the speed of the rest of
your system.

As a general rule, if you have a fast graphics card and a slow CPU, then overclocking your graphics card
yields less performance improvements. If you have a fast CPU and a slower graphics card, then overclocking
the graphics card can show greater improvement. The reason for this is that if the graphics card is the weak
link (or 'bottleneck’) in the equation, and a particular game requires more graphical power and speed, then
quite clearly overclocking the graphics card can show more of an improvement than in situations where the
CPU or the rest of your system is the weak point.

Remember if you have an old or low-end graphics card then overclocking is unlikely to improve
performance dramatically. The reason for this is that certain lower end graphics cards simply do not have
hardware support for the advanced functionality demanded by recent games, like the latest Pixel Shaders
and Vertex Shaders. If your card does not have hardware support for a required advanced function,
overclocking cannot surmount this handicap.

VOLTAGE ADJUSTMENT

As components are pushed outside specifications with overclocking, they will do more work. Often they can
accommodate this extra work within their current voltage, however sometimes to gain stability and/or to
push a component further, you will have to increase the voltage to these components. The three main
components that can benefit from voltage tweaking are the CPU, the graphics card and RAM. The two main
voltage adjustments you will find in almost any BIOS are VCore and VDIMM, and these are explained
below.

CPU Voltage (vCore): This is the amount of voltage applied to the CPU. The base voltage will vary depending
on the CPU architecture, however make sure to note what your CPU's default voltage is before raising it. The
only reason to alter the vCore from its default is that when overclocking your CPU you may notice that you
cannot overclock it beyond a certain point, or that you experience a lot of instability. Raising the vCore
slightly in your BIOS may allow the CPU to regain stability and/or allow you to push the CPU further. The
theory behind raising the vCore is more complex than just supplying more juice to the CPU, and you can
read about it in this CPU Overvolting Article as well as this Wikipedia Article. The most important thing to
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understand is that upping the VCore beyond a certain point can result in permanent damage to your CPU,
and generally speaking any increase in the VCore can further shorten the life span of a CPU. However for
the most part a small bump in voltage (e.g. 0.1 or 0.2 volts) can help stabilize an overclocked CPU that is
acting slightly unstable. Just remember that more voltage requires greater cooling to maintain safe
temperatures.

RAM Voltage (vDIMM): Also sometimes called DDR Voltage, this is the amount of voltage for the RAM
DIMMS (Dual Inline Memory Modules). Just like vCore, increasing vDIMM can improve stability, and RAM
in particularly can benefit from higher voltages when your system is suffering from stability issues under
overclocked conditions. This is particularly true if you're experiencing random reboots or crashes to desktop
as these are almost always RAM related in some way. Once again, increasing the voltage to your RAM can
result in permanent damage so do not overvolt by a substantial amount without first consulting with other
owners of the same RAM and motherboard combination to see what a recommended 'safe' voltage level
would be. As always make sure your RAM has plenty of fresh cool air circulating around it to prevent any
heat buildup.

There may however be additional voltage settings in your BIOS, and unless you have full knowledge of
what they do, and what a safe adjustment is, do not alter them as you can permanently damage or kill your
components this way.

POWER SUPPLY UNIT

Your Power Supply Unit (PSU) is an essential part of your system, and one that is often ignored, especially
when overclocking. For basic details regarding PSUs see this PSU Article which talks about the common
output specifications for PSUs and what they mean. Essentially while the amount of voltage supplied for
each component is important, equally as important is the variability in this voltage and how closely it
adheres to the specified requirements for each component. Sensitive electronic components require stable
‘clean’ voltage to operate at maximum stability. If there is substantial variability in the voltage to a particular
component as its demands change, this can contribute towards crashes, freezes and sudden reboots.

There are two main aspects to a power supply that will tell you how good they are for your system. The first
is the Wattage. This specifies the maximum power output of the PSU in Watts, and a simple rule is that the
more devices you have connected to your system, the higher the Wattage of the PSU you will need. As a rule
of thumb, I recommend at least a 350W power supply for modern PCs, preferably 480W or above. However
as soon as you attach several optical drives, hard drives, case fans and various USB devices for example you
will find even 480W may not be enough when combined with a power-hungry CPU and graphics card. To
work out the PSU Wattage which is sufficient for a particular system, use this Interactive PSU Calculator.

The second, and more important, but lesser known aspect of a PSU is the stability of the voltages along the
+12V, +5V and +3.3V rails. That is, how close is the actual voltage being supplied to your components on
these rails to the advertised requirements (i.e. 12V, 5V and 3.3V). For an explanation of these see the PSU
guide mentioned above. The most accurate way to check is to use a voltmeter, but that requires the right
equipment and a bit of technical expertise. The common way for most people to get an indication of voltage
stability is to use some sort of monitoring software. There should be one such utility included on your
motherboard's driver CD, or available on your motherboard manufacturer's website. Use it to check your
voltages and see how variable they are when performing various tasks. The more variation there is in the
voltage over time, and greater the variation from the rated voltage for a rail - especially when you computer
is under load - the greater your chances of experiencing crashes, freezes and reboots due simply to
inadequate and/or unstable power supply to your components - especially when overclocked.

Do not underestimate the importance of a good quality PSU with sufficient wattage and stable voltages.
Your entire system can suffer from constant instability unless you have a decent suitable PSU.
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COOLING

The very first thing that happens as you begin to push your components beyond their recommended
specifications through overclocking is that they will work harder, and hence will generate more heat. It is
essential that you provide more cooling to these components, so that they can expel the additional heat and
remain within safe operating temperatures - otherwise the components will begin to malfunction, and
ultimately they may be permanently damaged, sometimes within a matter of minutes. Furthermore, a typical
computer case is designed such that it traps heat, and hence excess heat output from one component can
begin to affect other components in the case, causing them to overheat even if they are at stock speed. In
extreme cases, on a warm day your entire system can begin to malfunction even if everything is at stock
speed due to high ambient temperatures in the case. So good cooling is absolutely vital, even if you don't
plan on overclocking your components.

To begin with, you may be wondering how to measure your system's temperature. Well your CPU and
motherboard both have built-in diodes that measure the temperature for these components. The CPU
temperature monitor is a reasonably accurate measure of the temperature at or near the core of the CPU,
while the motherboard temperature monitor is a good measure of the general system (or case) temperature -
the ambient temperature of the air in the immediate vicinity of the motherboard. Most recent graphics cards
come with built-in temperature diodes as well, allowing measurement of the temperature near the core of
the graphics card. Most other components do not come with temperature measurement devices, and so you
can only tell their heat by touching them, or by using specialized equipment such as an electronic
thermometer.

To actually see the temperature readings from your components, you can check them in your BIOS typically
under a 'Hardware Monitor' section or similar. This gives you the CPU and motherboard temperatures while
the CPU is relatively idle. Clearly you need an additional method of checking temperatures under Windows,
especially when running a system intensive application. Your motherboard may already come with such a
software utility. Check your motherboard driver CD or the hardware manufacturer's website for such a
similar utility.

Monitoring your graphics card's temperature is possible through your graphics card control panel, generally
accessed via Control Panel>Display>Settings>Advanced. On ATI graphics cards this temperature display is
under the Overdrive section of the ATI Control Panel/Control Center. On Nvidia graphics cards the display
is under the Temperature Settings section of the Forceware Control Panel. Remember, only if your graphics
card is equipped with a temperature sensor can you monitor its temperatures in this way. If it is not so
equipped, the only possible course of action is to buy an electronic thermometer and attempt to measure the
temperatures near the GPU of the card. Also remember that the GPU temperature shown is not the same as
the Video RAM temperature which may be much higher.

The main thing to note is that you will need to monitor your CPU and motherboard temperatures at the very
least, and in particular you should run a temperature monitoring utility while running a CPU stress-tester or
an intensive graphical benchmark (See the Benchmarking & Stress Testing section). This will simulate just
how hot your system can get during sustained usage of CPU-intensive games or applications; that is when
CPU usage is consistently around 100%. If you see your CPU and/or motherboard and/or graphics card
temperatures reaching dangerously high levels during such stress testing, it is very likely you will
experience crashes, freezes and even damage to your components unless you introduce additional cooling to
reduce temperatures. So what is a 'safe' operating temperature for your components? The answer is different
based on different hardware architectures, as some are designed to run hotter than others, but you can
ascertain what a safe temperature under full load is by checking with other people who have a similar
system on any PC tech forum.

If you are experiencing problems with heat in your system, or if you just want to ensure that you remain
problem-free with regards to heat, try the following simple tips. They will help you obtain a more stable
overclock or even just a more stable system at stock speeds:
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* Remove any obstructions from around your case - for example do not have any of your case grills/air
holes obscured, pressed against a wall, blocked by dust etc. Insufficient flow of air into and out of the
case is the number one cause of heat buildup and heat-related problems. See the Troubleshooting section
for the correct method of cleaning and handling the contents of your case.

= If you have few or no major case fans drawing in cool air and expelling hot air, remove the sides of your
case so that the fans on the CPU, graphics card and Power Supply can get a fresh supply of cooler air,
and can expel hot air outside the case.

* If you do have several case fans, arrange them so that some are to the front and low in the case, sucking
air into the case (as the air near the floor is cooler) and some are to the rear and/or the top of the case,
blowing hot air out of the case (where the hot air expelled will rise away from the case). In this situation
make sure to keep the sides of your case closed so that the fans have more pressure to suck/blow air
through the case's contents like a wind tunnel.

*= Don't position a sucking and a blowing fan(s) too close together as they will 'short circuit' each other —
that is they will pass air through the shortest line between the two, bypassing your components and
hence not cooling them as efficiently. As mentioned above, fans sucking air into your case should be low
and on the furthest side of the case from the blowing fans that expel heat from the case.

= Tidy up the internal components of your case. This means all ribbon cables, power cables, etc. should be
clipped or twisty-tied to be as neatly arranged as possible, primarily to avoid blocking the flow of free
air around components, especially the CPU and graphics card which are the two hottest components in
most cases. Securing cabling and ensuring snug plug connections also means you can be sure nothing
becomes accidentally unplugged or short-circuited over time and hence causes hardware-based errors
that will confuse you in the future.

= If using additional internal cooling like larger heatsinks or fans, make sure they are not too heavy for the
surface they are mounted on. For example, using extremely large heatsinks on a graphics card can result
in the card actually bending under the weight and hence becoming permanently damaged. Even a large
heatsink mounted on a motherboard can cause it to warp or crack, once again damaging the
motherboard PCB beyond repair. If you feel you require such hefty cooling you should consider
reducing your overclock or buying a case that has better cooling instead of risking physical damage to
components through excessive weight.

* Make sure your hard drive is not smothered by cabling or crammed into a stuffy area of the case with no
nearby cooling or fresh air. Higher speed hard drives in particular (i.e. 7,200RPM or 10,000 RPM drives)
can heat up quite a bit - one touch of their metal casing will tell you just how hot. Hard drives are often
overlooked in cooling, and yet they are a vital system component, and as such you should make sure
they receive plenty of fresh cool air. You can buy specific 'drive cooler' fans which take up a CDROM or
Hard drive slot in your case and blow on the hard drives, but this is not vital as long as you keep the
area around the drive(s) free from obstructions.

= Make sure that any heatsinks on the motherboard itself are not covered or blocked by other components
or cables, or covered in dust. There is a reason why these heatsinks are there: because motherboard
memory controller chips for example require cooling otherwise they can malfunction due to excessive
heat just like any other major component. Don't assume a heatsink without a fan implies the component
requires minimal cooling, as sometimes manufacturers skimp on putting a fan on these heatsinks, which
simply means the heatsinks have to do more work, so keep them well exposed to cool air. You can even
consider installing a small fan on them if you wish, and this can aid in system stability.

That covers the basic cooling tips I can provide. Of course the most simple of all of these tips which anyone
can undertake is to provide greater access to fresh cool air for the case's contents and regularly clean the case
to remove dust buildup. Dust in particular can reduce airflow significantly, so keep your case dust-free by
using a damp cloth or compressed air (never use a vacuum cleaner due to static electricity).

In general cooling is critical for overclocking; without adequate cooling on and around your components,
overclocking simply results in massive instability or even permanent damage.
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COMPARING OVERCLOCKS

One of the most common statements I hear when people compare overclocks or are told that their overclock
is unstable is: "But my friend who has the exact same system can overclock it much higher than me and his
games don't crash!". A comment like that demonstrates a lack of understanding of some fundamental
principles of overclocking when comparing overclocks:

* No two components are exactly the same. Even if the two components being compared are an identical
brand, model and speed, they may have very different tolerances to overclocking depending on which
factory they were produced in and which revision they are (how early/late into the production run they
were produced - e.g. for CPUs this is called Stepping).

* No two people have the exact same conditions for their overclocking. Your computer room may be hotter
or cooler than your friend's, your case may provide better or worse cooling, your combination of
components may include a different PSU or different brand or speed of RAM, etc.

*  Your Windows settings and software environment will not be identical to anyone else's. You may have
sub-optimal software settings, background programs that are the source of conflicts, or even malware
causing problems, or you may even have data corruption.

* No two games are identical in the way they stress components on your machine, and hence if all of your
other games work absolutely fine at a certain level of overclock, it may well be that the latest game you
are playing has a completely different tolerance to your overclock and will crash 3 times out of 4.

OVERCLOCKING AND STABILITY

I'have a golden rule about troubleshooting any problem on an overclocked system:
Always start by assuming your overclock is the primary source of any problems

Begin the investigation of any problem on your PC by suspecting your overclock as the source of a problem.
Reset your entire system to its default speeds and see if the problem persists or is as severe. If the problem
goes away, or doesn't happen as often you can be certain your overclocking is contributing in some way to,
or is the sole cause of, your problems. You will have to lower or remove your overclock and/or increase your
cooling.

Details on how to correctly test your system for stability are covered in the Benchmarking & Stress Testing,
but bear in mind that even if your system passes every artificial test, the real test is having complete stability
day-in, day-out even when running stressful games and programs. If your system starts behaving strangely,
or you are having crashes and problems, don't persist in maintaining your overclock. I know from
experience that it is psychologically difficult to lower or remove an overclock because you may feel you are
losing extra performance that you deserve, but this is something you will have to deal with. Virtually every
day I receive emails or see forum posts from people who are wondering about some 'mysterious’' problem on
their machine, only to eventually find that it was in some way related to their overclocking. Subtle data
corruption can occur over time on overclocked systems, even seemingly stable ones, and this is one of the
main reasons why so many people often find they have to reinstall Windows every few months. This is not
exaggeration or scaremongering - electronic hardware components are highly accurate devices, forcing them
to run outside their normal operating speeds can increase the potential for small errors to creep into their
operation.

If it appears that I'm being overly harsh or biased against overclocking, it is because I've been doing it myself
since 1999 and I know full well how easy it can be to become lulled into accepting an unstable system as
somehow being the norm. It is totally false to claim that it is normal to constantly reinstall Windows, or that
it is normal for your system to crash every few hours. My last two (non-overclocked) systems have been rock
solid every single day for years, even after hours of very stressful gaming. My current system still has its
original two-year old installation of Windows XP running perfectly, as fast as the day I installed it. My
games do not crash randomly nor do my programs or system behave strangely. The point is if you're going
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to overclock, don't do it at the cost of system stability; do it properly. At the first sign of strange behavior,
don't be quick to blame everything else - suspect your overclock first and foremost.

RESEARCHING OVERCLOCKING

Having stressed the importance of researching overclocking before you dive into it, I recommend that you
start by referring to the following guides for more details. This is obviously not a definitive list of places to
research, nor have I personally tested out all the procedures in these guides - they are simply a starting
point:

Comprehensive Overclocking Guide

Tom's Hardware Overclocking Guide

Core2Duo Overclocking Guide 1
Core2Duo Overclocking Guide 2
Core2Duo Temperature Guide
AMD CPU Overclocking Guide 1
AMD CPU Overclocking Guide 2

Take the time to search Google and various tech forums for peoples' experiences with overclocking
hardware similar to your own. More often than not you will find someone who has a similar setup and who
has overclocked it with reasonable success, so look out for such information. Be aware however that people
often have different definitions of 'stable’ when it comes to overclocking, and of course as noted further
above, no two systems are identical so don't just automatically assume you can reach the same results using
similar hardware. Take the time to research, read and think about overclocking and make sure you have the
right tools and knowledge to undertake it properly.
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BENCHMARKING & STRESS TESTING

Sometimes when you change settings in Windows XP or your BIOS, or if you've applied a new tweak, or
perhaps if you've overclocked a system component it is difficult to tell whether your overall performance or
system stability has improved or decreased, and by how much. The best way to gauge performance changes
and system stability is to Benchmark your system and Stress Test it. There are a range of utilities that are
reasonably valid, objective benchmarking tools, and we will look at them in this section. We will also look at
some reputable stress testing tools.

It is important to understand that some benchmarking tools double as stress testing programs since they put
your system through a series of relatively rigorous tests to produce their performance figures. These tests
should assist in highlighting any latent instability in your system, so the simple act of benchmarking can also
result in stress testing your system. Stress testing plays a critical part in troubleshooting and diagnosing the
source of system problems, so do not skip this section.

B BENCHMARKING

To set the actual benchmark - or base level of performance - you should ideally run the benchmarking
program(s) prior to the majority of performance tweaks or changes you make, and note the initial results
they provide. That way once you've started tweaking you can run the benchmarks again to confirm that the
tweaks are having the desired effect, i.e. improving performance. However, most benchmarking tools
already provide some information on the comparative level of performance of your system; that is, whether
or not your system is above or below an average level of performance given the type of hardware you are
using. You can often compare results online with other users with similar systems for example.

You may choose instead to take your base level of performance as being a freshly installed and tweaked
Windows XP with no overclock for example, then perform additional alterations and perhaps even
overclock certain components, then retest against the base level to see what impact your changes have had.
The main point is that for benchmarking to be successful you need a reference point or starting point;
something to compare with down the track to determine whether your performance is going up or down
with the changes you have made.

Some important notes to keep in mind about benchmarking:

* Benchmarking programs usually focus on testing the performance of particular components of your
machine. Graphics benchmarks for example usually test the graphics card and to some extent the CPU's
performance. That means that if you want to test any tweaks you've made to your hard drive's speed for
example, a graphics benchmark is not the best tool to use.

= All benchmarking (and stress testing) programs can result in sudden crashes and reboots, and on rare
occasions data corruption, so as a precaution always make sure any valuable data has been recently
backed up before doing comprehensive benchmarking.

» For optimal results make sure that you do not have any other programs or games running in the
background when benchmarking, since these can lower your results and introduce significant
variability. They can also cause a benchmark to crash prematurely, misleading you into believing your
system is overly unstable.

» For the purposes of using a benchmark as a stress test you may want to run other stress testing and/or
benchmarking programs in conjunction with the benchmark, or other applications/games, to really put
the pressure on your machine. Of course this can still result in prematurely crashing a system, but it
would be an extreme test of system stability.

Below are the more popular benchmarking programs available for free, and how to use them correctly —
including details on the component(s) they primarily focus on testing:
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3DMARK

You can download the latest version of 3DMark from the FutureMark Website. 3DMark is an eye-catching,
popular and reasonably accurate 3D graphics benchmarking utility that has been around for several years
(the earliest version being 3DMark 1999). The latest version of 3DMark primarily utilizes your graphics card
and to a lesser extent the CPU, with the memory subset a player as well in this benchmark. 3DMark results
will give you a good indication of 3D gaming performance on your machine, and broadly speaking the
higher your results the faster the performance of recent games on your system. And in very general terms if
one system scores higher in the same version of 3DMark than another, then it should be better for gaming.

To use the free version of 3DMark start the program and click the Run 3DMark' button. You will see a series
of tests running. These use various graphical techniques, some of which may not be supported by your
graphics card, and some of which are only available in the purchased version of the benchmark. At the end
of the run the benchmark will present a final score. You can then use this score to compare with other people
who have run the benchmark and this will tell you whether your system is relatively faster or slower, and if
compared with others who have virtually the same system specifications, it will tell you whether you have
room to improve on your particular system. Note however that some systems with the same specifications
may be heavily overclocked just to get a high 3DMark score and not particularly stable for day-to-day use.

One method of comparing results with others is to simply find an appropriate forum and post your results
for comparison and discussion. For example you can compare results in the 3DMark Thread on the
TweakGuides Forums. Another method is to use 3DMark's Online Result Browser (ORB) to compare results
with others who have posted their 3DMarks. Using the ORB means you have a better chance of finding a
precise match for your system specs since the ORB has many thousands of users. To enter the ORB at any
time, click the 'Options' button under the Results section of the main 3DMark screen and then click the
'Online ResultBrowser' button.

If at any time you want to know your exact System Specifications, you can click the 'Details' button under
the System section of the main screen, and a list of all the items in your computer will be shown. You can
expand each major device by clicking the black triangle, and details such as clock speeds and driver versions
can be viewed. You can also install and run earlier versions of 3DMark, such as 3DMark05 or 3DMark03 if
you want to see how older games would perform on your system, or simply to see what previous versions
looked like. However remember that the scores from the different versions are definitely non-comparable,
and that the different versions stress the components of your system in different ways.

AQUAMARKS3

You can download Aquamark3 from MajorGeeks. Aquamark3 is another Direct3D/DirectX9.0-based
benchmark that also provides a result at the end of a series of graphical tests. Install Aquamark3 and start it,
on the main screen click the 'Select Measurement' button, and on the free version of Aquamark you can only
select the 'Start Measurement' under Option 1. At the end of the run, record your score, and you can then
compare this with others in the online Aquamark Result Comparator, which is similar to 3DMark's ORB.

CODECREATURES

An older Direct3D/DirectX8.1 benchmark, CodeCreatures can be downloaded from MajorGeeks. It is useful
as an indication of performance for older games and also a reasonable stress tester. Install the program and
start it, then click the Run button on the left side of the main screen to begin a series of strenuous tests.
Record the results you get at the end and keep them handy for future reference.

You may have noticed that all of the above are Direct3D benchmarks. This reflects the popularity and more
common usage of this Microsoft standard for developing games. However, there are some OpenGL
benchmarks you can use. One of the more popular ones is:
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GLEXCESS

You can download GLExcess (also called XSMark) from the GLExcess Website. As with most benchmarks,
installing and running the program results in a run through a series of tests, with results provided at the

end. You can upload and compare these results online using XSMark Results page.
In terms of general non-graphics benchmarks, the following are the more popular ones:

PCMARK

You can download the latest version of PCMark from the FutureMark Website. This general benchmarking
utility from the makers of 3DMark has been around for several years as well, and although not as reputable
or as widely used as 3DMark, provides a reasonably good benchmark of your computer's general
performance. It runs a series of tests based on such things as file encoding, disk reads/writes and basic
graphics display. To use PCMark run the program and click the 'Run PCMark' button on the main screen.
After several tests it arrives at a score you can compare with others online, whether on the TweakGuides
Forum or again on the ORB. Note that PCMark results are recorded separately from 3DMark results and are
not comparable figures.

SANDRA

You can download the latest version of Sandra from the SiSoft Sandra Website. Sandra (System ANalyser
Diagnostic and Reporting Assistant) is a system information utility with some benchmarking and stress
testing functionality. It contains a range of modules, each designed to inform you about, and often test,
certain components of your system, such as the RAM, or your various Drives. The free version of Sandra is
limited in the particular modules you can access and hence the tests you can run, however there are

sufficient benchmarks in the free version for you to use it as a decent system benchmarking tool.

To use Sandra, open the program and click on a particular module to see the relevant information for that
component. For example, click on the Mainboard module to see details about your motherboard such as the
manufacturer, chipset, current FSB, memory speeds etc. To see the modules which have benchmarking
functionality, click the Benchmarks tab and you will see modules such as the Processor Arithmetic', 'Cache
and Memory' and Physical Disks'.

To run a benchmark, open the appropriate module and press F5 or click the blue 'opposing arrows' (Refresh)
icon at the bottom of the module. This will begin a benchmarking run, after which you will eventually see
the results displayed at the top of the module. You might want to record the score(s) somewhere. You can
put the benchmarking results in context by looking at the reference figures provided beneath it. You can also
change the reference data to reflect a variety of hardware to compare against. Note that for the File System
Benchmark, by default it does not use the Windows File Cache, and this can give quite low results. To enable
the file cache, and hence see the real-world results of Windows memory management tweaking on your
Windows XP system, click on the Options button at the bottom left of the File System Benchmark module,
untick the '‘Bypass Windows File Cache' option, click OK then run the benchmark. Note also that the
'Internet Connection' benchmark will give inaccurate results depending on your geographic location.

Sandra also has a role as a stress tester, but this functionality is covered in the Stress Testing section below.

HDTACH

You can download HDTach from the HDTach Website. HDTach is a free hard drive benchmarking utility
that allows you to test your hard drive's speed. Launch the program, make sure all background programs
and applications are closed, select 'Quick Test' then click the 'Run Test' button and wait for the testing cycle
to complete. You will be presented with a graph showing the drive speed over the course of the drive. In the
right hand pane you can see the various speed statistics and CPU usage information for the tested drive. If
you want to compare your results to users online, click the "Long Bench' option and then 'Run Test', and this
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time when the benchmarking run is completed you can click on the 'Upload Results' button to lodge your
results to the database.

NERO CD-DVD SPEED

You can download CD-DVD Speed from the CD Speed Homepage. You may already have a version of this
utility installed on your system if you have installed Nero Burning ROM CD burning software on your PC. If
you have, it can be found under your \Program Files\ Ahead\Nero Toolkit\ directory as CDSpeed.exe. This
program provides the means to benchmark your CD or DVD drive with a range of tests which you can select
by going to the 'Run Test' menu, and selecting the relevant test under it. If you don't want to select any
specific tests, simply launch the program, leave it at default settings, insert a disk into the drive to be tested,
and click on the Start button. You can save your results in various file formats, and you can share these
results with others on an Internet forum for comparative purposes for example.

GAME BENCHMARKS

The most useful form of benchmarking is through the use of the benchmarking features in many recent
games. This is considered 'real world' benchmarking, since for most intents and purposes modern PC games
are the most system intensive - and system-wide - benchmarks you can use. Many of the more recent games
such as Doom 3, Half Life 2, Quake 4, Prey and F.E.A.R. contain built-in benchmarking utilities. For more
details of these benchmarking functions, as well as how to configure these games for optimal performance,
see this list of my Game Tweak Guides.

If you want an automated utility to run the benchmarks for you, then you can download a range of free
game benchmarking utilities at HardwareOC Benchmarks. Note that they have been given explicit
permission to use TweakGuides.com game guide text and descriptions in their utilities by me. It is strongly
recommended that if you want to do proper benchmarking, you use a recent game benchmark.

The next page covers Stress Testing procedures and tools.

Sunsa] ssamng 2 Sunjreunypuag

Copyright © 2007 Koroush Ghazi 161



http://www.cdspeed2000.com/
http://www.tweakguides.com/Games.html
http://www.hocbench.com/

O.IJE ARSI e s

THE TWEAKGUIDES TWEAKING COMPANION

B STRESS TESTING

Stress testing has one primary purpose on a PC: to exaggerate and bring out any instabilities or sub-optimal
settings as quickly as possible. The reason for this is that instability usually manifests itself at various times
on your system and in various ways and thus its causes may not be clear. A stress tester accelerates the
process by placing extreme stress on certain components of your system to quickly and accurately determine
whether they are the likely cause of system instability. For example, running a program which almost solely
stress-tests your CPU (e.g. Prime95) can give you a good indication of whether it is your CPU which is
causing crashes, freezes, or Windows errors; or whether another component may be to blame.

However specialized a stress tester may be, it will still not provide you with rock-solid evidence that a
specific component is to blame. In the case of the CPU tester for example, it must be recognized that if the
program indicates CPU instability, the causes can still vary. A CPU can appear to be unstable due to one or
more of the following reasons:

= Alack of sufficient CPU cooling

» Alack of voltage to the CPU

» A physical fault with the CPU chip

* The memory subset being unstable

= A particular incorrect software or BIOS setting
* A fault with the motherboard's CPU mounting

The best the stress tester can do is point you in a certain direction - it usually can't provide a precise solution
for your problem. However often this is enough for you to rule out many other causes and hence save you a
lot of time and trouble, and even prevent you from wasting money on repairing or replacing another
component which is not the cause. This is typically the case when you are experiencing game-related
problems, since it may not be clear which of the many components involved in running a game are the
actual culprit. Often the graphics card, the drivers, or the game software itself is blamed when the cause may
be anything from your power supply to the RAM in your system to general settings in Windows.

Below are the more popular stress testing programs available for free, and how to use them correctly,
including details on the component(s) they primarily focus on stress testing:

PRIME95

You can download Prime95 from the Prime95 Website. This small mathematics program will effectively
stress test your CPU and memory subset. Once you've installed the application, to run the actual stress test
run Prime95.exe and choose the 'Just Stress Testing' button. Next, under the Options menu select 'Torture

Test' to start stress testing.

If you want to primarily test your CPU, select the 'Small FFTs' option. If you want to test your CPU in terms
of stability under high heat and voltage usage, select 'In-place large FFTs'. If you want a general system test
which is more 'real world' and combines CPU, cache and RAM testing, select 'Blend'. Once you click OK the
testing will begin. If the program aborts with an error, you will be notified. If at any point you want to stop
the test, go to the Test menu and select Stop.

Make sure you read the document Stress.txt that comes with the program when you get the chance. It will
explain more about CPU stress testing and how Prime95 helps uncover instability. The program
recommends running the torture test for between 6 - 24 hours. In my experience a heavily overclocked PC
that is unstable will crash within a few minutes of running the test. In general if your PC lasts for over 2
continuous hours under the Prime95 torture test it proves that the CPU and memory subset are very stable
and that your overclock and/or system cooling is up to the task.
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Note that stability under Prime95 does not equate to stability for 3D gaming applications for example, since
Prime95 does not stress the graphics card or test graphics functionality in any way. So if you're testing for
stability on a gaming machine, make sure that once you achieve a stable Prime95-tested system, that you
then run a long loop of a graphics benchmark/stress tester like 3DMark or a game afterwards.

SUPER PI

You can download Super PI from the Super PI Website. This small utility is similar to Prime95, in that it
stress tests your CPU and memory subset by calculating the mathematical number PI to a certain number of
places. Download the program and run the super_pi_mod.exe file. Click the Calculate menu item at the top,
and select the number of places to calculate PI to, ranking from 16 thousand (16k) to 32 million (32M) places -
the larger the number of places, the longer it will take.

In general for a speed test of your CPU, select the 1M option and once the calculation is done, note the time
in seconds taken for the final loop (e.g. 38.562s). You can then compare this figure to other people to see how
fast your CPU is. If you want to stress test your CPU, run the full 32M calculation which will take longer,
and hence is a better stress test of your CPU. Once again you can also compare the time taken to complete
this with other users. Just as with Prime95, remember that stability in Super PI does not equate to overall
system stability, or stability in gaming.

SANDRA

Sandra's information and benchmarking functionality has already been covered in detail in the
Benchmarking section above. Here we look at its stress testing abilities. To use Sandra as a stress tester of
specific components on your system, use the relevant modules mentioned under the benchmarking section.
However instead of simply running them once, if you want to stress test the relevant component simply
refresh the benchmark repeatedly (by pressing F5) whenever it completes each run.

If you want to stress all your components in turn automatically, Sandra has a 'Burn-in Computer' module
under the Tools tab which will undertake more thorough stress testing of your machine. Start the wizard,
tick the components you want to continually stress test, set the number of times for them to loop, make sure
to tick the 'Terminate on overheat/failure' option to be safe, and then commence stress testing.

MEMTEST

You can download MemTest from the MemTest Website. MemTest is a Windows-based memory test for all
systems and will help in stress testing your RAM to detect any errors. Memory-related errors are one of the
primary causes of system instability and data corruption/errors, so a RAM tester is a necessity. To use
MemTest simply launch the program, and if you want to use the default memory amount ('All Unused
RAM) simply click the 'Start Testing' button to begin RAM testing. Allow the test to run until it has reached
100%. However ideally you should run the test for at least an hour or more, or even overnight if you want to
test for total system stability. If any errors whatsoever are found then you have unstable memory which can
lead to many types of system problems such as sudden reboots, memory-related errors in games (e.g.
General Protection Faults) or sudden crashes to desktop in programs. Consider reducing any overclocking
and/or increasing your RAM timings and/or even swapping or replacing your RAM module(s) until you
achieve total stability.

MEMTESTS86

You can download MemTest86 (not to be confused with MemTest above) from the MemTest86 Website.
Memtest86 is another good memory test and is better than MemTest in that it tests your memory before
Windows XP loads into memory, which is a much more accurate test/check of your RAM and memory
subset free of any memory spaces taken up by the operating system. To use MemTest86 download the latest
zip file and extract the contents. Run the Install.bat file from the archive and enter a blank 1.44MB floppy as
prompted. To run Memtest86, leave the floppy in the drive and reboot your system - it will run from the
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floppy and test your RAM. Note that some motherboard BIOSes come with MemTest86 built-in, so check
your BIOS for this option and run it from there.

GOLDMEMORY

You can download GoldMemory from the GoldMemory Website. GoldMemory is another memory tester
that runs before your operating system and other programs are loaded into memory, which is the most
optimal condition for memory testing. Usage of GoldMemory is similar to MemTest86, and involves running
the install.bat file of the package to create a bootable floppy disk that can be used for running GoldMemory
upon rebooting.

RTHDRIBL

You can download RTHDribl from the RTHDRIBL Website. RTHDribl (Real Time High Dynamic Range
Image-Based Lighting) is actually a DirectX9 tech demo and not a benchmark or stress tester as such. You
must have a graphics card with Pixel Shader 2.0 support to run it, such as a Radeon 9600 or GeForce FX or
higher card. It does not have a series of tests to run, so simply start up the program and observe your
framerates (top left corner). You can turn off the text shown on the screen at any time by pressing F1 and F3.
You can also cycle through a range of object shown (Press O), the materials used on their surfaces (Press M),
and the backgrounds used (Press L). You can change the display resolution or simply increase the size of the
program's window, either of which will increase the load on your graphics card.

To use it as a stress tester, go to the File menu and select 'Config Display'. In the Direct3D Settings screen
which opens, click the Fullscreen' option, then select a higher resolution such as 1024x768 or 1280x1024. If
you really want to stress your graphics card, select the highest resolution available. You don't need to alter
any of the other options on this screen unless you know what you're doing. Click Ok and the changes will be
implemented. Now start the Auto Demo mode by pressing F5 (or Demo>'Enter Planet Demo') and let the
program run for a while and any graphics instabilities will soon become apparent through crashes, artifacts
or glitches. You can also manually rotate the objects, change them, their materials and background
environments often to put further stress on the graphics card.

Remember, you can use any of the benchmarks listed earlier as stress testers simply by running them at their
highest settings in a continual loop for example. The benchmarking/stress testing tools above are my
personal recommendations, and generally the most popular such tools available. However for a complete list
of benchmarking tools, check the list at BenchmarkHQ. Benchmarking and stress testing tools are an
essential part of any PC troubleshooting, so you should download as many as you possibly can for usage
now and further down the track.
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WINDOWS ERRORS

The information throughout this guide is already aimed at helping you configure your system for optimal
performance and stability. As such the whole guide must be read to allow you to correctly troubleshoot any
problems you may have. However this section contains some specific details on common Windows errors,
and what they may mean. It is by no means a comprehensive listing of procedures to follow in
troubleshooting problems, and must be used in conjunction with the information in the rest of this guide.

B IDENTIFYING ERRORS

Below are links to reputable sources of information (primarily Microsoft) on troubleshooting and solving the
most common errors people experience when using Windows XP. It is import to understand that most
Windows and program errors are not easy to diagnose, and often what the error message says is the source
of a problem, is not the actual source of the problem.

For example, a DRIVER_IRQL_NOT_LESS_OR_EQUAL error is supposed to occur due to faulty drivers,
however most commonly it actually occurs due to excess heat and/or overclocking on the graphics card,
which then generates driver errors, which Windows then reports as a driver error. As you can see, if heat is
the source of your problems, uninstalling and reinstalling your graphics drivers will do nothing to resolve
this issue. So you need to make sure you follow the steps under the Diagnosing Problems area further below
to correctly diagnose a problem.

I cannot cover all the error numbers and error types in this section. Therefore it is also necessary that you
take the initiative and research the particular error code using one of the following trustworthy sources:

Microsoft Knowledgebase

Microsoft TechNet

Microsoft Windows XP Solutions Center
Microsoft Events & Errors Message Center
Windows Support Center Misc. Errors

Use the search functionality in the sites above and enter your exact error code as shown on screen.

SUDDEN REBOOTS ON ERRORS

If you find that your system suddenly reboots when you experience an error, and hence you can't see the full
details of an error, then you will need to disable the automatic reboot on error function in Windows. To do
this, follow these steps:

1. Go to Control Panel>System>Advanced>Startup & Recovery Settings.
Under the 'System Failure' section untick the 'Automatically Restart' option, as well as the 'Send an
Administrative Alert".

3. When next you receive an error, your system will freeze at the error screen and show the error message.
Write down the error type and number exactly as shown for future reference.

4. Manually reboot your system using the restart button on your PC, or by pressing CTRL+ALT+DELETE,
or by holding down the Shutdown button on your PC for 5 seconds.

If your system still suddenly reboots, then this is a sign of memory subset issues. See the Memory
Optimization section and the Overclocking sections, as this is related to your RAM, virtual memory or CPU
Caches, especially when overclocked. Important system information held in memory is suddenly corrupted
and must be dumped, and the system either aborts the program responsible for the corruption - causing an
instant Crash To Desktop (CTD) with no error - or reboots your system instantly to reset memory and clear
the error.
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EVENT VIEWER

Another place to view error codes and error listings is in the Event Viewer, accessible under Control
Panel>Administrative Tools, or by going to Start>Run and typing "Eventvwr.msc" (without quotes) and
pressing Enter. There are three categories of event logs to view - Application, Security and System. Click on
each of these in the left pane, and a list of events and errors (shown as red X's) will display in the right pane.
The first thing to do is not panic if you see several Red X's; this is normal on all systems. What is important is
the details of the error - for example, under System there are commonly lots of DCOM errors if you've
disabled any services. This is because an application will call for a service to start; if the service has been
manually disabled, the application reports an error and continues loading. This is not a genuine error or
something to worry about, unless of course it is the application with which you are having a problem in the
first place - in which case re-enable the relevant service.

To correctly diagnose an Event Viewer error, read the error log text and enter its details into this Microsoft
Error Message Center form, and it will provide you with more details and links to help resolve your

problem.

COMMON WINDOWS ERRORS & PROBLEMS

Below are some common Windows error codes, an excerpt from the Microsoft document describing the error
and some potential causes for the error. Remember, none of these errors has a definite cause, sometimes
something unrelated can cause Windows to generate a certain error. Make sure to click the relevant link to
find out more about the error.

IRQL_NOT_LESS_OR_EQUAL
Microsoft Article

"A Stop 0xA message might occur after installing a faulty device driver, system service, or firmware. If a Stop message
lists a driver by name, disable, remove, or roll back the driver to correct the problem. If disabling or removing drivers
resolves the issues, contact the manufacturer about a possible update. Using updated software is especially important for
multimedia applications, antivirus scanners, and CD mastering tools."

"A Stop 0xA message might also be due to failing or defective hardware. If a Stop message points to a category of devices
(video or disk adapters, for example), try removing or replacing the hardware to determine if it is causing the problem."

"If you encounter a Stop 0xA message while upgrading to Windows XP Professional, the problem might be due to an
incompatible driver, system service, virus scanner, or backup. To avoid problems while upgrading, simplify your
hardware configuration and remove all third-party device drivers and system services (including virus scanners) prior to
running setup. After you have successfully installed Windows XP Professional, contact the hardware manufacturer to
obtain compatible updates.”

DRIVER_IRQL NOT_LESS OR_EQUAL
Microsoft Article

"Stop 0xD1 messages can occur after installing faulty drivers or system services. If a driver is listed by name, disable,
remove, or roll back that driver to confirm that this resolves the error. If so, contact the manufacturer about a possible
update. Using updated software is especially important for backup programs, multimedia applications, antivirus
scanners, DVD playback, and CD mastering tools."

PAGE_FAULT _IN _NONPAGED_AREA
Microsoft Article

"If you added new hardware recently, remove and replace the hardware to determine if it is causing or contributing to
the problem. Run diagnostics software supplied by the hardware manufacturer to determine if the component has
failed."
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"Stop 0x50 messages can also occur after installing faulty drivers or system services. If the file name is listed, you need to
disable, remove, or roll back that driver. If not, disable the recently installed service or application to determine if this
resolves the error. If this does not resolve the problem, contact the hardware manufacturer for updates. Using updated
drivers and software is especially important for network interface cards, video adapters, backup programs, multimedia
applications, antivirus scanners, and CD mastering tools. If an updated driver is not available, attempt to use a driver
from a similar device in the same family. For example, if printing to a Model 1100C printer causes Stop 0x50 errors, using
a printer driver meant for a Model 1100A or Model 1000 might temporarily resolve the problem."

UNMOUNTABLE_BOOT_VOLUME
Microsoft Article

"This behavior can occur if either of the following conditions is true:
= Your computer uses an Ultra Direct Memory Access (UDMA) hard disk controller, and the following conditions are
true:
¢+ You use a standard 40-wire connector cable to connect the UDMA drive to the controller instead of the
required 80-wire, 40-pin cable.
+  The basic input/output system (BIOS) settings are configured to force the faster UDMA modes.
= The file system is damaged and cannot be mounted."

See the Backup & Recovery section for use of the Windows Recovery Console to repair this with the
CHKDSK /R and also possibly with the FIXBOOT commands.

Other Windows Errors
Microsoft Support How-To's

Troubleshooting Article

Long Black Screen on Bootup
Microsoft Article

"The master boot record (MBR), partition tables, boot sector, or NTLDR file is corrupted.”

See the Backup & Recovery section for use of the Windows Recovery Console to repair this with the FIXMBR
command.

Windows Device Manager Error Codes
Microsoft Article

Windows XP Firewall Issues
Microsoft Article

Windows Startup Problems
Microsoft Article 1
Microsoft Article 2
Microsoft Article 3

Startup Issues & Solutions

Windows XP Shutdown Problems
Windows Support Center Article
User Profile Hive Cleanup Service

That is just a brief list of the more common errors and possible solutions. As always your specific problems
may be more difficult to resolve or not found in the list above, therefore I urge you to see the reference
sources listed further above in this section to research and find the solution to your problem, as well as
trying the methods covered below to diagnose your problem.

SIOLI] SMOPUIA

Copyright © 2007 Koroush Ghazi 167



http://support.microsoft.com/default.aspx?scid=KB;en-us;q297185
http://support.microsoft.com/ph/1173
http://aumha.org/win5/kbestop.htm
http://support.microsoft.com/default.aspx?scid=KB;en-us;q155053
http://support.microsoft.com/default.aspx?scid=kb;en-us;310123
http://support.microsoft.com/default.aspx?kbid=875357
http://support.microsoft.com/?kbid=310353
http://support.microsoft.com/?kbid=307545
http://support.microsoft.com/?kbid=317277
http://labmice.techtarget.com/windowsxp/TroubleshootingXP/startup.htm
http://aumha.org/win5/a/shtdwnxp.htm
http://www.microsoft.com/downloads/details.aspx?FamilyID=1b286e6d-8912-4e18-b570-42470e2f3582&DisplayLang=en

O.IJE ARSI e s

THE TWEAKGUIDES TWEAKING COMPANION

B DIAGNOSING PROBLEMS

I've noticed that whenever a problem occurs on a PC, new users tend to think everything that's going wrong
is due to faulty hardware, and that they've just damaged their machine or screwed up thousands of dollars
worth of equipment by editing their registry or changing a setting in a game. More experienced users go to
the opposite extreme: they are always convinced that every fault they see on their PC lies with the software,
despite their overclocking for example, or the fact that they've physically modified their graphics card the
other day, or flashed it with a modified BIOS. The truth lies somewhere in between, and requires that you
have some patience and try some common steps to diagnose your particular problem.

TROUBLESHOOTING CHECKLIST

I suggest you follow these general steps, preferably in the order shown:

Remove any overclocking: I cannot stress this point enough - almost all of the problems which I see reported
on Internet forums and in emails to me are based at least in some part on some form of heat-related issue,
usually brought on by overclocking. Crashes, memory errors, freezing, sudden reboots, garbled graphics or
unusual colors or dots on the screen — these are all the classic signs of a system which is operating outside its
specifications and being over-stressed by a particular game or application. Before blaming any software of
being at fault, you must first change all your hardware back to their default speeds, including such things as
RAM timings. Even if every single other game or program on your system runs fine at a particular level of
overclock, but one game or program doesn't, that does not mean the program is at fault; you should still
make sure your overclock is not the issue by running at stock speeds for a while. If the problem is reduced or
completely eradicated by running at stock speed then the issue is without a doubt related to your overclock.
Note that if you have heavily overclocked and/or modified your components in the past you may have
already caused them permanent damage, so keep this in mind as you try to find the source of the problem.
For example, if you have heavily overclocked your graphics card for some time it is quite likely that you
have permanently damaged the Video RAM and this is the cause of any video artifacts you may see in
games, even at stock speeds.

Check for Heat Issues: A major cause of most system problems is heat buildup. Even if none of your
components are overclocked, under certain conditions components such as your CPU and graphics card in
particular will generate a large amount of heat. This can build up in your case, but even with good case
cooling the heat may buildup locally near the particular component and cause it to malfunction. The most
obvious signs of this are random errors, graphical glitches in games, and crashes to desktop. Check the
Cooling tips in the Overclocking section, and as a temporary solution open the sides of your case and place a
desk fan pointing into the case, or some other method of cooling the internal components. If this helps
reduce the frequency of errors or problems, then heat is a major cause.

Optimize your System: In order to rule out a software-based problem you must make sure your general
system settings are correctly configured. Clearly that is what this guide is designed to do, so follow it in full
and also make sure to check for application or game-specific tweak guides (such as those on
TweakGuides.com listed here) to make sure the software's settings are configured correctly. Sub-optimal
Windows and/or software settings and/or out-of-date drivers are a major cause of problems on many
systems, and even if they are not the primary cause they can certainly exacerbate any existing issues.

Optimize your BIOS: Along with any software optimization you must make sure your BIOS settings are
correct otherwise no amount of software optimization or reduction in overclocking will help. This is another
important area that is almost always overlooked because it is not easy to do. See the BIOS Optimization
section for details. For example, some game problems can be resolved by correctly setting your AGP
Aperture size, or by disabling Thermal Management, or by adjusting your RAM timings - so make sure your
BIOS is optimal.
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Read the Manual & Help Files: There are times when particular games have a known issue with a particular
hardware component or hardware combination. Usually these issues are addressed in patches for the
program, or by new driver releases for the hardware. However you need to be aware of these problems, and
the best way to do that is to read the Readme.txt or similar help files which come with the program. These are
usually located somewhere in the program's directories and a link is typically found for them under the
program's install folder. You may even find mention of known issues in the program's manual or on their
website, so make absolutely certain you read these.

The Problem Occurs During Bootup or in the BIOS: If the problem you are experiencing occurs during your
PC's initial bootup and/or in the BIOS screen then this clearly indicates that it is unrelated to your Windows
settings, drivers or programs, since none of these have even loaded while the BIOS is loading. Problems
which occur during initial bootup or when you are in the BIOS are always either hardware-related faults
(including heat and/or overclocking) and/or a BIOS setting which is incorrect.

Benchmark and Stress Test: It is imperative that if you don't know which component(s) are causing a
problem, that you use several benchmarking and stress testing tools (covered in the Benchmarking & Stress
Testing section) to narrow down the cause. For example if your system is freezing during the playing of
games, it could be the graphics card, CPU, RAM or even the sound card which are at fault. Using several
benchmarking or stress testing programs that are specialized in stressing particular components more than
others will tell you which component is the likely candidate for further investigation. There is no easy way
for anyone to know what the cause is on your system unless you specifically test for it yourself.

Check your Cabling and Components: If you feel comfortable in doing so, turn off your system at the power

switch (but don't unplug it) and open up your case. Check the Hardware Handling Tips section below first,

then:

»  Check to ensure that your component fans are not covered with dust or debris.

* Check to ensure all the cables to and from your components are firmly plugged in and not damaged
along their length.

=  Check your motherboard manual to make sure all the switches on the motherboard are set correctly, and
that all plugs are going into the right source.

» Check for signs of extreme heat such as scorch marks or a burnt smell: these indicate heat damage to
particular components.

* Check to make sure metallic surfaces are not in contact with each other as this can short-circuit
components.

HARDWARE HANDLING TIPS

If you have to physically handle the components in your system, such as removing or installing a
component, checking for component connections, or cleaning the components, you should make sure you
follow these tips to prevent any permanent damage to the components through mishandling;:

* Before opening your case and/or handling any of your components, always shut down your PC and turn
off the power directly at the wall socket - the electricity in your PC can kill or injure you, especially the
dangerous voltages contained in your Power Supply. Even when switched off at the wall, the PSU can
retain a lethal charge for quite some time, so on no account should you ever open your PSU or insert any
metal objects into its casing.

=  Once you've turned off your system at the wall, press and hold the power button on the PSU for several
seconds to discharge any residual energy in the motherboard's capacitors.

*  While handling computer components, make sure you regularly discharge any static electricity in your
body by touching any 'earthed’ object — that is any object that can harmlessly dissipate static electricity.
Typically if you leave your Power Supply Unit plugged into the wall socket (but switched off) then
periodically touching the side of the metal PSU case will harmlessly discharge any static electricity. You
can also purchase an anti-static wrist strap if you handle components regularly. If you are going to
handle components try to minimize how much artificial fabrics and materials you are wearing — these
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can help to build up a significant electrostatic charge in your body. An electrostatic discharge from your
body can instantly kill an electronic component, so do not take this lightly as it can actually happen.

= Do not use a vacuum cleaner to clean your computer and its components — precisely because vacuum
cleaners can discharge static electricity and zap your components. Use a clean barely damp lint-free cloth
to wipe dust from most surfaces, making sure you don't rub or scrape the Printed Circuit Board (PCB).
Don't use any detergents on the cloth and most certainly don't spray any onto the components. Ideally if

it is available to you, use a can of compressed air to blow dust from hard-to-reach or sensitive surfaces as
this is much safer and far more effective.

* Do not force any plugs or cables into sockets that do not appear to be accepting them. Even if the two
ends appear to be matched, the pin arrangements may be slightly different or out of alignment and
hence forcing a fit may actually bend some of the pins and make the connection useless or permanently
damaged. Computer plugs are designed to fit together with firm but not excessive force. This includes
hardware components like the CPU chip which fits into the appropriate socket on the motherboard —
align all the pins perfectly and press evenly but not too hard and they will mate safely. Force the fit and
you may just end up permanently ruining your CPU.

* Most devices in your PC require a source of power, however the voltage they require is very specific. If
you connect the wrong plug to the component (which is hard to do), or forget to attach a power
connector then the component will appear to be dead or may malfunction. You will have to check your
component documentation and especially the motherboard manual to ensure that all components are
plugged in correctly and firmly to receive sufficient power.

* Most hardware components are very sensitive to physical impact and strong vibrations — avoid
situations which result in the bumping or banging of these components, or for example the mounting of
heavy fans onto them which can pass vibrations to these components or warp them under the weight.

* Do not handle liquids around electronic components — any spillage can result in disastrous short-
circuiting. This also includes any thermal or adhesive compounds which can conduct electricity and
hence cause a short-circuit — apply them cautiously and don't just assume that any excess will dry up
and disappear — remove all excess thermal compounds with a cloth.

* Do not place excessive weights on PCBs as this can crack or warp them such that they will be
permanently damaged. Don't even rest a large object temporarily on the motherboard or a component
for example — put them on another surface until you need to use them.

The above tips are for the most part fairly basic and perhaps obvious, but nonetheless essential for correctly
handling electronic hardware components in your PC. Electronic components these days are quite hardy,
and can withstand a lot of abuse, but given how valuable they are I suggest that you don't take any risks.

In the end, if you really can't find a solution to your problem, try contacting Microsoft technical support, or
the tech support for the particular game, application or hardware you are having issues with. Their contact
details are listed on the product box, in the manual or on their website. Make sure to provide them with your
correct system specifications - as covered in the System Specifications section of this guide - as well as full
details of the error. You can also post your specifications and error code(s) along with the things you have
already tried on an Internet forum.
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REGULAR MAINTENANCE

Keeping your Windows XP in optimal working order requires regular system maintenance. This consists of
multiple steps, which cannot all be automated, and should be done at least weekly and ideally after any
major installation/uninstallation of software, drivers, or medium-large files. PCs demand proper system
maintenance, and it can make a significant performance difference, as well as lengthening the period of time
before you need to reinstall Windows to regain that responsive feel. Follow the procedures throughout this
guide and those below to maintain your PC:

STEP 1 - SCAN FOR MALICIOUS SOFTWARE
Update your scanners and then run a full manual on each of your particular scanners (See PC Security
section).

STEP 2 - UPDATE WINDOWS
Check the Windows Update site for any new updates to Windows XP and install all important updates (See
Internet Explorer section).

STEP 3 - CHECK FOR NEW STARTUP PROGRAMS & SERVICES
Using MSConfig, quickly check for any newly installed startup programs or non-Microsoft services, and
then identify and disable those which are unnecessary (See Startup Programs and Services sections).

STEP 4 - RUN A DISK CHECK
Open Windows Explorer, right-click on your main hard drive and select Properties>Tools>Check Now. Tick
'‘Automatically fix file system errors', click OK, then reboot your system to allow Windows to run a Check
Disk scan and repair of your hard drive.

STEP 5 - CLEAN WINDOWS
Manually delete any files you are certain are unnecessary on your system, then run the Disk Cleanup utility,
then CCleaner to delete all additional unnecessary files (See Cleaning Windows section).

STEP 6 - CLEAN & OPTIMIZE THE REGISTRY
Use either RegSupreme or RegCleaner to run a thorough clean of your Registry, then use NTRegOpt to
compact it (See Windows Registry section).

STEP 7 - DEFRAGMENT
Using either the default Windows Disk Defragmenter along with PageDefrag, or a commercial package like
Diskeeper, run a full defragmentation of your hard drive (See Drive Optimization section).

STEP 8 - OPTIMIZE BOOTUP

Clear your Windows Prefetch folder (if not using Prefetch) and then use the Bootvis utility to optimize your
Windows startup layout (See Drive Optimization section).

If done correctly, all of the above shouldn't take longer than an hour - with most of that time taken up by
Step 1 due to manual scanning times. If you want to perform a faster maintenance routine more often you
can run steps 2 - 7 in a much shorter period of time. However make sure you run through the entire set of
procedures often if you want to keep your Windows XP installation responsive and secure.
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CONCLUSION

That brings The TweakGuides Tweaking Companion to a close. I hope you've found the information in this
guide valuable as a reference source. As I say at the end of all my guides: Until next time, take care!

Cheers,

Koroush Ghazi

B VERSION HISTORY

The table below shows all the major revisions made to this guide since first released. Note that Version 3.00
was a major revision and far too many things were changed for there to be detailed change notes provided.

Version

Release Date

Pages Revised

1.00

22 December 2004

Nil - First Release.

1.01

23 December 2004

pp-55, 98 - RegCleaner links fixed.
pp-101 - Reference to /Windows/Prefetch fixed.

10 January 2005

All pages - Formatting altered (e.g. inserted section name on side of each page).
All pages - Numerous typographical /grammatical errors fixed.

pp.13 - XPTC problem reporting link changed.

pp-40 - Internet connection advice clarified in Driver Installation Order.
pp42 - Added XGI graphics card driver download link.

pp-49 - Added 2GB+ RAM example for Virtual Memory.

pp.54 - Prefetcher tweak clarified.

pp.56, 99 - Correct RegCleaner version clarified.

pp-86 - Mention how to re-enable User Names column in Task Manager.
pp-104 - Recycle Bin rename/delete tweak fixed.

pp.121 - Windows Update repair tweak fixed.

pp-145 - AMD CPU Thermal Limiting mentioned.

15 February 2005

All pages - Numerous typographical/grammatical errors fixed.
pp-41, 62, 140 - Added Nvidia Forceware Tweak Guide link.

10 March 2005

pp-34 - Corrected IRQ Priority tweak.

pp-41 - Changed ATI Catalyst download link.

pp.50 - Clarified Position of Pagefile using Diskeeper tweak.

pp.53 - Clarified/corrected LargeSystemCache and IOPageLockLimit tweaks.
pp.54 - Clarified the Windows Prefetcher advice.

pp.102 - Instructions for Prefetch files in /Windows/Prefetch folder clarified.
pp-121 - Changed the Firefox Tweak Guide link.

10 April 2005

All pages - Several typographical/grammatical errors fixed.

pp-23 - Ad-Aware TweakSE plugin linked.

pp-29,87 - Erunt & NTRegOpt links fixed.

pp.56,100-101,157 - All WinOptimizer advice and links replaced by CCleaner.
pp-145 - Throttlewatch link fixed.

pp.148 - PSU Guide link fixed.

pp-160 - Electrostatic Discharge Article link fixed.

1.06

18 April 2005

pp.38 - Provided alternate links for XP Home and Pro Installation Guides.
pp-82-83 - Provide alternate links for XP Services Guide.

1.07

22 April 2005

pp-41 - Fixed Intel software download links.

2.00

18 August 2005

Guide renamed from The Windows XP Tweaking Companion to The TweakGuides Tweaking Companion as
requested by Microsoft.

Guide edited throughout to fix some grammatical/spelling errors and fix dead links.

Otherwise contents remain the same as the previous version(s).

4 January 2006

Major revision and rewriting of the guide - too many changes to list individually:

- Revision/clarification/addition of a wide range of advice.

- Shifting/merging/renaming of a large number of chapters and creation of new ones.

- Fixing/removing a range of dead links, and provision of many new links.

- Format and grammatical corrections and adjustments.

All previous TweakGuides Tweaking Companion/Windows XP Tweaking Companion users should update to this
latest version as soon as possible.
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8 June 2006

All pages - Several typographical/grammatical errors fixed.

All pages - Fixed all dead or inaccurate hyperlinks.
pp.19,164,167 - Updated Sandra instructions for new version.
Pp-29 - Repair install instructions link added.

pp-43 - Removed reference to .NET 1.1

pp-89,93 - ProcessLibrary site link added.

pp-90 - Added Autoruns instructions.

pp-92 - HID Service removed from Disabled list.

pp.97 - $hf_mig$ details added

pp-100 - Imagecfg instructions fixed.

pp.119 - Updated Internet Explorer section for IE7 Beta.

pp-130 - Switched order of Registry compacting & cleaning.
pp-108 - Low Disk Space instructions fixed.

pp.116 - Context Menu Editor link added, CMenu details fixed.
pp-136 - Updated Windows Media Player section for WMP11 Beta.
pp-139 - Quicktime and Real Alternative Codecs added.

pp.144 - Shortcut To instructions fixed.

pp.167 - Added SuperPI instructions.

uoIsSnPUO))

3.20

22 August 2006

All pages - Several typographical/grammatical errors fixed.

All pages - Fixed all dead or inaccurate hyperlinks.

All pages - Updated the TweakGuides Logo.

pp.25 - Corrected KeyPass reference to KeePass.

pp-47 - A-Squared instructions updated.

pp.55-56 - Prefetch instructions further clarified.

pp.62 - I-IFAAST & NTFSDisableLastAccessUpdate Registry key conflict.
pp-69 - Added link to Gamer's Graphics & Display Settings Guide.
pp.95 - Added Advanced Disk Cleanup options.

pp.100 - Added AMD Dual Core Optimizer Utility link.

pp-106 - Updated NTFSDisableLastAccessUpdate details.

pp.145 - Corrected Windows Blinds references to WindowBlinds.

20 November 2006

All pages - Several typographical/grammatical errors fixed.

All pages - Fixed all dead or inaccurate hyperlinks.

pp-19 - Sandra Service names updated.

pp-40 - Intel Matrix Storage Manager link added.

pp43 - .NET reference updated to 3.0.

pp-46 - AVG Free instructions updated.

pp-47 - A-Squared Free instructions updated.

pp.47 - Microsoft Antispyware renamed to Windows Defender.
Pp-49 - Sophos Anti-Rootkit link & instructions added.
pp.61-63 - Diskeeper advice updated.

pp.73 - USB Mouserate tweak clarified.

pp-91 - HijackFree link & instructions added.

pp.120-123 - Internet Explorer chapter revised to suit both IE6 & IE7 final.

pp.137-141 - Windows Media Player chapter revised to suit both WMP10 & WMP11 final.

pp-146 - Zune & Royale Noir theme links added.
pp-172 - User Profile Hive Cleanup Service link added.

3.40

1 March 2007

Cover - TGTC Logo changed.

All pages - Fixed any dead or inaccurate hyperlinks.
pp.102 - Added SetAffinity utility.

pp.149-157 - Overclocking chapter heavily edited.

3.50

1 July 2007

All pages - Fixed any dead or inaccurate hyperlinks.
All pages - Minor layout changes.

pp-47 - Updated A-Squared Free advice.

pp-47-48 - Ad-Aware 2007 instructions added.
pp-49 - HijackThis advice updated.

pp.157 - Added new link for AMD overclocking.
pp-136 - Added Windows Live Mail link.

[End of Guide]
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